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Preface

This document describes the steps for installing and configuring the components of
the Argus Safety Solution application.

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle
Accessibility Program website at
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support. For
information, visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are
hearing impaired.

Related Documents

This section lists the manuals for all Oracle Life Sciences Applications products. You
can order printed manuals from the Oracle iStore.

Oracle Argus Documentation
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»  Oracle Argus Safety User's Guide
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Checking My Oracle Support

The Oracle Argus Safety product suite continues to grow and evolve. To help you use
it and stay abreast of updates we provide between releases, it is a good practice to
check My Oracle Support for information that enhances our released documentation.

To open the Oracle Argus Safety product page on My Oracle Support, complete the
following steps:

1. Open a Web browser to https://support.oracle.com/CSP/ui/flash.html#.

2. Click the Sign In button and log in. The My Oracle Support portal opens,
displaying general news from several categories. If you do not yet have an
account, click "Register here" and follow the instructions given on the registration

page.
3. Click the Knowledge link.
4. In the "Browse any Product, by Name" field, enter "Oracle Argus Safety".

5. Click the Go button to the right of the drop down field. My Oracle Support loads
the Oracle Argus Safety Knowledge Browser Product Page.

Conventions

The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code
in examples, text that appears on the screen, or text that you enter.

xviii
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Getting Started

This chapter discusses how to start working with the Argus application and access
Help files. It also explains how to perform some generic operations in the application.

Product Overview
Logging In
About the Argus Home Page

Basic Features

1.1 Product Overview

Argus Safety is a complete pharmacovigilance software system designed to solve the
pharmaceutical industry's toughest regulatory challenges. Argus Safety supports drug
safety business processes from an easy-to-understand user interface.

1.2 Logging In and Out

Ensure that before starting Argus Safety, the Argus Safety Administrator of your
company has created an account for you and that you have the correct Username and
Password for the system. Be aware of the following;:

If you enter an incorrect password three (3) consecutive times, the system disables
the Login button and displays the following message:

Your account has been locked due to 3 consecutive failed login attempts. Please
contact your System Administrator.

The number of times the user is permitted to enter an incorrect password is
configurable. The default is 3. For information about configuring Argus Safety see
the Oracle Arqus Administrator’s Guide.

The Date/Time format reflect s the 24-hour format used by the Web server.

Note: It is recommended that you use the Application Access portlet
to open the Argus Safety application for different enterprises, as it
takes care of closing the previous enterprise before opening the new
one.

1.2.1 Logging into the Argus Application

Use the following procedure to login to the Argus application:
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About the Argus Home Page

1.  Open Microsoft Internet Explorer and enter the Uniform Resource Locator (URL)

for Argus Safety Web in the Address bar.

2. When the Argus login screen opens, enter your username and password in the

appropriate fields.

Note: Available modules appear in bold text on the log-in screen.
Once the system authenticates your log-in information, you will be

able to access these modules.

3. Select the appropriate database from the Database drop-down list and click Login.

Note: If you get an error message such "Unable to connect to the
database," you may not have permissions to access the database.
Please contact your database administrator for assistance.

4. Once the system authenticates your log in, you can access the modules whose
names are in Bold text. For more information, click the following Single Signon

link.

Note: If your login ID fails three times in a row, the system presents
the following error message: "The log in button has been disabled due
to 3 consecutive incorrect entries of Username or Password. Please

refresh the page to enable the Login button."

To log out of the Argus application

Click Logout on the top-right frame of the window to log out of the application.

1.3 About the Argus Home Page

The Argus Safety application Home page displays a list of Cases Assigned, Contact
Log Entries and Action Item Entries sections specifically for the logged-in user.

Home Page Sections and Fields

The following table lists and describes the section and the fields it contains.

Section Name Field/ Control Name

Search Case Case Quick Launch

Cases Assigned (Country) Case Number

Report Type

Product
Workflow State

Event

Description

Enables you to enter number
of a specific case to search for.

Displays the name of the
country the case belongs to.
The Country is in brackets.

Displays the report type of the

case.
Displays the product name.
Displays the workflow state.

Displays the event name.
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Contact Log Entries

Action Item Entries

(Country) Case Number Displays the name of the
country to which the case
belongs, with the Case
Number listed in brackets.

Contact Date Displays the contact date.

Description Displays the description of the
case.

(Country) Case Number Displays the name of the

country the case belongs to.
The Case Number is in

brackets.

Due On Displays the date when the
case is due.

Description Displays a description of the
case.

1.4 Additional Tabs

The Argus Safety menu displays additional tabs, if you have permission to use the

associated applications.

Tab Name

Description

Argus Console

Argus Insight

The system displays this tab if you have administrator
permissions.

The system displays this tab if you have permission to
use Argus Insight.

1.4.1 Quick Launch Toolbar

Quick Launch enables you to navigate through the application more quickly and more

efficiently. Click the relevant

Quick Launch icons allow you to perform different actions. The Quick Launch Toolbar
is on the top right side of the screen.

HUeE aEbiEelEEE 2y

To enable you to perform the quick launch, the menu bar also lists the quick launch

shortcut keys in parentheses.

Note:

Shortcut keys are driven off a combination of Common Profile

switches and menu access rights. For example, the "Case Save"
shortcut / icon is visible only to users who have been granted access
to save the case in the group configuration. If the menu option is
disabled in the group configuration for a user, the respective shortcut
/ icon will be removed as well. Certain shortcuts / icons such as Field
Validation are enabled only through a common profile switch. These
switches are described in the Common Profile Switch document.
Shortcuts / icons that are driven through common profile switches are
global to all users and are not controlled by group permissions.
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Place the cursor over each icon to view the tool tip, which describes the role of each

icon.The following table lists and describes the function of each icon and includes each

associated shortcut key.

Icon

Tool Tip

Description

Shortcut Key

B ®

B & ©E B B N

New Case from
Image

New Case

Open Case

Close Case

Print Case

Save Case

Forward Case

Return Case

Worklist

Lock Case

Medical Review

Displays a new case from an
image.

Displays the Initial Case Entry
dialog. This is similar to
performing Case Actions -
New Case.

Displays the Case Search
dialog. This is similar to
performing Case Actions -
Open Case.

Performs the same functionality
as Case Actions - Close Case.

Displays the Case Print dialog.
This is similar to performing
Case Actions - Print Case.

Saves the case with any changes
made.

Displays the Case Routing
dialog and enables you to
forward the case.

Displays the Case Routing
dialog and enables you to
return the case.

Displays the Worklist dialog.
This is similar to performing
Worklist - XXX option.

Note: XXX is defined within the
User Configuration for the
default Worklist option. If no
default Worklist option is
defined, then Worklist - New is
displayed.

Displays the Case Lock or Case
Unlock dialog. This is similar to
performing Locking or
Unlocking Cases in the
Activities Tab.

Displays the Medical Review
dialog. This is similar to
performing Case Actions -
Medical Review.

CTRL+ALT+G

CTRL+ALT+N

CTRL+ALT+O

CTRL+ALT+C

CTRL+ALT+P

CTRL+ALT+S

CTRL+ALT+>

CTRL+ALT+<

CTRL+ALT+W

CTRL+ALT+L

CTRL+ALT+M
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Icon Tool Tip

Description

Shortcut Key

E Coding Review

Draft Report

- E2B Check
&

@ Validation Check

Displays the Coding Review
dialog. This is similar to
performing Case Actions -
Coding Review.

Displays the Report List of All
the Expedited Reports. This is
similar to selecting View Draft
Report.

Performs the function that

prints the E2B Report - DTD
Length Check Warnings and
E2B report - DTD Validation.

Performs case validation.

CTRL+ALT+Q

CTRL+ALT+R

CTRL+ALT+E

CTRL+ALT+V

1.4.2 Error Messages

The system displays error messages in pop-up boxes. Every popup box has a Copy
link that enables you to copy the message text to the clipboard so that you can use it

later.

1.4.3 Searching for a Case

You can search for the following:
= A specific case
= An existing case

= A duplicate case

s Incoming E2B (Reports-> E2B Pendings)

To search for a specific case

1. Type the case number in the Case Quick Launch field of the Home page and click

Open.

Case Quick Launch |

| [open |

2. The system displays the case details

To search for an existing case
1. Select Case Actions --> Open.
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OoORACLE Argus Safety Web

I Active Cases Worklist Case Actions Reports Local Affiliate
Case Actions > Case Open Open (Ctri+At+0)

MNew (Ctri=Alt+N}
Case DpEﬂ Mew Caze from Image (Ctri+Alt+G)

Case Search Criteria

2. Enter the case search criteria in the appropriate fields.

3. Click the link displaying a case number to view the case details. By default, each
section and header column is sorted by Case Number in ascending order.

4. Select the checkbox for any of the headers to enable that section. The sections in
which the checkbox is not selected display at the bottom of the screen.

To search for a duplicate case
1. Select Case Actions --> New.

ORACLE" Argus Safety Web

I Active Cases Worklist Case Actions Reports Laecal Affiliate
Home > Personal Argus Status | OpeEn (Ctri+Alt+0)
MNew (Ctri=Alt+N}
Personal Argus Status Hew Casze from Image (Ctri+Al+G)

2. Enter the case search criteria in the appropriate fields to determine whether a
duplicate case is already in the system.

Case Search Criteria Q! Initial Receipt Date # Receipt Range Limits 16-DEC-2009 - 18-MAR-2010
General

¥ Initial Receipt Date Central Receipt Date ¥ Country of Incidence + % Report Type

[ | [72-227-0000 [ | [ |

Protocol ID Study 1D Center ID Initial Justification

| \ | | [ |®

¥ Product Hame Generic Name

| | [csmiee | |

¥ Description as Reported Onset Date/Time

[ | &  [rz-rrr-0000 0000

Note: Users can also perform 'Duplicate Search' through other
options in the application, such as through:

1. Incoming E2B (Reports-> E2B Pendings).
2. Local Affiliate -> Incoming Review.

3.LAM

1.4.4 Argus Insight Integration

Argus Safety has following integration points with Argus Insight. All these integration
point operate within the same enterprise for both Argus Safety and Insight.
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= Case Series sharing: In case of multi-tenant installations, Argus Safety Case
Actions Case Open screen Result from Argus Insight button imports the active
case series for the user from the same enterprise partition of Insight which is
currently opened in Argus Safety.

= Argus Insight application launch: Argus Insight button in the main Argus
Navigation bar opens the same enterprise partition of Insight which is currently
opened in Argus Safety.

1.4.5 Sharing a Case Series

You can share a case series between Argus and Argus Insight as follows:
= Sharing a Case Series in Argus with Argus Insight
= Sharing a Case Series in Argus Insight with Argus

Sharing a Case Series in Argus with Argus Insight
In Argus, a case series can be made available through the Case Search dialog.

1. Search for and select a case in Argus.
2. Open Argus Insight.

3. The system writes case series belonging to the alert to the Argus case-sharing
table.

4. Select Make Active from Argus to make the Case Search dialog case series active in
Argus Insight.

5. If Argus Insight was already open, the Active Case series in Argus Insight is
replaced with cases from Argus.

Sharing a Case Series in Argus Insight with Argus

A case series can be made available from Argus Insight through Active Case Series. To
share a case series in Argus Insight with Argus

1. Go to Case Actions and then click Open.

2. Click Result from Argus Insight to create a search result with the same cases as the
Active case series in Argus Insight.

1.4.6 Basic Features and User Actions

This section discusses the basic features and common user actions available
throughout Argus Safety. These features can be used when working in different
sections of the Argus application.

Common Icons. The icons shown below are common to all modules within Argus:

Icons Description

3 These icons help the user to traverse to the left or right side in a page.

Note: These arrows will not be visible if there is no need to scroll the tabs.

Ij A standard Notes dialog is available.

Note: If the notes are filled in, the dialog displays a Notepad icon.
Otherwise, it is shown as empty by the icon, without any flags.
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Icons Description

Re-arranges the entered items by moving them up or down.

£3
&3

) Depicts the column that is being sorted currently.
@ Enter a justification for an optional field.
@ Indicates that a field has been overwritten or that you can enter data in an

initial justification field.

1.4.6.1 Sorting on Columns
The user can sort on all the columns by clicking the header column.

Tip: Click the same column header again to toggle between
ascending and descending order.

1.4.6.1.1 Field Justifications The fields that display in the application are either required
or optional. Each field type displays with a different colored icon:

= Required fields display with a red icon.
= Optional fields are displayed with a green icon.

Click the icon next to a field to view its corresponding Field Justification dialog. The
image below shows the Field Justification Dialog:

Listedness Justification

Please enter a justification for performing this action:

Not =pecified A

Select a standard justification for this field:
Not =pecified

| clear || spelichese || ok || cancel
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This field warning justification dialog asks the user for a justification to perform the
selected action. To overwrite the warning;:

= Enter a specific reason
= Select a standard reason from the message box.
Enter a justification by doing one of the following:

3. Click OK to overwrite the field justification warning.

4. The orange icon changes to green.

Common Right Click Options
The following table lists and describes common right-click options.

Right-click option Description

Re-arrange Re-arranges all the information.

Copy Copies all the information.

Delete Deletes all the information entered in the tab.

1.4.6.2 Getting Help

Argus Safety provides you with two main sources of online help:
»  Field-level Help
»  Task-based Online Help

To get help performing a particular task
= From the Help menu, select Online Help.

= When the Argus Safety Online Help opens use the Contents, Index, or Search tabs
to locate the required information.

To get information about a particular field on the Case Form

Double-click the label associated with the field. For instance, on the Case Form, you
can double-click the Country label to obtain information about this field.

1.4.6.3 Changing Your Password

When you log on to the system for the first time, it change the password that has been
assigned to you.

Note: LDAP users cannot change their passwords.

To change your password
1. Select Change Password from the Utilities menu.
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Local Affiliate Utilities Dashhoards I Arg
Change Password E
MedDRA Browser
Uszer Login List e
sctivities | Additio| -°9° -
EZB -
_ Reconciliation I
Caze Undelete
i Batch Reports
Blank Report Forms ifi
Initial Justification | End Of Study
| Clear Cache
Advanced Condition Library
olloww-un Add T Tetete i

2. The Change Password dialog box opens.

3. Enter your current password in the Old Password field.

Change Password

Password Information for margarete
0Old Password || |

Date Time 123-MAR-2010 20:03 |

New Password | |

Confirm Password | |

| ox || Cancel |

4. Enter the new password in the New Password field and confirm the new
password by re-entering it.

5. Click OK to change your password. Your password has now been changed.

1.4.6.4 Entering Dates

Several fields in the Argus Safety user interface enable you to enter dates. Fields that
accept full dates appear in the "dd-mmm-yyyy" format. You enter the month using
numbers, or alphabetic characters.

Appropriate formats for entering English dates are as follows:

s DDMMMYYYY where MMM is the three-character abbreviation for the month
(e.g., MAR, APR, JUN, etc.)

s DDMMMYY where MMM is the three-character abbreviation for the month and
YY is the two-digit numeric value for the year (e.g. 09, 10, etc.)

=  DDMMYYYY where MM is the two-digit value identifying the month (e.g. , 01 =
January, 02 = February, etc.) and YYYY is the four-digit value for the year.
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« DDMMYY

» DD-MMM-YYYY
= DD-MMM-YY

s DD-MM-YYYY

= DD-MM-YY

= DD.MMYY

» DD.MMMYY

= DDMMYYYY

= DDMMYY

« DD/MMM/YYYY
= DD/MMM/YY

= DD/MM/YYYY
= DD/MM/YY

1.4.6.5 Entering Multiple Language Text

Certain fields on the Case Form allow you to enter text in languages other than
English. The non-English text that is entered in these fields can also appear on
expedited reports.

To enter text in a language other than English:
1. Click the English language icon.

2. Use the pane associated with English to enter the English language text. Open the
tab associated with the required language to enter text in that language.

3. After completing text entry, you can perform a spell-check for the text.

4. Once you enter text in another language, the icon associated with that language
opens adjacent to the field on the Case Form.

1.4.6.6 Languages Supported in Argus Safety

The table below displays different icons representing different languages.

Icon Language
ﬁ English
E German
-l French
SRR
- Spanish
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Icon Language

|

Italian

III Japanese

Getting Started 1-12



2

Argus Affiliate Module

2.1 Argus Affiliate Module Information

Please see the Oracle® Argus Affiliate User’s Guide for detailed information about each
option available to Central and Affiliate Users under the Local Affiliate menu.
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Active Cases

Active Cases are cases that have already been opened or are currently in use. The
system logs any cases you view in the active case list.

3.1 Opening Active Cases
Follow these steps:

1. Login to Argus.

2. When system opens the Home page, click Active Cases.

3. The system displays a list of the last 10 cases you accessed in the Last Accessed
Cases drop-down list.

4. Click any of the links to select and open an active case

ORACLE

Argus Safety Web

Active Cases

Worklist

Case Actions Reports

10JPOCOOO0DO0S
10US000000008
Last Access Cases

0008 DOX001
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Case Form

This chapter provides information about the Case Form section of the Argus Safety
user interface.

4.1 Case Form Functions
The Case Form enables you to do the following;:
= Enter case-specific information
s Log preliminary information about cases
The Case Form has the following tabs:
= General Tab
= Patient Tab
s Products Tab
= Events Tab
= Analysis Tab
m  Activities Tab
» Additional Info Tab
= Regulatory Reports Tab

Each tab enables you to capture specific information about the case and is designed to
capture similar information in each of its subsections.

Note: Some sections in each tab enable you to make multiple entries.
For example, you can have more than one reporter in the Reporter
Information section of the General tab. Each individual entry is
identified by another set of tabs in the section.

All tabs of the Case Form also display read-only information about case priority and
status.

To access the Case Form
1. Search for an existing case.

2. When the application displays the search results, locate the appropriate case
number and click the case number link.

3. The system opens the Case Form with information about the case.

Case Form 4-1



Case Form Functions

4.1.1 Case Form Features

The case form provides features to help you use it more effectively.

General Case Form Usage Information
When using the Case Form, be aware of the following:

The maximum number of Products and Events is 200 per case.

The drop down values for elements such as Yes/No/Unk is not hard coded. The
system retrieves the values from a look-up table. This affects the following:

- Reporter Information | HCP
- Device Information | Improper usage/Storage Field

The system defaults to the first button on every message box pop up dialog. When
the user clicks Enter or the space bar, the system validates the choices.

The user can enter a hyperlink (e.g. http://www.oracle.com and
https:/ /www.oracle.com) in the Field Label Help for the Case Form Fields

When the user clicks a hyperlink, the system opens the link in a new Internet
Explorer browser window.

The following Case Form fields are type ahead fields:
- Contact Logs | Group and Users
- Action Items | Groups and Users

The WHO Drug browser displays the WHO Drug Version on the browser dialog.
The browser dialog is configured in System Configuration | Case Form
Configuration.

Users can enter decimal numbers with up to three (3) decimal places in the UDF
Number fields on all tabs. If the user does not enter a decimal, the system does not
display trailing zeroes.

4.1.1.1 Using Password Acceptance Dialog Boxes

The system displays the User Name in read-only mode in following dialog boxes
where the user must enter a password to start processing:

Activities Tab: Case Lock/Unlock

Activities Tab: Case Archive/Un-Archive

General Tab: Unblind Case

E2B Acceptance/Rejection for Initial, Follow-up, and Notification
Affiliate Acceptance/Rejection of Events

Case Actions: Delete/Undelete

4.1.1.2 Initial Case Entry
When using the BookIn dialog box, be aware of the following:

You can enter the attachment classifications and their descriptions on the Initial
Case entry dialog.

The field labels are the same as those defined in the Field Labels and the Case
Form
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— The lengths for the Classifications type ahead field and the Description field
are the same as those on the Additional Info tab

— The system filters classifications by user sites and the attachment
classifications permissions.

- When you select the URL Reference, the system hides the Classifications and
Description fields.

s The system transfers the values the user enters in the Classifications and
Description fields after the cases have been booked in.

= If the system does not find any cases during a duplicate search, it places the
following message in the search results section: No cases found.

= When you try to book in a clinical trial case and select a study where the country
of incidence value does not match the list of countries defined in the study
configuration, the system displays the following warning message in the standard
Argus Safety warning message dialog box:

The country of incidence does not match the country list specified for the selected
study.

- If no countries are specified in the study configuration for the selected study,
the warning message does not display.

—  If the user selects the study before entering the COI, the system performs the
validation

s The user can right click on the row and select the following:

- Case Summary -- The system displays the Case Summary (Current
functionality).

- Medical Summary Report -- The system displays the Medical Summary report
PDF only if the user has access to the Medical Review dialog box. If the user
does not have access, the system hides the Medical Summary Report option.

—  Print -- The system launches the Case Form print dialog box. If the user has
permission to access the Print Case dialog, the user can print the Case Form. If
the user does not have access to the Case Form print dialog box, the system
hides the Print Case option.

Zoom Function
The Zoom feature enables you to increase or decrease the font size of the text.

1. Click the Zoom icon across the Case Form tabs.

2. The Zoom dialog enables you to increase or decrease the Font Size of the text on
the Zoom dialog.
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/) Notes -- Webpage Dialog X

E hktkp: ff10, 143,213, 190: 8053/ CaseformyDialogs/Motes, asprDSPLYLMG=0

Hotes Adjust Font Size [

Thiz iz test narrative

| ok || cancel || SpellChed

Ihttp:/f10,143,213. 190:8083/Caseform/Dialo (@) Internet y

3. Click Adjust Font Size to increase or decrease the font size.
»  Click + to increase the font size up to five (5) font sizes in one-size increments.
s Click - to decrease the font size to the current by increments of 1.

This feature is available on the following dialogs:

= Reporter Notes

= Patient Notes

»  Patient Other Relevant History Notes

= Patient Lab Data Notes

= Patient Relevant Test

= Parent Medical History

= Parent Other Relevant History Notes

= Product Notes

= Case Analysis: Narrative. This is also available on the Medical Review Dialog.

= Case Analysis: Abbreviated Narrative. This is also available on the Medical
Review Dialog.

= Case Analysis: Company Comment. This is also available on the Medical Review
Dialog.

= Case Analysis: Local Evaluator Comment. This is also available on the Medical
Review Dialog.

= Case Analysis: Administrative Notes. This is also available on the Medical Review
Dialog.

= Case Analysis: Evaluation in light of similar events in the past. This is also
available on the Medical Review Dialog.

s AffSAPS: Future Actions.
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s Activities: Contact Log Description.

»  Activities: Action Item Description. This is also available on the Medical Review
Dialog.

= Activities: Routing Comments

= Notes and Attachments: Description

Case Form Drop-down Options

The Case form for the following fields includes Type Ahead functionality. This feature
automatically suggests possible options as term names as you are entering the text. If
you double-click on the field, the system shows the standard drop-down values for the
field.

The following is a list of fields with type ahead functionality:
= Accidental Exposure

= Action Taken

= Action Type

s Age Groups

s Age Units

= Anatomical Locations

= Attachment Classification
= Attachment Keywords

= Birth Type

s Case Classification

»  Causality Category

= Condition Type

s Contact Type

s Delivery Types

s Device Preliminary Comments
= Device Subcomponents

= Device Type

s Dosage Frequency

s Dosage Units

s Ethnicity

= Evaluation Reason

= Event Frequency

= Event Intensity

= Event Outcome

s Fetal Outcome

s Formulation

s Gender
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s Intermediary

s Lab Result Assessment Terms
= Lab Test Type

»  Manufacturers

s Occupations

= Package Units

= Reference Type

= Report Media

= Report Type

= Reporter Type

= Routes of Administration

s Study Center

4.1.1.3 Argus Safety Case Form User Preferences
Argus Safety remembers your actions as you navigate through the Case Form.

The system can return to the same location on the tab after you tab to a different form.
For example, you are on the 8th reporter in the Reporter Section on the General tab
and move to another location in the application. When you return to the General tab,
the system takes you directly to the 8th Reporter because it was the last Case Form
location that you accessed before moving out of the Case Form.

User preferences are only applicable during the same session for a case, irrespective of
the Case Status (read-only or editable). If you exit from the case and open a new case,
the system resets the preferences.

Quick Navigation

Each page displays the navigation flow used to access the page. The following table
lists shortcut keys to help you navigate more easily and quickly.

Shortcut Key Output

CTRL+SHIFT+# Goes to the tab indicated by the # entered. (1=General tab, 2=Patient
tab, etc.)

ALT+SHIFT+# Goes to the sub-tab as indicated by the # entered (= Product 1, Product

2, etc.)Note: The maximum # for the sub entities is 10 which pertains to
ALT+SHIFT+1 for the first entity within the tab till ALT+SHIFT+0 for
the 10th entity within the tab.

4.1.2 General Tab

The General tab is designed to capture case information in categorized sections that
capture category-specific information. The General tab enables you to enter or view
information such as type of report, literature information, and so forth.

The General tab has four sections as described in the following table.

Section Purpose

General Information ~Contains information about the report type, receipt dates, etc.
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Section Purpose

Study Information Contains information about clinical trial details, if appropriate.
Reporter Information Contains information about Reporter details.

Literature Contains information about Literature cases.
Information

4.1.2.1 General Usage Information
When using the General Tab be aware of the following:

»  The system saves all filtering criteria the user enters on the Reporter Look Up
dialog as user preferences while it populates the reporter information on the
General Tab.

- If you have reporter information in the case, the system continues to display
the reporter information in the Reporter Lookup dialog and automatically
performs a search.

-  After performing the search the system retains the search criteria as user
preferences. The next time you perform a search, the system displays these
preferences.

- When you log out, the system retains the user preferences and makes them
available the next time you log in to the system

- You can click Clear to clear all the values in the filtering elements.

—  If the system cannot find any reporters during a search, it displays the
following message in the reporter look up dialog:

No reporters found

= If a priority has not been assigned to a case, the system hides the Case Priority
field label.

= If a case owner has been assigned to the case, the system displays the name of the
case at the top of the Case form. If a case owner has not been assigned, the system
hides the Case Owner label.

s The Project ID can be 40 characters long. Users can scroll in the field.
s The Study Name field can be 70 characters long.

= When the Classifications field is hidden, the system does not display the
classification section on the Case Form.

s The mandatory fields identified in the E2B Mapping in the factory or custom
profiles are identified with an icon on the Case Form fields on the Case From and
Medical Review dialog boxes.

= All popup message boxes that had only an OK or Cancel button have a Clipboard
button that enables you to copy the message content to the clipboard for later use.

4.1.2.2 Dynamic Workflow Indicators

Dynamic workflow indicators track the amount of elapsed time it takes to complete a
workflow step.

»  The first number represents the time left or exceeded for a given workflow step
s The second number indicates the time left till the reporting deadline.

= Time is expressed in days (d), hours (h), and minutes (m) respectively.
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The icon changes based on the amount of elapsed time for the workflow step.

Icon Denotes

Traffic Light No status can be indicated, for example if no timing is defined in the
workflow.

Red Traffic Light The timing has been exceeded.

Yellow Traffic Light The timing is in danger of being exceeded.

Green Traffic Light The timing is in good standing.

If the time to complete the case process exceeds the allocated time, the system displays
the value in red with the time displayed as a negative value. Only archived, locked
cases do not display the dynamic workflow indicator.

4.1.2.3 General Tab: General Information Section
The following is an illustration of the General Information section on the General tab.
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4.1.23.1 General Information Fields The following table lists and describes the fields in
the General Information section.

Field/Control Name

Description

Report Type

Country of Incidence

Initial Receipt Date

Central Receipt Date

Initial Justification

Select the item that best describes the type of report. Choice of
report type determines availability of fields relating to clinical
studies and/or literature references.

Note: Clinical study reports prompt the user for information
relating to the study, and literature-based reports enable the user to
select the journal and reference on which the case is based.

Select the country where the adverse event occurred. The E2B icon
identifies fields required for E2B.

Enter the date your company became aware of the case. Argus
Safety uses this date throughout all reports.

Note: This date can be changed only prior to regulatory report
submission.

Enter the date on which this information was received by Central
Safety.

Enables you to enter the initial justification reason. The entry in
this field is displayed as per the reason entered when the case is
being booked in.
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Field/Control Name

Description

Aware Date

Follow-up (#)

Follow-up Received

Central Received

Significant

Data Clean up

Follow-up Justification

Classification

Case Requires Follow-up

This item is read-only. It displays the most recent significant
follow-up when such follow-up information was specified. If not,
the initial receipt date is displayed.

Follow-up number automatically increments based on updates to
the Follow-up Received field.

The figure displayed within "()" denotes the number of follow-ups
added to the case.

Note: The order of the Follow up dates is maintained. For instance,
on sorting the Follow-up, the serial number still displays the order
of entering the follow-ups. The Follow-up headers can be sorted by
the Follow-up Received and Follow-up Safety Received Columns.
Click on the header to sort in ascending order or to sort in
descending order. By default, the sorting is in descending order of
the Follow-up Received Date.

Click Add to enter the date on which follow-up information was
received by your company. You can select whether the case has
significant follow-up information.

Note: If you select Yes, the Significant check box is selected. When
sorting on follow-ups, by default, the dates are sorted in
descending order of the Follow-up Received Date.

Enter the date on which follow-up information was received by
Central Safety.

Click the checkbox if the follow-up is significant.

Click the checkbox to mark the Follow up as a Data Clean up
version. This version is used in the Data Lock Point for Case
Versioning in and System Reports.

Enables you to select a pre-defined justification for Follow-up.
Click the icon to view the standard justifications dialog.

You can select a pre-defined justification from this dialog or enter a
new justification. Refer to the screen shot given below the table.

Select up to 50 case classifications used to categorize a case. Click
Add to enter additional case classifications.

Select this check box if the case requires follow-up information.

4.1.2.4 General Tab: Study Information Section
The Study Information section enables you to enter information about case studies.

-]
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4.1.24.1 Study Information Fields and Field Descriptions The following table lists and

describes the fields in the Study Information section.

Field/Control Name

Description

Project ID

Center ID

Enter the Project ID, or select one from the list. Selecting a Project ID
automatically creates items in the Study ID list.

Select the appropriate center ID from the list.
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Field/Control Name

Description

Study Phase

Study Name
Study Type
Week #

Visit #

Blinding Status

Study Description
Observe Study Type

Unblinding Date

Enables you to enter the Study Phase for the configured study.

Note: This field is pre-populated if you select a Study with an
already-configured Study Phase.

The study name is entered automatically based on the study that is
selected.

The study type is entered automatically based on the study that is
selected.

Enter the week number of the study during which the adverse event
occurred.

Enter the visit number of the study during which the adverse event
occurred.

Depending on the type of study, this item is entered automatically by
the system. You need special access rights to use any of the Broken By
entries.

Note: The Unblind Case dialog appears when you try to unblind a
study. For Not Blinded studies, saving the case or generating a report,
you can enter the actual drug (vs. placebo) given to the patient.

The study description is entered automatically based on the study that
is selected.

The value selected from this drop-down list is populated in the Case
Form Study Section when the Clinical Study is selected.

This item is automatically entered by the system. If you double-click
the date in this item, the Unblind Case dialog is displayed. If the date
of unblinding is more recent than the date for the most significant
follow-up information, an automatic follow-up is generated.

4.1.2.4.2 Study Restrictions To enter pre-defined Study Information

1. Click Select to choose from the already available list of study information.

2.  When the Clinical Trial Selection dialog opens, enter Project, Study, and Center
information as appropriate.

The Clinical Trial Selection dialog allows you to select a clinical trial from the list
configured by the Administrator.
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Clinical Trial Selection

Enter study information and click on search

Project Study Center

| [x-22 us 002 || | [Ssarch|

Total Number of Rows: (1}

Project ID Study ID Other ID
X-22 X-22 U5 004 Phase Hi

Total Number of Rows: [0}

Center Center ID Address

Total Number of Rows: (1)
K -22 S va PLACEBO Double Blinded

3. Click Search to generate the search results.

Tip: To broaden the search results, enter as little information as
possible. Select the required clinical study and study center and click
Select.

4. Choose the appropriate study information from the list and click Select.

5. The details of the selected Study Information are added to each field in the Study
Information section

4.1.2.5 General Tab: Reporter Information

The Reporter Information section enables you to enter information about the person
providing the case-related information. The following is an illustration of the Reporter

Information section.

When using this section, be aware of the following:

s The Reporter Rearrangement dialog also shows the number of Reporters present
in the case. It displays the First Name and Last Name, followed by the Reporter
Type in brackets, as entered in the reporter information dialog.

= You can also view all the Reporters by clicking the Quick Launch icon.

Case Form 4-11



Case Form Functions

s Click any Reporter Name to view the details of the selected Reporter tab.

s Click the New tab to add a new reporter anytime. You can add a maximum of 100

reporters.

s The Primary Reporter is identified by the Reporter icon on the Reporter
Information tab.

Reporter Information Fields
The following table lists and describes the fields in the Reported Information section.

Field/Control

Name Description

Notes Click this button to enter free text notes relating to this reporter.

Note: This field supports multiple language entry. You can click on a flag,
select the language tab, and enter information.

Sal. Enter the reporter's salutation.

First Name Enter the reporter's first name.

Middle Name Enter the reporter's middle name.

Last Name Enter the reporter's last name. The Select button displays the Reporter
Selection dialog. If you select a reporter from this dialog, the system
automatically completes the case form reporter fields.

Suffix Enter the reporter's suffix; for example, HR, or MED.

Health Care Select Yes, No, or Unk (Unknown) to indicate whether the reporter is a

Professional health-care professional.

Occupation Select the reporter's occupation from the list.

Address Enter the reporter's address.

Institution Enter the reporter's institution.

Department Enter the reporter's department.

City Enter the reporter's city.

State/Province Enter the reporter's state, province, or county.

Postal Code Enter the reporter's postal code.

Country Select the country name. The Administrator maintains this list.

Phone Number
Alternate Phone
FAX Number

Reporter ID

Reporter's
Reference #

Email Address
Reporter Type
Report Media

Intermediary

Enter the reporter's telephone number.
Enter another telephone number for the reporter, if available.
Enter the reporter's fax number.

If known, enter the Reporter ID. This automatically completes the Case
Form reporter fields.

Enter the Reporter's Reference # for the case.

Enter the reporter's email address.
Select the Reporter Type. The Administrator maintains this list.
Select the medium of the report. The Administrator maintains this list.

If appropriate, select the type of intermediary. The Administrator
maintains this list.

Case Form 4-12



Case Form Functions

Field/Control
Name

Description

Report sent to
Regulatory
Authority by
Reporter?

Protect
Confidentiality

Primary Reporter

Correspondence
Contact

(New) Tab

Make a selection, as appropriate to the case.

If this check box is selected, the name and address of the reporter do not
appear on regulatory reports and the reporter's information displays
"NAME AND ADDRESS WITHHELD".

Identifies the primary reporter. Only one primary reporter is permitted
per case. The primary reporter is the reporter whose name appears on the
regulatory reports. The tab that identifies the primary reporter is
displayed in blue as compared to the other reporter tabs.

If this check box is selected for a reporter, the reporter's address
information is used in letters. You can select more than one reporter as
the correspondence contacts for the case.

Creates details for a new reporter.

4.1.2.5.1 Adding Reporter Information You can add reporter information by clicking the
Select button and entering data in the Reporter Lookup dialog box.

To add reporter information
1. Click Select in the Reporter Information section.

2, When the system opens the Reporter Lookup dialog box, enter the required search
criteria in the fields and click Search.

Tip: You can choose to search either by Search Cases or by Search
List Maintenance.

Reporter Lookup

First Hame
Institution

Address

Couniry

Last Hame Reporter D
Institution I Department Reporter Type
=
City Phione Humber
StateProvince Postal Code
=| © searchcCases ¥ seareh List Maintenance Chesr Smion

Seadt == 1

3. The Search results for the entered search are displayed.

4. When the system displays the search results, choose the appropriate reporter
information from the list and click Select.
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5. The system adds the selected, pre-defined information to the fields in the Reporter
Information section.

4.1.25.2 Reporter Lookup Dialog Box Fields The following table lists and describes the
fields in the Reporter Lookup dialog box.

Field/Control Name Description

First Name
Last Name

ID

Institution

MR

Physician
Department
Reporter Type
Address

City
State/Province
Postal Code
Phone Number
Country

Search Cases

Search List
Maintenance

Enter the first name of the reporter.

Enter the last name of the reporter.

Enter the ID of the reporter.

Enter the institution of the reporter.

Select this button if the reporter is a Medical Representative (MR).
Select this button if the reporter is a Healthcare Physician.
Enter the department of the reporter.

Enter the reporter type.

Enter the address of the reporter.

Enter the city of the reporter.

Enter the state/province of the reporter.

Enter the postal code of the reporter.

Enter the phone number of the reporter.

Enter the country of the reporter.

Click this button to search for cases that match the specified search
criteria.

Click this button to search the list maintenance for the specified criteria.

4.1.2.6 General Tab: Literature Information Section

This section enables you to enter a literature reference for the case. You can enter the
information manually or you can enter pre-defined literature information by click the

Select button and selecting from the list of pre-defined references.

pre Taar
Tame o
g ol P
Lingratase e i ¥

Click the Quick Launch iconto view all the items present in the case. This information
appears in the format: (Journal Name Yea Vol: Pages)

8

1. Literature #1
2. (New)
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4.1.26.1 Literature Information Fields and Field Descriptions The following table lists and
describes the fields in the Literature Information section.

Field/Control

Name Description

Select Selects a literature reference directly from the list of literature articles entered by
the Administrator.
Note: If the required literature article is not present in the list, details of the
article can be entered by using the remaining fields in the section.

Journal Enter the name of the journal in which the article appeared. This value gets
displayed in italics.

Author Enter the name(s) of the author(s) of the article.

Title Enter the title of the article.

Volume Enter the volume of the particular journal.

Year Enter the year in which the article was published.

Pgs Enter the journal page numbers in which the article appears.

To enter pre-defined literature information
1. Click Select to choose from the already available list of literature information.

2. When the Literature Reference dialog opens, locate and select the appropriate
reference in the list and click Select.

3. The details of the selected literature information are added to each field in
Literature Information.

4.1.3 Patient Tab

This section of the Case Form helps you to enter patient information such as the
patient's past medical history and current conditions, and laboratory tests and test
results. The medical information entered here could be very useful to the person
analyzing the event. For example, if the adverse event was a rash that developed after
applying a topical product, the knowledge that the patient has a history of allergic
reactions could be relevant.

iy Fee |
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teal Rame ] Ladt Basia Futidls

T it Conmdertatty T Cresd ory Case
e ity Coumiry
[T — Poatsl Cade [Leney——

Lo Sy fi s [5]
—_——— S e e )

The Patient tab includes the following tabs: Patient and Parent.
= Patient Tab
= Parent Tab
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4.1.3.1 Patient Tab: Patient Information
The Patient tab includes the following sections:

= Patient Information

= Patient Details

s Other Relevant History
= Event Death Details

= Lab Data

s Relevant Tests
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4.1.3.1.1 Patient Information Fields The following table lists and describes the function of
each field.

Field/Control

Name Description

Patient Info From  Copies name and address information from the Reporter section of the
Reporter button General Tab into the Patient Information section.

Current Medical
Status Button

Sponsor Identifier

Pat. ID

Randomization #

Number of Patients

Captures details about the history and the current condition of the patient
from the dialog.

Note: The items that appear in the Current Medical Status dialog
automatically map to the fields for the German BfArM tab on the
Analysis tab. Changing the values on the BfArM tab does not affect these
items.

Enter the Sponsor Identifier of the patient.

Note: This field appears for clinical trial cases only.

Tip: This field can be used while searching for cases in the Case Selection
dialog.

Enter the Patient Identifier number.

Note: This field appears for clinical trial cases only.

Tip: This field can be used while searching for cases in the Case Selection
dialog.

Determines which drug was administered to the patient during the
course of the study.

Note: This field appears for clinical trial cases only.

Tip: This field can be used while searching for cases in the Case Selection
dialog.

Enter the number of patients involved in the adverse event.
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Field/Control

Name Description

First Name Enter the first name of the patient.

Note: During book-in, the system transfers the appropriate patient name
to the relevant name and initials fields. If the Patient Name or Initials are
three characters or less, this is transferred to the Initials field.

MI Enter the middle initial of the patient.

Last Name Enter the last name of the patient.

Initials Enter the patient's initials. Existence of the patient's first, middle, or last
name automatically populates this field.

Protect If this check box is selected, the patient's name and address will not

Confidentiality appear on any of the regulatory reports and the patient's information will
show the word PRIVACY.

Child only Case If this check box is selected, then the pregnancy [Detail] button is
accessible from the Parent information tab only and no longer through
the Patient tab directly.

Address This field and the following four fields allow you to enter the patient's
address.

City Enter the patient's city.

State/Province Enter the patient's state, province, or county.

Country Select the country. The Administrator can adjust this list.

Postal Code Enter the patient's postal code.

Phone Number Enables you to enter the phone number of the patient.

4.1.3.1.2 Neonate Information Section When using the Neonate Information section, be
aware of the following:

= You can delete neonate information by right clicking the neonate and selecting the

Delete option.
= The system tracks changes to the neonate information in the audit log.
4.1.3.1.3 Pregnancy Information The Pregnancy Information section enables you to enter
data about a pregnancy. When using this section be aware of the following new fields:

Gravida and Para. These fields enable you to capture numerical gravida and para
information.

4.1.3.1.4 Entering Current Medical Status Use the following procedure to enter
information about the patient's current medical status.
1. Click Current Medical Status in the Patient tab of the Case Form.

2. The Current Medical Status form opens as a pop-up.
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3. Select the choices that apply to the patient from the items in the form.

If you don't know whether a particular condition applies for the patient, select
Unk.

4. C(lick OK to save the current medical status.

4.1.3.1.5 Copying Patient Information from Reporter Information If the patient and the
reporter are the same person, the reporter information entered in the General tab can
be copied to the Patient tab.

Reporter Information
If the patient and the reporter are the same person, the reporter information entered in
the General tab can be copied to the Patient tab.

Click Patient Info From Reporter in the Patient tab to copy the reporter information.
The reporter information is copied.

4.1.3.2 Patient Details Section

The Patient Details section enables you to enter information, including pregnancy
data, about a patient. The following is an illustration of the Patient Details section.
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4.1.3.21 Patient Details Fields and Field Descriptions The following table lists and
describes the fields in the Patient Details section.

Field/Control
Name Description
Date of Birth Enter the patient's date of birth. You can enter a partial date if the actual

date is unavailable.
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Field/Control

Name Description

Age Calculates the patient's age, from the date of birth and earliest event onset
date, if both full dates are available; otherwise, you can enter the age
manually.

Units Select the age units. (i.e., days, weeks, months, years)
Note: If both the date of birth and event onset date are available, the Age
Units field is automatically calculated. The Administrator can adjust this
list.

Age Group Select an age group. If the age group is entered manually, the Age and Age
Units fields are disabled. The Administrator can adjust this list.
Note: This field is automatically filled in when the Age and Age Units
fields are both entered.

Ethnicity Select the patient's ethnicity. The Administrator can adjust this list.

Occupation Select the patient's occupation. The Administrator can adjust this list.

Weight Enter the patient's weight.

Weight Units Select the appropriate weight unit.

Height Enter the patient's height.

Height Units Select the appropriate height unit.

Gender Select the patient's gender.
Note: If the patient is male, the system automatically disables the
Pregnancy field.
When the Gender is set to Female, the Pregnancy drop down is enabled
and set to Unknown.

Pregnant Make the appropriate selection.
Note: If Yes is selected, a Details button will appear. Click Details to enter
pregnancy information.

Date of LMP Enter the date of the Last Menstrual Period, if applicable. A partial date
can also be entered.

Breastfeeding Select the checkbox, if applicable.

User Defined Enables the user to enter information about the patient.

UDText2--UD  Enables users to enter information about the patient.

Text 9

4.1.3.2.2 Entering Pregnancy Information Use the following procedure to enter pregnancy

information.

1. Select Yes from the Pregnant drop-down list, if applicable.

This field is shown as active only after the Gender field in this section is selected

as Female.

The Pregnancy Information section is displayed.

2. Enter the available pregnancy information in the form.

3. (Click OK to save the pregnancy information.

The following lists and describes the fields on the Pregnancy Information form.
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Field/Control Name

Name Description

Due Date Enter a due date or an approximate due date, if known.

Weeks at Onset Enter the number of weeks of pregnancy at the time the event occurred,
if known. The maximum entry allowed in this field is 50.

Prospective/Retrospe Select if the information was Prospective or Retrospective.

ctive

Weeks at Exposure

Trimester of
Exposure

Number of Fetus

Delivery Date
Weight
Weight Units
Delivery Type

Birth Type
Fetal Outcome
APGAR Score
Delivery Notes

Note: A prospective information is one where the company hears of the
case before the baby is born to the patient who took the drug.

In a retrospective case, a company gets to know after the baby is born.

Enter the number of weeks of pregnancy at the time of exposure, if
known. The maximum entry allowed in this field is 50.

Make the appropriate selection.

This tab allows entry of data for a baby who is born to the patient. Click
New to make an additional entry.

Enter the date of the delivery.
Enter the birth weight
Select the appropriate weight units.

Select the delivery type from the list. The Administrator can adjust this
list.

Select the birth type from the list.
Select the fetal outcome from the list.
Enter the APGAR scores-up to three per neonate.

Enter notes on the case.

4.1.3.3 Event Death Details

The Event Death Details section enables you to enter information about the death of a

patient.
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The following table lists and describes the fields in the Event Death Details section.

Field/Control

Name Description

Date of Death Enter the date of death

Autopsy Done? Select whether autopsy was done.

Note: If Autopsy Done is set to No or Unknown, the Autopsy Results
Available is shown as No.
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Field/Control

Name Description

Autopsy Results Select if autopsy results are available.

i ?

Available? Note: The Autopsy Results Available? field is enabled only if the
Autopsy Done? field is marked as Yes. However, if Autopsy Results
Available is changed to No and Autopsy Result rows exist, you will be
asked to delete the rows first. Click Yes to delete the data.

Add Click this button to add a Cause of Death and Autopsy Results row.
Note: A user can add multiple records, up to 50 entries.

Delete Enables you to delete a highlighted row.

Up/Down Click Up to move the record up and click Down to move the record down.
Note: Ordering reflected on the case form displays the same ordering as
displayed in the E2B report repeatable tags.

Cause of Death Describes the cause of death.

Description as Displays the description reported by the reporter.

Reported

Autopsy Result Describes the autopsy results.

Encode Encodes the event reported by the reporter.

4.1.3.4 Other Relevant History Section

The Other Relevant History section enables you to enter information that might be
useful. The system enables you to copy the Other Relevant History rows by selecting
the row and clicking Copy. The following is an illustration of the Other Relevant
History section.
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4.1.3.41 Other Relevant History Fields and Field Descriptions The following table lists and
describes the fields in the Other Relevant History section.

Field/Control

Name Description

Start Date Enter the start date of the condition. You can enter a partial date if the
actual date is not available. You can also choose not to enter a date.
Note: If you click Add but do not enter a date, the Date column is
removed.
Once the date is entered and there is a test associated with the date, you
cannot clear the date but can only modify it. To remove the date column,
individually delete all the cells in that Date column.

Stop Date Enter the stop date of the condition. You can enter a partial date if the
actual date is not available. You can also choose not to enter a date.

Ongoing If the condition is ongoing, select the Ongoing check box.
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Field/Control

Name Description

Condition Select a condition type from the list. The Administrator can adjust this list.

g}i](g?ci/oze/rgzggli{) Ln Note: If the Condition Type value is Medical History Episode and the
term is not encoded, the value entered in the Description field is
appended to the Patient Notes value. However, if the Condition Type
value is Other Relevant Therapy and the term specified in the
Description field is not encoded, then this record is not transmitted at all.

Encode Click this button to encode the term.
Note: To view the complete MEDDRA hierarchy for the encoded term,
click the encoding status icon.

Coded Enter a term to describe the condition. You can either manually encode or

PT/Description of auto-encode, if you have been so configured by the Administrator.

condition In manual mode, type the description (for example, Fever).

LLT/Indication

PT/Reaction PT In Auto-encode mode, enter a partial description and press ENTER or
TAB.
The appropriate coding dialog appears.
In either mode, you can click Encode and modify the encoding. If the
condition type is historical drug, the encoding will be done with WHO
drugs.
Note: To view the complete MEDDRA hierarchy for the encoded term,
click the encoding status icon.

Indication PT Enter a term to describe the indication.
Note: This field is visible on the case form only if the condition type
selected in the List maintenance is Patient Other Relevant Therapy.

Reaction PT Enter a term to describe the reaction.
Note: This field is visible on the case form only if the condition type
selected in the List maintenance is Patient Other Relevant Therapy.

Notes Enter any notes that are relevant to the condition.

Copy Enables you to copy a row. After you copy the row, the focus will be on
the newly copied row.

Add Enables you to add a row to the relevant history. After you add the row,
the focus will be on the new row.

Delete Enables you to delete a row from the relevant history.

Up Enables you to move up a row in the relevant history.

Down Enables you to move down a row in the relevant history.

4.1.3.5 Lab Data Section

The Lab Data section provides data about lab test and test results. The maximum
number of lab test data on the Case Form is 2000. The following is an illustration of the
Lab Data section.
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4.1.3.5.1 Lab Data Fields and Field Descriptions The following table lists and describes the
fields in the Lab Data section.

Field/Control Name

Name Description

Lab Data Section

Date Enter the date the test was carried out. Partial dates are allowed for in
this field.

Test Enter a lab test name, or select from the list. Also select the assessment

Name/Assessment  from the list below the Test Name.
Select Lab Test Group Enables you to select one or more lab test groups.

Result/Units Enter the test result, including the appropriate units and select a term to
describe the qualitative assessment of the results. The Administrator
can modify the list of possible assessments.

Norm Low/Norm The Test Name list can retrieve details of the normal range for the test
High selected (if the Administrator has entered the normal range into the
list). Otherwise, enter the values manually.

Encode Click this button to encode the term.

Note: To view the complete MedDRA hierarchy for the encoded term,
click the encoding status icon.

Notes Enter notes pertinent to this case.

4.1.3.5.2 Using the Lab Data Section When using the Lab Data section, be aware of the
following:

= A single, vertical scroll bar has been placed beneath the header and date
information in the Lab Data section. This enables the date to be seen at all times.

- To keep all the rows together, all rows in the Lab Data Test as Reported " and
Results/Units use this scroll bar.

— A maximum of three (3) rows is visible at all times.

You can perform several different actions in the Lab Data section as follows:

To enter a Lab Test Name
1. Click Add Test.

2. Enter a partial description of the lab test in the Lab Test Name dialog.
3. Click Search. Select the required lab test from the search results.

Selecting a Lab Test Group
The system enables you to select a lab test group from the dialog box.
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When selecting a lab test group, be aware of the following;:

= When you click Select, the system populates the Lab Test Group with a list of lab
tests that match the selected lab test group.

= Iflab test data is already on the Case form, the system appends the lab test group
after the last lab test.

Arranging Entries in a Specific Order
Click the Order icons to arrange entries in a specific order.

Adding Additional Rows of Lab Test Data

Right-click on an empty cell as shown below. Click the Add option that gets displayed,
to add more rows of lab test data.

Deleting or Copying Rows in Lab Data

Right-click the row to be deleted or copied to an empty cell after a Test Date has been
added, as shown below.

Lab Data (2)

[04-NOV-2011 | | [08-nOw-2011
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The Copy and Delete options are displayed. Select the applicable option, as required.

Sorting the Entries
The Lab data will be displayed in chronological order by Date of the Test and
alphabetically by the Test Name.

If there are partial dates entered, the date is displayed at the beginning of the month,
and year for the date entered.

Viewing the Hierarchy of the Event Term
1. Click the icon to view the entire hierarchy of the Event Term.

2. Click outside the MedDRA hierarchy dialog to close this hierarchy listing.

Viewing Notes
Click the icon to view display the Notes in a Zoom dialog.

4.1.3.5.3 Arranging the Lab Test data Click the arrow button to arrange the Lab Test to
the right Lab Test. This shall only be available when the Lab Test has been entered for
the same date.

Click the arrow button to arrange the Lab Test to the Left Lab Test. This shall only be
available when the Lab Test has been entered for the same date.

4.1.3.54 Relevant Tests Section This section enables you to enter additional information
about any relevant tests, such as toxicology. The following is an illustration of this
section.
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4.1.3.6 Patient Tab: Parent Information
The following is an illustration of the Parent tab.
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4.1.3.6.1 Parent Information Section The following is an illustration of the Parent
Information section on the Parent tab.
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Parent Tab Fields and Field Descriptions
The following table lists and describes the fields on the Parent tab.

Field/Control Name
Name

Description

Parent Initials
Date of Birth

Age

Units

Gender

Date of LMP

Weight

Weight Units

Height

Height Units

Parent Breastfeeding

Medical History

Enter initials about the parent.

Enter the parent's date of birth. You can enter a partial date if the actual
date is unavailable.

Calculates the parent's age, from the date of birth and earliest event
onset date, if both full dates are available; otherwise, you can enter the
age manually.

Select the age units.

Note: If both the date of birth and event onset date are available, age
units field is automatically calculated. The Administrator can adjust
this list.

Select the parent's gender.

Note: If the parent is male, the system automatically disables the
Pregnancy field.

When the Gender is set to Female, the Pregnancy drop down is enabled
and set to Unknown.

Enter the date of the Last Menstrual Period, if applicable. A partial date
can also be entered.

Enter the parent's weight.
Select the appropriate weight unit.
Enter the parent's height.
Select the appropriate height unit.
Select the check box, if applicable.

Captures information about the parent's medical history.

4.1.3.6.2 Other Relevant History Section The Other Relevant History section enables you
to enter information that might be useful. The system enables you to copy the Other
Relevant History rows by selecting the row and clicking Copy. The following is an
illustration of the Other Relevant History section.
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Other Relevant History Fields and Field Descriptions
The following table lists and describes the fields in the Other Relevant History

section.

Field/Control Name

Description

Start Date

Stop Date

Ongoing
Condition

Type/Verbatim/Indic
ation/Reaction

Encode

Coded

PT /Description of
condition
LLT/Indication
PT/Reaction PT

Indication PT

Reaction PT

Notes

Copy

Add

Delete
Up

Enter the start date of the condition. You can enter a partial date if the
actual date is not available. You can also choose not to enter a date.

Note: If you click Add but do not enter a date, the Date column is
removed.

Once the date is entered and there is a test associated with the date, you
cannot clear the date but can only modify it. To remove the date
column, individually delete all the cells in that Date column.

Enter the stop date of the condition. You can enter a partial date if the
actual date is not available. You can also choose not to enter a date.

If the condition is ongoing, select the Ongoing check box.

Select a condition type from the list. The Administrator can adjust this
list.

Note: If the Condition Type value is Medical History Episode and the
term is not encoded, the value entered in the Description field is
appended to the Patient Notes value. However, if the Condition Type
value is Other Relevant Therapy and the term specified in the
Description field is not encoded, then this record is not transmitted at
all.

Click this button to encode the term.

Note: To view the complete MEDDRA hierarchy for the encoded term,
click the encoding status icon.

Enter a term to describe the condition. You can either manually encode
or auto-encode, if you have been so configured by the Administrator.

In manual mode, type the description (for example, Fever).

In Auto-encode mode, enter a partial description and press ENTER or
TAB.

The appropriate coding dialog appears.

In either mode, you can click Encode and modify the encoding. If the
condition type is historical drug, the encoding will be done with WHO
drugs.

Note: To view the complete MEDDRA hierarchy for the encoded term,
click the encoding status icon.

Enter a term to describe the indication.

Note: This field is visible on the case form only if the condition type
selected in the List maintenance is Patient Other Relevant Therapy.

Enter a term to describe the reaction.

Note: This field is visible on the case form only if the condition type
selected in the List maintenance is Patient Other Relevant Therapy.

Enter any notes that are relevant to the condition.

Enables you to copy a row. After you copy the row, the focus will be on
the newly copied row.

Enables you to add a row to the relevant history. After you add the row,
the focus will be on the new row.

Enables you to delete a row from the relevant history.

Enables you to move up a row in the relevant history.
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Field/Control Name Description

Down Enables you to move down a row in the relevant history.

4.1.4 Products Tab

The Products tab enables you to enter and view details about products and dosage
regimens. The Products tab contains the name of the drug that has been entered within
that tab. For Blinded Studies, the Blinded Product Name gets displayed in the tab.

When a user has no access to view unblinded information on the Case Form, the
following fields are hidden:

s Drug Code

s Study Drug

»  Formulation

s Concentration

s Outside Therapeutic Range

s Dose

s Dose Description

= Daily Dosage

= Regimen Dosage

» Patient Route of Administration
= Parent Route of Administration
» Package ID

s Pack Units

= Batch\Lot

= Expiration Date

»s  Total Dosage Units

» Total Dose to Primary Event

4.1.4.1 General Usage Information
When using the Products tab, be aware of the following:
If the study has been unblinded and a study drug had been selected, the selected

Study Drug Name is displayed. You cannot view unblinded information and the tab
continues to show the Blinded Product Name.

You can enter details of more than one product and more than one dosage regimen for
a company product for which multiple licenses exist (for example, drug and vaccine,
or drug and device).

Depending on the type of license (drug, vaccine, or device), different views are
available in the Products tab. If the selected item is not a company product or if a
license for a company product does not exist, all three views are always available.

4.1.41.1 Time Measurement Fields You can enter seconds in the following fields:

= Argus > Case Actions > Open > (Select a Case) > Event tab > Event sub tab >
{event description} sub tab > Event Information section (middle of screen)
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—  Onset From Last Dose field
— Duration field
-  Onset Latency field

= Argus > Case Actions > Open > (Select a Case) > Products tab > Product sub tab >
{Product Name} sub-sub tab (drug) > Dosage Regimen section (lower 1/3 of
screen)

- Duration of Regimen

= Argus > Case Actions > Open > (Select a Case) > Products tab > Product sub tab >
{Product Name} sub-sub tab (drug) > Product Details section (lower 1/3 of screen

- Duration of Administration
—  Time between First Dose/Primary Event
—  Time between First Dose/Primary Event
= Any number following by the letter "s" defaults to "#sec."
s The system interprets the seconds the user enters in the following formats where:
#is a number from 0 to 9
#s -- The system automatically changes the format to # sec.
#s -- The system automatically changes the format to # sec.
# sxx
where:
x is other letters -- The system automatically changes the format to # sec
s The Temporal View and the Case Form printout display the seconds.
s The E2B import and export case functions support seconds and M2 Validation for
the defined fields.
4.1.4.1.2 Date of Mfr Field You can enter a partial date in the Date of Mfr field. The
MedWatch (Device) and EU Device Reports print the partial dates entered in the field.

The Products tab includes three tabs: Drug, Device, and Vaccine.
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4.1.4.2 Products Tab: Drug Tab

The Products tab displays the Drug section by default as shown in the following
illustration.
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The Drug tab includes the following sections:

Product Information
Product Indication
Dosage Regimens
QC Info
Product Details

4.1.4.21 Product Information Section The Products Information section enables you to
enter information about the drug being used for the case. The following is an
illustration of the Product Information section.
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Product Information Fields and Field Descriptions

The following table lists and describes the fields and controls in the Product
Information section.

Field/Control Name Description

Suspect Indicates whether the drug

Concomitant

Treatment

Product Name The name of the product associated with the adverse event.
Generic Name The generic name of the product

Company Drug Code The unique value the company uses to identify the drug.

Obtain Drug Country The name of the country where the drug was obtained.

Drug Code The unique value that identifies the drug.

WHO Medicinal The WHO Drug code used to identify the drug

Product ID

Formulation The form in which the drug was administered (liquid, tablet, capsule,
etc.)
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Field/Control Name

Description

Drug Authorization
Country

Manufacturer
Concentration
Unit

Interaction
Contraindicated?

Study Drug Not
Administered

UD Number 1 -- UD
Number 9

The country where the drug was authorized for use.

The company that manufactured the drug.
The amount of the drug that was administered.
The drug unit (i.e., mg, tsp, etc.)

Identifies the drug interaction, if any.

Check this box if this is a study drug and was not administered.

4.1.4.2.2 Product Indication Section The Product Indication section enables you to enter
information about the indicator of the adverse event. It includes two fields: Reported
Indication and Coded Indication

Reported indication is the reported reaction and Coded Indication is the code for the
reaction. The two values may be the same, but they may also be different.

41423 QClInfo The QC Info section enables you to enter quality control information.
The following is an illustration of the
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QC Info Fields and Controls
The following table lists and describes the fields in the QC Info section.

F

Field/Control Name

Description

QC Safety Date

QC Sent Date

Enter the QC department reference number for the

analysis.

Enter the sent date.
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Field/Control Name

Description

QC Cross Reference

Date Returned
Global ID
Quantity

# CID Number
PCID Number
Lot Number

Complaint Categories Date
Complaint Categories Text

Analysis Categories Date

Analysis Categories Text

Analysis Summary Date

Analysis Summary Text
QC Result Date
QC Result

QC Comment

Enter the QC department reference number for the
analysis.

Enter the date returned.

Enter the global number.

Enter the quantity.

Enter the Control Identification Number.

Enter the Product Control Identification Number.

Enter the lot number. If the Lot Number entered is
incorrect, a Lot Number Lookup dialog is displayed, that
allows you to enter select from the existing lot numbers.

Enter a date for complaint categories.

Enter a text explanation as necessary. Use the zoom icon to
open the zoom notes and view or edit the text.

Enter a date for analysis categories.

Enter a text explanation as necessary. Use the zoom icon to
open the zoom notes and view or edit the text.

Enter a date for an analysis summary.

Enter a text explanation as necessary. Use the zoom icon to
open the zoom notes and view or edit the text.

Enter the date the result of the analysis was received by the
QC department.

Enter a text explanation as necessary. Use the zoom icon to
open the zoom notes and view or edit the text.

Enter any comment relating to the analysis.

4.1.4.2.4 Product Details Section The Product Details section enables you to enter
information about the drugs being used for the case. The following is an illustration of

the Product Details section
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Product Details Fields and Field Descriptions

The following lists and describes the fields in the Product Details section.

Field/Control Name Description

First Dose This date is defined as the earliest regimen start date and is entered

automatically.
Last Dose This date is defined as the latest regimen stop date and is entered

automatically. If the Ongoing check box is selected, this field will not be

filled in.
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Field/Control Name

Description

Duration of
Administration

Total Dosage

Total Dosage Units

Time between First
Dose/Primary Event

Time between Last
Dose/Primary Event

Total Dose to Primary
Event

Action Taken

Abuse

Overdose
Tampering

Taken Previously /
Tolerated

Was Protocol
Followed?

Dechallenge

Date

Rechallenge Results

Start Date/Time
Stop Date/Time

This field is calculated automatically if full dates are available for first
and last doses. It is the difference between the first and last dose for all
dosage regimens.

Note: If the duration is five days or more, the duration displays in
number of days. If less than five days, it displays in days and hours.

This field is calculated automatically based on daily dose, duration, and
frequency. If each regimen is associated with different dosage units, this
field is not calculated automatically.

This field is calculated automatically based on daily dose, duration and
frequency. If different regimens have different dosage units, this field is
not calculated automatically.

Enter the time from the first dose to the onset of the primary event.
Enter the time from the last dose to the onset of the primary event.
Enter the total dose of drug given before the onset of the primary event.

Select the appropriate item from the list. If no change or dose increased
is selected, the Dechallenge Results and Rechallenge Results sections
below are not available. The Administrator can adjust the values in this
list.

Select this check box if the patient abused the product (For example:
Painkillers taken without pain).

Select this check box if the patient took an overdose of the product.

Select this check box if the product appeared to have been tampered
with before it was used.

Select the appropriate response from the list.

Click the appropriate button to indicate whether the protocol was
followed during the study.

Note: This item is only available for study products.

Make the appropriate selection depending on whether the drug was
stopped.

If you select Neg or Pos or Unk, the Dechallenge Date is enabled.
Select N/A to disable the Dechallenge date.

Enter the date when the dechallenge was carried out.

Make the appropriate selection depending on whether the drug was
taken again. If Pos or Neg or UNK is selected for the Rechallenge field,
the Rechallenge Start Date/Time, Rechallenge Stop Date/Time, and
the Rechallenge Outcome fields are enabled.

Enter the date and/or time when the rechallenge was started.

Enter the date and/or time when the rechallenge was stopped.
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Field/Control Name

Description

Additional Product
Tabs

(New) Tab

Click the additional product tabs to switch views. The products may
have one or two letter icons next to it. The following are the icon names,
and what they mean:

VC- Vaccine view selected
DR- Drug view selected
DV- Device view selected
S- Suspect Product

C - Concomitant Product

Enter information about a new product.

4.1.4.25 Dosage Regimens Section The Dosage Regimens section enables you to enter
information about the size and frequency of drug doses being given to a patient. The
following is an illustration of the Dosage Regimens section.
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Dosage Regimens Fields and Field Descriptions
The following lists and describes the fields in the Dosage Regimens section of the Drug

tab.

Field/Control Name

Description

Start Date/Time

Stop Date/Time

Ongoing

Outside Therapeutic
Range

Duration of Regimen

Dose #

Dose

Enter the start date and time of the dosage. Entry of time information is
optional, and you can enter partial dates.

Enter the stop date and time of the dosage. Entry of time information is
optional, and you can enter partial dates.

Note: If no Stop Date is entered, Onset from Last Dose is calculated
automatically from the Event Onset Date and the most recent Stop Date
or the most recent Start Date.

Select this check box if the drug treatment is ongoing. The Stop Date,
Duration of Regimen, and Last Dose fields are removed if this check
box is selected.

Select this check box if the drug has not been used in accordance with
the label or has been used for outside the Therapeutic Range. Consult
your Administrator for further company-specific information on the
use of this field.

This value is calculated automatically, based on regimen start and stop
dates (if full dates are entered for the start and stop dates). If the value
is entered manually, the duration units (for example: minutes, hours,
days, months, or years) must also be entered along with the actual
duration.

Note: The Administrator can set the duration to be inclusive or
exclusive. In Inclusive mode, the starting day counts in the calculation
of the duration; in Exclusive mode, it does not.

Enter the drug dose number.

Enter the dose received by the patient.
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Field/Control Name

Description

Dose Units
Frequency

Dose Description

Daily Dose

Daily Dose Units

Regimen Dosage

Regimen Dosage
Unit

Route of
Administration

Parent Route of
Administration

Accidental Exposure

Package ID
Pack Units

Batch/Lot #

Expiration Date

(New) Tab

Select the dose unit. The Administrator can adjust this list.
Select the frequency. The Administrator can adjust this list.

This value is automatically entered by using the values from Dose,
Dose Units, and Frequency. If necessary, you can change this value.
However, if Dose, Units, or Frequency information is changed, this
value will be recalculated.

This value is calculated automatically depending on the dose and
frequency. It can be manually overwritten. If either the dose or the
frequency fields are blank, this field is not calculated automatically.

This value is derived automatically from the dose unit.

This value is calculated automatically depending on the daily dose,
duration, and frequency. This total can be overridden. If the daily dose
is blank or the frequency fields are 0, this field is not calculated
automatically.

This value is derived depending on the Daily Dose Units.

Select the route of administration. The Administrator can adjust this
list.

Select the route of administration for the parent. The Administrator can
adjust this list.

Select the type of Accidental Exposure from the list. A non-modifiable
list of items is provided for this list.

Enter the package ID.

Select the package presentation information of the product. The
Administrator can adjust this list.

Enter the batch and/or lot number(s).

Enter the expiration date. Enter a partial date if the full date is not
known.

Click this tab to create a new dosage regimen entry.

4.1.4.2.6 Study Drug Information You can enter a Study Drug for a Non-Configured
Study entered in a case and mark a current product as a study drug.

To mark a product as a study drug
1. Right click on any suspect product in the case.

2. Select Make Study Drug to mark the current product as a study drug.

Be aware of the following:

»  The system disables the drug type to make the product a Concomitant or
Treatment option.

= Study Drug is a read-only field that contains the product name selected by the

user.

= For non-configured studies in the case, the system displays the following for all
study drugs in the case:

Study Drug Not Administered.
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4.1.4.3 Products Tab: Device Tab

The Device tab enables you to enter information about devices being used for a
particular case. It has the following subsections:

s Product Informationi

s Product Indication

s Product Delivered by Device
= Device Information

4.1.4.3.1 Product Information Section The following is an illustration of the Product
Information section of the Device tab.
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Fields and Field Descriptions
The following table lists and describes the fields in the section.

Field/Control Name Description

Multiple Language Click Multiple Language Text to open the Multiple Language Text dialog
Text box.

Notes Click the Notes icon to enter notes related to the product.

Select Displays the product selection dialog.
Select a product from the list of company products click Select.

The relevant fields are added to the Case Form.

Encode Click Encode to retrieve the code.

Suspect/ Make the appropriate selection for the product you are entering. The
Concomitant/ drug types indicate the involvement of the product with the adverse
Treatment event(s) reported for the case.

Suspect indicates that the product may have caused the adverse event(s).
Concomitant indicates drugs that are taken with the suspect drug.

Treatment is the drug taken to treat the adverse event.

Product Name Enter the name of the product using the Select button or by entering a
partial product name. Type a partial product name and press TAB. This
displays the Product Selection dialog. If only one product is found, this
information is entered without showing the dialog. If no match is found
in the company product list, the WHO Drug Dictionary is searched for a
possible match through the WHO Drug Dictionary Dialog. If a match is
still not found, the text you initially typed in, is used as is.

Note: If the study is blinded, the Blinded Name of the clinical study is
displayed in this field. If a user has access, the selected Study Product
Name for Unblinded cases is shown.
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Field/Control Name

Description

Generic Name

Company Drug Code
Obtain Drug Country
Drug Code

WHO Medicinal
Product ID

Device Type

Formulation

Drug Authorization
Country

Manufacturer

Concentration

Units
Interaction?

Contraindicated?

Study Drug

Enter the generic name of the drug in a manner similar to the Product
Name. If the study is blinded, the Generic Name is replaced with the
Study Name of the product.

Note: This name is entered automatically depending on the chosen
company product.

Displays the licensed country for the selected company product.
Country the drug is licensed in.
Enter the WHO-DRUG code.

Displays the Medicinal ID associated with the selected WHO drug.
Note: This ID is populated only if a WHO-drug is selected.

Indicates the type of device being used for this case.

Select the formulation of the product. The Administrator can adjust this
list.

Note: This field is entered automatically depending on the product.

Enter the company drug code.

Note: This name is entered automatically depending on the chosen
company product.

A different Manufacturer can be selected from the drop-down list and
can still be kept as a company product.

After a drug and formulation have been entered, select the concentration
from the list, or enter the concentration. If this information is changed
manually, the product is marked as a non-company product.

Note: This field is entered automatically depending on the chosen
product. The concentration cannot be modified for a Study drug.

Select a concentration unit. The Administrator can adjust this list.
Indicates whether the case involves a drug interaction

Indicates whether the drug was administered contrary to its indication.
Make the appropriate selection to indicate whether the drug was
contraindicated in this case.

Select the study treatment the patient received from the list. If the study
is Blinded, this field is disabled. The Administrator can adjust the
information in this list. Drugs listed here are dependent on the Study ID
selected for the General tab.

Note: This field is applicable for Unblinded or not blinded clinical trial
cases only.

4.1.4.3.2 Searching for Products You can perform two types of searches in the section:

»  Product Browser Search

= WHO Drug Coding Search

Product Browser Search
To search for a product

1. Click Select in the Products tab.

2. The Product Browser dialog is displayed.
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9.

Click Select to start searching.

When the system opens the Product Browser dialog box, Click the entities
displayed in the dialog.

The hierarchy above and below the entity being searched is also displayed. For
example, if Product Name is searched, it displays the Product Name as well as the
Family Name and Trade Name.

Search for Products based on the following criteria:

s Ingredient

= Family

s Product Name

= Trade Name - Searches the License Trade Name

Click the Full Search check box to select all these criteria when searching.
Click Select.

The results based on the search criteria are displayed and the user can select the
Product.

Click Clear to remove the entered search criteria.

WHO Drug Browser Search
Be aware of the following when using the WHO Drug Browser search function:

The system enables you to perform a full search from the WHO Drug browser
when you select the Full Search option.

- By default, the system performs a like search (e.g.,, CUREALL%)
- You can use the percent (%) sign to perform wildcard searches

- If you click Full Search, the system performs a full search (e.g., %CUREALL%)
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s The system also enables you to search for drug formulation and country. However,
this is available only if you select the WHO Drug C format. Otherwise, the option
is disabled.

= When you click Clear, the system clears the search criteria you entered.

= After the system performs the search, you can sort the results on all the fields.

To perform a WHO Drug Browser Search
1. Select the Encode button to open the WHO Drug Coding dialog.
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2. You can use both the WHO Drug B Format as well as the WHO Drug C Format
using the same browser.

Select either the WHO Drug B format or the WHO Drug C format from the Case
Form Configuration dialog where the Dictionaries are chosen for encoding.

3. Enter your search criteria in these fields and click Search to display the product
attributes that match the given search criteria:

» Trade Name - the trade name of the product

s Formulation / Strength - the Formulation / Strength (sequence 3 and
sequence 4) of the product.

s Country - The Sales Country Code of the Product as defined in the WHO
Dictionary

»  Generic - Whether Generic - Yes or No.

The following criteria are not available for display or searching in the WHO
Drug B Format:

— Formulation
- Strength
—  Generic

— Medicinal Product ID
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- Product Type
4. Click Select to copy the selected drug to the Product tab.

5. Click Cancel to close the selection dialog without making any updates to the
Product tab.

The WHO Drug Coding Dialog has the following fields:

Field Description

Product Type Select the type of product from the drop-down list. Note: All is
displayed as the Product Type by default.

ATC Code Enter the ATC Code up to a maximum of 10 characters.

Drug Code / Searches on either criterion as per the radio button selected for the

Medicinal Prod ID search. By default, the Drug Code option is selected.

Trade Name / Searches on either criterion as per the radio button selected for the

Ingredient search. By default, the Trade Name option is selected.

Formulation Enables you to search based on the drug formulation.

Country Enables you to search for a drug based on the country where the drug
was sold.

4.1.4.3.3 Entering Quality Control Information You can enter quality control information
by clicking the QC Info button and entering the appropriate information in the
Quality Control dialog box.

About the Quality Control Dialog Box
The following is an illustration of the Quality Control dialog box.
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The following table lists and describes the fields in the Quality Control dialog box.

Field Description
QC Safety Date Enter the QC department reference number for the analysis.
QC Sent Date Enter the sent date.
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Field Description

QC Cross Reference  Enter the QC department reference number for the analysis.

Date Returned Enter the date returned.

Global ID Enter the global number.

Quantity Enter the quantity.

# CID Number Enter the Control Identification Number.

PCID Number Enter the Product Control Identification Number.

Lot Number Enter the lot number. If the Lot Number entered is incorrect, a Lot
Number Lookup dialog is displayed, that allows you to enter select
from the existing lot numbers.

Complaint Enter a date for complaint categories.

Categories Date

Complaint Enter a text explanation as necessary. Use the zoom icon to open the

Categories Text

Analysis Categories
Date

Analysis Categories
Text

Analysis Summary
Date

Analysis Summary
Text

QC Result Date
QC Result

QC Comment

zoom notes and view or edit the text.

Enter a date for analysis categories.

Enter a text explanation as necessary. Use the zoom icon to open the
zoom notes and view or edit the text.

Enter a date for an analysis summary.

Enter a text explanation as necessary. Use the zoom icon to open the
zoom notes and view or edit the text.

Enter the date the result of the analysis was received by the QC
department.

Enter a text explanation as necessary. Use the zoom icon to open the
zoom notes and view or edit the text.

Enter any comment relating to the analysis.

4.1.4.3.4 Product Indication Section The following is an illustration of the Product
Indication section of the Device tab.

Product Indication Fields and Field Descriptions

The following table lists and describes the fields in the Product Indication section.

A=l

Field/Control

Name Description

Reported By default, the value of this field is populated with the Product Indication
Indication from the Product Configuration, if set up by the user. If not, you can enter a

term into the Reported Indication field.

Note: Argus Safety automatically encodes this information. You can also
click Encode to open the coding dictionary dialog.

Coded Indication This field is populated with the encoded term when the user enters data in
the reported indication field and tabs out.
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Field/Control
Name Description
Encode Opens the MedDRA Browser with the term already populated from the
(Indication) Coded Indication field.
Note: To view the complete MEDDRA hierarchy for the encoded term, click
the Encoding Status icon.
Add Adds a new Indication row.
Note: Only two indications are visible at a time
Delete Click this button to delete the selected Indication row.
M/W Info The MW Info dialog allows you to enter the following device information:

= Usage of Device: Make the appropriate selection to indicate whether
the use of the suspect medical device was the initial use, reuse, or
unknown.

= Is this a single-use device that was reprocessed and reused on a
patient?: Indicate whether the device was labeled for single use. If the
question is not relevant to the device being reported (for example, an
X-ray machine), leave the select box cleared.

= Single Use Device: This field will be populated by information on the
form.

= Name and Address of Reprocessor: Enter the name and address of the
reprocessor.

= Device Evaluated by Mfr: Select the Not returned to mfr. check box if
an evaluation could not be made because the device was not returned
to or made available to the manufacturer. Select Yes if an evaluation
was made for the suspect medical device. You can attach a summary of
the evaluation and select the Yes,Summary Attached. If an evaluation
of a returned suspect or related medical device was not conducted,
select the No check box and attach an explanation or provide an
appropriate code from the coding manual (Part II, Subpart A).

= Ifno, provide reason: If the Device Evaluated by Mfr is "No," then
select a reason from the drop down.

»  Type of Follow-up Report: Select the appropriate check boxes that most
accurately describe the nature of the follow-up (supplemental) report
as follows:

= Correction - Changes to previously submitted information.Additional
information - Information concerning the event that was not provided
in the initial report because it was not known/available when the
report was originally submitted.Response to FDA request - Additional
information requested by FDA concerning the device/event.Device
evaluation - Evaluation/analysis of device.

= Evaluation Codes: Click Select to enter the applicable codes from the
categories listed. Follow the instructions in the dialog to enter the
evaluation codes. Conclusion codes must be entered even if the device
was not evaluated.
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Field/Control
Name Description

= USC 360i(f) correction/removal reporting number: Enter the number
that the FDA assigned to the corrective action. If the FDA has not yet
assigned a number, the internal number assigned to the action by the
company is used.

= Ifremedial action indicated, check type: Select the applicable actions. If
other, specify the type of action in the space provided (for further
reference, see 21 U.S.C. 360h and 21 CFR part 803).

= Additional manufacturer narrative: Select the check box (if applicable)
and enter any additional information, evaluation, or clarification of
data presented in previous sections.

s Corrected Data: Select the check box if corrected data.

s Select if the device was an Adverse Event or a Product Problem.

EU / CA Device The EU/CA Device dialog allows you to enter the device information.
Fields are marked by either an EU flag or a Canadian flag to indicate which
entity is mapped to the field. The following list describes each field in
detail:

»  Accessories Associated Devices: Enter associated devices and/or
accessories involved in the incident.

s Software Version: Enter relevant software version.
= Incident or Near incident: Select the appropriate incidence type.

= Identification of notified body involved in Conformity Assessment:
Enter identification number of the Notified Body involved in the
conformity assessment procedure (if any) and the date(s) of the
attestation(s).

= Was the device labeled sterile?: Select the appropriate choice.

= Reporting firm is aware of other similar incidents having an impact on
the current report: Select the appropriate choice.

= If yes, to which countries: Enter appropriate countries.

= Device distributed within the following EEA Countries: Enter
appropriate countries.

»  Current location of device: Enter the present location of the device that
was involved in the incident.

= Where was the device purchased: Enter the establishment where the
device was purchased.

s Address: Enter the address of the location where the device was
purchased.

= Expected date of follow-up report: Enter the expected date of
follow-up report.

= Importer: Enter the name, address, telephone, and fax of the importer.
= Initial Corrective Action: Enter corrective action for the Initial report.
=  Initial Project Timing: Enter projected timing for the Initial report.

= Final Corrective Action: Enter corrective action for the Final report.

= Final Project Timing: Enter projected timing for the Final report.

= Investigation Result: Enter the results of investigation from the
follow-up.

»  Further Investigation: Enter the details of further investigation from
the follow-up.

CID Number Enter the Control Identification Number.
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Field/Control
Name Description

Global ID Enter the Global Identification number. When you add a second device
product to a case that already contains a device product with a Global ID
number, the same number populates the new device added. Changing the
Global ID number for the new product updates all products in the case to
have the same Global ID number.

Device Select the sub-component of the device.
Subcomponent
Name

Device Enter the lot number for the sub-component of the device.
Subcomponent
Lot#

4.1.4.3.5 Product Delivered by Device Section The following is an illustration of the
Product Delivered by Device section
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4.1.4.3.6 Product Delivered by Device Fields and Field Descriptions The following table lists
and describes the fields in the Product Delivered by Device section.

Field/Control Name Description

Type of Drug Select the type of drug from the drop-down list.
Other Mfg Product ~ Displays the Other Manufacturing Product.
Add Adds another row.

Delete Deletes the highlighted row.

4.1.4.3.7 Device Information Section This section enables you to enter information about
the device being used. The following is an illustration of the section.
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4.1.4.3.8 Device Information Fields and Field Descriptions When using the Device
Information section, be aware of the following;:

= You can enter up to 20,000 characters in the Additional Manufacturer Narrative
field.

»  The device evaluation codes have been updated to reflect FDA standards. Go to
the following link for more information:
http://www.fda.gov/cdrh/mdr/373_appdxb.html.
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s The evaluation method is available is the following site:
http://www.fda.gov/cdrh/mdr/373 .html.

s The evaluation results are available at the following site:
http://www.fda.gov/cdrh/mdr/373_appdxd.html.

The following table lists and describes the fields in the Device Information Section

Field/Control Name

Description

Lot #

Expiration Date

Date of Mfg

Device Age (Approx.)
Model #

Serial #

Catalog #

Other #

Date Implanted
Date Explanted
Improper

Use/Storage

Operator of Device

If other
Trained User

Device Available for
Evaluation

Preliminary
Comments

Malfunction

Malfunction Type

Manufacturer /Impor
ter Awareness Date

Return Date

Enter the lot number of the device.

Enter the expiration date. Enter a partial date or no date if the full date
is not available.

Enter the month and year of manufacture of the suspect medical device.
Enter the age of the device.

Enter the model number of the device.

Enter the serial number of the device.

Under Catalog#, enter the exact catalog number as it appears in the
manufacturer's catalog, device labeling, or accompanying packaging.

Under Other #, enter any other applicable identification number (for
example: component number, product number, part number, bar-coded
product ID).

If the device is implantable, enter the date of the implant. Enter a partial
date if the full date is not available.

If the device is implantable, enter the date of the explant, if any. Enter a
partial date if the full date is not available.

Indicate if the device was improperly used or stored.

Select the type of person operating or using the suspect medical device
on the patient at the time of the event. For instance, Health Professional
applies to a physician, nurse, or respiratory therapist. Lay User applies
to the person being treated, a parent, or a spouse. Other applies to a
nurse's assistant, or orderly.

If the operator of the device is other, enter the operator of the device.
Indicate if the operator of the devices was trained to use the device.

Indicate whether the device is available for evaluation. Also, indicate
whether the device was returned to the manufacturer and if so, the date
of the return.

Enter or select preliminary comments.

Indicate if the devices malfunctioned.

Make the appropriate selection to indicate the type of reportable event.
For an event associated with a malfunction, the FDA refers users to
applicable sections in 21 CFR Part 803 reporting guidelines.

Enter the date when the manufacturer became aware of the event

Enter the Device Return Date.

EU/CA Device Dialog Fields and Field Descriptions
The EU/CADevice Fields dialog includes the following fields:
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s NCA Reference Number

s Identify to what other NCA's this report was also sent

s Number of Patients Involved

s Number of Devices Involved

s User facility reference number

= Remedial Action by HC Facility

= Usage of Medical Device

s Other

= Update to Initial Report (Follow-up Report)

=  Final Report

The following table provides attribute information for the device fields

Field/Control Name Name Field Length Field Type
NCA Reference Number 100 characters Alphanumeric
Identify to what other NCA's 2000 characters Alphanumeric
this report was also sent

Number of Patients Involved 3 characters Numeric
Number of Devices 3 characters Numeric

User facility reference number 20 characters Alphanumeric
Remedial Action by HC 1000 characters Alphanumeric
Facility

Usage of Medical Device N/A Check box
Other 15 characters Alphanumeric
Update to Initial Report N/A Check box
(Follow-up Report)

Final Report N/A Check box

When you select the EU/CA Device option, the system prints the fields on the Case

form. The system tracks the fields and any updates in the audit log.

4.1.4.4 Products Tab: Vaccine Tab

The Vaccine section of the Products tab enables you to enter information about a
vaccine. The Vaccine tab includes the following sections:

s Product Information
s Product Indication

s Vaccine Information

41.44.1 Product Information Section Fields and Field Descriptions

The following table lists and describes the fields in the Product Information section.

Field/Control Name Description

Notes Enter notes related to the product.
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Field/Control Name

Description

WHO Medicinal
Product ID

Obtain Drug Country

Drug Authorization
Country

Product Name

Select

Drug Code
Encode

Suspect/Concomitan
t/Treatment

Generic Name

Company Drug Code

Manufacturer

Study Drug

Formulation

Interaction?

Displays the Medicinal ID associated with the selected WHO drug.
Note: This ID is populated only if a WHO-drug is selected.

Enter the country where the drug was purchased.

Displays the licensed country for the selected company product.

Enter the name of the product using the Select button or by entering a
partial product name.

Type a partial product name and press TAB. This displays the Product
Selection dialog. If only one product is found, this information is
entered without showing the dialog. If no match is found in the
company product list, the WHO Drug Dictionary is searched for a
possible match through the WHO Drug Dictionary Dialog. If a match is
still not found, the text you initially typed in, is used as is.

Note: If the study is blinded, the Blinded Name of the clinical study is
displayed in this field. If a user has access, the selected Study Product
Name for Unblinded cases is shown.

Displays the product selection dialog.
Select a product from the list of company products click Select.
The relevant fields are added to the Case Form.

Enter the WHO-DRUG code.
Click Encode to retrieve the code.

Make the appropriate selection for the product you are entering. The
drug types indicate the involvement of the product with the adverse
event(s) reported for the case.

Suspect indicates that the product may have caused the adverse
event(s).

Concomitant indicates drugs that are taken with the suspect drug.

Treatment is the drug taken to treat the adverse event.

Enter the generic name of the drug in a manner similar to the Product
Name. If the study is blinded, the Generic Name is replaced with the
Study Name of the product.

Note: This name is entered automatically depending on the chosen
company product.

Enter the company drug code.

Note: This name is entered automatically depending on the chosen
company product.

A different Manufacturer can be selected from the drop-down list and
can still be kept as a company product.

Select the study treatment the patient received from the list. If the study
is Blinded, this field is disabled. The Administrator can adjust the
information in this list. Drugs listed here are dependent on the Study ID
selected for the General tab.

Note: This field is applicable for Unblinded or not blinded clinical trial
cases only.

Select the formulation of the product. The Administrator can adjust this
list.

Note: This field is entered automatically depending on the product.

Indicates whether the case involves a drug interaction
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Field/Control Name Description

Contraindicated? Indicates whether the drug was administered contrary to its indication.
Make the appropriate selection to indicate whether the drug was
contraindicated in this case.

Concentration After a drug and formulation have been entered, select the
concentration from the list, or enter the concentration. If this
information is changed manually, the product is marked as a
non-company product.

Note: This field is entered automatically depending on the chosen
product. The concentration cannot be modified for a Study drug.

Units Select a concentration unit. The Administrator can adjust this list.

4.1.4.42 Searching for Products You can perform two types of searches in the section:

s Product Browser Search

s WHO Drug Coding Search

4.1.44.3 To perform a search in the Product Browser dialog box 1.Click Select in the
Products tab.

2. The Product Browser dialog is displayed.

3. Click Select to start searching.

4. When the system opens the Product Browser dialog box, Click the entities
displayed in the dialog.

The hierarchy above and below the entity being searched is also displayed. For
example, if Product Name is searched, it displays the Product Name as well as the
Family Name and Trade Name.

5. Search for Products based on the following criteria:

= Ingredient

s Family

s Product Name

» Trade Name - Searches the License Trade Name
6. Click the Full Search check box to select all these criteria when searching.
7. Click Select.

8. The results based on the search criteria are displayed and the user can select the
Product.

9. Click Clear to remove the entered search criteria.
4.1.444 WHO Drug Browser Search Be aware of the following when using the WHO
Drug Browser search function:

s The system enables you to perform a full search from the WHO Drug browser
when you select the Full Search option.

— By default, the system performs a like search (e.g., CUREALL%)
- You can use the percent (%) sign to perform wildcard searches

- If you click Full Search, the system performs a full search (e.g., %CUREALL%)
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The system also enables you to search for drug formulation and country. However,
this is available only if you select the WHO Drug C format. Otherwise, the option
is disabled.

When you click Clear, the system clears the search criteria you entered.

After the system performs the search, you can sort the results on all the fields.

To perform a WHO Drug Browser Search

1.
2

Select the Encode button to open the WHO Drug Coding dialog.

You can use both the WHO Drug B Format as well as the WHO Drug C Format
using the same browser.

Select either the WHO Drug B format or the WHO Drug C format from the Case
Form Configuration dialog where the Dictionaries are chosen for encoding.

The WHO Drug Coding Dialog has the following fields:

Field/Control Name Description

Product Type Select the type of product from the drop-down list. Note: All is
displayed as the Product Type by default.

ATC Code Enter the ATC Code up to a maximum of 10 characters.

Drug Code / Medicinal Searches on either criterion as per the radio button selected for the

Prod ID search. By default, the Drug Code option is selected.

Trade Name / Searches on either criterion as per the radio button selected for the

Ingredient search. By default, the Trade Name option is selected.

Formulation Enables you to search based on the drug formulation.

Country Enables you to search for a drug based on the country where the

drug was sold.

Enter your search criteria in these fields and click Search to didisplay the product
attributes that match the given search criteria:

s Trade Name -- the trade name of the product

s Formulation / Strength -- the Formulation / Strength (sequence 3 and
sequence 4) of the product.

s Country -- The Sales Country Code of the Product as defined in the WHO
Dictionary

»  Generic - Whether Generic - Yes or No.

The following criteria are not available for display or searching in the WHO
Drug B Format:

— Formulation

- Strength

— Generic

— Medicinal Product ID
- Product Type

4. Click Select to copy the selected drug to the Product tab.

5.

Click Cancel to close the selection dialog without making any updates to the
Product tab.
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4.1.4.45 Entering Quality Control Information You can enter quality control information
and enter the appropriate information in the Quality Control window.

About the Quality Control Window
The following is an illustration of the Quality Control window.
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The following table lists and describes the fields in the Quality Control window.

Field/Control Name Description

QC Safety Date Enter the QC department reference number for the analysis.
QC Sent Date Enter the sent date.

QC Cross Reference  Enter the QC department reference number for the analysis.

Date Returned Enter the date returned.

Global ID Enter the global number.

Quantity Enter the quantity.

# CID Number Enter the Control Identification Number.

PCID Number Enter the Product Control Identification Number.

Lot Number Enter the lot number. If the Lot Number entered is incorrect, a Lot

Number Lookup dialog is displayed, that allows you to enter select
from the existing lot numbers.

Complaint Enter a date for complaint categories.

Categories Date

Complaint Enter a text explanation as necessary. Use the zoom icon to open the
Categories Text zoom notes and view or edit the text.

Analysis Categories  Enter a date for analysis categories.
Date

Analysis Categories  Enter a text explanation as necessary. Use the zoom icon to open the
Text zoom notes and view or edit the text.

Analysis Summary  Enter a date for an analysis summary.
Date
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Field/Control Name

Description

Analysis Summary
Text

QC Result Date
QC Result

QC Comment

Enter a text explanation as necessary. Use the zoom icon to open the
zoom notes and view or edit the text.

Enter the date the result of the analysis was received by the QC
department.

Enter a text explanation as necessary. Use the zoom icon to open the
zoom notes and view or edit the text.

Enter any comment relating to the analysis.

4.1.4.4.6 Product Indication Section The following is an illustration of the fields in the
Product Indication section of the Vaccine tab.

Product Indication Fields and Field Descriptions
The following table lists and describes the fields in the Product Indication section.

Field/Control Name

Description

Product Indication Section

Reported Indication

Coded Indication

Encode (Indication)

# of Siblings

Birth Weight

Birth Weight Units
Add

Delete
Order
Obtain Drug Country

Interaction

By default, the value of this field is populated with the Product
Indication from the Product Configuration, if set up by the user. If not,
you can enter a term into the Reported Indication field.

Note: Argus Safety automatically encodes this information. You can
also click Encode to open the coding dictionary dialog.

This field is populated with the encoded term when the user enters
data in the reported indication field and tabs out.

Opens the MedDRA Browser with the term already populated from the
Coded Indication field.

Note: To view the complete MEDDRA hierarchy for the encoded term,
click the Encoding Status icon

Enter the number of siblings for patients who are children under the
age of five.

For patients who are children under the age of five, enter the birth
weight. For example: 3260g, 3.26kg, or 71b 40z. If a number without
units is entered, the following units are assumed: < 32 - Pounds 32-200 -
Ounces >200 - Grams

Select the appropriate weight units.

Adds a new Indication row.

Note: Only two indications are visible at a time

Click this button to delete the selected Indication row.
Allows the user to move an indication up and down.
Enter the country where the drug was purchased.

Indicates whether the case involves a drug interaction
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Field/Control Name Description

Contraindicated?

Indicates whether the drug was administered contrary to its indication.
Make the appropriate selection to indicate whether the drug was
contraindicated in this case.

4.1.44.7 Product Details Section Product Details Fields and Field Descriptions
The following table lists and describes the fields in the Product Details section.

Field/Control Name Description

Product Details Section

Action Taken

Dechallenge Results

Date

Taken Previously /
Tolerated

Rechallenge Results

Start Date/Time
Stop Date/Time
Abuse

Overdose

Tampering

Select the appropriate term. If you select Dose Increased or No change,
the dechallenge and rechallenge fields are disabled. The Administrator
can adjust this list.

Indicates the drug stopped for the purpose of determining if it was the
drug that caused the adverse event. Click the appropriate button

Enter the date the dechallenge was carried out

Select the appropriate response from the list.

Make the appropriate selection depending on whether the drug was
taken again. If Pos or Neg or UNK is selected for the Rechallenge field,
the Rechallenge Start Date/Time, Rechallenge Stop Date/Time, and
the Rechallenge Outcome fields are enabled.

Enter the date and/or time when the rechallenge was started.
Enter the date and/or time when the rechallenge was stopped.

Select this check box if the patient abused the product (For example:
Painkillers taken without pain).

Select this check box if the patient took an overdose of the product.

Select this check box if the product appeared to have been tampered
with before it was used.

4.1.4.4.8 Vaccine Information Section The Vaccine Information section has the following

sections:

s Vaccine Information

»  Vaccine Administration

s Prior Adverse Events

= Vaccine History
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Vaccine Information Fields and Field Descriptions
The following table lists and describes the fields in the Vaccine Information section.

Field/Control Name

Description

Start Date/Time

Dose Number
Dose
Units

Patient Route of
Administration

Parent Route of
Administration

Anatomical Location

Package ID
Batch / Lot #

Expiration Date

Vaccine
Administration

Prior Adverse Events

Vaccine History

Enter the vaccination date. Enter a partial date if the full date is not
available.

Enter the vaccine dose number.
Enter the vaccine dose.
Select the dose unit. The Administrator can adjust this list.

Enter the route of administration or a short code for the route of
administration. The system automatically decodes your entry. The
Administrator can adjust this list.

Enter the route of administration or a short code for the route of
administration. The system automatically decodes your entry. The
Administrator can adjust this list.

Select the anatomical location of the vaccination. The Administrator can
adjust this list.

Enter the package ID.
Enter the batch and/or lot number(s).

Enter the expiration date. Enter a partial date or no date if the full date
is not available.

Enter the Vaccine Information. Items entered here are used to complete
the VAERS form.

Enter the Prior Adverse Events.

Enter the vaccine history.
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4.1.44.9 Entering Vaccine Administration Information The following is an illustration of the
Vaccine Administration form.
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To enter vaccination information
1. Enter the relevant vaccination information items in the form.

2. Click OK to save the entered vaccine information.

The following table lists and describes the fields in the Vaccine Administration form.

Field/Control Name

Description

General Information

Vaccinated At

State
County
Purchased With

Person Completing
Form Relationship to
Patient

Reported Previously

Illness at time of
Vaccination

CDC/FDA VAERS #
Required ER Visit

Administrator
Administered By
Resp. Physician
Facility name
Address

City

State

Postal Code

Phone

Select the most appropriate item from the list to describe where the
patient was vaccinated.

Enter the state where the patient was vaccinated.
Enter the county where the patient was vaccinated.

Select the most appropriate item from the list to describe how the
vaccine was purchased.

Select an appropriate item from the list.

Select an appropriate item from the list.

Enter the illness, if known.

Enter the verification number.

Select this check box if the event required a visit to the emergency room
or doctor.

Enter the name of the person who administered the vaccine.

Enter the name of the physician responsible for the patient.

Enter the name of the facility where the vaccine was administered.
Enter the address of the facility where the responsible physician works.
Enter the city of the facility where the responsible physician works.
Enter the state of the facility where the responsible physician works.

Enter the postal code of the facility where the responsible physician
works.

Enter the telephone number of the facility where the responsible
physician works.
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4.1.44.10 Entering Prior Adverse Events Information The following is an illustration of the
VaccinePrior Adverse Events form.
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To enter prior adverse events information
1. Enter the relevant vaccination information items in the form.

2. Click OK to save the entered prior vaccination adverse event information.

The following table lists and describes the fields in the Vaccine Prior Adverse Events
form.

Field/Control Name Description

Patient Select whether the details refer to the patient or to a sibling.
Vaccine Enter the name of the vaccine.

Dose # Enter the dose number of the vaccine.

Age Enter the patient's age at onset of the event.

Age Units Select the appropriate age unit from the list.

Adverse Events Enter a term that describes the adverse event.

4.1.4.4.11 Vaccine History Section The following is an illustration of the Vaccine History
section of the screen.
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Vaccine History Fields and Field Descriptions
The following table lists and describes the fields in the Vaccine History section.
Field/Control Name Description
Date Enter the date of vaccination. Enter a partial date if the full date is not
available.
Route of Admin Enter the route of administration or a short code for the route of

administration. The system automatically decodes your entry. The
Administrator can adjust this list.

Vaccine Enter the name of the vaccine.

Anatomical Location = Select the anatomical location of the vaccination. The Administrator can

adjust this list.
Dose # Enter the vaccine dose number.
Manufacturer Enter the vaccine manufacturer or select a manufacturer. The

Administrator can adjust this list.
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Field/Control Name Description

Dose Enter the vaccine dose.

Units Select the dose unit. The Administrator can adjust this list.
Batch & Lot # Enter the batch and/or lot number(s).

Add Adds a new Indication row.

Note: Only two indications are visible at a time.

Delete Click this button to delete the selected Indication row.

4.1.5 Events Tab

The Events tab enables you to enter or view details for adverse events associated with
a case. The following is an illustration of the Events tab.
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4.1.5.1 General Usage Information
When using the Events tab, be aware of the following:

- You can change the listedness for a drug at the individual level.
- This limitation also applies to the Medical Review and Local Labeling dialogs.

»  The field labels for the Event Assessment tab are updated and configured on the
Argus Console

s When you modify the Event outcome on the Events Tab, and the event outcome
and case outcome don't match, the system displays the following message:

Case Outcome may no longer match events.

s If the Death Seriousness criteria on the Event tab are unchecked, the event
outcome reverts to empty and is not set to fatal.

= On the Death Details screen, the Autopsy Results field defaults to blank instead
of No. If the value is incorrectly set, the system sets it to null during the upgrade.
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= On the Event Assessment tab, the system displays the Notes icon beside the event
term if the preferred term has associated notes on the datasheet.

s If the datasheet does not have notes for the preferred term, the system does not
display the Notes icon.

s This is also true for the Medical Summary and the Local Labeling dialog
= When you click the Notes icon, the system displays the notes in read-only mode.

s The system populates the "To be coded" value on the MedDRA popup dialog box
when you click the green checkbox for the MedDRA hierarchy. This applies to the
following area where the MedDRA dialog box appears.

- Patient Tab: Other Relevant History: Description

— Patient Tab: Other Relevant History: Reaction

— Patient Tab: Other Relevant History: Indication

— Patient Tab: lab Tests

- Product Tab: Product Indications

- Event Tab: Event Coding

- Analysis Tab: Company Diagnosis Syndrome

— Console: Business Configuration: Products: Datasheets
— Console Business Configuration: Products: Product Indications
- Console: Codelists: Lab Tests

— Console: Codelists: Always Serious Term List

s The Event to Exclude from Report Field enables you to identify information not to
include in a PMDA expedited report.

— The default for this check box is unchecked.

—  When this check box is checked, you are required to enter a justification for
this action in the Reason to Exclude from Report dialog box.

- After you enter the justsification, the system places a symbol to the right of the
field.

- You must have at least one event in a report. If you try to exclude all events
from the report, the system presents the following message: "All the events are
excluded from reports. If you want to report, at least one event is necessary.
Proceed?"

—  The system does not retrieve evenst that are excluded from a report as part of
CSPSR (Clinical Study Periodic Safety Report) unless it has been configured to
include them in such a report.

The following is an illustration of the MedDRA dialog box.
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When you click the Recalculate button, the system does not recalculate listedness
where the Event Assessment Listedness already has a case justification ( generated
automatically or manually overwritten).

4.1.5.1.1 Field Properties for Help Text/Default Labels The following table describes the
field properties for the Help Text/Default Labels.

Default Field Label

Default Help Text

Onset from First Dose

Onset from Last Dose

Total Dose to Event
Units

Action Taken

Other

Dechallenge Results

Rechallenge Results

Event occurred as consequence of
Term

Most Important Diagnosis?

This date is defined as the earliest regimen start date to
Onset and is completed automatically.

The Date calculation is based on the Case Form
Calculation for Inclusive or Exclusive

This date is defined as the latest regimen stop date to
Onset and is completed automatically.

The Date calculation is based on the Case Form
Calculation for Inclusive or Exclusive.

The system calculates this value based on daily dose
and duration.

The system provides this value based on the dosage
units entered.

Select the appropriate term from the drop-down list
(e.g., Dose Increased, Withdrawn, etc.). The
Administrator may adjust the values in this list.

The value can only be entered when the Action Taken is
"Other."

Select the appropriate option.
Select the appropriate option.
Select the appropriate option.
Select the appropriate option.

Select the appropriate option.

Event more specific/severe than PT? Select the appropriate option.

Field Calculations

The following table describes the calculations the system uses for each field.
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Field Calculation
Total Dosage The sum of all Total Regimen Dosages.

First Dose to Onset ~ The system calculates this value based on the first dose stop date and
the event onset date, if present.

If any regimen start date is null, the system sets the First Dose to Onset
is to null.

The system does not automatically use partial date entries for the
Regimen Start and Stop Date/Time fields to calculate First Dose to
Onset.

The user can overwrite this field.

Last Dose to Onset The system calculates this value based on the last dose stop date and
the even onset date, if present.

If the regimen start date is null, the system sets the Last Dose to Onset
is to null.

The system does not automatically use partial date entries for regimen
Start and Stop Date/Time fields to calculate the Last Dose to Onset.

The user can overwrite this field.

4.1.5.2 Events Tab: Event Tab

The Event information tab enables you to encode adverse events, record the criteria for
the seriousness of each event, and display the results of automated assessments to
determine whether events are listed in data sheets. It also lists the licenses for the data
sheets. The Event information tab includes the following sections:

s Event Information
s Event Coding
s Seriousness Criteria

s Nature of Event
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| bwm | Peerd Ansedimend
L myperrenea reanten |11 e

[Er— [icerrs ]
Brworipton e PBeporied -|5 [Ragroin T Sghlphied by Beporte:

e e sty B cugronen T symptoms [ =
Beworiphion fo ba Coded L e o Laak Sowe Sinp Date T Dusruiicen

A i 1, FFEL00] DR D PL.FFLE00) B8R0

Dt Lamsncy ot Dans Fatusnt Has Prics Matoey Traatrmai Racersa?
[ — S ihn BN I = |
tee g [ intierven o Feprt

Syniem Orgen Clasn {5300 [Code]  Nervoun syt Saorders | M0NI0Y) “

Mg Lowal Torm: fonde) - - L. i (HOCHI0) T Lok of By T Peogrension of Bassss ™ Azwnrue Dnag VWishde e Rsacton

High Lewel Term [Coda) Diyniirenias und mowemnt Snceder BEC {0 | | paned o sy Conduirtols  Trms shis vt nebsssd s ot

Fratarred Torm ilose] Hyseirana Pestale | 10500 Eusportad) conduct of w sy ?

Iracheciad Tarm (Codeh Fyparrasa recas | 1523MAT | =l 2] orapped from Snuy tus 1o lees

Sprompm (Code) T rtecton
L T o0 Ve § 0 Tean 3 0 Team i
D Taxi & o0 Taxd & 0 Teat T 0 Taaz &
O Tant &

I gaarh I i sty Rogpitar st !‘
I oapashaed F Lo fupsterang

T iy I Wi it Wit sl

™ oetar: ™ Congenas Armaty

Case Form 4-59



Case Form Functions

4.1.5.2.1 Event Information Section The Event Information section enables you to enter
information about the event information including diagnosis, patient history, intensity,

and so forth.

Event Information Fields and Field Descriptions
The following table lists and describes the fields in the Event Information section.

Field/Control Name

Description

Description as
Reported

Relationships

Encode

Term Highlighted by
Reporter

Diagnosis

Description to be
Coded

Patient Has Prior
History?
Onset Date/Time

Onset from Last Dose

Stop Date/Time

Duration

Onset Latency

Intensity
Frequency

Was this event
related to the conduct
of a study?

Associated with
Rechallenge?

Enter the verbatim term used by the reporter, or patient, to describe the
adverse event. As you type, the term is automatically copied under
Description to be Coded. Verbatim English translations of foreign
languages may also be entered here.

Click the Relationshipsbutton to view the Diagnosis-Event
Relationships dialog. This allows you to group symptoms and signs
with diagnoses. This requires at least two events and a diagnosis.

Click this button to search for the term entered under Event
Description. The entered term is checked in the MedDRA dictionary.

Make the appropriate selection to indicate whether the person
reporting the event considered it to be serious.

Note: Selecting Yes does not mark this case as Serious automatically.

Make the appropriate selection to indicate whether the event is a
diagnosis.

If necessary, the verbatim term can be modified in this field. For
example, the original term may need to be split, or enhanced with an
anatomical location. The Administrator can prevent manual encoding
of the description. If automatic encoding is enabled, the term can be
auto-encoded to the included term level.

Make the appropriate selection to indicate whether the patient has had
a prior history or has suffered from the same event in the past.

Enter the date/time when the event started. Enter a partial date if the
full date is not available.

This field is calculated automatically from the event onset date and
most recent stop date listed in the dosage regimen details of the suspect
drug(s). You can also enter or modify the field manually. This field is
removed if the dosage regimen is ongoing.

Enter the date/time when the event stopped.

This field is calculated automatically from the event start and stop
dates. You can also enter or modify the duration manually.

This field is calculated automatically from the earliest first dose date of
the suspect drug(s) to onset date. You can also enter or modify the
duration manually.Note: Onset Latency = Onset Date - First Dose.

Select the category of severity of the event. The Administrator can
adjust this list.

Select the frequency of the event from the list. The Administrator can
adjust this list.

For clinical trial cases only. Make the appropriate selection to indicate
whether the event was associated with the conduct of a study. Consult
your Administrator for further company-specific information on
completing this field.

Only available if a suspect drug was rechallenged. Make the
appropriate selection.
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Field/Control Name Description

Product Only available if event is associated with rechallenge. A list of all
suspect products that were rechallenged is displayed. Select the
product associated with this event from the list. You can identify
multiple products to be associated with a single event.

Dropped from Study For clinical trial cases only. Select this check box if the subject was
due to Event dropped from the study due to this adverse event.

Treatment Received? Make the appropriate selection to indicate whether the event required
treatment.

Outcome of Event Select the outcome of the event. The Administrator can adjust this list.
If Fatal is selected, Death is selected in the list of seriousness criteria.

Note: If the Death check box is subsequently cleared, the outcome still
remains fatal.

Receipt Date Enter the date on which information about this event was received by
your company.

Lack of Efficacy Select this check box, if appropriate.

Progression of Select this check box, if appropriate.

Disease

Adverse Drug Select this check box, if appropriate.

Withdrawal Reaction

Infection Select this check box, if an infection has occurred.

4.1.5.2.2 Understanding the Diagnosis-Event Relationship Argus Safety allows you to
group events in a case, and/or to associate them with particular diagnoses. These
determinations can be made by your company or simply as reported to your company.
This feature aids significantly in the interpretation and review of individual case
reports. It is also useful in summary reports as it enables the reporting of diagnoses
only, while retaining database records of individual event terms.

Click the Relationships button in the Event Information section of the Eventstab to
open the Diagnosis-Event relationship dialog.

Note: To use this feature, the case must contain at least two events
and, at a minimum, one diagnosis. The events related to a diagnosis
are listed on top in this dialog and the symptoms are indented with
respect to the diagnoses. You can group events together and associate
them with individual diagnoses.

4.15.2.3 Associating a symptom with a diagnosis Click the up or down arrows to
associate a selected symptom with a diagnosis. In Argus Safety Web, select the
symptom and click Move Up or Move Down.

Example:
Such Adverse Events (AE) might be entered into the database as follows:

This example demonstrates how defining a diagnosis-event relationship can clarify an
adverse event report. Suppose an initial case report describes a patient suffering from
"Somnolence," "Sore Throat," and "Fever."

AE# Diagnosis AE Term (Associated AEs)

1 Somnolence
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2 Sore Throat

3 Fever

For reports on all events, they would appear on a CIOMS-I form as:
s Somnolence [SEDATION]

s Sore Throat [SORE THROAT NOS]

s Fever [PYREXIA]

Suppose a follow-up report then supplies information that the patient also had
neutropenia, and had been diagnosed as suffering from agranulocytosis (the cause of
the sore throat and fever). The somnolence was considered to be co-incidental, and
unrelated to any other adverse events.

Neutropenia and agranulocytosis would be entered onto the system, and a
diagnosis-event relationship established as follows:

AE # Diagnosis AE Term (Associated AEs)
1 Yes agranulocytosis

2 (sore throat)

3 (fever)

4 (neutropenia)

5 Somnolence

These events would appear on a CIOMS I form as:
= AGRANULOCYTOSIS

=  [AGRANULOCYTOSIS] ([SORE THROAT],

= [PYREXIA NOS], [NEUTROPENIA])

s Somnolence [SEDATION]

s This immediately gives a clear clinical picture of the case.

4.1.5.2.4 Using the MedDRA Browser The MedDRA application searches the term
dictionary for a match at the Lower level term or at the Synonym level. If a match is
found, the following fields are automatically populated: Term code, Preferred Term,
Included Term, High Level Term, Group Term and Body System/SOC.

Click the icon to view the MedDRA Browser.

4.1.5.25 Configuring Regulatory Reporting Rules The regulatory reporting rules can be
configured to look at any type of criteria but are mainly configured to look at
Seriousness, Listedness, Causality, and Outcome. Out of these, Listedness and
Causality can be captured and controlled (using the event assessment section) down to
an individual license basis.

This granularity allows individual license holders to override the normal listedness
and causality assessment to control the need for submissions to their local regulatory
authority. Each affiliate could either suppress the need for a report by demoting the
criteria, or add the requirement for a report by promoting the listedness or causality.

This serves to promote the global reporting automation while maintaining the level of
individual local affiliate control that is often needed.
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Note: To obtain an assessment of the adverse event, the product
must be in the company's suspect product and the event must be

encoded.

4.1.5.3 Event Coding Section

The Event Coding section enables you to enter information about the event. The
following is an illustration of the Event Coding section.

Event Coding

System Organ Class (S0C) (Code) |Ner'.r|:ru3 sy=tem dizorders (10025205)

|
High Level Term (Code) |I'|'I|:r1.rernent dizorders (incl parkinsonizm} (10028037} |
High Level Term (Code]) |D}I‘SkiI'IESiES and movement dizorders NEC (10013525) |
Preferred Term (Code) |Hyperkinesia neonatal (10020652) |
Included Term (Code) |Hyperkinesia neonatal (10020652) |
|

Synonym (Code)

The following table lists and describes the fields in the Event Coding section.

Field/Control Name

Description

Body System/SOC

Lower Level Term
Preferred Term
Preferred Term Code

High Level Term

High Level Group
Term

Displays the body system or System Organ Class. This item is
automatically entered from the event dictionary that is used and it
cannot be edited.

Displays the ART code. If you have appropriate access rights, click
Encode to view the associated coding dialog.

Displays the preferred term. This item is automatically entered from the
event dictionary that is used and it cannot be edited.

Displays the preferred term code. This item is automatically entered
from the event dictionary that is used and it cannot be edited.

Displays the High Level Term when the MedDRA coding dictionary is
used. This item is not displayed when event encoding is done using the
WHO-ART dictionary. This field cannot be edited.

Displays the high-level group term when using the MedDRA coding
dictionary. This field is not shown when coding with WHO-ART. This
field cannot be edited.

4.1.5.4 Seriousness Criteria Section

The Seriousness Criteria section enables you to identify how serious the event was.
For example, did the result in death or was it life threatening. The following is an
illustration of the Seriousness Criteria section.

" Death

[T Hospitalized
™ Disability
[T other

[T Medically Significant
¥ Life-threatening

™ Intervention Required
r Congenital Anomaly
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Seriousness Criteria Fields and Field Descriptions
The following table lists and describes the options in the Seriousness Criteria section.

Field/Control Name

Description

Death

Hospitalized
Medically Significant
Life-threatening
Disability

Intervention
Required

Congenital Anomaly

Other

Displays the Death Details dialog

Note: If you un-check the Death option in the Seriousness Criteria,
you are required to confirm the deletion of the death details.

Displays the Event Hospitalization dialog.

Select this check box to display the seriousness as medically significant.
Select this check box to display the seriousness as life-threatening.
Select this check box to display the seriousness as a disability.

Select this check box to display the seriousness as requiring
intervention.

Select this check box to display the seriousness as a congenital anomaly.

Select this check box to enter explanatory text. It is mandatory to enter
text, specifying the Other Seriousness Criteria.

4.1.5.41 Entering Death Details Use the following procedure to enter details about a

death.

1. Select the Death check box under Seriousness Criteria.

2. The form for EventDeath Details appears
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3. Enter information for the items in the form.

4. C(Click OK to save the entered Death Details.

The following table lists and describes the fields in the Event Death Details section.

Field /Control Name
Date

Autopsy Done?
Cause of Death
Autopsy Results
Available?

Autopsy Results

Description

Enter the date of death. You can enter a partial date if the exact date is
unavailable.

Make the appropriate selection.

Enter a term to describe the cause of death. Click Encode to display the
associated encoding dialog.

Make the appropriate selection.

Enter Information about the autopsy results.
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4.1.5.4.2 Entering Hospitalization Details Use the following procedure to fill out the
Hospitalization Details form.

To complete the Hospitalization Details form
1. Select the Hospitalized check box under Seriousness Criteria.

2. The form for Hospitalization Details appears.

. Hospitalization Details

Ho=spitalization

A
G s 77-277 0000 |
Hospitalization P
BTt 77-277-0000 |

Duration of |
Ho=pitalization

" Event caused initial hospitalization
I Event prolonged hospitalization

- Discharge summary available

3. Enter information for the items in the form.
4. Click OK to save the entered Hospitalization Details.

The following tables lists and describes the fields in the Hospitalization Details form.

Field/Control Name Description

Hospitalization Start  Enter the first date of the patient's hospitalization associated with this

Date adverse event. If the exact date is not available, you can enter a partial
date in this field.

Hospitalization End  Enter the last date of the patient's hospitalization associated with this

Date adverse event. If the exact date is not available, you can enter a partial

date in this field.

Duration of
Hospitalization

This field is automatically calculated by the system, based on the start
and end dates entered. This field is calculated using 24-hour
increments. You can also manually enter the number of days the patient
was hospitalized.

Event caused initial
hospitalization

Event caused
prolonged
hospitalization

Discharge summary
available

Select this check box if the event is associated with the initial
hospitalization of the patient.

Select this check box if the event prolonged hospitalization.

Select this check box if a discharge summary is available.

4.1.5.4.3 Nature of Event Section The Nature of Event section enables you to identify the
nature of the event from the drop-down list. You can add a maximum of 50 such
Nature of Event rows.
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4.1.5.44 Details Section This section enables you to enter notes related to the event. If
Reported Causality is entered when the case is booked-in, the system automatically
transfers it to this field. The following is an illustration of the Details section.

4.1.5.5 Events Tab: Event Assessment Tab

The Event Assessment tab enables you to capture causality and listedness information
for a case. All encoded events in the case are compared with the listed events for
company products (agents) associated with the case. The following is an illustration of
the Event Assessment tab.
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Event Assessment Tab Fields and Field Descriptions
The following table lists and describes the fields on the Event Assessment tab.

Field/Control Name Description

Recalculate Refreshes the Event Assessment section with the newly entered data if
new suspect products or events are entered, or the Event Relationship
is modified.

Product This field is populated when events are entered in the Products tab and
is displayed in the following format:

s First Line - Product Name

s Second Line - Generic Name
Causality Source This field defines the source of causality calculation.

Causality as Partner  This field stores the Partner Level Causality defined within the cases.

Causality as Indicates the degree of reported causality.

Reported

Causality as This field is populated automatically, along with the information
Determined entered in the Reported Causality field.
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Field/Control Name

Description

Event

D/S

Seriousness Severity
Duration

This field is populated when events are encoded and are displayed in
the following format:

= First Line - Event PT (Verbatim)
= Second Line - LLT

Displays the Diagnosis/Symptom details by D or S in line with the
Events.

Displays the Seriousness, Severity and the Duration of the Event.

Datasheet Displays the datasheet(s) for the agent.

License Displays the license(s) for the agent.

Listedness Indicates whether the system found the event on the datasheet for this
product.

4.1.5.5.1 Filtering in the Event Assessment Tab The following table lists and describes

how the system filters each field on the Event Assessment tab.

Field/Control Name

Description

Product The product filter drop down list contains all products listed in the
event assessment. The user can filter on all the products which are
present in the Event Assessment dialog.

Event Contains a drop down of values of distinct Event PT. The user can filter
on all the products which are present in the Event Assessment dialog.

D/S Contains a drop down values of D for Diagnosis or S for Symptoms.

Datasheet Contains a drop down of values of distinct Datasheets.

Licenses Contains a drop down of values of distinct Countries of the Licenses.

Note: Only the assessment rows that match the selected criteria

display in the filtering results.

4.1.5.5.2 User Actions on the Event Assessment Tab The following table list user actions
and the results of those actions.

User Action

Result

Click Datasheet
column's icon

Click Product Name
link

Click Event
Description link

The system does the following;:

= Displays the license view

= Displays the datasheet view
= Displays the License column

s Enables the icon for the License column

Displays the name for the selected product

Displays the Event Information for the selected event
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User Action

Result

Click License
Description link

Click Datasheet
Description link

Displays the license description as defined in the License Configuration

Displays the first 1000 terms in the datasheet. Click Print to view all the
terms and click Export to export all the labeled terms to an Excel file in
a single column with column header as Labeled Terms.

4.1.6 Analysis Tab

The Analysis tab enables you to generate or view a narrative description of the case,
together with other notes. In addition, it also enables you to enter information required
for generating the MedWatch 3500A, BfEArM, and AFSSaPS reports.

The typical users of this tab are responsible for:
= Making a medical assessment of the case
= Approving the case for completeness and accuracy.

The following is an illustration of the Analysis tab.
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4.1.6.1 Case Analysis Section

The Case Analysis section of the Case Analysis tab enables you to enter narrative
information about the adverse event. The following is an illustration of the Case
Analysis section.
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Case Analysis Fields and Field Descriptions
The following table lists and describes the fields in the Case Analysis section of the

Case Analysis tab.

Field/Control Name

Description

Narrative

Case Comment

Abbreviated
Narrative

Company Comment

Evaluation Comment

Click Generate to generate an auto narrative.
This feature is configured by the Administrator.

If you are not utilizing the auto narrative feature, enter the narrative
here.

The narrative is printed on expedited reports.

You can enter comments in this area. If you are not permitted to edit the
auto narrative, you can use this field to provide additional details
important to the interpretation of the case. Comments appear on certain
expedited reports.

Enter brief comments in this field. This item maps only to the PSUR
report.

Enter comments in this area. This information does not appear on
expedited reports.

Enter an evaluation comment that takes in to consideration similar
events that have occurred in the past.

4.1.6.2 Using Auto Narrative Templates

You can select an Auto Narrative template for the Narrative, Case Comment,
Abbreviated Narrative, Company Comment, and Evaluation in light of similar events

in the past.

To generate or add narrative templates
1. Click the button to view the Custom Auto Narrative Templates dialog.

Select the required Autonarrative from the list.

Click Append to append this Autonarrative to the existing narrative.

2
3
4. Click Append if this is the first narrative being added to the text area.
5

Click Replace to replace the existing narrative with the selected narrative.

Case Form 4-69



Case Form Functions

Note: You cannot modify the Autonarrative text if the
Administrator has configured the system to prevent modification of
the Autonarrative.

If an Autonarrative template has been configured in multiple
languages, icons representing the languages display above the text
area.

4.1.6.2.1 Viewing Differences in Case Narratives The system enables you to view the
differences in case comments from previously locked versions of the case. To view
these differences, click the Show Difference button in the Case Comments section of
the Analysis Tab.

When you choose to view the differences in the two narratives, the system does the
following:

= Displays the differences in red with a strike out and a yellow highlight.
» Displays additions to the narrative in black with green highlights.

s The Narrative is read-only and you cannot modify it.

s Use the zoom dialog to adjust the font size.

s The system displays the last revision number of the case and date and time stamp
in the following format:

» (Lastrevision # X as of YYYY MMMM)

where:
X Is the revision number of the last case
YYYY Is the date the case was locked
MMMM Is the time the case was locked in 24-hour format.

= The system disables the button if there is no previously locked version of the case.

= This function is also available on the Medical Review dialog.

4.1.6.3 Case Summary Section

The Case Summary section of the Case Analysis tab enables you to enter summary
information about the adverse event. The following is an illustration of the Case
Summary section.
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Case Summary Section Fields and Field Descriptions

The following table lists and describes the fields in the Case Summary section of the
Case Analysis tab.
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Field/Control Name

Description

Case Serious

Serious Notes

Case Causal

Case Causal Notes

Listedness
Determination

Listedness
Determination Notes

Case Outcome

Company
Diagnosis/Syndrome

Notes

This list indicates whether the overall adverse event case is serious or
non-serious. This assessment is automatically performed by the system
from the Seriousness Criteria of the Events tab. If any of the
Seriousness Criteria was selected for any event in the Event tab, Yes is
selected automatically in the list. No is selected if the Seriousness
Criteria is cleared for all events in the Events tab. You can modify the
selection after entering a justification, if you have the access rights to do
S0.

A justification for overriding the system determination will be
displayed in the Notes area. A green dot will appear adjacent to the
Notes area. Click the green dot to revert to the automatic calculation for
seriousness or to view the overriding notes.

The system automatically determines this value from the As Reported
and As Determined causalities in the Event Assessment section. This
field is displayed as Yes if the As Determined causality is Yes and vice
versa. If the As Determined causality is Unknown, this field will be
Yes.

A justification for overriding the system determination is displayed in
the Notes area. A green dot is displayed next to the Notes area. Click
the green dot to revert to the automatic calculation for seriousness or to
view the overriding notes.

The value for this field is calculated from the Event Assessment section
in the Events tab. If any row there shows Unlisted under the Listed
column, this value is set to unlisted.

A justification for overriding the system determination is displayed in
the Notes area. A green dot appears adjacent to the Notes area. Click
the green dot to revert to the automatic calculation for seriousness or to
view the overriding notes.

The value for this field is also calculated from the Events tab. If the
outcome for any event is Fatal, the case outcome is set to Fatal. If the
case outcome is changed here, that change is not made to the event
outcome in the Events tab.

The company diagnosis or syndrome is entered in this field.

A justification for overriding the system determination is displayed in
the Notes area. A green dot is displayed adjacent to the Notes area.
Click the green dot to revert to the automatic calculation for seriousness
or to view the overriding notes.

4.1.6.4 Analysis Tab: MedWatch Info Tab

The MedWatch Info tab enables you to enter additional details required for the
MedWatch 3500A Drug Report. The following is an illustration of the MedWatch Info

tab.
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MedWatch Info Tab Fields and Field Descriptions

The following table lists and describes the fields on the MedWatch Info tab. Be aware
that the values in the Form section column refer to specific sections of the MedWatch
3500A Drug Report form.

Form Section

Field Description

B1. Adverse Event /
Product Problem

C9. Suspect

Medications (NDC#)

F1. User Facility or
Distributor

F2. UF/Dist report
number

F3. User facility or
distributor
name/address

F4. Contact person

F5. Phone number

F6. Date aware of
event

Select the applicable check boxes.

Select Adverse Event when a product is suspected to have caused an
adverse outcome in a patient.

Select Product Problem when the defect or malfunction in the product
could lead to a death or serious injury. Select both check boxes if a
malfunction or product problem caused a death or serious injury.

Enter the National Drug Code if you have selected the Product Problem
check box.

Indicate whether this report is from a user facility or a distributor. You
can suppress printing of Block F of the MedWatch 3500A report by
selecting Suppress Block F Printing.

Enter the complete number of the report exactly as entered in the upper
right corner of the front screen.

Enter the full name and address of the user facility or distributor
reporting site.

Enter the full name of the medical device reporting (MDR) contact
person. This is the person who is designated as the device user

facility /distributor contact for this requirement. The FDA will conduct
its MDR correspondence with this individual. The contact person may
or may not be an employee of the facility. However, the facility and its
responsible officials will remain the parties ultimately responsible for
compliance with MDR reporting requirements.

Enter the phone number of the medical device reporting (MDR) contact
person.

Enter the date that the user facility's medical personnel or the
distributor became aware that the device may have caused or
contributed to the reported event.
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Form Section

Field Description

F10. FDA codes
Patient

FDA Device Codes
F11. Report sent to
FDA

F12. Location where
event occurred

F13. Report sent to
mfr?

G3. Report Source

Click the first row and column of the FDA Patient and Device Codes
section and then click Select. You can enter up to six FDA Patient
Codes. If the entered code is not present in the FDA Codes list, it is
erased.

Select this check box if a report has been sent to the FDA. If you select it,
enter the date when the report was sent to FDA.

Select the location of the actual occurrence of the event.

Select this check box if a report has been sent to the manufacturer. If
you select it, enter the date when the report is sent to manufacturer.

Select the Report Source check boxes as applicable, to match all report
sources specified with the Reporter Type.

See the following guidelines for selecting the check boxes.

G5. PLA# Pre-1938 /  Enter the PLA number.
OTC Product If the product pre-dates 1938, select Pre-1938.

If the product is an over-the-counter product, select OTC product.
4.1.6.4.1 Guidelines to Selecting G3 Report Source Checkboxes The following table

provides information about the conditions that govern when a specific check box

should be selected.

Select the following check

If this condition is true box
Country of Incidence is not USA Foreign
Report Case type is configured to contain cases from Literature
Literature

Report Case Type is configured to contain cases from Clinical Study

Trials

Any Reporter Type is selected as Consumer AND none of the

Health Professional

reporters is identified as Health Care Professional

Any Reporter Type is selected as Company Representative

Any Reporter (Primary or Other) exists in a case with a

Company Representative

Other

Reporter Type of Other, If the selected Report Type is a
Regulatory Authority (text value) within the Argus Case, the
Other check box should be checked and the text "Regulatory
Authority" should be entered in the text box.

Case contains a Consumer Reporter AND also does not

Consumer

contain any Health Care Professional reporters.

Note:
manually.

The User Facility and Distributor check boxes must be checked

Enter the appropriate text if you have selected Other as a report

source.

4.1.6.5 Analysis Tab: BfArM Info Tab

Use the BEArM Info tab to enter information required for the BfArm Report. The
following is an illustration of the BfArM Info tab.
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To enter data for the BfArM report
1. Open the BfArM Info tab.

2. Select the choices that apply to the patient from the items in the form.

3. If you do not know if a particular condition applies for the patient, select Unk.

Note: If any of the relevant items are entered in the Current Medical
Status form in the Patient tab, the system automatically enters them
here. If you change any of those items in the BfArM Info tab, the
system will not enter the data in the Patient tab.

4.1.6.6 Analysis Tab: AFSSaPS Info Tab

Use the AFSSaPS Info tab to enter the imputability assessment information for the
suspect product along with the Adverse Events. The following is an illustration of the

AFSSaPS Info tab.
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AFSSaPS Info Tab Fields and Field Descriptions
The following table lists and describes the fields on the AFSSaP$S Info tab.

Field/Control Name Description

Event Displays included terms for all events.
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Field/Control Name Description

Product Enter the suspect product. You cannot enter a concomitant
product.

Chronology Select a Chronology code. The fixed set of values is C0, C1, C2,

and C3. Click the icon to select the Time to onset,
Readministration and Drug Stopped Values.

The user's selection auto-calculates the Chronology for the
Product - Event combination.

Semiology Select a Semiology code. The fixed set of values is S1, S2, and
S3.

Click the icon to select the Semiology Outcome,
Complementary Test, and Other Explanation.

The user's selection auto-calculates the Semiology for the
Product - Event combination.

Bibliography Select a Bibliography code. The fixed set of values is B0, B1, B2,
and B3.
Imputability Imputability Calculation:

~ Select from one or more of the following checkboxes:
= Poursuite de I'étude sans modification du protocole
= Poursuite de I'étude avec amendement au protocole
= Arrétdel'étude
= Arrét du développement du produit
= Autres

The text box after Autres supports fifty characters. If the
Autres checkbox is not checked, the field is disabled.

You can click Copy to Local Evaluator Comment to copy
imputability values to the Local Evaluator Comment field and
place the imputability text-equivalent at the beginning of the
text that currently exists in the field. Copy to Local Evaluator
Comment is visible only if the language for the "Local
Evaluator Comment" field is French.

Future Actions Enter a text description for future actions.

4.1.7 Activities Tab

The Activities tab presents detailed information about the contact log, routing
comments, action items, and Case Lock/Closure.

The following is an illustration of the Activities tab.
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4.1.7.1 Activities Tab: Contact Log Section
The Contact Log section of the Activities tab enables you to:

Track correspondence related to individual cases

Display scheduled letters
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The following is an illustration of the Contact Log section of the Activities tab.
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Contact Log Fields and Field Descriptions
When using the Contact Log section, be aware of the following;:

The number displayed in parenthesis in the header of each section - Contact Log,
Action Item, Routing Comments, Case Lock/Archive - displays the total number of
entities within the section.

You can choose to view All Action Items or only Open Action Items, which shall
display all the Open Action items within the case. By default, All Action Items are
displayed.

You can sort Action Items by clicking on the column headers.
The system remembers the sort order on for the duration of the case.

The following table lists and describes the fields in the Contact Log section of the
Activities tab.

Field/Control Name Description

Date The date is automatically inserted by the system when a letter is
scheduled or generated through the Letters menu. You can enter the
date on which the letter is manually scheduled or generated.

Click the letter icon to open the Letter Preview dialog. This allows you
to view a letter or to modify it if it has not been sent already.

Code Select from a list of values to set the contact code for this entry. The
Administrator can adjust the information in this list.

e-mail button Click to send an e-mail message.

Description Enter a brief explanation for the letter, for example, "Initial Letter," or
the details of a phone conversation.

New Letter button Click this button to generate a new letter.

Group/User Select a group responsible for the Contact item. From the list below,

select a user from the selected group who will be responsible for the
action. The Contact Item will appear in the Worklist for selected user. If
"Any" is chosen as the group, the Action Item appears in all the users'
Worklist. The Administrator can adjust the information in these lists.

Date Sent The date is automatically inserted when a letter is sent through the
letter menu. You can also manually enter the date the letter was sent. If
this field is completed, the letter will become read-only.

4.1.7.1.1 Generating Letters You can generate letters from the Contact Log section.
When generating letters, be aware of the following:

»  The placeholders for the original letter template can be replaced by information
that is specific to the current case.

»  Aletter is only added to a search if the Correspondent check box is checked.
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s The Administrator can configure the system to generate letters automatically and
to schedule them for a specific number of days after receiving details of an adverse
event. For example, the system might schedule an Initial Response Letter to be
sent the day after an adverse event is received. Auto letter scheduling is triggered
when a case is initially saved.

»  Letters cannot be auto-generated unless the "Date" [contact log date] is reached, to
ensure that the latest information for the case has been updated to the letter.

»  If the Primary Reporter is marked as a correspondence contact, the system sends
Auto-scheduled letters are sent to the Primary Reporter. Otherwise, the letter is
sent to the first correspondence contact.

= Auto-scheduled letters appear in the Contact Log section of the Case Form. You
can view or print them by double clicking the letter icon. You can also edit letters
that have not been sent. The system does not automatically send letters. You must
send or remove letters manually.

= Inaddition to auto-scheduling letter, you can also configure auto action items,
which prompt you to follow-up with a correspondent after a letter has been
scheduled and sent. Auto action item scheduling is triggered once the sent date
has been entered for a letter. Auto action items appear in the Action Items section
on the Case Form and in the Action Items tab of the Worklist.

s The system uses the following naming convention to when saving letters in the
Uploaded letters folder:

XXXX_YYYYRTE

where:
XXXX Is the current case number
YYYY Is the current letter numbering format (i.e., date and time the letter was

generated)

s The system replaces all special characters in the case number with an underscore (
_ ) character.

s The CFG_PLACEHOLDER SQL limit is 4000 characters rather than 1000.

Use the following procedure to generate a letter.

To generate a letter
1. Go to Contact Log in the Activities tab and click New Letter.

2. The Custom Letter Templates dialog opens.
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Custom Letter Templates
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3. Select the required letter template from the list and click OK to open the letter in a
separate window.

]
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4. Make the necessary changes to the letter text.
5. Select File-->Save to save the changes.
6. If you modified the letter, select Yes.

This attaches the letter to the Case Form by browsing to the location where you
saved the changes.

7. After saving the letter, the system displays it in the Contact Log section of the
Activities tab.

8. The system creates an action item for following-up on this letter in the Action
Items section of the Activities tab.
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4.1.7.1.2  Scheduling Action ltems for Letters When specifying or changing the Date Sent
field in a letter, you can schedule an action item if you wish to do so.

= If an action item is not specified, the field is blank.

= Any Action Item can be updated on the screen immediately after a case has been
saved.

= Unless the Action Item has already been marked as completed, each time the Date
Sent field is changed for a letter, the corresponding action item (if one exists) is
also updated with a new Due Date of Date Sent of the Letter and the number of
days specified for the Action in the Letter configuration

4.1.7.1.3 Opening a Message Editor To open a message editor
1. Click the letter icon to open the message editor.

2. The system opens the message editor.

The following table lists and describes the fields in the dialog box

Field/Control Name Description

To Displays the e-mail address specified for the Primary Reporter in the
Case Form.

You can edit this field.

From Displays the email address specified in the Return Email Address in
Argus Console>Code Lists>Letter Configuration. You can edit this field
also.

Subject Displays the Case Number and the Description of the Contact log.
You can edit this field.

Send Enables you to send the e-mail to the intended recipient.

4.1.7.2 Activities Tab: Action Items Section

The Action Items section enables you to view or enter details of action items for the
case and to assign responsibilities for actions. The following is an illustration of the
Action Items section.
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4.1.7.2.1 Action ltems Fields and Field Descriptions The following lists and describes the
fields in the Action Items section.

Field/Control Name Description

Date Open Enter the date the action item was created. Open action items appear in
the Worklist of the user who is responsible for the action item. They
also appear in the Open Action Items Report.

Code Select an Action Item code from the drop-down list. This will display
the description of the selected Action Item Code. The Administrator
can adjust this list.
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Field/Control Name Description

Description Selecting an Action Item code automatically enters information into this
field. The text can be modified as required. The Administrator can
adjust this list.

Group/User Select a group responsible for the Action Item from the given
drop-down list. From the drop-down list below this, select a user from
the selected group who will be responsible for the action. The Action
Item will appear in the Worklist for the selected user. If "Any" is chosen
as the group, the Action Item appears in all the users' Worklist. The
Administrator can adjust these lists.

Due Enter the date on which the action item is to be completed.

Completed Enter the date on which the action item was completed. A red border
indicates a completed action item while a green border indicates an
incomplete action item.

Sent in Letter Identifies that the Query Type Action item has been sent as a part of the
Letters. Displays only for those Action Items that are configured as
"Query Action" in Console ' Action Type code list.

4.1.7.3 Activities Tab: Routing Comments Section

The Routing Comments section displays workflow routing information and
comments for the case. It also contains a read-only sub-section on Case
Locking/Closure. The following is an illustration of the Routing Comments section.
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Routing Comments Fields and Field Descriptions
The following table lists and describes the fields in the Routing Comments section.

Field/Control Name Description

Date Displays the date the case was routed to a new workflow state. This
field is automatically generated when a case is routed.

User Displays the name of the user who routed the case. This field is
automatically generated when case is routed.

Comment Displays the routing comment.

Route button Routes the cases.

Return button Returns the case to the previous state.

4.1.7.3.1 Routing Cases If the case meets the routing rules specified by the
Administrator, you can use the Case Routing dialog box to route a case to the next
workflow state. When using the Routing Forward Cases function, be aware of the
following:

= Non-Enterprise Workflow managers cannot view all the Workflow States below
the line if the Workflow States are assigned to Sites in the Workflow Configuration.

= Only Enterprise Workflow managers have access to all sites for routing cases
ahead in the Workflow.

»  If the Workflow state does not have defined site, all workflow managers can see it.
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To route a case

1.

Click Route in the Activities tab of the Case Form to open the Case Routing
dialog box.

From the Route to Next State drop-down list, select the state to which you would
like to route the case.

If only one workflow state can be selected for the Next Route state, that state can
be selected by default in the Route to Next State field.

From the Route to User drop-down list, select the user or user group to route the
case to.

Enter the routing comments in the Comments field
OR

Click Select to select a comment from a list of pre-defined routing justifications.

To select text from the pre-define list of routing justifications

1.

Click on the Select button in the Case Routing dialog to open the Routing
Justification dialog box.

Select the required justification from the justification list displayed under Select a
standard justification for this field. The system highlights the selected row.

Click OK.

The system closes the Routing Justification dialog box and displays the selected
justification text in the Comments field in the Case Routing dialog box.

Click OK to route the case.

Note: The system displays disabled users in the user drop-down list
in alphabetical order with an asterisk (*) at the end. You can view the
total number of times the case has been routed in the header section,
excluding the blank rows.

4.1.7.3.2 Returning Cases If necessary, you can return a case to its previous workflow
state.

To return a case to its previous workflow state

1.
2.
3.

Open the case.
Click the Return button in the Activities tab of the Case Form.

When the system opens the Case Routing dialog box, enter your password in the
Password field.

From the Route to User drop-down list, select the user or group the case needs to
be returned to.

Enter any routing comments in the Comments field.

Click OK to return the case to its previous workflow state.

4.1.7.4 Activities Tab: Case Lock/Close Section

The Case Lock/Close section enables you to lock a case, unlock a locked case, and
formally close a case. You must lock the case before you can generate a report. The
following is an illustration of the Case Lock/Close section on the Activities tab.
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When closing a case, be aware of the following:

s If the Auto-schedule Later checkbox for expedited reports is checked and you try
to archive a case, the system displays the following message:

Case xxxx cannot be closed while Auto Schedule Later is checked. Please uncheck
the option for the Auto Schedule Later option on the Regulatory Reports tab or
wait for the Report Scheduling to complete before attempting to archive the case.

s The system displays this same message when you close single or multiple cases
from the New /Open dialog on the Worklist.

Case Lock/Close Fields and Field Descriptions
The following table lists and describes the fields in the Case Lock/Close section of the

Activities tab.

Field/Control Name Description

Case Status

Closure Date

Lock or Closed By

Notes

Enables you to unlock, lock, or close a case after entering the
appropriate user information.

Unlock -- Enables you to unlock a case if you have the appropriate
permissions. To unlock a case, enter the password you use to log
on to Argus Safety.

Lock -- Enables you to lock a case if you have the appropriate
permissions. The current date will be used for the lock date. To
lock the case, enter the password you use to log on to Argus Safety
in the Case Locking dialog box.

Close -- Enables you to close a case if you have the appropriate
permissions. To close the case, enter the password you use to log
on to Argus Safety in the Case Closure dialog box.

Date on which the case was locked or closed. If a locked case is being
viewed by a user, any other user who tries to access the same case will
have read-only access to the case.

Cases should be closed only after all action items for the case are
complete, all expedited regulatory reports have been submitted,
and all the expected follow-up information has been received. If a
closed case that is closed requires modification, the case must be
re-opened by using the password.

A case may be either locked or closed, but not both. A locked case
will be moved from the locked state to the closed state without
having to unlock first.

Note: Case closure should not be confused with closing the Case
Form. Closing of the Case Form refers to removing the current
Case Form from the screen.

Displays the name of the user who locked or closed the case.

Displays relevant information about the case lock or closure.

4.1.7.4.1 Locking a Case To lock a case
1. In the Case Lock/Close section of the Activities tab, click Lock.

2. The system opens the Case Locking dialog box.
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Enter your Argus Safety password in the Password field.
Enter any notes in the Notes field.

Click OK.

o o k~ w

The system displays the locking notes in the Notes field of the Case Lock/Close

Note: To unlock a case from the Locked/Archived state, select the
Unlocked value from the Case Status drop-down list. This will
display the Archived Case or Case Lock dialog. The dialog box
requires you to specify your password and the reason for unlocking
the case. The case is unlocked/archived after you enter this
information.

4.1.7.42 Unlocking a Case Use the following procedure to unlock a case.

To unlock a case

1. In the Case Lock/Close section, select Unlocked from the Case Status drop-down
list.

2. When the system opens the Locked Case dialog box:
1. Type your password in the Password field.
2. Type any relevant information in the Notes field.
3. Click OK.
3. When the system opens the Case Unlock dialog box, click one of the following:
= Significant F/U
= Non-significant F/U
s Other
4.1.7.4.3 Setting the Focus for a Follow-up Event After unlocking a case, the system sets
the focus for significant/non-significant follow-up events as follows:

1. When you click the Significant F/U button on the Case Unlock dialog, the system
automatically displays the case General tab, checks the Significant check box for
both drugs and devices (if enabled by the profile switch), and sets the focus on the
Follow-up Received Date.

Screen: Argus > Case Actions > Open > (Select a Case) > General Tab > General
Information Section > Follow-ups sub-section (middle of screen).

s The system checks to determine whether the Significant check box is checked.
= The system sets the focus on the Follow-up Received Date.

2. When a case is unlocked and you select the Non-Significant F/U button from the
case unlock pop-up dialog, the system automatically displays the case General tab
and sets focus on the Follow-up Received Date.

Argus > Case Actions > Open > (Select a Case) > General Tab > General
Information Section > Follow-ups sub-section (middle of screen)

»  The Significant check box is not checked.
= Focus is on the Follow-up-Received Date.

= You can add multiple follow-ups.
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Argus > Case Actions > Open > (Select a Case) > General Tab > General
Information Section > Follow-ups sub-section (middle of screen)

- If you add a single follow-up, the Add button remains available for the
user to add additional follow-ups.

- Currently, the Add button disappears after the user adds a single
follow-up. The user must save, close and reopen the case before he/she
can add an additional follow-up.

= A hyperlink in the follow-ups section enables you to open the link in a
different dialog box.

4.1.8 Additional Information Tab

The Additional Information tab enables you to attach notes and other items to the
case. For example, you could attach a fax message that came in as part of the case and
needs to be scanned and attached or an electronic file received by e-mail. It also
enables you to set up cross-references to other cases such as links between cases
referring to mothers and children. The total number of attachments and references
attached to a case display in the header.

The following is an illustration of the Additional Information tab.
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When using the Additional Information tab, be aware of the following:

»  The system shrinks the main widow up to 60% and opens the attachments from
the Notes and Attachments dialog in a new browser window.

s The system opens any hyperlinks that appear on the Additional Info tab in a new
Internet Explorer window if the selected reference is HTTP /URL Reference.

= When you click the hyperlink and a reference case is present, the system opens a
case number irrespective of the selected reference type when you clicked the
hyperlink.

= If no sites are defined for the attachments classification, the system permits all
users to view the attachments on the Additional Info tab.

s The system only permits users who belong to the site defined on the attachment
classifications to view the attachments.
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= The system filters the attachment classifications based on the sites a user has
permission to access.

s The Case Form/Case Listing reports printout hides the row.

s The system permits Workflow Enterprise to view all attachments across all sites

4.1.8.1 Additional Info Tab Fields and Field Descriptions
The following table lists and describes the fields on the Additional Info tab.

Field/Control Name

Description

Notes and Attachments

Classification

Date

Incl. Reg. Sub

Keywords
Description
Attach File
Add

Delete

Attach Documentum
Link

References Type

ID #

Notes
Select
Add

Select a classification that describes the attachment. The Administrator
can adjust this list.

If any attachment classification has the E2B Additional Report checked
and the attachment is an file in either .XLS, .TXT, .TIF, .DOC/.RTF,
>PNG, >JPG or >BMP formats, the selected attachment is converted to
a PDF file.

This PDF file is then merged into a single PDF file, which comprises
text converted to PDF from all the attachments present in the case.

The single merged PDF comprises each attachment as a link by the
classification name provided for the attached file.

The current date is automatically entered in this field. You can also
enter a date manually.

Select this checkbox to merge PDF attachments within the case form.
The Incl. Reg. checkbox identifies the attachments to be included as an
appendix to the Expedited Reports. On selecting this checkbox, the
Expedited Reports - CIOMS I, CIOMS I (Local), US FDA MedWatch
3500 Drug and 3500 A Device print an appendix page before each
attachment. This is added to the case, and marked as Inc. Reg. Sub
checked.

Note: The checkbox is available only if a PDF is selected as an
attachment.

Enter keywords related to the case or click Select.

Enter a description of the attachment.

Inserts a file attachment into the case. Maximum file size is 4 GB.
Inserts a row for an additional attachment.

Deletes the selected row.

This option is visible only if Documentum is available.

Click Searching for Documentum to search for and attach
Documentum.

Select a reference type from the list, for example, a parent-child link.
The Administrator can adjust this list.

Enter the case number of the case that is to be referenced.

Note: Click Select to search for the case that is to be referenced. You can
also use this field to record the reference number for external cases.

Notes can be entered here for reference.
Opens the Case Selection dialog for the selected ID.

Inserts a row for an additional attachment.
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4.1.8.2 Searching for Documentum Links

To search for Documentum links

1. Click the Attach Documentum Link button to open the Documentum Lookup
screen.

2. Enter the desired search criteria as per Type Name, Attribute Name and Search
String, and click Search.

3. Select the desired link from the row displaying the search results.

4. Click Select to select the link from the list.

4.1.8.3 Attaching Files to a Case

You can attach from 1 to 99 files to a case.

4.1.8.3.1 To attach files to a case In the Notes and Attachments section of the
Additional Info tab, click Attach File to open the Attachment dialog box.
1. Click Browse to locate a file attachment.

2. Select the file and click OK.

Note: To view an attachment, click the icon associated with the
attachment

4.1.8.4 Entering Keywords

You can associate keywords with a case in the Notes and Attachments section.

To attach keywords to a case
1. Go to the Notes and Attachments section and click Select.

2. When the system opens the Attachment Keywords dialog box:
»  Select a keyword from the Select a keyword to add to the list drop-down list.
s The system displays the selected keywords in the Keywords field.

3. Click OK

4.1.8.5 Attaching References to a Case

To add a reference to a case
1. Locate the References section and click Select.

2. When the system opens the Case Search Criteria dialog box, enter the appropriate
search parameters and click Search.

3. When the system displays the search results in the Total Number of Rows section,
select the desired search criteria from the list and click Select to view details about
the selected case.

4.1.9 Regulatory Reports Tab
The Regulatory Reports tab enables you to:

= View all scheduled reports
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= Schedule new reports

When a new case is created, there are no reports associated with it. As data is entered
and the case is saved, the regulatory report scheduling algorithm determines which
reports, if any, will be required for that case.

The reports determined to be necessary appear in the Regulatory Reports tab. You can
manually schedule reports via the Reports menu or by clicking the Regulatory Reports
Tab. You can also add comments to the existing reports. The comment section can also
be updated to enter the notes for the report even after the report has been submitted.

The following is an illustration of the Regulatory Reports tab.
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4.1.9.1 General Usage Information
When using the Regulatory Reports tab, be aware of the following:

s The case submission date must be on or after the initial receipt date for the case. If
the submission date is before the initial receipt date, the system displays the
following message:

Please enter the Submitted Date greater than the Initial Receipt Date of the Case

s The system displays the time component for the date generated on the Case
Form | Regulatory Reports tab using the IE offset of the client machine for the
display.

s The system displays the time component for the date generated on the Report
Details using the IE offset of the client machine for the display.

s When you manually schedule an expedited report, the system places the word,
Manual, in the Notes field along with the current notes information.

= When you manually schedule a report, the system enables you to check "Blind
Product Study" on the Schedule New Expedited Report dialog box to blind the
study products if they are in the case.

4.1.9.2 Regulatory Report Tab Fields and Field Descriptions
The following table lists and describes the fields on the Regulatory Reports tab.
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Field/Control Name

Description

Status

Seq
Destination

Report Type

License Type
License #

Generated

Local Comment

Submitted

Notes

Due

Responsible

Auto Schedule
button

Auto Schedule
Device button

Schedule New Report

button

Auto Schedule Later

Auto Schedule
Device Later

The notification log provides a list of reports which have been
scheduled, generated, or submitted. The following report status are
available indicated by the icons in the regulatory reports tab:

= Report has been routed and approved by a user.

= Report has been routed and disapproved by a user.
= Report has been scheduled but not saved.

= Report has been scheduled and saved.

= Report has been scheduled and generated.

= Report has been scheduled /generated and it is past its due date of
submission.

= Report has been scheduled /generated and submitted.

= Report has been marked as submission not required by a user.
Displays the sequence (Initial, Follow-up, etc.)

Displays regulatory authority to which the report is to be submitted.

Displays the type of regulatory report like US IND Summary, BEARM
Form 643, etc.

Displays license information.
Displays the license number.

Displays the date when the regulatory report was generated (if
applicable). The system date on which it is generated is used as the
default value.

Displays a local comment, if it exists.

Displays the date the regulatory report was submitted (if applicable).
The system date on which it is generated is used as the default value.
This date does not initially appear on the Case Form when submitted. It
is displayed when the case is re-opened.

Displays notes entered when the report was created.

Displays the date the regulatory report is due for submission to the
regulatory authority (if applicable). This field is auto-calculated based
on the initial receipt date or on the basis of the most recent significant
follow-up date. It can also be specified manually by entering the date in
the Due Date section.

Displays the name of the user responsible for the report.

Initiates Auto-Scheduling of expedited reports according to the
configuration for this feature, for example, Always, Significant, Manual,
or None.

Schedules regulatory reports, using the Device rules.
Schedules a new expedited report.

This item appears if the system is configured for auto-schedule of
expedited reports using Argus Safety Service. Select this check box
when the system is about to run the auto-scheduling against this case
after the case is locked.

Select this check box to run the auto-scheduling for only devices.
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4.1.9.3 Grouping Regulatory Reports

You can group reports by selecting the appropriate grouping structure from the
Organized by drop-down list. You can group reports as follows:

= Report Type/Submit Category/Reporting Destination
= Report Type/Reporting Destination
= Report Type/Reporting Group

The numbers in parentheses next to each folder indicate the number of reports in the
folder.

The following are definitions of the terms used in the reporting structure.

= Report Type -- Can be either Expedited or Periodic reports. The system generates
a folder for each type.

= Reporting Destination contains all defined code list items for Reporting
Destinations that have at least one report scheduled within the case.

If no reports are scheduled for a defined reporting destination, no folder will be
created for this destination. All the folders which are the reporting destinations under
each folder are sorted alphabetically.

= Pending Reports -- Reports that have not been submitted or are marked as
non-submitted.

= Submitted Reports --All submitted reports.

= Marked as Non-Submit --Reports that have not been submitted.

= Reporting Group -- Contains all user groups assigned to the scheduled expedited
or scheduled in the case

4.1.9.3.1 Grouping by Report Type/Submit Category/Reporting Destination The Expedited

folder contains the following:

= Pending Reports by Destination

= Submitted Reports by Destination

= Non-Submitted Reports by Destination

The Periodic folder contains single case report forms (MedWatch, VAERS or CIOMS)
that were generated as part of a Periodic Report.

= Pending Reports by Destination

= Submitted Reports by Destination

= Non-Submitted Reports by Destination

4.1.93.2 Grouping by Report Type/Reporting Destination The Expedited folder contains a
sub-folder for reporting destinations that have at least one scheduled report.

The Periodic folder contains the single case report form (MedWatch, VAERS or
CIOMS) generated as part of a Periodic Report are listed in the Periodic section. If no
report was generated, the system does not create sub-folders.

4.1.9.3.3 Grouping by Report Type/Reporting Group The Expedited and Periodic folders

contain sub-folders for each group that has generated a report. If a group has not
generated a report, the system does not create a sub-folder.
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Case Actions

This chapter discusses the actions that can be performed on the existing cases.

5.1 Working with Cases

This section provides information about actions that can be performed on existing

cases. It includes discussions of the following:

Finding and Opening Existing Cases

Creating a New Case
Processing a Case

Closing a Case

Saving a Case

Copying a Case

Performing a Medical Review
Performing a Coding Review
Printing Cases

Printing Medical Summaries
Deleting a Case

Revising a Case

5.1.1 Finding and Opening Existing Cases

You can find and open a case from the Case Open form shown in the following
illustration.

To find and open an existing case
1.

2
3
4.
5
6

Select Case Actions --> Open to view the Case Open form.

Enter or select the appropriate search criteria in the form fields and click Search.

When the system displays the search results, locate the appropriate case in the list.

Click the link associated with the Case ID.

The system opens the Case Form for the selected case.

You can now review the case details and enter further information in the Case

Form.
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Note: You can open the 10 most recently-accessed cases without
going through the preceding process. These cases appear under Active
Cases.

5.1.1.1 General Usage Information
When using the Case Open dialog box, be aware of the following:

You can print all the cases in the current view from the Case Actions | Open
dialog.

If you open a case that is assigned to another user in Edit mode, case assignment is
not changed and the case remains with the user to whom it was initially assigned.
However, if you open an unassigned case in Edit mode, the case is now
automatically assigned to the user who has opened the case in Edit mode from any
module of Argus Safety.

If you search for a case that has been deleted, the system displays the following
message:

"The case number being searched has been deleted from the system. Please
undelete the case from the Utilities | Undelete option for further processing.’

This message appears across the application where you use the case number to
search for a case as follows:

- Worklist -- All dialogs

— Last Accessed Cases from the Menu

— Person Argus Status

Case Search while adding the Case as a reference

- Ifablinded user views the case information from the Case Summary, the
system displays the Blind name instead of the Study Drug name in the
product information.

- When you view the case details, the system displays the same folder structure
on the Regulatory Reports tab. This enables you to view the expedited and
periodic in an organized tree structure.

5.1.1.2 Case Open Form Fields and Field Descriptions
The following table lists and describes the fields on the Case Open form.

Field/Control Description

Search For Select the criteria by which the case must be searched for and enter an

appropriate search item, if applicable.

Note: You can search for cases based on multiple study identifiers. The
option, "Pri/Stdy/Othr/Cntr/Rptr/Pat" supports entry of Project ID,
Study ID, Other ID, Center ID, Reporter ID, and Patient ID values
separated by the "/" (forward slash) character. Any or all fields may be
present.
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Field/Control

Description

Full Search

Product Family
Date Range

Advanced
Condition

Result from Argus
Insight

Search

Select this check box, if necessary.

Full search is best explained with an example. If the full search option is
not used and the item that is entered under Search for is "AB", then a
string such as "ABCESS" will match "AB", but a string such as "LABOR"
will not. If the full search option is used, both these items will match
"AB". Also, items whose first few letters sound similar (like "TIM" and
"TIN") will also appear in the search results.

Select the Product Family that the case belongs to, if applicable.
Select a relevant Date Range, if applicable.

Tip: To enter a customized date range, select Custom Date Range from
the list.

= Enter an appropriate date range in the custom date range dialog and
click OK.

= Select the Follow-up radio button to search on Follow-up Dates,
including the Significant and Non-Significant Follow-ups.

Select an advanced condition for the case, if applicable.

Note: Click AC to create a new advanced condition.

Enables you to create a search result with the same cases as the Active
Case Series in Argus Insight.

Click Search to display the list of cases that match the search criteria.

5.1.1.3 Search Results Contents

The Search Results under Total Number of Rows display a list of cases as specified in
the Search Criteria (Default Criteria is Date Range of Last 30 days). The previous
search results are displayed if a search was performed by the user during the same
session without logging out.

The following table lists and describes the Search Results columns and contents.

Column Description
Total Number of Displays the total number of results found to match the search criteria.
Rows = Displaying Rows. The number of rows being displays.
= Page Size. The number of rows that display on each page.
s << >>. Click to scroll through the search results.
Lock State Displays the Lock Status - whether the case is locked or unlocked.

Case Number

Date
Product

State

Click the icon displaying the lock status for more information.

Displays the unique Case Number of each case. Click the case number
link to open the case.

Displays the date when the case was opened.
Displays the Product related to the case.
Displays the State that the case belongs to.

5.1.1.4 Sharing a Case Series

You can share a case series from:

= Argus to Argus Insight

= Argus Insight to Argus
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To share a case series from Argus to Argus Insight
1. Click the [Argus Insight] option to automatically activate the same case series in
the search result.

2. Argus Insight automatically makes the same case series active that is present in
the search result of the Case Search dialog in Argus.

Note: :If Argus Insight is already open, the system replaces the
active case series in Argus Insight with cases from Argus.

To share a case series from Argus Insight to Argus

Click the Result from Argus Insight button in Case Search to create a search result
with the same cases as the Active Case Series in Argus Insight.

Be aware of the following;:

» If there are no cases in the Active Case Series in Argus Insight or no Active Case
Series exists, the system generates an "empty" search result.

»  If there are cases in the Argus Insight Case series that no longer exist in Argus,
they are excluded from the case series in Argus.

= You can also make the Case Search dialog case series active from within Argus
Insight through the Case Series menu option Make Active from Argus in Argus
Insight.

» A caseis excluded from the case series, if a case series from Argus contains cases
that are not present in the data mart.

5.1.2 Processing a Case

When your company receives initial case information you enter this information on
the Initial Case Entry form. After entering this information, it must be verified, or
checked for duplicates (possibly by another user) to ensure that duplicate information
is not entered in the database. Once the information is verified, you can book in the
case or enter additional case data.

The following is an illustration of the Initial Case Entry form.
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5.1.2.1 Initial Case Entry Fields and Field Descriptions
The following table lists and describes the fields in the Initial Case Entry form.

Field Description

Initial Receipt Date Enter the date on which your company became aware of the case. The
Receipt Date cannot be entered as a partial date.

Central Receipt Enter the date on which this information was received by Central Safety.

Date

Country Enter the country where the adverse event occurred. You can select the
appropriate country from the list.
Note: This may or may not be the reporter's or the patient's country of
residence.

Report Type Select the item that best describes the type of report. This determines the
fields that are made available for entering case information.
Note: The report type also impacts the duplicate search. For example,
selecting Sponsored Trial makes the Study ID and Protocol ID fields
available. The Administrator can adjust the information in this list.

Project ID Enter the Project ID of the case.

Study ID This item is applicable to clinical trial cases only. Enter the study ID. Click
Select to choose the study ID from the Clinical Trial Selection dialog.

Center ID This item is applicable to clinical trial cases only. Click Select to choose the

Initial Justification

Product Name

Center ID from the Clinical Trial Selection dialog.

The values of this field are configurable through the standard Argus
Justifications dialog. This field is reflected in the General tab of the Case
Form and is also available for duplicate searching for cases.

Click the green dot to view and select justifications from the Argus
Justification dialog.

Enter the name of the product associated with the case. If the adverse
event(s) are associated with more than one product, each additional
product can be added from the Case Form.

Note: Enter the most suspect product here. Click Select to search for a
product from the Trade Name Product Lookup dialog. Several items are
automatically entered on the Case Form based on the product selected
here.
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Field

Description

Generic Name

Description as
Reported

Onset Date/Time

Sal. First Name
Middle Name Last
Name

Suffix

Country
State/Province
Postal Code
Intermediary

Patient Name or
Initials

Pat. ID
DOB

Age

Units
Gender

ID
Keyword

Journal Title

Full Search (Like
Soundex)

This field can be used to enter the generic name of the product. This field
will be automatically entered when a product is selected from the Trade
Name Product Lookup dialog.

Enter a brief verbatim description from the reporter that describes the
event that is most clinically important in the case. The icon denotes that
the event is encoded. Click the icon to populate the MedDRA hierarchy
dialog.

Enter the date/time for the onset of adverse event symptoms.

Enter the reporter's salutation, first name, middle name and last name.

Enter the reporter's name suffix, if applicable.

Enter the reporter's country.

Enter the reporter's state/province or county.

Enter the postal code or zip code.

Enter the type of intermediary for the case, if applicable.

Enter the patient's name or initials. The system can search for cases on
initials, first name, and last name.

Enter the patient's ID.

Enter the patient's Date of Birth (dd-MON-yyyy).
Note: When entering the month, enter 1 for JAN, 2 for FEB, 3 for MAR and
SO on.

Enter the patient's age. When searching for duplicates, the system will
retrieve all ages that begin with the number that was entered for the
search. For example, searching for "5," will retrieve patients aged 5, and 50
through 59.

Enter the age units (days, months, or years).

Select the patient's gender from the list. The Administrator can adjust the
information in this list.

Enter the value to search for a Reporter Reference number, Case Reference,
and Case number.

Enter a keyword when searching for duplicates. Keywords are only used
for searching for cases.

These items are applicable to literature cases only. Click Select to choose a
journal and title from the Literature Reference dialog. The Administrator
can adjust this list.

Check the Full Search (Like, Soundex) check box to perform a full search,
including Soundex search for cases.

Tip: Soundex enables you to search for cases with similar phonetics.

5.1.2.2 Booking in Cases and Entering Initial Case Information

From the Initial Case Entry form, you can decide to book-in a case before entering
further case information in the Case Form.
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Note: You can configure the number of cases that display in the
Bookin dialog in the Page Size drop-down list. By default, 100 cases
appear on the page. You can choose to display up to 2000 cases on a
single page.

To enter initial case information

1.
2.
3.

Select Case Actions --> New to open the Initial Case Entry form.
Enter preliminary case information in the form.

Click Search to determine whether information related to this case has already
been entered.

A list of cases that match the criteria you entered on the form is displayed. Inspect
the search results for a duplicate case.

Note: Fields displayed with a red flag are required fields and must
contain a value.

Note: :If a duplicate case exists, open the case to enter further
information (if any) related to the existing case. Click the link
associated with the case

If a duplicate case does not appear, click Continue in the Initial Case Entry form to
display the BookIn and Attachments and References sections.

Enter the relevant information in sections like Causality, Seriousness, Attachments
and References.

= Under Reported Causality, select the reporter's assessment of causality. The
causality relationship is the causal relationship between the clinically most
important event and the suspect drug that is entered in the Initial Case Entry
form.

»  For Seriousness Criteria, select the appropriate check boxes to indicate the
seriousness of the case, as appropriate.

Note:

= Select only the criteria that applies to the clinically most important
adverse event.

= If you select the Death check box, you can enter the death details
from the dialog that automatically appears. If you select the
Hospitalized check box, you can enter hospitalization details from
the dialog that automatically opens.

m FEither a seriousness criterion or a non-serious criterion must be
entered before a case can be booked in.

s When a Duplicate Search is performed, the system will remember
the results until the user logs out of the system or performs a
duplicate search again. When the Bookin screen is opened, the
search results from the last search are displayed again.
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7. If the case is not serious, select the appropriate check box under Case is
Non-Serious. The Non Serious Section of the Initial Case Entry dialog is
differentiated by a | between the Serious criteria and the Non Serious Criteria.

8. Click Add to add an attachment
9. Select File Attachment or URL Reference, as appropriate.

To insert a file attachment
1. Select File Attachment from the list and click Browse.
2. Click the New Case from Image button - is the first button (from left) in the Quick

Launch bar. This button opens the Windows Open dialog, which helps you to
browse to the default location from where the file(s) can be attached.

Note: This location is configured can be configured by the
administrator in Argus Console under System Configuration >
Common Profile Switches > Case Processing.

To insert a URL Reference
1. To insert a URL Reference, select URL Reference from the list.

2. Enter the URL after "http://".

To search for and insert a document
1. Select Documentum Link and click Add.

2. The Document Lookup dialog is displayed.

3. You can search for a document from the database by specifying a search criterion
in this dialog.

4. Click BooklIn.

Note: Once you click the Bookin button, it is hidden from the screen.
The button is enabled only if the Save operation fails or when the case
is booked in successfully. Mandatory fields are denoted by an orange
border across the field in the Bookin dialog.

5. If the Administrator has configured the system for automatic numbering of cases,
the automatically assigned case number opens. If the numbering of cases is
manual, you can enter the appropriate case number.

Note:

= When a case is booked in, the case may be assigned to a specific
user and it will be given a particular state, depending on the
configuration set up by the Administrator.

= The case can not be booked in without these fields populated:
Product, Event, Receipt Date, Report Type, Country of Incidence
and Seriousness.

= These are noted by an orange border across the field label and
identified by an orange flag to indicate that these are required
fields.
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Tip: When you book-in a case, a dialog that prompts you to open the
newly created case is displayed.

Click Yes to open the case.

5.1.2.3 Checking for Duplicates

To check for duplicates

1. Check whether the case information that is being entered in the Initial Case Entry
form has been entered previously (possibly by another user).

2. Enter the information related to the case in the Initial Case Entry form.

3. Select the Receipt Range Limits radio button to check for duplicates based on the
dates entered in the form. Click Search. A list of cases that match the criteria
entered in the form opens.

4. Inspect the list to determine if any case contains duplicate information.

5.1.2.4 Understanding Receipt Range Limits

The following table provides information about using Receipt Ranges.

Field

Description

No date

Full Onset Date

Full Initial Receipt

Date

Partial Onset Date

Partial Initial
Receipt Date

90 days before System Date and 2 days after System Date.
10 days before Onset date and 90 days after Onset Date.
60 days before Initial Receipt Date and 60 days after Initial Receipt Date.

Note: This default date range for searching on Initial Receipt Date can be
disabled by un-checking the Receipt Range Limits radio button on the
Initial Case Entry dialog.

Based on the Full Date Range - if only the year is entered, the date range
becomes: 10 days before the end of the previous year and 90 days after end
of the year.

Based on Full Date Range - if only a year is entered, the date range
becomes: 60 days before end of previous year and 60 days after the end of
the year.

5.1.3 Closing a Case

Note:

If an Initial Receipt Date is not entered but an Event Onset Date
has been entered, the search will default to look for cases with
Initial Receipt Dates 10 days before and 90 days after the event
onset date. This feature can also be disabled directly on the dialog
by un-checking the Receipt Range Limits check box. If you do not
check anything, the default date range shall be 90 days before and
2 days after the current date.

The Duplicate Search permits you to sort in ascending or
descending order in the duplicate search results. You can also use
wild card searches on all text fields in the BookIn dialog.

This section provides information about how to close a case. Once a case is closed, you
can do the following:
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You can view a closed case in the Case Form in read-only mode.
View reports generated for the case

Preview new drafts

View report details

View drafts of reports that haven't been generated

You cannot create expedited reports for cases that have been formally closed. For that
reason, you cannot close a case that has pending scheduled reports.

To close a case

1.
2

Select Case Actions --> Close.

When the system opens the Save Case dialog box:
Click Yes to save and close the case

OR

Click No to close the case without saving it.

After you close a case, the system does the following:

1.

2.

Opens the next active case, if you have active cases that you are working on. If
there are no active cases, the system displays the default Worklist.

Displays the Personal Argus Status if the default Worklist option is <None>.

5.1.4 Saving a Case

This menu option enables you to save a case.

To save a case

1.
2.
3.

Click the Case Number of the case you want to save.
When the system opens the Case Form, select Case Actions --> Save.

When the system opens the Case Form Saving dialog box, click OK.

5.1.5 Copying a Case

Argus enables you to save all or part of a case and stores the copy in the database as a
separate case. When copying cases, be aware of the following:

Clicking the case reference in any copied case opens the original case.
You can select specific sections of the case to copy.

If your system is configured for manual case numbering, the system prompts you
to enter a new Case ID. Otherwise, the system automatically assigns a new Case
ID. The following is an illustration of the Case ID Number dialog box.

To copy a case

1.
2.

Select Case Actions --> Copy.

When the system opens the Case Copy -- Webpage dialog box, enter the number
of copies you want to make and click Yes to copy the case.

When the system displays the Case Copy dialog box, click the appropriate check
boxes to select the portions of the case you want to copy
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OR
Click Select All to copy the entire case.
4. Click Copy.
5. The system saves and opens a copy of the case with a new case number and

presents a message. Click OK.

Note: Depending on whether the system is configured for automatic
case numbering, the system either generates a case ID or enables you
to enter the case ID for this case.

5.1.6 Using the Medical Review Function

Use the Medical Review function to quickly and efficiently add important information
to a case. The Medical Review form has three (3) tabs as follows:

s Medical Review Tab
s Temporal View Tab
s Action Items/Addl Info Tab

Medical Review - Case Form - 13US000012
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To access Medical Review
1. Select Case Actions --> Medical Review.

2. The system opens the Medical Review form.

3. Click on the appropriate tab.
5.1.6.1 Common Actions

The following table lists and describes the actions you can perform from all Medical
Review tabs.
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Field

Description

View Draft

Zoom/Unzoom

Return Case

Forward Case

Save and Close

Select a report from the drop-down list and click View Draft to generate a
draft version of the report based on the open case.

Note: This report form type is saved as a default and the next time the user
opens the Medical Review for another case, this is defaulted to the Report
Form selected previously.

The Draft report does not display all the changes made to the Case until
the case has been saved in the database.

Click the zoom icon to view the selected dialog on a much bigger scale.

Click Un-Zoom icon to revert back to the earlier view.

Click Return Case to open the return route dialog and save the
information.

Click Forward Case to open the forward route dialog and save the
information.

When the case has been routed and the form is closed, you cannot route
from the case form Activities tab till the case has been closed and
re-opened.

Click Save and Close to save and close the case.

5.1.6.2 Using the Medical Review Tab

The Medical Review tab has three sections as shown in the following illustration:

s Case Narrative

s Case Assessment

s Event Assessment

Medical Review - Case Form - 13US000012
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The system displays the user-defined fields in the Medical Review dialog box, if they
have been enabled on the Case Form Analysis tab. If they have not been enabled, they
do not display on the tab.

Enter information in the Case Narrative, Case Assessment and Event Assessment
sections.

Note:

= An (S)is displayed for Serious events.

= An (F)is displayed for Fatal events.

= An (LT) is displayed for Life Threatening events.
= An (H) is displayed for Hospitalized events.

5.1.6.2.1 About the Case Narrative Section The Case Narrative section is fixed and cannot
be changed. However, you can choose from the drop-down options associate with the
fields to view any of the other narrative fields. The system saves the view as a default
and uses it when you open the Medical Review for another case.

The following is an illustration of the Case Narrative section.

[ i ) ) Gsnmain) [case comment - =l o

Narrative

Company Comment - B i oerees

5.1.6.2.2 About the Case Assessment Section The Case Assessment section enables you
to provide information about case details. The following is an illustration of the Case
Assessment section.

Cane Torows T conasdered eapspdcale Livtedres s Drter=unaton Cane Dudrcorme
e - I -|-| -|-| ul

Select whether the case is serious or not from the Case Serious drop-down list. In a
similar manner, select relevant information about Company Agent Causal, Listedness,
and Case Outcome from the drop-down lists.

5.1.6.2.3 About the Event Assessment Section The Event Assessment section allows you
to understand more about the events. The following is an illustration of the Event
Assessment section.

Event Assessment. =

Product As Reported Causality | As Determined Causal  D/§ Seriousness  Data Sheet # As Determined Listedness
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Event Assessment Fields and Field Descriptions
The following table lists and describes the fields in the Event Assessment section.
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Field

Description

Product

Causality as
Reported/

Causality as
Determined

Event PT
/Description/LLT

D/S

Seriousness
Severity Duration

Data Sheet
License

As Determined
Listedness

This field is populated when events are entered in the Products tab and is
displayed in the following format:

= First Line - Product Name
s Second Line - Generic Name
Causality as Reported -- Indicates the degree of reported causality.

Causality as Determined -- This field is populated with information
entered in the Reported Causality field.

Event PT/Description/LLT -- This field is populated when events are
entered in the Events tab and displays in the following format:

First Line - Event PT
s Second Line - Verbatim
s Third Line - LLT

Displays the Diagnosis/Symptom details by D or S in line with the
Events.

Display the Seriousness, Severity and the Duration of the Event.

Displays the data sheets for the agent.
Displays the licenses for the agent.

Indicates whether the system found the event on the datasheet for this
product.

Filtering in the Event Assessment Section
The following table describes how the each field of the Event Assessment section is

filtered:

Field Description

Product The product filter drop down list contains all products listed in the event
assessment. The user can filter on all the products which are present in
the Event Assessment dialog.

Event Contains a drop-down of values of distinct Event PT. The user can filter
on all the products which are present in the Event Assessment dialog.

Diagnosis Contains a drop-down list of values of D for Diagnosis or S for
Symptoms.

Data Sheet Contains a drop-down of values of distinct data sheets. All the blank data
sheets display as a single row of <Unspecified>.

Licenses Contains a drop-down of values of distinct Countries of the Licenses. All

the Licenses which are not associated to a data sheet displays under
<Unspecified> or are aligned with the data sheet view.

Note: Only the assessment rows that match the selected criteria are
displayed in the filtering results.

User Actions within Event Assessment
The following table lists user actions and their result.
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User Action Result

Click Datasheet Displays the license and data sheet views and displays the License
column's "plus” Column and enable the "-" for the License Column.

icon

Click Product Displays the Product Information dialog for the selected product

Name

Click Event Displays the Event Information dialog for the selected event

Description

Click License Displays the Product Information as defined in the License Configuration.
Description

Click Datasheet Displays all the configured terms in the data sheet.
Description

Attaching Cases from the Medical Review Screen

Notes and Attachments and Contact Log sections appear on the Case Form Additional
Info tab to the Medical Review screen as follows:

The new functions appear on the Action Items/Addl Info tab.

The performance of the Medical Review dialog remains the same while initially
loading the dialog.

The system displays user-defined fields in the Medical Review dialog box if they
have been enabled on the Case Form Analysis tab.

5.1.6.3 Using Temporal View Tab

Click Temporal View tab to view a read-only version of the case before routing. The
following is an illustration of the Temporal View tab.
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The information displayed in the Temporal View tab is taken from the information
entered in the Case Form section. Click the following links for information about each
section on the Temporal View tab.

5.1.6.3.1 About the Summary Section The Summary section provides read-only
summary information about the case.
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The following table lists and describes each field in the Summary section.

Field Description

First Suspect Displays the name of the primary suspect product.
Product

Generic Name Displays the generic name of the primary suspect product.

Coded Indication  Displays information about the product indication.

Gender Displays the gender of the patient.

Age Displays the age of the patient.

Report Type Displays the report type.

Reporter Type Displays the type of reporter reporting the event.
Company Displays the company diagnosis.
Diagnosis/Syndro

me

Case Serious Displays whether the case is serious or not.

Company Agent  Displays the case causality status.
Causal

5.1.6.3.2 About the Display Options Section The Display Options section enables you to
select information to view in the Event Assessment section of the form. The following
is an illustration of the Display Options section.

P Suspsct Praducts B raberet ptory vty
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[ rm—— ™ Savieun Evevsta Orly

The following table lists each check box and describes the information that displays in
the Event Assessment section.

Field Description

Suspect Products ~ Select the check box to view Suspect Products in the Event Assessment
Section.

Non-Suspect Select the check box to view Non-Suspect Products in the Event

Products Assessment Section.

Patient History Select the check box to view Patient History in the Event Assessment
Section.
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Field Description

Patient Lab Data Select the check box to view Patient Lab Data in the Event Assessment
Section.

Relevant Tests Select the check box to view Relevant Tests in the Event Assessment
Section.

Events - All Select the check box as required to view All Events/Serious Events Only

Events, Serious in the Event Assessment Section.

Events Only

5.1.6.3.3 About the Event Assessment Section The Event Assessment section provides
summary information about the adverse event.

daw A [T R R TG s s FAFUR FEAR

The following table lists and describes the information in the Event Assessment
section.

Field Description

1D Denotes the type of event. For example, HOSP means Hospitalized.
Info Click the Info icon (i) to view details about the selected entity.

Item Displays the item name.

Start Displays the date from when the event assessment began.

Stop Displays the last date of the event assessment.

Duration Displays the duration of the event assessment.

The system opens a unique dialog box for the event you have chosen to view.

View Death Information
The system presents death information in the following dialog box.

View Event Information
The system presents event information in the following dialog box.

View Hospitalization Information
The system presents hospitalization information in the following dialog box.

View Patient History
The system presents patient history information in the following dialog box.

View Product Information

The system presents product information in the Temporal Information Product dialog
box.
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5.1.6.3.4 About the Relevant Tests Section The Relevant Tests section provides
information about any tests that were performed.

Relevant Tests

*- This data displayed in the Tamporsl Visw is from the last tens the case was saved

The following lists and describes

Field Description

Relevant Tests Displays information about any relevant tests, if any.

Zoom/Unzoom Click the Zoom icon to view the report on a bigger scale.
Click the Unzoom icon to revert to the earlier view.

Flag Icon This icon displays the language text that is supported.

Notes Icon Click this icon to view/enter notes.

5.1.6.4 Using the Action Items/Additional Info Tab

The Action Items/Additional Info tab enables you to enter contact log information,
information about action items, and notes and attachments. The tab has three sections
as shown in the following illustration. The sections are:

= Contact Log
s Action Items

= Notes and Attachments

epfecal Paretarey - Cama Form - SUPGMOMIE AL OL Shady "AG°

il Eifrviey T vl e [weari stamn =] | ohm Dot
Contact Log (1] Er—m e =
g [Due Code i

St derl e -

FMARIEE - 'S -
1 OO0 st Cemgar by bempiate A ]

ey Ll

H oA 00

e e £ )
Cannfcanon [r—
® et ¢ el Beg Sub Deacripaon
[mea] =
1
MU m
[ mmiest]
= O 200 m
J_
b Lo Fimard L harm ard i (=

5.1.6.4.1 About the Contact Log Section The Contact Log section enables you to track

correspondence about an adverse event. The following is an illustration of the Contact
Log section.
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Contact Log Fields and Field Descriptions
When using the Contact Log section, be aware of the following:

The number displayed in parentheses in the header of each section - Contact Log,
Action Item, Routing Comments, Case Lock/Archive - displays the total number
of entities within the section.

You can choose to view All Action Items or only Open Action Items, which shall
display all the Open Action items within the case. By default, All Action Items are
displayed.

You can sort Action Items by clicking on the column headers.

The system remembers the sort order on for the duration of the case.

The following table lists and describes the fields in the Contact Log section of the
Activities tab.

Field Description
Date The date the letter was generated and sent. The following icons may be
present:

Click the letter icon to open the Letter Preview dialog. This allows you to
view a letter or to modify it if it has not been sent already.

Date Sent The date is automatically inserted when a letter is sent through the letter

menu. You can also manually enter the date the letter was sent. If this
field is completed, the letter will become read-only.

Code The contact code for this entry. The Administrator can adjust the

information in this list.

Click this e-mail button to open a message editor.

Description Enter a brief explanation for the letter, for example, "Initial Letter," or the
details of a phone conversation.

New Letter Click this button to generate a new letter

Group/User Select a group responsible for the Contact item. From the list below, select

a user from the selected group who will be responsible for the action.

The Contact Item will appear in the Worklist for selected user. If "Any" is
chosen as the group, the Action Item appears in all the users’ Worklist.
The Administrator can adjust the information in these lists.

5.1.6.4.2 Generating Letters You can generate letters from the Contact Log section.
When generating letters, be aware of the following;:

The placeholders for the original letter template can be replaced by information
that is specific to the current case.

A letter is only added to a search if the Correspondent check box is checked.

The Administrator can configure the system to generate letters automatically and
to schedule them for a specific number of days after receiving details of an adverse
event. For example, the system might schedule an Initial Response Letter to be
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sent the day after an adverse event is received. Auto letter scheduling is triggered
when a case is initially saved.

Letters cannot be auto-generated unless the "Date" [contact log date] is reached, to
ensure that the latest information for the case has been updated to the letter.

If the Primary Reporter is marked as a correspondence contact, the system sends
Auto-scheduled letters are sent to the Primary Reporter. Otherwise, the letter is
sent to the first correspondence contact.

Auto-scheduled letters appear in the Contact Log section of the Case Form. You
can view or print them by double clicking the letter icon. You can also edit letters
that have not been sent. The system does not automatically send letters. You must
send or remove letters manually.

In addition to auto-scheduling letter, you can also configure auto action items,
which prompt you to follow-up with a correspondent after a letter has been
scheduled and sent. Auto action item scheduling is triggered once the sent date
has been entered for a letter. Auto action items appear in the Action Items section
on the Case Form and in the Action Items tab of the Worklist.

Use the following procedure to generate a letter.

To generate a letter

1.
2
3.

Go to Contact Log in the Activities tab and click New Letter.
The Custom Letter Templates dialog opens.

Select the required letter template from the list and click OK to open the letter in a
separate window.

Make the necessary changes to the letter text.
Select File-->Save to save the changes.
If you modified the letter, select Yes.

This attaches the letter to the Case Form by browsing to the location where you
saved the changes.

After saving the letter, the system displays it in the Contact Log section of the
Activities tab.

The system creates an action item for following-up on this letter in the Action
Items section of the Activities tab.

5.1.6.4.3 Scheduling Action Items for Letters When specifying or changing the Date Sent
field in a letter, you can schedule an action item if you wish to do so.

If an action item is not specified, the field is blank.

Any Action Item can be updated on the screen immediately after a case has been
saved.

Unless the Action Item has already been marked as completed, each time the Date
Sent field is changed for a letter, the corresponding action item (if one exists) is
also updated with a new Due Date of Date Sent of the Letter and the number of
days specified for the Action in the Letter configuration

5.1.6.4.4 Opening a Message Editor To open a message editor

Click to open the message editor.

The following table lists and describes the fields in the dialog box
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Field Description

To Displays the e-mail address specified for the Primary Reporter in the
Case Form.

You can edit this field.

From Displays the e-mail address specified in the Return E-mail Address in
Argus Console>Code Lists>Letter Configuration. You can edit this field
also.

Subject Displays the Case Number and the Description of the Contact log.

You can edit this field.
Send Enables you to send the e-mail to the intended recipient.

5.1.6.4.5 About the Action Items Section The Action Items section enables you to enter
action items and their related information. The following is an illustration of the
Action Items section.

The following tables lists and describes the fields in the Action Items section.

Field Description

Date Open Enter the date the action item was created. Open action items appear in
the Worklist of the user who is responsible for the action item. They also
appear in the Open Action Items Report.

Due Enter the date on which the action item is to be completed.

Completed Enter the date on which the action item was actually completed.

Code Select an Action Item code from the drop-down list. This will display the
description of the selected Action Item Code. The Administrator can
adjust this list.

Description Selecting an Action Item code automatically enters information into this
field. The text can be modified as required. The Administrator can adjust
this list.

Group/User Select a group responsible for the Action Item from the given drop-down

list. From the drop-down list below this, select a user from the selected
group who will be responsible for the action. The Action Item will appear
in the Worklist for the selected user. If "Any" is chosen as the group, the
Action Item appears in all the users' Worklist. The Administrator can
adjust these lists.

5.1.6.4.6 About the Notes and Attachments Section The Notes and Attachments section
enables you to view notes and attachments associated with a case. The following is an
illustration of the Notes and Attachments section.
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5.1.7 Using the Coding Review Function

The Coding tab provides a single entry point for viewing and coding several kinds of
information. The following is an illustration of the coding tab.

2 Coding Review -- Webpage Dialog,

Coding Review - 13US000012
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5.1.7.1 General Information
The following is an illustration of the General Information section of the Coding tab.

General Information il
Report Type [ | study Info: [ |
Patient Info: [ | Literature info: [ |

The following table lists and describes the fields in the General Information section.

Field Description

Report Type Identifies the type of case.

Study Info Displays study information about of the case.

Patient Info Identifies the patient's age & gender.

Literature Info Displays information about the Primary Literature of the case.
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5.1.7.2 Product Information
The following is an illustration of the Product Information section of the Coding tab.

Product Information [l
Concentration
# Product llame Formulation Reported Indication Coded Indication (LLT)

Units

1 B [oeoei_us_ o | [ely |20 Jme 1

The following table lists and describes the fields in the Product Information section.

Field Description
Product Name Displays the product name.
Dosage Form Displays the configured formulation for the drug.

Strength / Unit Displays the configured Concentration and Units for the drug.
Indication Verbatim Identifies the indication associated with the product.

IND Coded (LLT)  Displays the Coded PT with LLT in parenthesis.

5.1.7.3 Event Information
The following is an illustration of the Event Information section of the Coding tab.

Event information [

# Description to be Codsd Preferred Term (Lower Level Term) Seriousness Intensity Duration

1 | [pain | [Pain Fain) 1ld s 1 1 |

The following table lists and describes the fields in the Event Information section.

Field Description

Event verbatim Event name as reported.

Coded PT (LLT) Displays the Coded PT with LLT in parenthesis.
Seriousness Displays the Event Seriousness for the Event.
Severity Displays the Event Intensity for the Event.
Duration Displays the Event Duration for the Event.

5.1.7.4 Death Information
The following is an illustration of the Death Information section on the Coding tab.

4 Verbatim Coded Term PT (LLT)
1| B [cancer ] [Heopiasm malignant icancer) ] Q‘

The following table lists and describes the fields in the Death Information section.

Field Description

Cause of Death Displays the coded or un-coded event verbatim for cause of death.

Coded PT (LLT) Displays the Coded PT with LLT in parenthesis.
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5.1.7.5 Patient Information
The following is an illustration of the Patient Information section on the Coding tab.

& Condition Type Verbatim
I |

Coded PT (Description of condition LLT)

[headache | [Heagache Headache) ™

The following table lists and describes the fields in the Patient Information section.

Field

Description

Patient -- Other Relevant
history: Condition Type

Patient -- Other Relevant
history: Verbatim Coded
(Description)

Coded PT (LLT)

Patient -- Other Relevant
history: Condition Type if
equal to Historical Drug

Patient -- Other Relevant
history: Verbatim Coded
(Description)

Coded PT (LLT)
Indication Verbatim
Indication Coded PT (LLT)
Reaction Verbatim

Reaction Coded PT (LLT)

Displays the condition type of the patient's previous history.

Displays the condition of the patient's previous history.

Displays the Coded PT with LLT in parentheses.
Displays the condition type of the patient's previous history.

Displays the condition of the patient's previous history.

Displays the Coded PT with LLT in parentheses.
Displays the Indication Verbatim for the Historical Drug.
Displays the Coded PT with LLT in parentheses.
Displays the Reaction Verbatim for the Historical Drug.
Displays the Coded PT with LLT in parentheses.

5.1.7.6 Lab Data

The following is an illustration of the Lab Data section on the Coding tab.

# Lab Data Test as Reported

Test Name (LLT) Results Units Norm High Horm Low

1 | [blood |

[Blood 1. 25-dydroxycholecalciferol decreased (Blood 1.4 [210 [Ureg | [z00 | [iz0 |l

The following table lists and describes the fields in the Lab Data section.

Field Description

Test Name Displays the Lab Data Verbatim for the Lab Data.

Coded PT (LLT) Displays the Coded PT with LLT in parenthesis.

Results / Units Displays the entered Results and Units for the Lab Data.

Normal High / Displays the configured Normal High and Low with Units for the Lab
Low Data.

5.1.7.7 Parent Information
The following is an illustration of the Parent Information section on the Coding tab.
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& Condition Type Verbatim Coded PT (Description of condition LLT)

rash | [Rash Rasn} ™

The following table lists and describes the fields in the Parent Information section.

Field Description

Condition Type Displays the condition type of the Parent previous history.
Verbatim Coded Displays the condition of the Parent previous history.
Coded PT (LLT) Displays the Coded PT with LLT in parenthesis.

Coded PT (LLT) Displays the Coded PT with LLT in parenthesis.

Indication Verbatim Displays the Indication Verbatim for the Historical Drug.

Indication Coded PT Displays the Coded PT with LLT in parenthesis.
(LLT)

Reaction Verbatim  Displays the Reaction Verbatim for the Historical Drug.

Reaction Coded PT  Displays the Coded PT with LLT in parenthesis.
(LLT)

5.1.7.8 Case Analysis

The following is an illustration of the Case Analysis section of the Coding tab.

¥ Company Dagrous Sdromn Compuany Dagriosia’ Sy o (LT
1 @ [ | J

The following table lists and describes the fields in the Case Analysis section.

Field Description

Company Diagnosis Displays coded or un-coded event term for diagnosis or syndrome that
/ Syndrome the company ascribes to the case.

Verbatim

Coded PT (LLT) Displays the Coded PT with LLT in parenthesis.

5.1.7.9 Common Buttons Available in Coding Review
The Cosing Review screen comprises some common buttons.

[ERT—— -]
# Condition Type Verbatim Coded PT (Description of condition LLT)
l ] [readachs | [Heacache iHeadachs) ™

The following table lists and describes these buttons present in this section.

Field Description
Print Allows you to print the entries displayed on the screen.
Return Case Allows you to return the case displayed on the screen.
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Field Description
Forward Case Allows you to forward the case displayed on the screen.
Draft Report Provides access to the Draft Reports including Medical

Summary Report. You cannot access to Medical Review
Summary Report, if you do not have access to the Medical
Review dialog.

Code Opens the Code dialog box.
Save and Close Allows you to close the case after saving it.
Cancel Allows you to exit the case without saving it.

5.1.8 Using the Action ltem Tab

The Action Item tab enables you to view and track action items for a case. The
following is an illustration of the Action Item tab.
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Click the following link for information about the fields and controls on the Action
Items tab.

5.1.8.1 Action ltem Fields and Field Descriptions

The following lists and describes the fields and controls on the Action Item tab.

Field Description

Show Enables you to show all action items (open and closed) or show on the
open action items.

Add Enables you to add a new action item

Delete Enables you to delete an action item.

Up Enables you to move to the previous action item in the list

Down Enables you to move to the next action item in the list.

Date Open Enter the date the action item was created. Open action items appear in

the Worklist of the user who is responsible for the action item. They also
appear in the Open Action Items Report.

Date Due Enter the date the action item is due to be completed.
Completed Enter the date the action item was actually completed.
Code Select an Action Item code from the drop-down list. This will display the

description of the selected Action Item Code. The Administrator can
adjust this list.

Description Selecting an Action Item code automatically enters information into this
field. The text can be modified as required. The Administrator can adjust
this list.
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Field Description

Group Print Select a group responsible for the Action Item from the given drop-down
list. From the drop-down list below this, select a user from the selected
group who will be responsible for the action. The Action Item will appear
in the Worklist for the selected user. If "Any" is chosen as the group, the

Action Item appears in all the users' Worklist. The Administrator can
adjust these lists.

User Select the user responsible for handling the action item.

Print Enables you to print a list of action items

5.1.9 Using the Print Function

The Print function enables you to print the following:
= Case Form

s  Medical Summary

You access each of these print functions from the Case Actions menu. The following is

an illustration of the Print Case dialog box.
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Accessing Print Case Form Functions
Use the following procedure to access the Print Case Form functions.

To access print Case Form functions
1. Opena case

2. Select Case Actions --> Print --> Case Form.

3. The system opens the Print Cases tabbed dialog box.

5.1.9.1 Accessing Print Medical Summary Functions
Use the following procedure to access the Print Medical Summary function.

1. Open a case.
2. Select Case Actions --> Print --> Medical Summary.

3. The system opens the Medical Summary Report.

Case Actions
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5.1.10 Printing a Case

The Print Case tabbed dialog box enables you to:

= Print a case form or any of its sections (Print tab)

= View and print letters associated with the case (Letters tab)

= View and print attachments associated with a case (Attachments tab)

s  Transmit case information (Transmit tab)

The following is an illustration the tabbed Print Case dialog box.
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Click the following links for information about using the Print Case dialog box and
printing cases, letters, and attachments and transmitting cases.

5.1.10.1 Printing a Case

The Print tab contains a check box for each section of the Case Form. You can print any
or all of the sections on the Case form. However, the system only prints the sections
you select. When printing a Case Form, be aware of the following;:

»  Select the Include Multiple Text checkbox, to print multiple language text

»  Click the Blind Study Product checkbox to blind product information for study

cases

The following is an illustration of the Print tab.
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To print sections of the case form
1. Click the check box for each section of the Case Form you want to print

OR
Click Select All to select all the sections of the Case Form.

2. Click Print to print the case.

Note: If the printed cases do not appear to be formatted correctly,
adjust your printer settings.

5.1.10.2 Viewing and Printing Letters

The Letters tab enables you to view and print completed letters.

¥ owe Denarpton Date Bert

To view and print a letter
1. Click the letter description link to display the letter.

2. When the system opens the letter, click Print to print it.

5.1.10.3 Viewing and Printing Attachments

The Attachments tab enables you to view and/or print case attachments. The system
prints date/time information:

= As footers on all printouts (except letters).

= In the following format: dd-mmm-yyyy hh24: mm: ss.
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To print case attachments
1. Click the attachment description link to display the attachment.

2.  When the system opens the letter, click Print to print it.

5.1.10.4 Transmitting a Case
The Transmit tab enables you to transmit a case electronically.
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To transmit a case
1. Select the recipient from the Available Recipients list.

2. Select the transmission method from the Method list.
3. Enter any comments under Comments.

4. C(Click Transmit.

5.1.11 Printing a Medical Summary
The Print Medical Summary function enables you to print the medical summaries for
a case. The following is an illustration of the Medical Summary Report.
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To print the Medical Summary
1. Open a case.

2. Select Case Actions --> Print --> Medical Summary.
3. The system opens the Medical Summary Report.

4. Select File - Print in the PDF to take a printout of the medical summary.

5.1.12 Deleting a Case

When you delete a case, you can no longer access it from the application. However, the
system does not remove the case information from the database. Before the system
permits you to delete a case, you must provide a justification. The following is an
illustration of the delete justification dialog box.
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To delete a case
1. Select Delete --> Case Actions.

2. When the system opens the Action Justification dialog box, do one of the
following: Enter the justification manually in the Please enter a justification for
performing this action field

OR

Select a pre-defined justification from the Select a standard justification field.
3. Type your Argus login password in the Password field.
4. Click OK.
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Action Justification Dialog Box Fields and Field Descriptions
The following table lists and describes the fields in the Action Justification dialog box.

Field Description

Please enter a justification ~ Enter the text that justifies the need to delete a case.
for performing this action

Password Enter your password

Select a standard Contains standard, pre-configured descriptions of justifications
justification for this field for deletion.

Spell Check Checks the entered/selected text for any grammatical errors.
OK Saves the justification entered/selected for case deletion.
Cancel Exits out of this dialog without saving any justification.

5.1.13 Viewing Case Revisions

The Case Revisions feature enables you to view the Revisions made to cases. You can
track the revision where follow-up information appended to the case. The follow-up
designations are as follows:

s (S) F/U -- Indicates that significant follow- up information is attached to the case.

s (NS) F/U -- Indicates that the follow-up information attached to the case is not
significant.

The following is an illustration of the Case Details dialog box.
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To view case revisions
1. Open a case.

2. Select Case Actions --> Case Revisions.

The system opens the Argus Safety Case Details dialog box. The dialog box
provides the following information for the current case:

= Scheduled Reports
= Submitted Reports
= Case Revisions
3. 4. Select the desired report from this list.

4. 5. The system displays the Audit Log Details screen containing a list of all
revisions.

Case Actions 5-32



6

Advanced Conditions

This chapter provides information about Advanced Conditions, a powerful search tool
that enables you to build complex queries for retrieving system data.

6.1 Advanced Conditions

You can create complex or non-standard queries in the Advanced Conditions dialog
box where you can define field-level search criteria. Detailed knowledge of the
database schema is not required.

Click the Advanced Conditions button to begin creating advanced conditions to open
the Advanced Conditions dialog box.
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From the Advanced Condition dialog box, you can save and retrieve sets of search
criteria (advanced conditions) and add, edit, or delete them. Access rights and
permissions can be assigned to individual advanced conditions. You can execute and
modify rights to one or more groups on a per-advanced condition basis.

Note: Note: Only users with execute rights for an advanced
condition, can view the advanced condition in the drop-down list in
the Case Open dialog.

When using Advanced Conditions, be aware of the following:
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By default, the Advanced Conditions drop-down list enables you to view only the
New, None, and already selected Advanced Conditions.

Select New or None from the drop-down list and click the AC button to create a
new advanced condition.

6.1.1 About the Advanced Condition Screen

You can choose and rename a query set on the Advanced Condition screen. However,
the rename function is restricted to users who have permission to modify the
advanced condition. When you open an advanced condition or query set, the system
places the current query name in the Name field. The following is an illustration of the
Advanced Condition screen.
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When using the Advanced Condition screen:

You must click Save to record changes to the advanced condition name.

The system disables the Save button until you enter an advanced condition name
in the Name field.

If you fail to enter a name before saving, the system displays the following
message: 'Please enter the Advanced Condition name before saving’.

When you click Save, the system saves the query set with the new name and
description.

When you click Save, the system refreshes the Query Set drop-down list.

You can import an XLS, XLSX or TXT file with one column containing case
numbers as shown in the following illustration.
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& Advanced Condition -- Webpage Dialog

tion Set - [patinet age is 100]
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If you attempt to upload a file format other than XLS, XLSX, or TXT, the system
displays the following message:

Only XLS or Text Files are supported for Importing cases as a Hit List.

When you upload a text file, each line in the file is considered a complete case
number.

When you click Import, the system enables you to browse to the file.

If a case is missing (cannot be found), the system displays the following message:
Case Number: XXXX is not found

If a case has been deleted, the system displays the following message:

Case Number: XXXX is deleted.

If there are multiple missing or unfound cases, the system displays all of them in
the message dialog box.

If the same case has been entered multiple times; the system ignores it after it
imports it.

The system can import 1000 cases/60 seconds for the Hit List.

After the system creates the Hit List, the user clicks Store Hit List. This system
saves the advanced condition and stores the hit list so you can retrieve it for later
use.

When you click Hit List, the system displays the cases in the hit list, and all other
data and options, on the Case Open screen for further processing

When you click Export on the Hit List, the system exports the data in CSV format.

6.1.1.1 Filtering for Existing Advanced Conditions

Use the following procedure to filter for existing advanced conditions.
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To filter for existing advanced conditions

1.
2.

Go to Case Actions > Open and open the Case Open page.

Click the Lookup icon next to the Advanced Condition drop-down list, to open
the Advanced Conditions Lookup dialog box.

Select one of the following options from the drop-down list under Filter

/A Advanced Condition Lookup -- Webpage Dialog

| [eFitter |

2 [ B

= Contains - Enables you to filter for advanced conditions that contain the
entered criteria.

= Starts With - Enables you to filter for all advanced conditions that start with
the entered criteria.

Enter the search criteria for the advanced conditions in the text box, as applicable.

Click Filter to display the advanced conditions matching the specified filtering
criteria.

Select the appropriate advanced condition from the list.
Execute any of the actions below, as applicable:

s Click OK to list the selected advanced condition in the Advanced Conditions
drop-down list.

s Click AC to display the details for the selected advanced condition in the
Advanced Conditions dialog.

= Click Cancel to close the Advanced Condition Lookup dialog without saving
changes.

»  Select a previously selected advanced condition from the drop-down list to
apply the search criteria for that condition.

6.1.1.2 Viewing Results from Existing Advanced Conditions
Use the following procedure to view the results of existing advanced conditions.

To view the results of an existing advanced condition.

1.
2.
3.

Select an Advanced Condition from the Advanced Conditions drop-down list.
Click Search.

The system displays the cases matching the criteria specified in the selected
Advanced Condition.
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4. The system displays a list of matching cases is displayed in the Total Number of
Rows section.

6.1.2 Working with Advanced Conditions

This section provides information about how to create and user Advanced Conditions.

6.1.2.1 Creating, Viewing or Modifying Advanced Conditions

Use the following procedure the create, view, or modify an advanced condition.

To create an advanced condition
1. Select New from the Advanced Conditions drop-down list

OR
Click the Advanced Conditions icon.

2.  When the system opens the Confirmation dialog box:
Click Yes to create a new advanced condition query set
OR

Click No to create a new advanced condition by associating logical operators (like
AND, OR) with items from the Case Form.

3. If you select No, the system opens an Advanced Condition Set dialog box.
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6.1.2.2 About the Advanced Condition Set Dialog Box

The Advanced Condition Set dialog enables you to search for those entities under the
Properties tree-list, which are from either the case data or from the code list.
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) Advanced Condition -- Webpage Dialog

Advanced Condition Set
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The dialog box has two buttons that provide this functionality:

From Code List -- If you select this option, the Value drop-down list displays a list
of all values configured in the Code List

From Case Data -- If you select this option, the Value drop-down list displays only
the values actually in the cases.

These radio buttons display only if the selected entity belongs to a code list. Select
the relevant entity and one of the radio buttons, as applicable to search the entity
based on the code list or case data, as specified.

The Product name field can contain up to 70 characters for searching.

In the Suspect Product Name, Product Name 2/Study Cases, Company Product,
Study Drug, and Primary Suspect Drug sections, you select the product from the
company product browser instead of the drop-down values by clicking the select
button in the Read Only text field.

When you click the select button, the system transfers the Product Name to the Ul
to enable you to search on the selected product.

Select a property type from the Properties tree list.

6.1.2.3 Additional Information about Properties

The items available in the folders in the Properties list represent Case Form fields you
can use to perform the search in the advanced conditions.
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& Advanced Condition - Webpage Dialog

Advanced Condition Set
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Be aware of the following:

= You can auto-populate an Advanced Condition by right-clicking a field in the
Properties section to enable a field-to-field comparison.

s When you select a Property for which terms can be encoded, the system enables
the Select button. You can use the MedDRA Browser to select (possibly) multiple
terms for the property. Refer to Using the MedDRA Browser for Advanced
Conditions for further details.

s The system enables an SMQ icon when you select SMQ-related properties from the
Properties tree-list. Click this icon to view the SMQ Info dialog. It contains details
about the selected SMQ.

= In the Conditions list, select a condition that must apply to the item selected
above.

Available conditions are:

= equalto = notequal to = missing

= contains = greater thanorequalto =  doesnot contain
= less than = less than or equal to = begins with

= greater than = exists

1. In the Value field, enter the value that applies to the property or select an
appropriate value from the list.

2. If the created condition created is to be linked with another condition, select the
appropriate logical operator from the list adjoining Value.

3. Click Add to add the newly created condition to the advanced condition.
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Tip: You can use the AND and OR logical operators to link an
existing condition to a new condition.

s If you are using the AND operator to link two conditions, both
conditions must be TRUE for the advanced condition to be TRUE.
In all other cases, the advanced condition evaluates to FALSE.

s If you are using the OR operator to link two conditions, the
advanced condition is TRUE if either or both conditions are
TRUE. The advanced condition evaluates to FALSE if both
conditions are FALSE.

4. Repeat steps 3 through 8 to add more conditions to the advanced condition.

5. After entering each of the conditions required for the advanced condition, click
Save.

6. Enter a name for the advanced condition and click OK.

6.1.2.4 Sharing Advanced Conditions

The system provides the option of share advanced conditions with other users. To
enable other users to use the advanced condition, click the Share with other users.

When sharing advanced conditions with other users, be aware of the following:

s If an Advanced Condition is not shared with other users, the Advanced Condition
does not appear in the Advanced Condition list for any user except the
Administrator and the user who created it.

» If the Advanced Condition is shared, all users in the system can view the
advanced condition, but cannot modify it.

= You cannot stop sharing an Advanced Condition, if the Advanced Condition is in
use in the system.

Tip: To enter a customized Date Range:

1. Select Custom Date Range from the list.
2. Enter an appropriate date range in the custom date range dialog.
3. Click OK.

6.1.2.5 Using Advanced Conditions

You can use Advanced Conditions from the Case Selection dialog. Use the following
procedure to do so.

To use advanced conditions
1. Select Case Actions --> Open.

2. Depending on how the criteria is to be used, you can do the following:
= Use a set of previously saved criteria
n  Select the appropriate set of criteria from the Advanced Condition list.

= Select the set of criteria from the Advanced list and click the adjoining
Advanced Condition icon.

s Add anew condition to a set of criteria

s Create a new advanced condition by associating logical operators (like AND,
OR) with items from the Case Form
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6.1.2.6 Creating an Advanced Condition Query Set

Use the following procedure to create a Query Set of Advanced Conditions.

To create a Query Set of Advanced Conditions:

1. Select New from the Advanced Conditions drop-down list or click the Advanced
Conditions icon.

2. A dialog that prompts for the creation of an advanced condition query set opens.

3. Click Yes to create a set of advanced conditions by linking together those
advanced conditions that have been defined previously.

4. The Advanced Condition Set dialog appears. In this dialog, previously-created
advanced conditions can be linked together using set operators like UNION,
MINUS, and INTERSECT.

5. Click Add to add an advanced condition to the query set. A new row opens in the
advanced condition selection area. In this row, select an appropriate advanced
condition from the Advanced Condition list.

Tip: To modify, open, or delete advanced conditions, click Open in
the Advanced Conditions dialog. A list of all the advanced conditions
will be displayed. In this list, select the appropriate advanced
condition and click Open to open or modify it, or Delete to delete it.

To view or modify the SQL statement associated with an advanced
condition, click Show SQL. Make the required modifications to the
SQL statement, if necessary.

6. Select an appropriate set operator from the Set Operator list. This set operator will
link this advanced condition to the next advanced condition.
7. To add the next advanced condition to the query set, click Add.

8. Repeat steps 5 through 7 for each advanced condition that must be entered in the
query set.

Note: If the required advanced condition is not already present in
the list, it can be created by selecting (New) from the list. If an existing
advanced condition requires modification, select it and click Edit. The
advanced condition can be edited by a user only if it was created by
that user.

8. When each of the advanced conditions for the query set is entered, click Save.

9. Enter a name for the advanced condition and click OK.

Note: To view or modify the SQL statement associated with an
advanced condition, click Show SQL. Make the required modifications
to the SQL statement, if necessary.

6.1.2.6.1 Renaming Query Sets You can rename a query set from the Advanced
Condition Set screen. However, only users with the appropriate permissions can
modify a query set. When the user opens an advanced condition or query set, the
system places the current query name in the Name field. The following is an
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illustration of the Advanced Condition Set screen.When renaming a query set, be
aware of the following:

Click Save to update the changes to the query set name.

The system disables the Save button until you enter an advanced condition name
in the Name field.

When you click Save, the system saves the query set with the new name and
description.

When you click Save, the system refreshes the Query Set drop-down list.

If you fail to enter a query set name before clicking Save, the system displays the
following message:

Please enter Advanced Condition Query Set Name before saving.

If you rename the query set and attempt to close the Advanced Condition Set
window without clicking Save, the system displays the following error message:

You have made changes to the existing item. If you press OK, changes made will
be lost.

When you click New, the system clears all values from the Name, Description,
and Query Set fields.

6.1.2.7 Using the Hit List Tab

The Hit List tab enables you to search for cases that match the query set criteria for the
advanced condition.

To search for cases

1.
2

Click Find Now in the Hit List tab of the Advanced Conditions dialog.

This system runs a search based on the selected query set criteria and displays a
list of cases (if any) that satisfy the advanced condition query set.
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The following table show the operations you can perform in the Hit List tab.
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To...

Do the following

Manually add an existing case to the hit
list

Remove a case from the hit list
Save the hit list result for future use
Retrieve results of the saved hit list
Save the hit list as a text file

View SQL for Query

Run a Query

Click Add and enter the Case ID in the text box

Click Delete

Click Store Hit List
Click Retrieve Hit List
Click Export

Click Show SQL

Click Find
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Worklist

This chapter describes the Worklist tab and the information that it displays.

7.1 About Worklist

The Administrator may have configured your user account so that the Worklist
displays each time you log on to the system. Place the cursor over Worklist in the
menu bar to view the available options.

7.1.1 General Usage Information

The worklist displays the following information:

= New cases created in the system

»  Cases that are currently open

=  To Do items like letters, reports, and other action items
» Transmission status of reports

s All bulk printed reports

When using the worklist, be aware of the following

= The Worklist dialogs have filtering options on all elements in each worklist as
follows:

- New/Open

—  Bulk Print

— Reports

— Action Items

- Bulk Transmit

- Bulk Transmit E2B Messages
—  Bulk Transmit E2B Reports
- Coding Status

- Coding Action Items

- Contact/Letters

— Letters

= You can filter on any element by clicking the Filter icon to display the filtering
row.
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s The system now provides a type ahead feature to enable you to filter on any
text/date element.

= You can minimize the filtering options by clicking the minimize icon.
= The paper clip icon identifies the maximize icon.

= You can perform a Like search. In other words, if you search for "Cure," the system
returns all elements starting with "Cure."

= You can perform a wildcard search. In other words, if you search for "Cure" the
system returns all elements containing "Cure."

s The user can click the Search button to filter for reports in the reports list.

s These filtering options are available from worklist-specific views and when
performing case or reports drill down searches from the Dashboards.

s The system saves all user preferences, including filtering options and filter views,
for future use.

= The Days Open fields on the WL | New and Open have a drop-down list with
values of <7, 7-15, >15, and the Worklist Reports has values of 7, 15

s The Assigned To filtering element has been removed from the Worklist New and
Open dialogs in the MAIN filtering criteria

= All the worklist dialogs have a refresh icon beside the View option. This enables
you to refresh worklist dialogs that use the preference saved in the worklist
elements.

= All the worklist dialogs have a minimize button to minimize the filtering options.
This increases the number of rows that display in the list.

7.1.2 Worklist Filtering

The Worklist Filtering options enable you to search for a specific case. The Filter
contains editable fields that enable you to either select from a list of values or perform
a Wild card search. This feature applies to all the Worklist Filters across all worklist
items.

The Worklist filter in each Worklist entity contains the following filtering options:
s View Individual

= View Group and

= View All

The default filter is Case Number. This enables you to enter a Case Number to search
for results matching a specified case number.

7.1.3 Worklist Options

The following worklist options are available to you.
= New and Open

= Action Items

s Coding Action Items

= Contacts

= Reports
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s Bulk Transmit

= Bulk Print

s Coding Review

s Bulk Transmit E2B
s Local Labeling

s Coding Status

m Letters

7.1.3.1 New and Open

This section discusses the features provided by the Worklist - New and Open menu
items.

= When you select New, the system displays new worklist items that have been
assigned but not yet accepted. You can also see unassigned cases.

= When you select Open, the system displays all cases that have been assigned and
accepted.

To view the Worklist - New or Open page
1. Select Worklist --> New or Worklist --> Open

2.  When the system opens the Worklist - New or Worklist - Open screen, enter

Tip: The same fields are displayed in the Worklist - Open screen
also.

7.1.3.1.1  General Usage Information When using the New/Open Worklist screen, be
aware of the following:

s The New/Open Worklist displays the Workflow Group and the Workflow State
currently associated with the case.

»  The Workflow Group is available in the Worklist New and Open printouts.
= You can sort on this field.
s The lock icon identifies cases that are locked.

»  The Initial Date field has been renamed Receipt Date and enables you to view the
date the case was first received. The new name displays on the UI and on the
Printout.

s The system allows multiple assignments of cases for Workflow /Enterprise
Managers only on the Worklist New/Open dialogs.

s The system displays the user name to enable you to select a User for reassignment.
»  If the user has cases open, the system skips those cases.

»  The system tracks updates in the audit log.

= When the user selects this option, the selected cases have the same user as

modified by the user.

7.1.3.1.2 Search Case The following is an illustration of the Search Case section.

Field Description
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Filter
Value

Search Button
Group Membership
Case Owner
Assigned To

Only view locked Cases
requiring Follow-up

View Individual

View Group
View All

Performs searches for worklist items on the basis of the
filtering criteria selected here.

Enables the user to select the desired Value as the search
criterion.

Enables the user to open the selected or entered case ID.
Enables the user to select the type of Group Membership.
Enables the user to select the Case Owner.

Enables the user to select who the case has been assigned to.

Select this checkbox to view only those locked cases that
require follow-up.

Enables the user to view individual items assigned to this
group.
Allows the user to view all items assigned to this user group.

Allows administrator and workflow manager to see all items
in the system.

7.1.3.1.3 Filtering Functions The Filter function enables you to search for entities that
are only in the worklist. The following is an illustration of the options available in the

Filter drop-down list.

The following table describes the options available in the Filter drop-down list.

Option

Case Number

Workflow State

Product

Event Preferred Term

Event as Reported

Description
Filters on Case Number.

Displays only those workflow states that occur in the given worklist,
considering other filter elements such as Case Owner, Assigned to,
etc.

Displays only those products that occur in the given worklist,
considering other filter elements such as Case Owner, Assigned to,
etc.

Displays only those Event PTs that occur in the given worklist,
considering other filter elements such as Case Owner, Assigned to,
etc.

Displays the name of the event as reported.

Case Report Type Displays only those Report Types that occur in the given worklist,
considering other filter elements such as Case Owner, Assigned to,
etc.

Product Group Displays product groups where the Primary Suspect Drug occurs.

Note: The Assigned To option is not available if the user selects

Individual radio button option from View.

7.1.3.1.4 Total Number of Rows The following is an illustration of the Total Number of

Rows section
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The following table describes the contents in the columns in the Total Number of
Rows section.

Field Description
Priority Displays the Priority of the Case.
Lock Status Enables the user to view the Locked state of the case by the icon. If the

locked icon is present, it indicates that the case is locked and vice versa.

Note: The lock icon is also displayed if the Case Status is Initial or
Follow up. If the case is Follow-up, additionally, the Follow up number is
also displayed.

For example: Initial or F / U: 1.

The icon (displayed in the lock state column) in the Worklist - New,
Open and Reports screens denotes a SUSAR (Suspected Unexpected
Serious Adverse Reaction) case.

Lock State Header Options

Click the Lock State header row. A pop-up appears listing the following
sorting options:

s Lock State

= SUSAR

= Exp/Per

These options enable you to sort cases based on the case categorization.
Initial Date Displays the Initial Receipt Date of the Case.
Aware Date Displays the Aware Date of the case.

Note: Aware date is the latest significant follow up which is received in
the case or the Initial Receipt Date if there are no Significant follow ups
present in the case.

Days Open Displays the number of days that have elapsed since the Receipt Date.

Days Remaining Displays the number of days that are remaining, as configured in the
Administration module for Case Processing.

Case Number Displays the Case Number.

Note: Click the case number to open the case.

Workflow Status Displays the current workflow status of the case.

Product Name Displays the first suspect product in question.

Generic Name Displays the generic name of the suspect product in question.

Event PT Displays the Primary Event and Verbatim, as reported.

Event Verbatim Displays the Event Verbatim, as reported, in the format Primary Event
(Verbatim as Reported).
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Field Description

S/U/R Displays the Case Level Assessments:
= Sdenotes Serious (Y/N)
s U denotes Unlisted (Y/N)
= Rdenotes Causality (Y/N)
Note:
= Unknown is treated as a "?"
s When the user clicks the SUR link, the Case Summary gets

displayed.

FELTorH = F denotes a Fatal (F) case
= LT denotes Life Threatening (LT)
= H denotes Hospitalized (H)
Note:

If any of the above are present together, then Fatal takes precedence
followed by LT followed by H. If the case is neither of the above, No is

displayed.
Case Type Displays report type information.
Study ID Displays the Study ID of the study cases.
Note: If Study ID is not present, this field is blank.
Reporter Type Displays the Reporter type for the Primary Reporter in the case.
Note: If Reporter ID is not present, this field is blank.
Country Displays the Country of the incident.
Assigned To Displays the current owner or "Unassigned" user to the case.
Owner Displays the Owner of the case.

By default, the first user to accept a case after book-in becomes the "Case
Owner". The Case Owner has the access right to assign the cases that he
owns to another user. Though a Case Owner cannot be reassigned
automatically after the initial assignment, he can be reassigned manually
by a Workflow manager.

Note: If Owner is not present, this field is blank.

Print List Button Allows the user to print the current worklist for reference.

Note: You can open a case in read-only mode without creating a case
lock. Use Open in Read-Only to open the case in read-only mode. You
cannot save a case in a Read-Only mode.

The Worklist>New and Worklist>Open also display a status beside Priority,
indicating that the time remaining has exceeded the allocated time.

7.1.3.1.5 Routing Details This section enables you to enter case routing details.

7.1.4 Workflow Options

The Worklist pages have some common options for your use. To see a list of these
options, right-click the icon Lock State icon to display an option menu.
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7.1.4.1 Worklist User Options

The following tables lists the different user options and where they are available

Option

Description

Option available
under Worklist

Open Read Only

Accept Case

Batch Accept
Un-Accept Case

View Case

Batch Open

Accept Action Item

Assign Action Item

Case Summary

Opens the selected case in
read-only mode.

Allows the user to accept the case
and assign a user name as
responsible for that case. A case
marked with their name as
responsible moves the case from
the user's New tab to their Open
tab.

Allows the user to accept multiple
cases at a time (up to 10 cases).

Returns the case to the Open
status.

Opens the case.

Allows the user to Batch open up
to 5 Cases.

This option is displayed to users
who have access to Worklist >
Action Items.

On clicking this option, the
username of the current user is
populated in the Assigned To
column under Case Form >
Activities tab > Action Items >
Worklist > Action Item list.

The user who accepted the action
item can see it under the assigned
action item in Dashboard >
Personal Argus Status.

This option is displayed only to
Workflow Managers, and is
displayed in the context menu.

On selecting this option, a
drop-down list (of all active users)
is displayed in the Assigned To
field for the selected row, with
(Unassigned) as the default value.
On selecting a user from this
drop-down list, the assigned user
is populated in the Assigned To
column under Case Form >
Activities tab > Action Items >
Worklist > Action Item list.

The user who accepted the action
item can see it under the assigned
action item in Dashboard >
Personal Argus Status.

Displays the Summary dialog to
allow the user to view a summary
of the case form data.

New, Open

New

New

Open

Action Items

Action Items

Action Items

Action Items

Action Items,
Open, Reports
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Option

Description

Option available
under Worklist

Adjust Priority

Adjust Assignment

Adjust Case Owner

View Report
Accept Report

Approve Report

Local Labeling

Mark for Non-Submission

Mark Multiple for Non-Submission

Close Action Item

Adjust Assignments

Print Multiple Cases

Archive Case

Batch Archive

Allows the workflow manager to
modify the priority level of the
case.

Enables the Assigned User field for
the selected row.

Allows a workflow manager user
to modify the assigned user.

Enables the (re-)assignment of a
Case Owner by a Workflow
Manager.

Allows user to open the report.

Allows the user to accept the
unassigned report.

This option is enabled only if the
report is in the Generated state.
Select this option to automatically
open the Routing tab of the Report
Details pop-up window, with the
Comment field active waiting for
user input.

Allows the user to open the local
labeling for the case that the
expedited report belongs to,
showing all the non-assessed local
labeling rows.

Allows the user to mark the report
required for Non-Submission. The
report details dialog is displayed
with focus to the Submission tab.

Allows the user to also mark
Multiple reports for
Non-Submission. The notes and
date entered are also reflected in all
the reports.

Allows the user to close the
highlighted action item.

Note: Only the Owner of the action
item can view this option, not all
the users.

Allows the user to adjust
assignments for multiple cases.

Allows the user to print a case
form from the New and Open
worklist tabs.

Allows a workflow manager to
close a case from the worklist New
and Open windows.

Allows a workflow manager to
close multiple cases from the
worklist New and Open windows.

New, Open

New, Open,
Reports

New, Open

Reports
Reports

Reports

Reports

Reports

Reports

Action Items

Open

New, Open

New, Open

New, Open
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Option available
Option Description under Worklist

Medical Review Allows the user to view the New, Open,
Medical Review dialog (if he has Reports
the access rights to view it).

Medical Summary Report Allows the user to view the Reports
Medical Summary Report (if he has
the access rights to view it).

Coding Review Allows the user to view the Coding New, Open
Review dialog if the user belongs
to a group with access rights to
Coding Review (if he has the
access rights to view it).

Route Multiple Cases Allows the user to route multiple ~ New, Open
cases to the selected workflow
state.

7.1.5 Worklist Action ltems

This section discusses the features on the Worklist - Action Items.
To view the Worklist -- Action Items page
1. Select Action Items from Worklist.

2.  When the system opens the Action Items screen, enter the information in the fields
as necessary.

7.1.5.1 General Usage Information

The Worklist Action Items displays the entire description of the Action item selected in
the Description field on the dialog. Be aware of the following:

s The system displays the Action Item Code with the Description of the Action Item.
= You can filter or sort the groups assigned to the Action Items.

s The Product Name and Study ID have been combined into a single column.

= The printout prints the new columns.

= Worklist > Coding Action Items displays the entire description of the action item
selected in the Description field on the dialog.

7.1.5.2 Query Management

The system generates open Query Action Items based on the advanced conditions
rules for the action item type.

= When the user saves the case or clicks the Generate Query icon on the Quick
Launch toolbar, the system creates an open action item based on the profile switch.

»  The assigned group is defined in the code list. If there is no defined group, the
default group is Unassigned.

»  The Due date for the action item is the System Date + the Due Date (in days) as
defined in the code list.

s The Open Date is the system date on the day the Query is created for the case.
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When you click Generate Queries icon, the system generates the Action Item
queries. These queries are based on the rules define for the Action Item types in
Code List Maintenance where the Advance Condition satisfies the case criteria.

This item displays on the Quick Launch Toolbar when the case it open.
Short cut key: CTRL+ALT+X

When you save or click Generate Query, the system evaluates all open query
action types.

If, after the system schedules the action item query, unresolved queries are resolved or
there are queries that do not meet the criteria of the Advance Conditions, the system
closes the action item and uses the system date as the close date.

If there are open query action Items, the system does not create new action items with
the same name when the system tries to resolve the open queries list in the case form.

7.1.5.3 Query Action ltems

When querying action items, be aware of the following:

The Worklist | Action Items enables you to query only query action items by
selecting View Query Action Items.

The Worklist | Action Items enables you to filter only overdue action items by
clicking Overdue Action Items. The Worklist displays the Action Items where the
action item due date is before today's date (system date).

By default, the system displays all types of action items to the user.

The system allows all open query type action items to be populated in a Letter
template by adding the following place holder [OPEN_QUERY]. This populates
the open queries letter template content as configured in the code list when the
letter is being generated by the user in a separate line for each open query in the
following format.

Attribute Tool Tip Example

Query Name Name of Query to be included in ~ QUERY_Preg LMP (must begin with
the letter template. "QUERY_")

Query Condition ~ Advanced condition. If the Patient is pregnant and date LMP

condition is true, then insert text ~ missing (Advanced Condition)
into the generated letter.

Query Letter Text  Text to be inserted in generated Please provide the Date of Last

letter if Query Condition is True. If Menstrual Period (LMP) for the
Query Condition is no true, the no patient.
query item is created.

Query Item Text ~ Text to be display on the list of Patient missing Date of LMP.

open queries

Example:

Please provide Reporter Name (Adv. Cond is Reporter name is null)
Please provide Physician's address (Adv. Cond is Reporter address is null)

Please provide Physician's phone number (Adv. Cond is Reporter phone number
is null)

If the case is saved and the Reporter Name exists, the system creates two Action
items.
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s The following is an example of a generated letter:

Diate w0 5x Last F/U Date:
Accession Number Sequence Mumber
Jane Mary Does
123 PatientStreet
Anytown, XX 99999
Dear Jane Mary Doe,

The s=ff of Anytown Medial Center hasa contnuing interestinits patients and would appredate reciving
the information requestad below conceming your condition since you were treated hers. We recommend
that you have a physical examination annually for more often if warmanted by you or your physi dan.

[OPEN_CUERY] {This placeholder would fetd all the information of the letter placeholder contant for the
open guengs whid are presentin the Gse Dunng letter generation, this tag will be removed and replaced
with the data in green below)

1. Please provide Physidan's address
2. Please provide Physidan's phone number

If you ae unable to complets this questionnaire, it would be grestly appredated if you could obtain the
assistance of & friend or relative and supply as mud informationas possible

Any further comments you may wish to make may be wiitten on the reverse side of this letter. Astamped,
return-addressed envelope is endosed for your convenignce. Thank you for mking the time to respond to

our patient information letter. We at Anytown Medi @l Center are genuingly interestedin your health and
look forward to heanng from you soon.

Any questions may be directed to the Cancer Registry at (295 555-9995,
Sinceralyyours,
John Doe, K.D.

Chair, Cancer Program

7.1.5.4 Search Case

The following is an illustration of the Search Case section.

The following table lists and describes the fields and controls in the section.

Field Description

Filter Performs searches for worklist items on the basis of the filtering criteria
selected here

Value Enables the user to select the Value as the search criterion

Search Button Enables the user to open the selected or entered case ID.

View Individual Enables the user to view individual items assigned to this user.

View Group Enables the user to view all items assigned to this user group.

View All Enables administrator and workflow manager to see all items in the
system.

View Query Action Enables you to query only query action items.

Items

Overdue Action Displays the Action Items where the action item due date is before

Items today's date (system date).

7.1.5.5 Filter Function

The Filter function enables you to search for entities in the worklist. The following
tables describes the options available in the Filter drop-down list.
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Option Description

Case Number Displays the Case Number

Workflow State Displays only those workflow states that occur in the given work,
considering other filter elements such as Case Owner, Assigned to,
etc.

Product Displays only those products that occur in the given work,
considering other filter elements such as Case Owner, Assigned to,
etc.

Event Preferred Term Displays only those Event PTs that occur in the given work,
considering other filter elements such as Case Owner, Assigned to,
etc.

Event as Reported Displays the Event as Reported

Case Report Type Displays only those Report Types that occur in the given work,

considering other filter elements such as Case Owner, Assigned to,
etc.

Note: The Assigned To option is not available if you select the
Individual radio button option from View.

7.1.5.5.1

Total Number of Rows The following is an illustration of the Total Number of

Rows section.
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The following table describes the contents of each column in the Total Number of
Rows section.

Column Description
Case Number Displays the Case Number.
Note: Click the case number to open the case.
S/U/R Displays the Case Level Assessments:
= Sdenotes Serious (Y/N)
= U denotes Unlisted (Y/N)
= Rdenotes Causality (Y/N)
Note: Unknown is treated as a "?". When the user clicks the SUR link, the
Case Summary is displayed.
Description Displays the description of the Action Item in question.
Date Open Displays the date the action item was opened.
Date Due Displays the due date.
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Column Description

Days Open Displays the number of days for which the action item has been open.
Assigned To Displays the current owner or "Unassigned" user for the case

Print List Button Allows the user to print the current worklist for reference.

7.1.6 Coding Action ltems

This section discusses the features provided on the Worklist - Coding Action Items
page.

To view the Worklist - Coding Action Items page
1. Select Worklist --> Coding Action Items.

2. When the system opens the Coding Action Items page, enter the information in
the fields as necessary.

7.1.6.1 Search Case

The following is an illustration of the Search Case section.
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The following table lists and describes the fields in the Search Case section.

Field Description

Filter Performs searches for worklist items on the basis of the filtering criteria
selected here

Value Select a value as a search criteria

Assigned To Searches on the basis of who the case has been assigned to.

View Individual View only individual items assigned to this user group.

View Group View all items assigned to this user group.

View All Enables administrator and workflow manager to see all items in the
system.

7.1.6.2 Filter Functions

The Filter functionality performs searches on entities present in the worklist only. The
following table lists and describes the options available in the Filter list.

Option Description

All Does not filter on any cases in the work list, excluding other filter
elements that are specified, e.g. Case owner, etc.

Case Number Displays the Case Number

Workflow State Displays only those workflow states that occur in the given worklist,

considering other filter elements such as Case Owner, Assigned to, etc.

Product Displays only those products that occur in the given worklist,
considering other filter elements such as Case Owner, Assigned to, etc.
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Option Description
Event Preferred Displays only those Event PTs that occur in the given worklist,
Term considering other filter elements such as Case Owner, Assigned to, etc.

Event as Reported  Displays the name of the event as reported

Case Report Type  Displays only those Report Types that occur in the given worklist,
considering other filter elements such as Case Owner, Assigned to.

Note: The Assigned To option is not available if the user selects
Individual radio button option from View.

7.1.6.3 Total Number of Rows

The following is an illustration of the Total Number of Rows section.
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The following table describes the headers within Total Number of Rows:

Field Description

Case Number Displays the Case Number.

Note: Click the case number to open the case.

S/U/R Displays the Case Level Assessments:
= Sdenotes Serious (Y/N)
s U denotes Unlisted (Y/N)
= Rdenotes Causality (Y/N)
Note:
»  Unknown is treated as a "?"

= When the user clicks the SUR link, the Case Summary gets displayed.

Description Displays the description of the Action Item in question.

Date Open Displays the date the action item was opened.

Date Due Displays the due date.

Days Open Displays the number of days for which the action item has been open.
Assigned To Displays the current owner or "Unassigned" user to the case

Print List Button =~ Allows the user to print the current worklist for reference.
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7.1.7 Contacts

This section discusses the features provided on the Worklist - Contacts and Letters
page.

To view the Worklist -- Contacts and Letters page
1. Select Worklist --> Contacts and Letters.

2.  When the system opens the Worklist - Contacts and Letters screen, enter the
information in the fields as necessary.

7.1.7.1 Search Case

The following is an illustration of the Search Case section of the Worklist -- Contacts

screen.
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Worklist > Contacts and Letters E] J
CONTACTS AND LETTERS

Filter
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The following table lists and describes the fields in the Search Case section.

Field Description

Filter Performs searches for worklist items on the basis of the filtering criteria
selected here

Value Selects the Value as the search criterion

Select Button Opens the selected or entered case ID.

Assigned To Selects the user to whom the case has been assigned.

View Individual View individual items assigned to this user group.

View Group View all items assigned to this user group.

View All Enables the administrator and workflow manager to see all items in the
system.

7.1.7.1.1  Filter Functions The Filter function enables you to search for entities in the
worklist. The following table below describes the options available in the Filter
drop-down list.

Option Description

Case Number Displays the case number.

Note: The Assigned To option is not available if the user selects
Individual radio button option from View.

7.1.7.1.2  Total Number of Rows The following is an illustration of the Total Number of
Rows section.
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The following table describes the columns in Total Number of Rows:
Field Description
Case Number Displays the Case Number.
Note: Click the case number to open the case.
Study ID Allows the user to view the Study ID present in the case.
Description Displays the description of the Action Item in question.
Product Name Allows the user to view the Product Name of the Primary Suspect Drug.
Aware Date Displays the Aware Date of the Case. Aware date is the latest significant

follow up which is received in the case or the Initial Receipt Date if there
are no Significant follow ups present in the case.

Date Due Displays the due date.

Days Open Displays the number of days for which the action item has been open.
Assigned To Displays the current owner or "Unassigned" user to the case.

Print List Button Allows the user to print the current worklist for reference.

7.1.8 Reports

This section discusses the features available from Worklist - Reports page.

To view the Worklist Reports page
1. Select Worklist --> Reports.

2. When the system opens the Worklist - Reports screen, enter the appropriate
information as necessary.

7.1.8.1 Search Case

The following is an illustration of the Search Case section of the page.

The following table lists and describes the fields in the Search Case section.
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Field Description

Filter Performs searches for worklist items on the basis of the filtering criteria
selected here.

Value Selects the Value as the search criteria.

Search Button Opens the selected or entered case ID.

Assigned To Selects the person to whom the case is assigned.

View Individual

View Group
View All

Enables the administrator and workflow manager to see individual items
in the system.

View all items assigned to this user group.

Enables the administrator and workflow manager to see all items in the
system.

7.1.8.2 Filter Function

The Filter function enables you to search for entities in the worklist. The following
tables describes the options available from the Filter drop-down list.

Option

Description

Case Number

Reporting
Destination

Product

Event Preferred
Term

Displays the Case Number.

Displays the report destination (agency) for which the report is
scheduled.

Displays only those products that occur in the given worklist,
considering other filter elements such as Case Owner, Assigned to, etc.

Displays only those Event PTs that occur in the given worklist,
considering other filter elements such as Case Owner, Assigned to, etc.

Report Status Displays the status of the report as Approved, Generated or Scheduled.
Case Report Type Displays only those Report Types that occur in the given worklist,
considering other filter elements such as Case Owner, Assigned to, etc.
Report Form Displays the description of the report.
Due Date Enter a due date.
Note: The Assigned To option is not available if the user selects

Individual radio button option from View.

7.1.8.21 General Usage Information When using filtering, be aware of the following:

s The filter options have a Study ID element that enables the user to filter cases
within the list (not deleted).

= This option is a type ahead that enables users to enter values for studies defined in
the configuration.

s The type ahead feature limits the users to 25 items in the drop-down list.

= When the user selects type ahead values, the system performs a like search.

»  The filter options have a Reporting Group element that enables the user to filter

cases in the list.
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This option is a type ahead that enables users to enter values for Reporting
Groups defined for the reports in the worklist.

The type ahead limits the users to 25 items in the drop-down list.
When the user selects type ahead values, the system performs a like search.

The filtering elements have the Product and Reporting destinations removed from
the list.

The user can mark multiple reports for approval by selecting the Mark Multiple for
Approval option.

The user can view the Medical Summary report for all users who have permission
to print the Medical Summary report.

The system displays the Report Details dialog and permits the user to enter the
approval notes that are applied to all selected reports. The system skips any
reports selected by the user that have the following statuses:

- Scheduled
- Disapproved
- Approved

The system hides the reports fields from the report details dialog and does not
permit the user to access or modify any other tabs.

The system hides the Route button to prevent users from modifying the Report
Status.

Workflow Enterprise users can access View and can modify the report details for
all reports for all cases across multiple sites in their lists.

7.1.8.2.2 Filtering Reports by Report Destination When filtering by report destination, be
aware of the following:

You can click the magnifying glass icon to filter reports by report destination. The
system displays the standard lookup dialog.

The Report Destination filter multi-selection screen list contains the names of all
agencies as configured in the Argus Regulatory Authority CodeList.

The system displays only the report rows that match the authority /agency you
selected.

7.1.8.23 Filtering Reports by Product Family When filtering reports by product family, be
aware of the following:

You can click the magnifying glass icon to filter reports by product family. The
system displays the standard lookup dialog.

The Product Family filter multi-selection screen contains a list of all product
family names as configured in the Argus Products Code List.

The system displays only the report rows that match the product you selected.

7.1.8.2.4 Filtering Reports by Country of Incidence When filtering reports by country of
incidence, be aware of the following:

You can click the magnifying glass icon to filter reports by country of Incidence.
The system displays the standard lookup dialog.
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s The Country of Incidence filter multi-selection screen contains a list of all
available countries.

s The system displays only the report rows that match the country of incidence you

selected.

7.1.8.3 Total Number of Rows

The following is an illustration of the Total Number of Rows section.
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The following table lists and describes the columns in the Total Number of Rows

section.
Field Description
Selected Allows the user to select the report.
Lock State Allows the user to view the Locked state of the case by the icon. If the
locked icon is present, it indicates that the case is locked and vice versa.
Note: The lock icon is also displayed if the Case Status is Initial or
Follow up. If the case is Follow-up, additionally, the Follow up number
is also displayed.
E.g. Initialor F / U: 1.
The icon displayed in the lock state column, in the Worklist - New,
Open and Reports screens denotes a SUSAR (Suspected Unexpected
Serious Adverse Reaction) case.
Lock State Header Options
Click the Lock State header row. A pop-up appears listing the following
sorting options:
s Lock State
= SUSAR
= Exp/Per
These options enable you to sort cases based on the case categorization.
Status Displays the report status. Click the link displaying the report status to

Case Number

Country of Incidence

Report Type

view the Report Details. Refer to the About the Report Details Dialog
Box section for descriptions of each tab.

Displays the Case Number.

Note: Click the case number to open the case.
Displays the Country of incidence.

Displays the Case Report Type.
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Field

Description

Suspect Product

Diagnosis

Event Verbatim

S/U/R

For LT

7/15

Report Form
Destination

Initial / Follow-up
)

Due Date

Days Past Due

Displays the Trade name for which the report has been scheduled. A "+"
displayed at the end of a Product Name indicates that more than one
Suspect Company Products exist.

A Device Name is also displayed for those Reports which were
scheduled for the Device.

Displays the Primary Event Diagnoses PT

Displays the event verbatim (verbatim as reported) of the Primary
Event.

Displays the Case Level Assessments:
= Sindicates Serious (Y/N)

s U indicates Unlisted (Y/N)

= Rindicates Causality (Y/N)

Note: Unknown is treated as a "?". When the user clicks the SUR link,
the Case Summary gets displayed.

Indicates whether a case is fatal or life threatening as follows:
»  Fidentifies a Fatal (F) case
= LT identifies a Life Threatening (LT)

Note: If any of the above are present together, then Fatal takes
precedence followed by LT. If the case is neither of the above, No is
displayed.

Displays 7 if the report is due within 7 days
Displays 15 if the report is due in more than 7 days

Displays the description of the report. Click the link to view the DRAFT
Report PDF.

Displays the report destination (agency) for which the report is
scheduled.

Displays if the report is Initial or Follow-up.

If it is a Follow-up, the follow-up number is printed.
Displays the date the report is due.

Displays the number of days the report is past due date.

Days Open Displays the number of days since the report has been open.

Date Scheduled Displays the Scheduled Date of the report.

Assigned Displays the name of the individual to whom the case has been
assigned.

Downgrade Displays Yes if the report is a downgrade report.

Print List Button Allows the user to print the current worklist for reference.

The following table lists and describes the options available under Lock State.

Option Description

View Report Enables the user to view the report as a PDF.

Report Details Enables the user to view the report details.

Accept Report Enables the user to accept the report.

Approve Report Enables the user to approve the report.
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Option

Description

Adjust Assignment
Medical Review

Print Medical
Summary

Case Summary

Local Labeling

Mark for
Non-Submission

Mark for
Submission

View Multiple
Reports

Mark Multiple for
Non-Submission

Mark Multiple for
Submission

Enables the user to adjust assignment for the selected report.
Enables the user to view the Medical Review of the case.

Enables the user to print the medical summary of the case.

Enables the user to view the case summary of the case.

Enables the user to view the local labeling dialog.

= This option is available only if the user has access to Local Labeling
within the groups to which the user belongs to.

= The Local Labeling can also be viewed by clicking the local labeling
icon that is displayed next to S/U/R.

Enables the user to mark the report for non-submission.

Enables the user to mark the report for submission.

Enables the user to view multiple reports as a PDF.

Enables the user to mark multiple reports for non-submission.

Enables the user to mark multiple reports for submission.

7.1.9 Bulk Transmit

The Bulk Transmit function lists the status for all transmission events against your

assigned cases.

7.1.9.1 To view the Bulk Transmit page
1. Select Worklist --> Bulk Transmit.

2.  When the system opens the Bulk Transmit screen, enter the appropriate
information as necessary.

7.1.9.2 General Usage Information

Search Case Section
The following is an illustration of the Search Case section.
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The following tables lists and describes the fields and controls in the Search Case

section.

Field Description

Filter Performs searches for worklist items on the basis of the filtering criteria
selected here

Value Enables the user to select the Value as the search criterion
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Field Description

Search Button Enables the user to open the selected or entered case ID.

View Individual Enable users to view individual items assigned to this user group

View Group Enable the user to view all items assigned to this user group.

View All Enable administrator and workflow manager to see all items in the
system.

7.1.9.2.1 Filter Function The Filter function enables you to search for entities in the
worklist. The following table describes the options available from the Filter
drop-down list.

Option Description

Case Number Displays the case number

Reporting Displays the report destination (agency) for which the report is
Destination scheduled.

Report Form Displays the report form

Report Status Displays the report status

7.1.9.2.2 Total Number of Rows The following is an illustration of the Total Number of
Rows section.
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The following table below describes the columns in Total Number of Rows section

Field Description

Case Number Displays the Case Number. Click the Case Number to view the case
details.

Report Form Displays the Description of the report
Click the link to view the DRAFT Report PDE.

Fax Number Displays the fax number of the report recipient

Recipient Name Displays the name of the report recipient

Recipient Company Displays the name of the company of the report recipient

Date Created Displays the date on which the report was created.
Date Sent Displays the date on which the report was transmitted to the recipient.
# of Pages Displays the number of pages in the report
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Field Description

Attempts Displays the number of attempts made to transmit the report. If you are
using Right Fax, the value of this field is displayed as 0 even if the Right
Fax had attempted it multiple times. This is an unsupported feature in

Right Fax.

Sender Displays the name of the sender of the report

Sender Agency Displays the name of the agency that has generated the report

Name

Status Displays the Report Status e.g. Scheduled or Generated etc.
Click the Report Status to view the Report Details. Refer to the About the
Report Details Dialog Box section for descriptions of each tab.

Print List Button Allows the user to print the current worklist for reference.

7.1.9.2.3 User Options The following table describes the user options.

Option Description

View Transmission Displays the report in a PDF format.

Mark report as Marks the report for the selected row as submitted.

Submitted Note: This option is displayed to only those users who have the access

rights to mark a report as submitted.

Remove Removes the transmission log entry from the list.

transmission Note: A report whose status is pending cannot be transmitted.

Re-transmit This option is displayed if the selected row has a status of failure or
success. Select this option to change the status back to pending and the
re-fax the report.

Submit Multiple Multiple reports that are selected from the list can be marked as

Reports submitted simultaneously.
Re-transmit The status of multiple reports that are selected from the list can be
Multiple changed to "pending,” and those reports can be re-transmitted.

Remove Multiple ~ Transmission of multiple reports that are selected from the list can be
Transmissions removed.

7.1.9.2.4 Routing Details The following is an illustration of the Routing Details section.
Enter routing details in this text box.

Rt et

Note: Reports that appear in the Bulk Transmission section or the
Bulk Print section do not display in the Reports section of the
Worklist.

7.1.10 Bulk Print

The Bulk Print function displays a separate list for all Bulk Print events against
reports.
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To view the Bulk Print page
1. Select Worklist --> Bulk Print

2. When the system opens the Bulk Print page, enter the appropriate information.
7.1.10.1 General Usage Information

Search Case Section
The following is and illustration of the Search Case section.
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The following table lists and describes the fields and controls in the Search Case
section.

Field Description

Filter Performs searches for worklist items on the
basis of the filtering criteria selected here.

Value Enables the user to select the Value as the
search criterion.

Search Button Enables the user to search.

View Individual Enables the user to view individual items
assigned to this user group.

View Group Allows the user to view all items assigned to
this user group.

View All Allows administrator and workflow manager
to see all items in the system.

7.1.10.1.1 Filter Function The Filter function enables you to search for entities in the
worklist. The following table below describes the options available from the Filter
drop-down list.

Option Description

Case Number Displays the case number

Reporting Displays the report destination (agency) for which the report is
Destination scheduled.

Report Form Displays the report form

Report Status Displays the report status

7.1.10.1.2 Total Number of Rows Section The following is an illustration of the Total
Number of Rows section.
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The following table below describes the columns in Total Number of Rows:

Field

Description

Case Number

Report Form

Agency Name
Printer Name
Date Created
Date Sent
Sender

Report Status

Print List Button

Displays the Case Number. Click the Case Number to view the case
details.

Displays the Description of the report
Click the link to view the DRAFT Report PDE.

Displays the name of the agency that has generated the report
Displays the name of the printer.
Displays the date on which the report was created.

Displays the date on which the report was transmitted to the recipient.

Displays the name of the sender of the report

Displays the Report Status
Click the Report Status to view the Report Details.

Allows the user to print the current worklist for reference.

7.1.10.1.3  Bulk Print User Options Click the icon associated with each report to view
available user options. The following table describes the Bulk Print user options.

Option Description

View Report Displays the report in a PDF format.

Mark report as Marks the report for the selected row as submitted.
Submitted

Remove Print Job

Re-print

Submit Multiple
Reports

Re-print Multiple

Remove Multiple
Print Jobs

Note: This option is displayed to only those users who have the access

rights to mark a report as submitted.

Removes the print job entry from the list.

Note: A report whose status is pending cannot be printed.

This option is displayed if the selected row has a status of failure or

success. Select this option to change the status back to pending and the

re-print the report.

Multiple reports that are selected from the list can be marked as
submitted simultaneously.

The status of multiple reports that are selected from the list can be
changed to "pending,” and those reports can be re-transmitted.

Print jobs of multiple reports that are selected from the list can be
removed.

Worklist
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7.1.10.1.4 Routing Details Section The following is an illustration of the Routing Details
section. Enter routing details in this text box.

Note: The reports appearing in the Bulk Transmission section or the
Bulk Print section are not displayed in the Reports section of the
Worklist.

7.1.11 Bulk E2B Transmit

The Bulk E2B Transmit function displays only those E2B Reports that are awaiting
submission (not in submitted state) when transmitted from "Bulk Report By Form" to
the Trading partner.

This menu option is not displayed if Interchange is not licensed or if you do not have
access to open worklist screens based on existing File Menu Access rights in the Group
Configuration.

The Bulk E2B Transmit page has two (2) tabs as follows:

= Reports -- Displays the status of individual E2B Reports that are in the process of
being transmitted.

= Messages -- Displays the status of ESM Messages which may contain multiple
reports.

To view the Bulk E2B Transmit page
1. Select Worklist --> Bulk E2B Transmit.

2. When the system opens Bulk E2B Transmit page, entered the appropriate
information as necessary.

7.1.11.1 General Usage Information

7.1.11.1.1  Reports Tab The following is an illustration of the Reports tab.

Click the following links for information about the sections and user option on the
Reports tab.

Search Criteria Section
The following is an illustration of the Search Criteria section.
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The following table lists and describes the fields in the Search Criteria section.

Field Description
Case # Displays the Case Number.
Click the Case Number to view the report.
Message Type Select a pre-defined message type.
Periodic Report This field is enabled message type "Periodic”
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Field Description

Start Date Enter the start date.

End Date Enter the end date.

Range Select a date range.

Search button Triggers search based on the search criteria.

Only show Enable this checkbox to search for only those transmissions that have a

transmissions that
have reached a
failure state

View Individual
View Group
View All

Stage Legend

failed status.

Displays all items assigned only to the individual user.
Allows the user to view all items assigned to this user group.

Allows administrator and workflow manager to see all items in the
system.

Shows the status (through colors) corresponding to each stage.

7.1.11.1.2  Total Number of Rows Section The following is an illustration of the Total
Number of Rows section.
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The following table describes the columns in the Total Number of Rows section.
Field Description
Action Displays the icon containing the available user actions.
Tip: Click on the case lock status (unlocked, locked or archived) for
further options.
Case Number Displays the Case Number. Click the Case Number to view the case
details.
Case Status Displays the current workflow of the state
Reporting Displays the name of the Reporting Destination
Destination
Date Created Displays the date on which the report was created.
Date Transmitted Displays the date when the report was transmitted.
Local Company Displays the name of the local company that has sent the report.
Name
Status Displays the Report Status e.g. Scheduled or Generated etc.
Click the Report Status to view the Report Details.
Message Type Displays the ICSR message type for the transmission
Transmit Denotes Processing Report
Worklist  7-27



About Worklist

Field Description

EDI In Denotes EDI In

EDI Out Denotes EDI Out

MDN Rec. Denotes MDN Received

ACK Rec. Denotes Acknowledgement Received

Status Details Contains the details of the latest failure / success message for the
selected row.

Print Prints the row selected by the user

Print List Button Allows the user to print the current worklist for reference.

7.1.11.1.3 Reports Tab User Options Click the Action icon with each report to view the
available user options. The following table below describes the available options.

Option

Description

View Report Details

(Read only)

View E2B Report
(E2b Viewer for the
report)

E2B Transmission
History
(Transmission
History for the
selected report)

Remove
Transmission

Re-Transmit

Remove Multiple
Transmissions

Re-Transmit
Multiple Reports

Submit Multiple
Reports

Opens the existing Report Details dialog in read-only mode.

Opens the existing E2B Viewer report.

Opens the new Transmission History screen

Removes the transmission log entry from the list.

Note: A report whose status is pending cannot be transmitted.

This option is displayed if the selected row has a status of failure or
success. Select this option to change the status back to pending and the
re-fax the report.

Removes transmission of multiple reports that are selected from the list.

The status of multiple reports that are selected from the list can be
changed to "pending,” and those reports can be re-transmitted.

Multiple reports that are selected from the list can be marked as
submitted simultaneously.

7.1.11.1.4 Messages Tab The following is an illustration of the Messages tab.

7.1.11.1.5 Search Criteria Section The following is an illustration of the Search Criteria
section on the Message tab.
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The following table lists and describes the fields and controls in the Search Criteria

section.
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Field Description
Agency Trading Enter the agency or trading partner.
Partners

Transmit Date
Range From

Range

Message # Range
Search button

Stage Legend

Select the transmit date range.

Select a range to auto populate the Start Date and End Date.

Note: The Range option is cleared if the Start Date or End Date is
changed.

Select the message range.
Triggers search based on the search criteria.

Shows the status (through colors) corresponding to each stage.

7.1.11.1.6  Total Number of Rows Section The following is an illustration of the Total
Number of Rows section.
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The following table below describes the column in the Total Number of Rows section.

Field Description

Reports Displays the number of reports.

Action Displays the icon containing the available user actions.

Trading Partner Displays the name of the agency or the trading partner.

EDI Receive Receipt Displays the EDI Receipt status.

Local Msg # Displays the Local Message Number.

Remote Msg # Displays the Remote Message Number.

File Name Displays the File Name.

Transmit to EDI Displays the Transmit to EDI Status.

EDI Tracking ID Displays the EDI Tracking ID.

EDI Transmit Date = Displays the EDI Transmit Date.

Status Displays the Report Status e.g. Scheduled or Generated etc.
Click the Report Status to view the Report Details.

EDI In Denotes EDI In.

EDI Out Denotes EDI Out.

MDN Rec. Denotes MDN Received.

ACK Rec. Denotes Acknowledgement Received.

Status Detail Contains the details of the latest failure / success message for the

selected row.
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Field Description
Print button Prints the row selected by the user.
Print List button Allows the user to print the current worklist for reference.

7.1.11.1.7 Message Tab User Options Click the Action icon associated with each report to
view the available user options. The following tables lists and describes the available
user options.

Option Description

E2B Transmission History (Transmission Opens the new Transmission History screen
History for the selected report)

View Acknowledgement (Read only) Displays the Acknowledgment report.

Note: This menu option is not displayed if ACK
has not been received for message.

View Reports Opens the Bulk Transmit E2B in the report view
for all the reports in the message.

View xml acknowledgement Displays business level acknowledgement

7.1.12 Local Labeling

When using worklist local labeling, be aware of the following:
=  Filtering by Product Family
Click the magnifying glass icon to filter the search results by product family.

You can filter products in the Event Assessment dialog based on the selected product
families.

On filtering, the system displays only the assessment rows matching the selected
product families.

= Events Assessment can show all listedness values. By default it shows listedness
only for core datasheets and for those countries the user has permission to access.

»  The filter options have a Study ID element and a Case Number (not a type ahead)
added to filter cases in the list.

— This option is a type ahead field that enables you to enter values for studies
defined in the configuration.

—  The type ahead limits the number of values in the drop-down list to 25.
— When you select type ahead values, the system performs a like search.

= Sorting

Search results can be sorted by case number and product name.

= Printing --You can print the current view of the Worklist as defined by the filtering
and sorting criteria.

= Saving
The system remembers the filtering and sorting selections for a particular session.

The system displays the default settings on the Worklist - Local Labeling for a new
user session.
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The system displays the total number of rows in the Search header section (e.g., 20
cases of a possible 450 with 0 cases being processed.)

You can configure the number of cases to display on the Page Size drop-down list
in the Search dialog (based on the profile settings for paging as a read only value).

The system displays the number of cases currently in view and automatically
updates the range based on the page size specified in the Search dialog (read
only). For example, if you select 100, the system divides the displays rows into
groups of 100 cases.

You can go directly to a range of cases from the Displaying Rows drop down list.

You can scroll through the Search results page-by-page, as defined by the Page
Size drop-down list.

You can filter search results by Product:

—  The product Filter drop down list contains all products listed in the event
assessment.

— The system enables you to filter on the Products in the Event Assessment
dialog.

- By default, the system displays all the products with the <ALL> option.

—  When filtering, the system displays only the assessment rows for the product
you selected.

Events assessment can show all listedness values. By default, it shows listedness
only for the core datasheets and countries you have permission to access.

Event

— The Event Filter contains a drop down values of distinct Event PT.

— The system enables you to filter on the events in the Event Assessment dialog.
— By default, the system displays all events with the <ALL> option.

—  When filtering, the system displays only the assessment rows that match the
product you selected.

Diagnosis -- The Diagnosis Filter contains a drop-down list with the following
values:

- D (Diagnosis)
- 5 (Symptoms)

— Inthe Events Assessment dialog, you can filter on either the diagnosis or the
symptom.

By default, the system displays all events with the <ALL> option.

When filtering, the system displays only the assessment rows that match the
product you selected.

Datasheets

— The Datasheets drop-down contains a list of distinct datasheets.

- You can filter on the datasheets in the Event Assessment dialog.

- By default, the system displays all datasheets with the <ALL> option.

—  When filtering, the system displays only the assessment rows for the product
you selected.
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—  All the blank datasheets display as a single row of Unspecified.

-  When you click the Datasheet hyperlink, the system displays the datasheet
notes.

= Licenses
— The Licenses drop-down contains a list of distinct countries for the licenses.
- In the Event Assessment dialog, you can filter on licenses.
- By default, the system displays all licenses with the <ALL> option.

-  When filtering, the system displays only the assessment rows that match the
product you selected.

— All licenses not associated with a datasheet display under Unspecified and
are aligned with the datasheet view.

—  When you click the Licenses hyperlink, the system displays the license
references.

- You can print the current Search view as defined by the filtering and sorting
criteria.

s For more information about Local Labeling, see the LAM User Guide for Worklist -
Local Labeling requirements.

7.1.13 Coding Status

Coding Status enables you to perform the following functions:
s Coding Status View

= Single Case Coding / Recoding

s Bulk Coding / Recoding

s Coding Status Reports

Configured users can select Coding Status through the Worklist menu. The following
is an illustration of the Coding Status screen.

7.1.13.1 Search Conditions Section
The following is an illustration of the Search Conditions section.
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The following table lists and describes the fields and controls in the Search Conditions
section.
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Field

Description

Search For

Select the criteria by which the case must be searched for and

enter an appropriate search item, if applicable.

Note: You can search for cases based on multiple study
identifiers. The option, "Prj/Othr/Stdy /Rptr/Pat" supports
entry of Project ID, Study ID, Other ID, Center ID, Reporter ID,
and Patient ID values separated by the "/" (forward slash)
character.

Any or all fields may be present.

Full Search Select this checkbox, if necessary.

Full search is best explained with an example. If the full search
option is not used and the item that is entered under Search for is
"AB", then a string such as "ABCESS" will match "AB", but a
string such as "LABOR" will not. If the full search option is used,
both these items will match "AB". Also, items whose first few
letters sound similar (like "TIM" and "TIN") will also appear in
the search results.

Product Family Select the Product Family that the case belongs to, if applicable.

Date Range Select a relevant Date Range, if applicable.

Tip: To enter a customized date range, select Custom Date
Range from the list.

Enter an appropriate date range in the custom date range dialog
and click OK.

Advanced Select an advanced condition for the case, if applicable.

Note: Click AC to create a new advanced condition.

Search Displays the list of cases that match the entered search criteria

7.1.13.2 Total Number of Rows Section

The following is an illustration of the Total Number of Rows section.

[F——— =

The following table lists and describes the columns in the Total Number of Rows
section.

Field Description

Case Lock icon Depicts the lock or unlock status of the case.

Case Number Displays the case number. Click the link to view the case form.

Aware Date Displays the Aware Date for the case.

Seriousness Displays the Case level Seriousness Criteria. In case the case has any Fatal
Criteria or Life Threatening event, it is displayed as such.

Workflow State Displays the Workflow State of the case
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Field Description

Aging (Days) If all code-able items of the case are coded completely, Aging is displayed
as the Number of days from the Initial Receipt Date to the date when
latest item of the case was coded.

If any code-able item of the case is not coded, Aging is displayed as the
Number of days from the Initial Receipt Date to the system date
(Database Server).

Coding State If all the events / products are encoded, the coding state is denoted with
a green check mark.

If the case has even a single code-able item as not coded, the coding state
is shown as a red cross mark.

7.1.13.3 Coding Status Icons

The following table lists and describes the icons used to identify the coding status.

Icon Description
= Displays that the verbatim text has not yet been coded.
2 Displays that the verbatim text has been successfully coded.
& Is displayed if the verbatim text has been submitted to Central Coding,
but no result has been returned to Argus yet.
o Is displayed if the term was submitted to Central Coding for coding and

returned a status of error either from Central Coding or Argus.

7.1.14 Letters

The Letters function enables you to search for letters associated with a case.

To access the Worklist - Letters page
1. Select Worklist --> Letters.

2. When the system opens the Worklist - Letters page, enter the appropriate
information.

7.1.14.1 Search Case Section

The following is an illustration of the Search Case section.
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The following table lists and describes the fields and controls in this section.

Field Description

Current Letter Select the current letter from this list
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7.1.15 Intake

Field Description

Date Range Allows the user to select a date range from which cases may be selected.
The selection made from the Date Range drop-down list automatically
populates the From and To fields.

Show only those Allows the user to filter the case list search to only those cases that have
cases with no not had any correspondence letters sent.

previous

notifications

Advanced Select an Advanced Condition from the list

Condition

AC Creates a query for an Advanced Condition

Search button Displays the results matching the search criteria

7.1.14.2 Total Number of Rows Section

The following is an illustration of the Total Number of Rows section.

[F— =1

The following table below describes the columns in the section.

Field Description

Action Displays the Action icon

Case ID Displays the Case ID. Click the Case ID to view the case details.
Date Displays the date

Reporter Displays the reporter name

Last Notification Displays the last notification date

The Intake function enables you to view a list of incoming attachments in Worklist
View where you can select an attachment for creating a case.

To access the Worklist - Intake page
1. Select Worklist --> Intake.

2.  When the system opens the Worklist - Intake page, enter the appropriate
information.

7.1.15.1 Pending Tab

The following is an illustration of the Pending tab.
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The following table lists and describes the fields and controls in this section.

Field Description

Priority Allows the user to view the priority of the case.

Initial Date Allows the user to view the initial receipt date of the case.
Intake Date Allows the user to view the date of case intake.

Product Name

Generic Name

Event PT

Event Verbatim

S/U/R
ELTorH
Case Type
Study ID
Reporter Type

Country

Assigned To
Group

Central Site/LAM
Site

Attachment Name

Classification
Description

Create Case
Reject Case
Print List

Allows the user to view the first suspect Product in question.

Allows the user to view the generic name of the suspect product in
question.

Allows the user to view the Primary Event and Verbatim as Reported.

The following format is used:

Primary Event (Verbatim as Reported)

Allows the user to view case-level assessments

Allows the user to view Fatal, Life-Threatening or Hospitalized cases.
Allows the user to view report type information.

Allows the user to view the Study ID of the study cases.

Allows the user to view the Reporter type for the Primary Reporter in
the case.

Allows the user to view the Country of incident.

Allows for the current owner or "Unassigned" user to be assigned to the
case.

Allows for the current group owner or "Unassigned" group to be
assigned to the case.

Allows the user to view the current Site (Argus or Affiliate) of the Case -
If there are no Sites defined then ALL users shall access to the case
attachment.

Allows the user to view the attachment which is associated to the case.

Allows the user to view the attachment classifications which is
associated to the case.

Allows the user to view the attachment description which is associated
to the case.

Allows the user to create a case.
Allows the user to reject the case.

Allows the user to print the case.
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7.1.15.2 Rejected Tab

The following is an illustration of the Rejected tab.
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The following table below describes the columns in the section.

Field

Description

Priority

Initial Date
Intake Date
Product Name

Generic Name

Event PT

Event Verbatim

S/U/R
ELTorH
Case Type
Study ID
Reporter Type

Country
Assigned To

Group

Central Site/LAM
Site

Attachment Name

Classification
Description

Rejected Date

Allows the user to view the priority of the case.

Allows the user to view the initial receipt date of the case.
Allows the user to view the date of case intake.

Allows the user to view the first suspect Product in question.

Allows the user to view the generic name of the suspect product in
question.

Allows the user to view the Primary Event and Verbatim as Reported.

The following format is used:

Primary Event (Verbatim as Reported)

Allows the user to view case-level assessments

Allows the user to view Fatal, Life-Threatening or Hospitalized cases.
Allows the user to view report type information.

Allows the user to view the Study ID of the study cases.

Allows the user to view the Reporter type for the Primary Reporter in
the case.

Allows the user to view the Country of incident.

Allows for the current owner or "Unassigned" user to be assigned to the
case.

Allows for the current group owner or "Unassigned" group to be
assigned to the case.

Allows the user to view the current Site (Argus or Affiliate) of the Case -
If there are no Sites defined then ALL users shall access to the case
attachment.

Allows the user to view the attachment which is associated to the case.

Allows the user to view the attachment classifications which is
associated to the case.

Allows the user to view the attachment description which is associated
to the case.

Allows the user to view the date when the case was rejected.
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Field Description

Rejected By Allows the user to view the user who rejected the case.
Create Case Allows the user to create a case.

Reject Case Allows the user to reject the case.

Print List Allows the user to print the case.
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MedDRA Browser

This chapter describes the MedDRA (Medical Dictionary for Regulatory Activities)
browser which is used to encode diseases, symptoms, signs, and so forth. In Argus
Safety, using such a dictionary provides consistency when assigning terms for adverse
events.

8.1 MedDRA Browser Functionality

When loading the new MedDRA dictionary, the system selects the default MedDRA
browser.

The following is an illustration of the MedDRA Browser screen.
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To view the MedDRA Browser
1. Select Utilities --> MedDRA Browser.

The system opens the MedDRA Browser screen.

8.1.1 Using the MedDRA Browser

Your Argus Safety Administrator may have configured the system to use the MedDRA
Browser for encoding events or indications.
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If this is the case, the MedDRA Browser dialog opens when you click the Encode
button. The dialog can also be invoked while creating Advanced Conditions or by
going to Utilities > MedDRA Browser.
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8.1.1.1 MedDRA Browser Dialog Fields and Field Descriptions
The following table lists and describes the fields in the MedDRA Browser dialog box.

Field Description

Coded Version Shows the version of the dictionary under which this event was
originally encoded.

Terminology Allows you to select the version of the dictionary in which you wish to
encode this event.

Full Search If you select this check box, the search text you enter will be matched
within each word of the terms. If this check box is cleared, the system
will only return the terms that begin with the text you entered.

Special Category You can select a special category in the MedDRA dictionary from this list
in order to display the terms related to that category.

Clear Clears all entries in the dialog.

Search All Levels You can enter text in this field and press ENTER in order to search for the
text across all of the five levels of the dictionary.

SOC column System Organ Class. You can enter text in this field to search for the term
in this particular level.

HLGT column High Level Group Term. You can enter text in this field to search for the
term in this particular level.

HLT column High Level Term. You can enter text in this field to search for the term in
this particular level.

PT column Preferred Term. You can enter text in this field to search for the term in

LLT column

Synonyms

this particular level.

Low Level Term. You can enter text in this field to search for the term in
this particular level.

This level can list company-specific synonyms for LLT terms.
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Field Description

Print Creates a report of the information that is currently on the dialog. This
report will be in PDF format.

Select Click this button to enter the terms that have been selected into the
encoding.

Save Click this button to save the query. This button is enabled only on

selection of the PT term(s).

Export This button is enabled in two scenarios - when MedDRA is opened from:

i) Argus Console > Business Configuration > Products and Licenses >
Product Family > Datasheet

or, from:

ii) Argus Console > Code Lists > Argus > Event Group

MedDRA terms are selected at any level of the MedDRA hierarchy:.

On clicking this button, a dialog is displayed, that allows you to select the
file type - .csv / xIs / .xlsx file.

On specifying the file type, the selected PT terms are then exported in the
Export file. in the <PT terms> format.

Cancel Click this button to close the dialog without making any changes.

8.1.1.2 MedDRA Searches and Search Results

Use the following procedure to search for terms.

Execute these steps to search for terms:

1.
2.

4.

Enter the required term in one of the five levels of encoding.

You can enter as little information as necessary in order to get a broader set of
results. Alternatively, you can enter the term under Search All Levels to search for
the term across all levels.

Select the Full Search check box, if necessary.

Full search is best explained with an example: If the full search option is not used
and the item that is entered under Search for is "AB", then a string such as
"ABCESS" will match "AB", but a string such as "LABOR" will not. If the full search
option is used, both these items will match "AB."

Press ENTER. A list of search results opens.

8.1.1.21 About Search Results When using search results, be aware of the following:

You can click the Select button to transfer the selected terms to the Case Form or
the Advanced Conditions dialog, depending on where the browser was invoked
from. The button only becomes available after terms at all levels have been
selected.

If you double-click an LLT term, a Term Details dialog appear. The dialog displays
the following details about the term:

— Indicate if the term is current or non-current
- MedDRA code for the highlighted term
-  Primary SOC code and term
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- Secondary SOC code(s) and term(s), if applicable
- Dictionary identifier

When you select a term in a particular column, the other columns will be filled-in
with the appropriate terms that correspond to the selected term.

The Primary SOC Path is highlighted by using bold text for the path.

To perform a synonym search, select an LLT among the search results. A synonym
for the LLT will appear in the Synonyms column. When you select a synonym, the
LLTs for that synonym will appear in the Synonyms column.

8.1.1.2.2 Using the MedDRA Browser for Advanced Conditions When you select a field for
which the terms can be encoded in the Advanced Conditions dialog, the Select button
appears.

Click this button to view the MedDRA Browser dialog. You can search and select the
required terms from the MedDRA browser. These terms are automatically transferred
to the Advanced Conditions dialog.

8.1.2 MedDRA Recoding

The MedDRA recoding tool displays the following options for each case with the
existing data elements after the case number in the XLS export or tab delimited file:

Current Workflow State.
Current Workflow Group.

If Excel is the output format and the number of record returned is more than 60K,
the system splits the record set into multiple worksheets of 64K each.

These options are available for the end user logs.

The SOC/HLGT/HLT/PT/LLT and Synonym columns in the MedDRA schema
and the MedDRA table have been expanded to 250 characters to conform to the
ICH guidelines.

The MedDRA Recoding Tool is configurable as per customer requirements.

The following table lists the tables that support MedDRA Recoding and their locations
in the Argus application.

Argus Database Table Location in Argus

CASE_PAT_HIST Argus Safety > Case Form > Patients Tab > Parent Section >
Other Relevant History

CASE_EVENT Argus Safety > Case Form > Events Tab > Event Information

CASE_PROD_INDICATIONS  Argus Safety > Case Form > Products > Products Indication

CASE_ASSESS Argus Safety > Case Form > Events Tab > Event Assessment
> Event PT (Description)/LLT

CASE_DEATH_DETAILS Argus Safety > Case Form > Events Tab > Seriousness Criteria
> Death Details > Cause of Death & Autopsy Details

CASE_LAB_DATA Argus Safety > Case Form > Patient Tab > Lab Data

LM_PRODUCT Argus Console > Business Configuration > Products and

Licenses > Primary Indication

LM_LAB_TEST_TYPES Argus Console > Code Lists > Lab Test Type
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8.1.2.1 MedDRA Recoding Logic
The following logic is used during the MedDRA recoding:

1.
2.

Get the Lower Level Term (LLT).

Check LLT_Code column in the MEDDRA_PREF_TERM_LLT table to see if LLT is
not current (LLT_CURRENCY = N).

Decisions:

" If LLT cannot be found in MEDDRA_PREF_TERM_LLT then record as
exception to be noted in LOG file.

s IfLLT is not current then get PT_CODE from MEDDRA_PREF_TERM_LLT
and use as LLT (Each PT exists as LLT also - always).

" If LLT is current then keep LLT as it is.

If a current LLT can be found in previous step then continue with next step else go
to 1 and select next set of Terms.

Based on the LLT, get the Preferred Term (PT_CODE) from MEDDRA_PREF_
TERM_LLT. Get the rest of the hierarchy from MEDDRA_MD_HIERARCHY,
based on PT_CODE and PRIMARY_SOC_FG ="'Y".

Match all the 5 levels of Code and Description and update the data, if required.
Populate the following columns:

DICT_ID = Current MedDRA Dictionary ID, present under Case Form
Configuration.

CODE_STATUS = 1 (displaying that this set of terms has been encoded).

8.1.2.2 Recode MedDRA terms at the Enterprise level

For multi-tenant environment, the MedDRA Re-Code Tool allows recoding of
MedDRA terms at the Enterprise level.
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MedDRA Re-code
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s The MedDRA recoding tool displays an additional multi-select list of all active
Enterprises. This lists all active Enterprise Short Names in alphabetical order.

= New Schema Owner is no longer required. As per the recoding logic, cases are also
re-coded to the MedDRA version that is configured in Console.

= Displays a note below the Existing MedDRA Version to Re-Code list - "Note -
Cases will be re-coded to the MedDRA version configured in Console for the
respective Enterprises.”

s The MedDRA recoding tool only re-codes the items that match the selected
Enterprises and values selected in the"Existing MedDRA Version to Re-Code" list.

s Thelog file specifies the Enterprise Short Name with every log record that is
processed for a particular Enterprise.
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Reports: Compliance and Aggregate
Reports

This chapter contains detailed information about Argus reports and how to create and
use them.

9.1 Reports

Several different kinds of reports are available in Argus. You can access them from the
Reports menu. When using reports, be aware of the following;:

»  The system prints a DRAFT watermark across the entire page starting from the
bottom left to top right for the following on all pages:

- ALL Expedited reports including E2B CIOMS and MedWatch on the E2B
Viewer

- ALL Periodic Reports including Expedited reports part of the Periodic and
Aggregate reports part of Periodic

= If you select Internal or a value for Other text for PSUR/CTPR reports, the system
prints "Internal” or the other text value as the watermark on the PDF reports that
include the expedited reports that are part of the periodic for all pages.

»  The Bulk Reporting screen has a Study ID filter option that enables you to filter
cases in the list.

= When using the Study ID filter, be aware of the following:

— The Study ID is a type ahead field the system enables you to enter the study
ID values defined for cases.

—  There can be a maximum of 25 items on the drop-down list.

—  When you select values from the drop-down list, the system performs a like
search.

s The system prints the user-defined summaries in the order they are listed in the
Periodic report.

This chapter discusses these reports in detail and also about the reports in the
following categories. The following is a list of all available Argus reports.
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= Compliance Reports = CIOMSII Line Listing s USIND Periodic Reports
= Expedited Reports Reports = USNDA Periodic Reports
= Periodic Reports = CaseListing Reports = Bulk Reporting
= Submitted Reports = Memorized Reports = Incoming E2B Reports
= Aggregate Reports = Periodic Reports = Processed E2B Reports

s Clinical Trial Periodic

s Case Data Analysis
Reports

Reports = Report Mapping

= ICHPSUR Reports

9.1.1 Compliance Reports

This section lists the different Compliance Reports in Argus and discusses about each
of them in detail.

Place the cursor over the Compliance option in the Reports tab to go to any of the
Compliance Reports.

9.1.1.1 About Expedited Reports

Expedited Reports provide access to the list of previously scheduled or generated but
not submitted expedited reports.
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Apart from viewing these reports, you can also schedule a new expedited report from
this dialog.

Depending on the regulations set forth by the Regulatory Authorities, expedited
reports might need to be submitted for the adverse events pertaining to your
company's products.

You can generate several different kinds of expedited reports as follows:
s CIOMS-I Form (English)

s CIOMS-I Local Form (English)

s CERFA 65-0040 (French)

s CERFA 65-0044 (French)
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MHLW Clinical (Japanese)

MHLW Spontaneous (Japanese)

US FDA MedWatch Form 3500A (English)

US FDA MedWatch Form 3500A (English) Drug Only
MCA Clinical (English)

MCA Spontaneous (English)

US FDA VAERS Form (English)

EU EMEA Clinical Form (English)

EU EMEA Spontaneous Form (English)

EU Device Vigilance Initial Form (English)

EU Device Vigilance Final Form (English)

German BfArM form 643 / PEI Form (German) French CERFA (French)
E2B

Spain Clinical

Spain Spontaneous

Canadian Device Form

Canadian Expedited Form

9.1.1.1.1  General Usage Information When using Expedited Reports, be aware of the
following:

The following expedited report forms do not print a follow up number when the
user selects DRAFT on the Regulatory Reports tab or when he/she selects the
Quick Launch Draft option:

s US FDA MedWatch Drug/Device
= USFDA VAERS

s CIOMS I/CIOMS I (Local)

s French CERFA

= Spanish Spontaneous/Clinical

The system enables you to print draft expedited reports from the Batch Print or
Create Reports without printing DRAFT on the reports from the Case Open or the
Reports | Compliance | Expedited Reports dialog.

When you select the Draft option, the system enables you to print a DRAFT
watermark on the expedited reports.

If you do not enter a value, the system does not print a watermark on the
expedited reports.

You can enter a maximum of 10 characters in the text field.

9.1.1.1.2 Storing Expedited Reports in Documentum Argus Safety lets you store your
Expedited Reports in Documentum.

Mark an Expedited Report as submitted from within Argus. to insert the report
into the Documentum system as a PDF.
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If the report is to be transmitted via fax or email, Argus Safety Service marks the
report as a successful submission in Documentum only after the fax or email
transmission has succeeded.

9.1.1.1.3 Understanding Follow-up Reports Follow-up reports are created when
significant follow-up information is entered for the case. This is indicated by entering
follow-up information in the General Information section of the General tab and
when one of the following two things happens:

Data for a case changes
Update information for a case has been entered

Depending on the configuration set up by the Administrator, the system analyzes
the scheduled reports prior to the data changes to see if they are still required.

If the system determines that they are not required, the report status is marked as
"Downgrade". New reports are automatically scheduled, if required.

If the system determines the report is still needed and needs to be updated, one of
two functions can take place depending on the configuration done by the
Administrator:

— The system overwrites the report
— The system schedules a new report in addition to the old report

If the system has been configured to overwrite the existing report, the report status
becomes "New Data Available."

In the Worklist, the status for this report shows "New Data Available" for this
report. When you re-generate the report, you can select whether or not you would
like to re-generate the report with the new data.

If the system is configured to create a follow-up report, the previous report
remains in its current state and a new report is scheduled with the status of
"Scheduled.”

If a report has been previously submitted, this report is never deleted under any
configuration.

9.1.1.1.4 Viewing a Summary of Expedited Regulatory Reports The following table below
describes how to view a summary of Expedited Regulatory Reports:

To.. Do..

View the regulatory reports for a Open the Regulatory Reports tab of the Case
particular case (scheduled, generated and Form.

submitted)

View all scheduled, generated, and Select Reports from the Worklist menu.

approved reports, as well as other
outstanding action items

View a list of all scheduled, generated, and Select Compliance | Expedited from the Reports

approved reports menu.
View all the submitted reports in the Select Compliance | Submitted from the Reports
system menu.

9.1.1.1.5 User Options Several common features are available in the Expedited Reports
section. These include:

Lock State Header Options
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s Lock Icons

s Lock Icon Options

Lock State Header Options

Click the Lock State header row to sort on the following category of cases. A pop-up
appears listing the following sorting options:

s Lock State
s SUSAR
s Exp/Per

Click on the required option to sort cases based on the selected case categorization.

Note: The icon displayed in the lock state column in the Reports->
Compliance - Expedited and Submitted screens denotes a SUSAR
(Suspected Unexpected Serious Adverse Reaction) case.

Lock Icons
The following table describes the meaning of each icon when attached to a case.

Icon... Identifies...

) A case marked for a Periodic ICSR submission.

A locked case.

An unlocked case

¢ A SUSAR (Suspected Unexpected Serious Adverse Reaction) case.

Lock Icon Options
Click the lock icon to view the list of options described in the following table:

Field Description
View Report Displays the details of the selected report.
Report Details Displays specific information about the report as entered in the

Regulatory Reports section.

Note: The information displayed in the fields of the Report Details
dialog is fetched from the data entered in the Regulatory Reports
section of Case Form. Refer to the About the Report Details Dialog Box
section for descriptions of each tab.

Case Summary Displays the Case Summary dialog

Remove Report Deletes the report from the case on being asked for a justification.
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Field

Description

Mark for
Non-Submission

Remove Multiple
Reports

Mark Multiple for
Non-Submission

Displays the Submission tab in the Report Details dialog.

Select No for Mark for Non-Submission and enter the reason for the
non-submission.

Deletes multiple reports from the case on being asked a justification.
Displays the Submission tab in the Report Details dialog. Select No for

Mark Multiple for Non-Submission and enter the reason for the
non-submission. This is applied to all selected reports.

9.1.1.1.6 Scheduling Reports Use the following procedure to schedule reports.

1. Open the case for which the report has to be scheduled.

2.  When the system displays the Case Form for the selected case, select Regulatory
Reports --> Schedule New Reports.

3. When the system opens the Schedule New Expedited Report dialog box, enter the
appropriate information in the fields in the dialog box.

4. Click OK to schedule the report.

5. Save the case to save the report.

Schedule New Expedited Reports Dialog Box Fields and Field Descriptions
The following table lists and describes the fields in the Schedule New Expedited

Report dialog box.

“
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Field

Description

Product

License #

Select the relevant company product from the list. All company
products associated with the particular case appear in the list.

Note: The items appearing in the drop-down list are listed in the
following format:

Trade Name, Product Name, Formulation, Concentration and
Indication.

Select the appropriate license.

Note: The items appearing in this drop-down list are listed in the
following format:

Country of License, License Type and License Number
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Field Description

Destination Select the regulatory authority for which the report is to be
scheduled.

Form Select the type of the report that is to be created.

Message Type Select the Message Type from the drop-down list.

Aware Date This drop-down list is only populated and enabled after a license

has been selected. The Aware Dates are displayed in descending

order of the Current Aware Date.

The list of the aware dates is determined based on the license

type selected in the following two groups:

i. Drug/Vaccine - follow-up dates that are marked significant

ii. Device - follow-up dates that are marked as "device"

significant

If the system is configured to not have separate significant
indication for Drug and Device, only the standard
(Drug/ Vaccine) significant follow-up dates are considered.

The resulting expedited report Due Date is based on the selected

Aware Date and the duration of the Due Date section.

Note: The selected Aware Date has no impact on the Actual Due
Date if the user specifies an absolute Due Date. For instance,
selecting a date in the Due Date field causes the report to be due
on the specified date, regardless of the selected Aware Date.

Protect Confidentiality of ~ Select this check box if identifying information about the patient

Patient and Reporter and the reporter must not appear on the report.

Notes Enter any relevant notes in this field.

Group Select the group that will be responsible for the report.
Cover Letter Select a cover letter for the report, if relevant.

Due Date Specify the due date of the report by selecting the number of

days after which it will be due, or by specifying the exact date.

9.1.1.1.7 Generating Reports You can generate a report using either of the following

procedures.

Method 1: Generating a Report

1. Verify that the relevant case has been locked and the required report has been

scheduled.

2. Open the selected case to display its associated Case Form.

3. Open the report from the Regulatory Reports tab of the Case Form.

4. When the system opens the Regulatory Reports details for the selected case, locate

the relevant report and click the Final link to generate the report.

5. The system generates the selected report.

Method 2: Generating a Report

1. Verify that the relevant case has been locked and the required report has been

scheduled.

2. Select Case Actions --> Open to view the Case Open form.

3. Click Search to view cases matching the search criteria.
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When the system displays the search results, click the Lock State icon and select
Case Details.

When the system opens the Argus Safety Case Details dialog, open the
Scheduled Regulatory Reports folder and select the relevant regulatory report.

The system automatically generates the report.

Note: aTo preview a report in draft mode, click the DRAFT link for
the report in the Case Form.

= You do not need to lock the case to preview a report in draft
mode.

s If you have access rights to view or print blinded information, you
are prompted to select whether you would like to view a blinded
or unblinded version of the report. If your access rights disallow
you from viewing or printing unblinded information, you can
view only a blinded version of the expedited report. The
following items are not displayed when viewing a blinded version
of the expedited report:

»  Clinical Treatment Given (Study Drug field)
s Study Drug Formulation and Concentration
s Study Drug Dose, Daily Dose and Route

s Study Drug Batch/Lot # and Expiration Date

»  If the case is locked you can generate the report from the Worklist
| Reports, Reports | Bulk Reporting and Reports | Compliance |
Expedited screens.

9.1.1.1.8 Approving Reports Use the following procedure to approve reports.

1.
2.

Open the case associated with the report that needs to be approved.

When the system opens the Case Form, click the Regulatory Reports tab to
displays the case details.

Click the icon associated with the report you wish to approve and select View
Report Details.

When the system opens the Report Details dialog, click the Routing tab.

When the system opens the Routing tab, select Approved from the State
drop-down list and click Route.

When the system opens a dialog box, enter the required information and click OK
to approve the report.

Note: Refer to Report Routing to understand how you can route a
report to another state.

9.1.1.1.9 Creating Unscheduled Expedited Reports Use the following procedure to create
unscheduled expedited reports.

1.

Select Reports --> Expedited --> Compliance.
Expedited Reports Dialog Box Fields and Fields Descriptions
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Field Description

Selected Click the checkbox to select the report.

Lock State Displays if the case is locked or un-locked.

Status Displays the Report Status e.g. Scheduled or Generated etc.

Case Number

Country of Incidence

Report Type

Suspect Product

Diagnosis
Event Verbatim

S/U/R

F/LT

7/15

Report Form

Destination

Initial / Follow-up
*)

Due Date

Days Past Due
Downgrade

View All

View Group

Individual

Note: Click the link displaying the status to view the report details.

Displays the Case Number.

Note: Click the link displaying the Case Number to open the selected
case.

Displays the Country of Incidence for the selected case.
Displays the Report Type of the selected case.

Displays the Trade Name for which the report has been scheduled. A
(+) displayed at the end of the Product Name denotes that more than
one Suspect Company Product exists.

For Reports which were scheduled for the Device, the Device name gets
displayed.

Displays the Primary Event Diagnoses PT

Displays the (verbatim as reported) of the Primary Event.
Displays the Case Level Assessments

» S-Serious (Y/N)

s U-Unlisted (Y/N)

= R-Causality (Y/N)

= Unknown is displayed by a
Click the SUR link to view the Case Summary.

non

Denotes Fatal / Life Threatening
If the case is both F and LT, only F is displayed.
If the case is neither F nor LT, No is displayed.

Displays 7 if the report is due within 7 days
Displays 15 if the report is due in more than 7 days

Displays the Description of the report.
Click the link to view the DRAFT Report PDFE.

Displays the Report Destination (Agency) for which the report is
scheduled.

Displays the status whether it is Initial or Follow-up.

If it is Follow-up, the follow-up number is also displayed.

Displays the due date. This date is based on the previously submitted
report for the MedWatch Reports under the G7 Section for 5, 7, 10, 15
and 30 Days.

Displays the number of days the report is past due date.
Displays Yes if the report is a Downgrade Report.

Allows the administrator and workflow manager to see all items in the
system.

Allows the user to view all items assigned to this user group.

Allows the user to view all items assigned to him.
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Field Description

Print List Button Allows the user to print the current Expedited Reports List for
referencing the current view of the Expedited Reports List.

Batch Print Allows the user to batch schedule Expedited Reports for Locked or

Unlocked Cases.

2. Click Batch Print or Create Report and search for the case for which the expedited
report has to be scheduled.

3. When the system displays the search results, select the locked cases for which the
expedited report is to be scheduled.

4. Click Batch.

5. When the system opens the Batch Print or Create Reports dialog box, enter the
appropriate information and click OK.

6. The system generates the unscheduled expedited report.

Batch Print or Create Reports Fields and Field Descriptions
The following table lists and describes the Batch Print fields.

Field Description
Reporting Displays the different reporting destinations.
Destination

Report Form

License Type

Message Type

Format

Destination

Protect
Confidentiality of
Reporter and Patient

Displays the report form types.

Select the license type as investigational or marketed or any type of
license.

Select the message type from the drop-down list

Enables you to print reports As Draft or As Final.

The Print As Final option is available only if all the selected cases
are locked.

If Print As Final is selected, then the option Save with case, mark
as submitted is also available as a checkbox option.

Click the options Print As Final and Save with case, mark as
submitted to generate final Regulatory Reports and create a
submission record with each case identical to the current
functionality.

Click the options combination of Print As Final only (and not Save
with case, mark as submitted) to generate final Regulatory Reports
without creating a submission record with each case.

If the report is associated with a blinded study, select the Blind
study product check box.

Click the Printer check box to print the report

Click this check box to hide the Reporter and Patient information on the
expedited reports.
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Field Description

Scheduling = If Run Now is selected, all the selected reports run against all
selected cases and a PDF is generated.

= The Run Now option is visible only when a MedWatch, MedWatch
Drug, CIOMS, or VAERS form is selected on the Batch Expedited
Report screen.

= 2Select Run at and enter the appropriate date and time when the
generation of reports should occur.

= Note that if you select an unlocked case, the report gets printed in
draft form only and is not saved.

9.1.1.1.10 Creating Batch Reports You can use the Batch Reports function to schedule
and generate reports for multiple cases. Before using this function, verify that no cases
or reports are open.

Use the following procedure to create batch reports.
1. Select Expedited Reports from the Reports - Compliance menu.

2. When the system opens the Expedited Reports dialog box, click Batch Print or
Create Report.

Expedited Reports Dialog Box Fields and Field Description
The following table lists and describes the fields in the Expedited Reports dialog box.

Field Description

Selected Click the check box to select the report.

Lock State Displays if the case is locked or un-locked.

Status Displays the Report Status e.g. Scheduled or Generated etc.

Note: Click the link displaying the status to view the report details.

Case Number Displays the Case Number.

Note: Click the link displaying the Case Number to open the selected
case.

Country of Incidence Displays the Country of Incidence for the selected case.
Report Type Displays the Report Type of the selected case.

Suspect Product Displays the Trade Name for which the report has been scheduled. A
(+) displayed at the end of the Product Name denotes that more than
one Suspect Company Product exists.

For Reports which were scheduled for the Device, the Device name gets

displayed.
Diagnosis Displays the Primary Event Diagnoses PT
Event Verbatim Displays the (verbatim as reported) of the Primary Event.
S/U/R Displays the Case Level Assessments

» S-Serious (Y/N)

s U-Unlisted (Y/N)

= R-Causality (Y/N)

= Unknown is displayed by a "?"

Click the SUR link to view the Case Summary.
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Field Description
F/LT Denotes Fatal / Life Threatening
If the case is both F and LT, only F is displayed.
If the case is neither F nor LT, No is displayed.
7/15 Displays 7 if the report is due within 7 days

Report Form

Destination

Initial / Follow-up
#)

Due Date

Days Past Due
Downgrade

View All

View Group
Individual

Print List Button

Batch Print

Displays 15 if the report is due in more than 7 days

Displays the Description of the report
Click the link to view the DRAFT Report PDFE.

Displays the Report Destination (Agency) for which the report is
scheduled.

Displays the status whether it is Initial or Follow-up

If it is Follow-up, the follow-up number is also displayed.
Displays the due date.

Displays the number of days the report is past due date.
Displays Yes if the report is a Downgrade Report.

Allows the administrator and workflow manager to see all items in the
system.

Allows the user to view all items assigned to this user group.
Allows the user to view all items assigned to him.

Allows the user to print the current Expedited Reports List for
referencing the current view of the Expedited Reports List.

Allows the user to batch schedule Expedited Reports for Locked or
Unlocked Cases.

1.  When the system opens the Expedited Reports dialog box, search for the cases for
which the expedited report needs to be scheduled.

2.  When the system displays the search results, select the appropriate cases and click

Batch.

3. When the system opens the Batch Print or Create Reports dialog box, enter the
appropriate information in the fields and click OK

The Expedited Batch Printing dialog supports printing Batch CIOMS, Medwatch, and
VAERS on Argus Web locally.

Batch Print or Create Reports Dialog Box Fields and Field Descriptions
The following tables lists and describes the fields in the Batch Print or Create Reports

dialog box.
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Field Description

Reporting Displays the different reporting destinations.
Destination

Report Form Displays the report form types.

License Type Select the license type as investigational or marketed or any type of
license.

Message Type Select the message type from the drop-down list

Format Enables you to print reports As Draft or As Final.

»  The Print As Final option is available only if all the selected cases
are locked.

= If Print As Final is selected, then the option Save with case, mark
as submitted is also available as a checkbox option.

= Click the options Print As Final and Save with case, mark as
submitted to generate final Regulatory Reports and create a
submission record with each case identical to the current
functionality.

= Click the options combination of Print As Final only (and not Save
with case, mark as submitted) to generate final Regulatory Reports
without creating a submission record with each case.

= If the report is associated with a blinded study, select the Blind
study product check box.

Destination Click the Printer check box to print the report

Protect Click this check box to hide the Reporter and Patient information on the
Confidentiality of expedited reports.
Reporter and Patient

Scheduling 1. If Run Now is selected, all the selected reports run against all
selected cases and a PDF is generated.

The Run Now option is visible only when a MedWatch, MedWatch
Drug, CIOMS, or VAERS form is selected on the Batch Expedited
Report screen.

Note: If you select an unlocked case, the report gets printed in draft
form only and is not saved.

2. Select Run at and enter the appropriate date and time when the
generation of reports should occur.

9.1.1.1.11 Expedited Reporting Rules Algorithm The expedited reporting rules algorithm
affects the following:

= Suppression of Duplicate Reports
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Blinded /Forced Distribution
Letter Placeholder for the IND Cover Letter

Suppression of Duplicate Reports

You can suppress duplicate expedited reports to be scheduled at the reporting
destination level, according to the following criteria:

The Suppress Duplicate Reports option only applies to drug reports. It does not
apply to device reports.

This option does not reduce the number of reporting rules the system evaluates.
However, it does prevent the system from scheduling and generating expedited
reports that match the duplication criteria.

When you select Suppress Duplicate Reports, the system uses the following
attributes to determine whether the reports are duplicates of other reports:

— Report Form
— Reporting Destination
- Aware Date

If two or more duplicate reports have different due dates (regardless of license
type), the system schedules the report with the earliest due date.

Blinded/Forced Distribution

The system enables you to configure the Blinding Study option for products in the
case.

When the user selects this checkbox, the system blinds the study products for the
report being sent to the reporting destination in a manner similar to the Bulk
Reporting dialog option.

If the user selects either of the Blind Study product options (Reporting Rules or
Bulk Reporting), the system blinds the study product information on the report
form.

The system blinds only active blinded studies. It does not blind the following case
reports even if the Blind Study product is selected

- Open Label Studies
- Study is eligible for unblinding

In cases where expedited reports are due, the system permits the user to
force-distribute the reports based on user-defined reporting rules, even if case
processing is incomplete.

When the user selects the Force Distribution rule, the following occurs:

If a case encounters a rule where a report is due is locked, the system schedules the
report based on the rule and does the following:

- Generates the report on the due date.

- Dynamically replaces the current case comment with the force distribution
case comment.

— Transmits the report based on the preferences defined by the reporting
destinations.

- Displays the status in the Worklist Bulk Transmit/Transmit E2B dialogs.
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s The AG Service Force Reporting process for expedited reports completes the
process by:

—  Checking the reports required for force distribution
— Locks the case (if it's not already locked)
- Generates the reports and makes sure it is ready for transmission
= The system adds case comments to the following reports:
- CIOMSI
- CIOMS (Local)
- Spanish Spontaneous
- Clinical Forms
= If a user has a case open, the system skips the case until the user releases the case.

= After transmitting the reports (sent to the WL Status dialogs), the system does the
following:

—  Unlocks the case

—  Uses the justification of the unlock as the case comment (as defined in the
Profile switch)

— Determines whether there are any unsubmitted reports and, if there are
unsubmitted reports, sends the current forced distribute reports to the Bulk
Reporting queue for transmission.

s The system puts the following in the Notes field of the report:
- Auto-scheduled; Forced Distributed: (EU) 15 day EMEA Mkt; Cure All

—  During the time the case is locked and reports are being generated, the system
does not allow the user to edit the case. The system displays the following
message:

— The case is in use by XXXX user
where:
- XXXX s the name of the AG Service user executing the report scheduling.

= The notes for the Case Locking/Unlocking are the same as those defined as the
common profile value for the Forces Distribution option; System is the user.

Letter Placeholder for the IND Cover Letter
Be aware of the following;:

= You can define a placeholder for the IND_SIMILAR_EVENTS table. The system
uses data from this table to populate the Case Number, Protocol Number, Subject
ID, and Adverse Event terms for previously submitted cases reporting the same
events.

» If the placeholder is used in a letter template, the system prints the information
shown in the following table.

Adverse Event Report Protocol Number Subject ID Number Adverse Event
No. (AER#) Term(s)
CASEQ001 CUREALL P101 Verbatim[PT]
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where:

AER# is the case number when an Investigational IND MedWatch was previously
submitted and included the same Related Event Term as the current case.

Protocol Number is the Project ID for the case in (a).
Subject ID is the Patient ID for the case in (a).
Adverse Event Terms(s) are the Related Events for the licensed product in case(a).

If no reports were submitted, the system prints None Submitted instead of the
table.

The placeholder only prints this information when it is used in the cover letter for
the Regulatory Report. The system uses the license associated with the scheduled
report to track other cases where the same product license was previously
submitted for the same events in the current case.

9.1.1.2 About Periodic Reports

This section discusses the different fields and features available in Periodic Reports.

The Periodic Reports screen comprises two tabs: Periodic Report tab, and Background
Periodic Report Status tab.
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9.1.1.2.1 General Usage Information When using periodic reports, be aware of the
following:

= You can filter cases in the following period reports based on the Case
Locked/Archived date:

= NDA
= IND

= PSUR
= CTPR

= When you select the Case Locked/Archived date, the system limits the cases based
on whether the case has been locked or archived within the specified time frame.

s The locked date is the lock date for the current case.

s If there is significant FU in the reporting time frame, the system considers the case
a follow-up case in the group options of the PSUR/CTPR reports.

= If you specify the time frame for the case locked/archived date, the system
disables the following;:

Include Follow-up

Exclude Follow-up

Include Summary of Unlocked Cases

Include Unlocked Cases
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= For the 15 day report section of the NDA Reports, the system uses the timestamp
to determine whether there are further follow-up or downgraded cases in that
date range.

9.1.1.2.2 Periodic Report Features The following table lists and describes the data that
appear in the columns on the Periodic Reports screen:
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Field Description

View All Enables the user to view all available periodic reports.

Trade Name Displays the Trade Name.

Destination Displays the name of the Destination.

Description Displays the report name. Click this to open the selected report in PDF
format.

Due Date Displays the Due Date.

Status Opens the Report Details dialog for the selected report.

Print List Allows the user to print the current Periodic Reporting for referencing the

current view of the Periodic Reporting.

9.1.1.2.3 User Options Common features on the Period Reports page. Click the icon
associated with each report to view the following options:

Option Description
View Report Opens the Individual Periodic Report selected by the user.
Report Details Displays specific information about the report as entered in the

Regulatory Reports section.

Note: The information displayed in the fields of the Report Details
dialog is fetched from the data entered in the Regulatory Reports
section of Case Form.

9.1.1.2.4 About the Report Details Dialog Box The Report Details dialog box includes
several tabs.

General Tab

The General tab displays the general information about the report. The information on
this tab cannot be modified.
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The following table lists and describes the fields on the General tab.

Field Description

Agency Displays the Reporting Destination for which the report is scheduled.
Responsibility Displays the User Group to which the report is assigned.

Date Generated Displays the date when the report was generated.

Date Submitted Displays the date when the report was submitted.

Report Type Displays the Expedited Report Form of the report.

Language Displays the language in which the report has been made.

Date Due Displays the date when the report is due.

Date Transmitted

Case Nullification
Date

Case Nullification
Reason

Displays the date when the report was transmitted.

Displays the date when the case was nullified.

Displays the reason entered when a case is logically deleted in Argus.

9.1.1.25 Scheduling Tab The Scheduling tab displays a reason for scheduling this
report. It also shows the date on which the report was scheduled.
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The following table lists and describes the fields on the Scheduling tab.

Field

Description
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Scheduled On Displays the date when the report was scheduled.
Scheduled By Displays the name of the person who schedule the report.
Case Revision Displays the case revision number.

Case Number Displays the case number.

Reason for Displays the reason for scheduling the report.

Scheduling

Note: All fields in this tab are auto-populated as per records entered
in Argus.

9.1.1.2.6 Routing Tab The Routing tab displays the routing history of the report. To
route the report, click Route.
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The following table lists and describes the fields on the Routing tab.

Field Description

Current State Displays the current state of the report.

State Displays the state of the report. This button is enabled when you click the
Route button.

Date Time Displays the date and time of the report routing.

Group Displays the group of the report. This button is enabled when you click
the Route button.

Reports Displays the type of report it is.

User Displays the state of the report. This button is enabled when you click the

Route button.

Comments Displays routing comments entered before routing the report.

9.1.1.2.7 Submission Tab The Submission tab enables you to specify whether
submission is required and enter a reason for not submitting the report.
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The following table lists and describes the fields on the Submission tab.

Field Description

Submission Enables you to select if this report is not required to be submitted to the

Required regulatory authority.

Determined On Displays the date when the report was considered not required to be
submitted.

Determined By Displays the name of the user who decided the report was not required to

be submitted.

Reason for Click Select to select the reason for non-submission.
Non-Submission

9.1.1.2.8 Comment Tab The Comment tab enables you to enter a local comment that
prints out on that specific report when generated. Each report has its own Local
Comment section.
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The following describes the Local Comment field on the Report Details tab.

Field Description

Local Comment Enables you to enter any remarks about the report.

Transmission Tab
To transmit a report

Reports: Compliance and Aggregate Reports 9-20



Reports

1. Click the icon associated with a report and select the Transmission tab from
Report Details.

2. When the system opens the Report Details The Report Details dialog opens.
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3. This dialog displays the status of reports that have been transmitted to different
recipients.

The following table lists the fields that comprise the Report Details dialog.

Field Description

Report Form Displays the name and type of report being transmitted.
Agency Name Displays the agency name for the report.

Fax Number / Displays the Fax Number or name of the recipient of the report.

Recipient Name

Recipient Company Displays the name of the company that is receiving the report.

Date Created Displays the date when the report was created.

Date Sent Displays the date when the report was sent.

# of Pages Displays the number of pages present in the report.
Attempts Displays the number of attempts in transmitting the report.
Sender Displays the sender of the report.

Status Displays the transmission status of the report.

4. Click OK or Cancel to approve the transmission or discard any changes,
respectively.

5. Click the Transmit button to transmit a report. The Transmit to Recipients dialog
is displayed.
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Select the recipients of the report, as applicable from the Available Recipients list.

Select the method of transmission from Method, as applicable.

6
7
8. Enter remarks in Comments.
9

Click Transmit.

10. The selected report is transmitted to the specified recipients.

9.1.1.2.9 Background Periodic Report Status The Background Periodic Report Status tab
is displayed for users who have been configured by the Argus Safety administrator in
Argus Console, under Access Management > Groups > Menu > Reports > Periodic

Reports.

The following table displays a description of the Background Periodic Report Status

tab:

|| Actve Cases | Workiist | CaseActions | Repons | Localasilate | uniities | Dashboards [| Argus Consote || Argusmnsigtt [| Argus Perceptive ﬁ

Reports > Comphiance » Periodic
PERIODIC REPORTS

(]
L. PSUR 06-09-2009 12:45:02 John Miller L Exgcuing ~
2 :;:fé:: I o8 06-09-2000 12:45:02 Andrew Srrith Peter Exeouting
9| 1z : O 06-03-2008 12:45:02 JOHN SMITH Errar
4 AAR CIPR 06-03-2009 12:45:02 JANE SMITH Pending
X
[Ratresn | [PrintList |
Field Description
Report Name Displays the name of the report, as entered in the Report Configuration
screen.
Report Type Displays the type of the report, such as NDA, PSUR, CTPR, etc.
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Field

Description

Start Date

Username

Status

Refresh
Print List

Context Menu >
View Report

Remove Report

Displays the date and time when the report generation started.

For English users, it is displayed in DD-MMM-YYYY HH:MM:SS (GMT
offset) format.

For Japanese users, it is displayed in YYYY/MM/DD 00:00 (GMT offset)
format.

Displays the username of the user who initiated the report.

Displays the current status of report generation in the form of hyperlinks,
with the options listed below:

Executing

Error

Pending

Generated

On clicking the Generated status, the Periodic Report is displayed.

On selecting any status other than Generated, the Background Periodic
Report Execution Status dialog is displayed, as shown below:

Case Fiterng

Basc Case nformaton

Line Latng Case Nformaton
Swmmary Tabulatons

User Defned Summanes
Expedted Report Generaton

POF Regort Creation

This dialog displays the different stages of Periodic Report status. A grey
tick mark is denotes Pending state, a Green tick mark denotes Completed
State, and a Red cross mark denotes an Error.

Allows you to refresh the screen.

Allows you to print the entries in Background Periodic Report Status for
reference of the current view.

This option is displayed in the context menu only when 'PDF/CSV /RTF
Report Creation’ is ‘Generated’. On clicking View Report, the selected
report is displayed.

Allows you to remove a selected report. Reports can be selected from the
AG Service Report Status screen and can be removed by clicking this
Remove Report context menu option. On selecting this option, a
Justification for the removal must be provided, after which the report is
removed.

9.1.1.3 Creating Unscheduled Periodic Reports

To create Unscheduled Periodic Reports:
1. Click the Create Unscheduled Report button

2. The system opens Periodic Reports dialog box that provides a list of configured
reports of the following types:

s PSUR - Containing ICH PSUR Line Listing Reports
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= IND - Containing US IND Periodic Reports
= NDA - Containing US NDA Periodic Reports
s CTPR - Containing CT Periodic Reports

Click the (+) icon against the desired category to view all the reports within that
category.

Select the report you wish to create from this list and click Select.

When the system opens the Report Batch Printing dialog, select Run Now or Run
at, as appropriate.

Note: If you select Run Now, specify PDF, RTF, or CSV from the
drop-down menu for the report output option to generate the PSUR or
CTPR report in the selected format.

If you select Run at, specify the date/time to schedule the PSUR
report to be generated by Argus Safety Service. This enables only
Final and disables all other Print As options.

In the Email field, enter the email ID of the user to whom the periodic report
should be e-mailed, once completed. By default, this field lists the email address (if
configured) of the current user.

Select what you want printed on the report: Final, Draft, Internal, or enter Other
information.

Click OK.

The system generates the periodic report.

9.1.1.4 About Submitted Reports

This section provides information about how to submit and view reports.

The following table lists and describes the icons that appear on the Submitted Reports

page.

Field Description

View Report Enables you to view the report.

Report Details Enables you to view the report details.

Unsubmit Reports Enables you to unsubmit reports through a confirmation dialog. If you

select the option to send a nullification report before clicking OK, a
justification dialog also appears, as shown in the section on Deleting a
Case.

9.1.1.41 Submitting Reports Before you can mark a report as submitted, the report must
first be approved.

Use the following procedure the submit an approved report.

1.
2.
3.

Open the case for which the report has to be approved.
Open the Regulatory Reports tab in the Case Form.

When the system opens the Regulatory Reports details for the selected case, click
the icon associated with the report you wish to approve.
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Select View Report Details.

Note: The Case Nullification Date is the date when the case is
deleted, the Case Nullification Reason is the comment entered when
the case is logically deleted in Argus.

Select Submitted from the State list in the Routing tab and click Route.
When the system opens a dialog box, enter the required details and click OK.
The report is approved.

Note: A user who has "Workflow Manager" rights can undo the
submission of a report, if necessary.

Viewing Submitted Reports
Use the following procedure to view submitted reports.

1.
2.

Select the Reports --> Compliance --> Submitted Reports.

When the system opens the Submitted Reports page, enter the appropriate search
criteria and click Search.

The system displays the Search Results.

Submitted Reports Fields and Field Descriptions
The following table lists and describes the search fields on the Submitted Reports

page.
Field Description
Destination Select one or more Reporting Destination(s).
Report Form Select one or more Report Form(s).
Submission Date  Specify a specific date range from the drop-down list.
Range Tip: To specify your own dates use the To and From dates.
License Type Select the License type.
Note: Only reports that have been scheduled based on the selected license
type will be displayed.
Case ID Enter the specific case number.
Tip: Use wild cards such as 2007% to search for cases starting with 2007.
Include these Select the required report type or case status to be displayed.
Reports
Product Select the product as required. The reports scheduled for these products

will be displayed.

9.1.1.4.2 Submitted Reports Search Results The following table lists and describes the
contents of the columns in the Submitted Reports Search Results.

Field Description

Status Displays the status of the report.
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Field Description

Case ID Displays the Case Number for the report.

Revision Date Displays the date when the last revision was made.
Destination Displays the destination of the report (agency name).

Time Frame (I/F-u) Displays the whether the report was initial or follow-up.

Product Displays the first suspect product for the case on which the report is
based (expedited reports).

License Type Displays the license type of the report.

Primary Event Displays the first event term for the case on which the report is based
(expedited reports).

Reason for Displays the reason provided for scheduling the report.

Scheduling

Report Form Displays the type of report scheduled (form) and initial/follow-up status
(e.g. "Initial Report" or "Follow-up #3").

Submitted Date Displays the report's submission date.

Case Del. Date Displays the date when the case was deleted.

Blind Study Enables you to mark the study product as blinded.

Product

Print All Submitted Enables you to print all the submitted reports.

Reports

Export Enables you to export the report.

Print List Enables you to print the report as a PDE.

9.1.1.43 Unsubmitting Reports Cases that are archived while unsubmitting reports can
be reopened from the Archived Case dialog.

Use the following procedure to unsubmit such cases.
1. Enter the password and notes required in the Archived Case dialog box.

2.  When the system opens the Report Unsubmit dialog box, enter the reason for
unsubmitting the report and click OK.

3. The system unsubmits the report.

Tip: The icon (displayed in the lock state column) in the Reports->
Compliance - Expedited and Submitted screens denotes a SUSAR
case.

9.1.1.44 Lock State Header Options Click the Lock State header row. A pop-up appears
listing the following sorting options:

= Lock State

= SUSAR

s Exp/Per

These options enable you to sort cases based on the case categorization.
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9.1.2 Aggregate Reports

Argus Safety has powerful system reporting capabilities that enable you to monitor
the following:

= Product safety profiles
= Case progress
s Company productivity during the case handling process

This section provides information about the Argus Aggregate Reports.

To view an aggregate report
Select Reports --> Aggregate Reports --> <Report Type>. P

9.1.2.1 General Usage Information
When using Aggregate reports, be aware of the following:

s The date and time printed on the following reports are the date and time the query
is executed for case qualification. They are not the date/time the query was
completed and the report obtained Web Server.

»  Case Listing Report
s Case Data Analysis Report

s The system converts the following elements that display in the case form as actual
text on the Case Listing and CIOMS II Line Listing reports:

s Duration of Administration
» Time Between First Dose/Primary Event
» Time between Last Dose/Primary Event

= Another field has been added to the Regulatory Reports section for the report
follow up number. The system prints the report follow-up number on the
expedited reports in the following format:

F/U#X

where:

X is the report follow-up number.

s For an initial report, the system prints initial in the column.

»  If there are no reports for the case in the Case Listing/CIOMS II Line Listing, the
column is left blank.

s This option is available on the CIOMS II Line Listing/Case Listing reports.

= The system uses the IE offset of the client workstation to print the date and time
component for all system-calculated fields on the Case Listing/CIOMS II Line
Listing reports for the following fields

Table Name Column Name Local IE Adjustment
case_master close_date Yes
case_master date_locked Yes
case_routing route_date Yes
cmn_reg_reports date_approved Yes
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cmn_reg_reports DATE_GENERATED Yes
cmn_reg_reports date_scheduled No
cmn_reg_reports date_submission_determined Yes
cmn_reg_reports date_submitted Yes
cmn_reg_reports date_xmt Yes
rpt_routing route_date Yes

You can filter cases in the following aggregate reports based on the lock/archived
date:

Case Listing
Case Data Analysis
CIOMS II Line Listing

When you select Case Locked/Archived date, the system limits the cases based on
whether the case is locked/archived within the specified time frame.

The lock date is considered the locked date.

If you select the Case Patient or Reporter Information in the Case Listing or
CIOMS II Line Listing reports and the Protect Confidentiality field is checked for
the patient or reporter Information, the system does not print the relevant patient
or reporter Information selected in the Case Listing or CIOMS II Line Listing
report.

If you do not have permission to view the reporter or patient information, the
corresponding reporter or patient elements selected on the Case Listing or CIOMS
I Line Listing report are blank.

If the report doesn't have cases that meet the criteria, the system prints the PDF with a
"No data found" message.

9.1.2.2 Using the System Reports Library

You can access the System Reports Library from Reports --> Aggregate Reports -->
System Reports Library.

When using the System Reports Library, be aware of the following:

The user can use the following fields to query all memorized reports:
— Report Name (type ahead)
—  Description (type ahead)
- Report Type (type ahead)
- Case Data Analysis
- CIOMII Line Listing
- Case Listing
Author (type ahead)
Last Modified
— Date (date text box)
— Upgrade populates this with System Date
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Avail. for Periodic (text box)

Blank
Yes
No

Shared (text box)

Blank
Yes
No

The user can enter wildcards in Name and Description fields.

The following are in Search and Navigation bar:

Displaying Records Drop-down list (standard functionality)
Page Size Drop-down list (standard functionality)

Back Button (page back standard functionality)

Forward Button (page forward standard functionality)
Search Button (executes the search with any entered criteria)

Clear Button (clears the search drop-downs or text boxes)

The system displays the following columns on the screen:

Report Name - The report name given by the user.

Description - A description of the report as defined by the user.

Report Type - The report type.

Author - The name of the author of the report.

Last Modified - The date the report was last modified. This is the system date.

Avail. for Periodic - Indicates whether the report is available for Periodic
reports

Shared (See System Rule below)

The system displays the following buttons on the page:

Copy
Delete

Open
Execute (standard functionality)
Export

Transmit

When the user clicks the Filter icon, he/she can filter on any element.

The system provides the type ahead feature to enable the users to filter on any
text element.

When the user clicks X, the system closes the filtering options.

When the user specifies filtering criteria, the filter icon changes to the paper
clip icon to indicate that filtering criteria has been specified.
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— The system permits the user to conduct a like search, For example, if user
searches for "Cure" the system returns all elements beginning with Cure.

— The system permits the user to conduct wildcard searches. For example, if the
user searches for "%Cure," the system returns all elements containing Cure.

—  When the user clicks Search, the system filters reports in the report list.
The system saves all user preferences for future use.

The following fields word wrap, but do not scroll:

- Report Name

—  Description (200 Characters)

If a record in a row is available for periodic reporting, the system places a Yes in
the Avail. for Periodic column; otherwise the system displays No in the column.

—  The user must select the available for periodic reporting option when he/she
creates the report.

If the system report is shared, the system places a Yes in the Shared column;
otherwise it displays No in the column.

— The user must set the report creation or modification options when he/she
creates the report.

The user can click the column heading to sort the column in ascending or
descending order.

— Report Name is the default sort column and is sorted in ascending order.
- Ascending (A to Z, 1&emdash;10, etc.) is the default sort order.

- A sorted column has an up or down arrow to indicate whether the column is
sorted in ascending or descending order.

When the user clicks Copy, the system displays a copy of the report in the
appropriate popup. The system displays the Case Data Analysis Report, the CIOM
IT Line Listing Report, or the Case Listing Report.

—  The system names the copy of the report Copy of xxxxxx
where:
The system displays the following columns on the screen:
xxxxxx is the name of the report the system is copying.

If there are too many characters in the report name, the system truncates the
name.

When the user clicks Delete, the system displays the following message:
Are you sure you want to delete?
- If the user clicks Yes, the system deletes the selected row.
—  If the user clicks No, the pop-up window closes and nothing changes.
— If the report is in use, the system displays the following message:

The report which is selected is being used and cannot be deleted.

When the user clicks Open, the systems displays the appropriate Report pop-up
box:

— If the has not selected a row, the system disables the Open button.
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— The system determines the appropriate dialog box based on the report type.

*

If the user selects a Case Data Analysis report, the system displays the
Case Data Analysis popup.

If the user selects a CIOMS II Line Listing report, the system displays the
CIOM II Line Listing popup.

If the user selects a Case Listing report, the system displays the Case
Listing popup.

- If the selected report is in use, the system displays the following:
The report which is selected is being used by XXXX and cannot be modified.
where:
XXX is the full user name of the person using the report.
= When the user clicks Execute, the system generates the selected reports.
— If the user has not selected a row, the system disables the Execute button.

— The system creates and displays the report in PDF format just as it does when
the user clicks OK on the individual report pages.

= When the user clicks Export, the system generates the selected report and starts
the export process (i.e., CSV file download).

— If the user has not selected a row, the system disables the Export button.

s If the user clicks Transmits, the system generates the selected report and starts the
transmit process.

— The system displays the Recipient popup.
— If the user has not selected a row, the system disables the Transmit button.

s The Memorize button in the System Report dialog enables the user to enter the
memorize details in the report configuration options.

—  If the user fails to enter the Name in the memorize section, the system disables
the Memorize button.

*

Case Listing
*  CIOMS II Line Listing

*  Case Data Analysis
9.1.2.3 About Case Data Analysis Reports

The Case Data Analysis Report enables you to view quantities of cases over time in a
Cross-Tabular Fashion. Use the following procedure to create a Case Data Analysis
report. The following is an illustration of a Case Data Analysis Report.
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9.1.2.3.1 Creating a Case Data Analysis Report Use the following procedure to create a
Case Data Analysis report.

To create a Case Data Analysis Report
1. Select Reports --> Aggregate Reports --> Case Data Analysis.

2. In the Case Data Analysis Report view, select the information that must appear in
the report.

In Rowl, select the field the system uses to group cases by row.

In Column1, select the data the system uses to group cases by column.

In Row?2, select the field by which each Row1 item will be categorized.

In Column2, select the field by which each Column1 item will be categorized.

Select a product family to which the report applies, if appropriate.

©® N o g

In Selection for Row1, select the value for row 1 by which the report must be
restricted.

9. Specify an advanced condition, as appropriate.

10. Select Report Number of Cases or Report Number of Events, depending on the
number of cases or the number of events to be entered in the report.

11. If you select Report Number of Events, you can specify the kind of events (serious
listed, non-serious listed, serious non-listed, or non- serious non-listed) that will
appear in the report.

12. Select whether only the top few items should be displayed and enter the number
of items that should be displayed.

13. Select the Show % of Total check box to specify the percentage in each cell in the
report.

14. Select the Blinded check box to hide blinded information in the report.

15. Select the Use Case Search Results checkbox to limit the Case Data Analysis only
to the cases present in the Case Search dialog.

16. Specify a date range for the cases that will appear in the report.
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17. 1In Report Type, select whether the report is to be printed in text (data) format or
in graphical (chart) format.

If you select Chart, you can specify the kind of chart (bar graph, line chart, etc.)
that will be used to display the information.

18. Enter a title for the report.

9.1.2.3.2 Memorizing the Criteria Specified for a Particular Report. To memorize the criteria
for a specific report

1. Click Memorize to open the Memorized Report dialog box.
2. Click Save.

9.1.2.3.3 Saving, Deleting, or Cancelling a Report Use the following procedure to save,
delete, or cancel a report, as applicable.

To save, delete or cancel the report, as applicable
1. Click OK in the Case Data Analysis screen to generate the report in PDF format.

2. To export a report in CSV format, click Export.
3. To transmit a report using Argus Safety Service, click Transmit.

4. To delete a report, click Delete.

9.1.2.4 About CIOMS Il Line Listing Reports

The CIOMS 1I line listing report is a common format desired by Drug Safety
professionals for reviewing cases. Create this report from the CIOM II Line Listing
dialog box shown in the following illustration.
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9.1.2.4.1 Creating a CIOMS Il Line Listing Report Use the following procedure to create a
CIOMS II Line Listing report.

To create the CIOMS Il Line Listing report

1. Select CIOMS II Line Listing from Reports -->Aggregate Reports --> CIOMS II
Line Listing.
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2. Onthe CIOMSII Line Listing Criteria tab, select information for the header, footer,
product family, advanced condition (if any), cases to include, and date.

3. Select either the Case Creation Date or Case Receipt Date radio button and
specify a date range to run the report.

Note: If you perform a search and return a list of cases to the Case
Search screen, the Use Case Search Results is visible. Checking this
box will disable all selection criteria with the exception of "Include
Unlocked Cases". For example, the Advanced Condition and Date
Range will be disabled.

4. In the Line Listing tab, add or remove the appropriate fields.

5. In the Grouping tab, add or remove elements, insert a page break and change the
sort order (if desired).

6. Click Memorize to open the Memorized Report dialog box.
7. Save, Delete or Cancel the report, as applicable.

8. Click OK in the CIOMS II Line Listing screen to generate the report in PDF
format.

9. Click Export to export a report in CSV format.

10. Click Transmit, to use Argus Safety Service to transmit a report.

9.1.2.5 About Case Listing Reports

The Case Listing Report enables you to filter cases based on Case Initial Receipt Date
and Case Creation Date. You can select multiple entities from the List of available
fields using the CTRL+CLICK functionality. The following is an illustration of the Case
Listing dialog box.
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Creating a Case Listing Report
Execute the steps below to create a Case Listing report:

1. Select Reports --> Aggregate Reports --> Case Listing.

2. When the system opens the in the Case Listing Reports view select the
information to appear on the report.

Select the fields that are to appear in the report from the Available Fields list.
Click Add. Repeat this process for each field that must appear in the report.
Use Move Up and Move Down to arrange the fields in the Selected Fields list.
Select the Blinded checkbox to hide blinded information in the report.

Specify an Advanced Condition, if appropriate.

Specify a date range for the cases to be displayed in the report.

© ® N o o & o

If you select the Include in Header check box, the selected date range is displayed
on the report.

10. Under Sorting Order, select the fields by which the cases will be sorted. The first
field allows you to create a list that is sorted with respect to that particular field.
Groups of cases that are identical with respect to the first field can be sorted by
specifying the second field.

Note: You cannot sort the cases by fields that do not appear on the
report.

11. Enter the title of the report.

12. Click Memorize to memorize the criteria specified for a particular report. The
Memorized Report dialog appears.

13. Save, Delete or Cancel the report, as applicable.

14. Click OK in the Case Listing Reports screen to generate the report. The report will
be generated in PDF format.

15. To export a report in CSV format, click Export.

16. To transmit a report using Argus Safety Service, click Transmit.

9.1.2.6 About System Reports Library

The System Reports Library / Memorized Reports enables you to recall a memorized
Case Listing, CIOMS II Line Listing or Case Data Analysis Report criteria. You can
save (memorize) search criteria and reuse these criteria when generating future
reports.

The Memorized Reports dialog displays current user reports as well as reports that
are shared by all users. Use the following procedure to create Memorized Report.

To create a Memorized report

1. Select Reports --> Aggregate Reports --> System Reports Library to open the
Memorized Report dialog box.

2. Select a memorized report and click Open.
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3. Click the Share this report with other users check box to make the report criteria
available to all users. Previously memorized reports appear in the Your
Memorized Reports list.

4. Click Delete to delete a selected memorized report.

5. Select the Make available for use Periodic Reports check box to use this report in
periodic reports like PSUR, CTPR, IND, and NDA.

Note: A shared report can only be deleted by the Administrator or
the user who created it.

9.1.2.6.1 General Usage Information When using the System (Memorized) Reports, be
aware of the following.

= The following Line Listing Available fields functionality boxes have been
updated:

- Reports > Aggregate Reports > CIOMS II Line Listing, (Line Listing tab) to
allow select fields.

- Reports > Aggregate Reports > Case Listing to allow the user to select fields.
- Reports > Aggregate Reports > Case Data Analysis.

m A tree view, similar to the advanced condition tree view, has been created for the
available fields. The fields are the same as those currently displayed and the field
text box is read-only.

= If you select a field from the tree view and adds it to the Selected Fields list, the
system removes the field from the Available Fields list.

» If the you try to add the field again, the system displays a message and displays
the name of the selected field inside brackets ([ ] ). If you wish to remove the
selected field, click Yes.
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Reports: Periodic Reports

This chapter contains detailed information about Argus periodic reports and how to
create and use them.

10.1 Periodic Report Types

This section lists the different Periodic Reports in Argus and discusses about each of
them in detail. Place the cursor over the Periodic Reports option in the Reports tab to
go to any of the Periodic Reports.

You can create four kinds of periodic reports:
»  Clinical Trial Periodic Reports

s ICH PSUR Reports

s USIND Periodic Reports

= US NDA Periodic Reports

10.1.1 Storing Periodic Reports in Documentum

Argus Safety enables you store your Periodic Reports in Documentum.

When you approve an expedited report from within Argus, the system exports the
report as a PDF file and saves it in the Documentum database by Argus Safety Service.
From this point, you can perform document reviews within the Documentum system.

When the report is ready to be submitted, mark the report as submitted from within
Argus. Argus Safety Service updates the status of the report within Documentum to
Submitted.

If the report is to be transmitted via fax or email, Argus Safety Service marks the report
as a successful submission in Documentum only after the fax or email transmission
has succeeded.

10.1.2 Viewing a Summary of Periodic Regulatory Reports

You can select any of the following options in viewing the summary of a periodic
regulatory report:

»  To view the regulatory reports for a particular case (scheduled, generated, and
submitted), open the Regulatory Reports tab of the Case Form.

» To view all scheduled, generated, and approved reports, as well as other
outstanding action items assigned to you or your user group, select Reports in the
Worklist menu.
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To view a list of all scheduled, generated, and approved periodic reports, select
Periodic Reports from the Reports | Compliance menu.

10.1.3 Using the Library Page

The periodic reports have a library page for the following reports:
PSUR

CTPR

IND

NDA

The following table lists and describes the fields on the Library Page:

Field/Control Name Purpose

Category Enables the user to view the report Category.

Sub Category Enables the user to view the report Sub Category.
Report Name Enables the user to view the name of the Periodic Report

Inclusion Start Date/Stop Date  Enables the user to view the report start and stop dates as

defined in the configuration.

DRAFT/FINAL Enables the user to view the draft and/or final report

Author Created Enables the user to view the name of the author who created
the report.

Date Created Enables the user to view the date the report was created.

Date Modified Enables the user to view the date the report was last
modified.

Justification Enables the user to view the justification for updating the
report.

Search

Clear

The system displays the standard Justifications dialog that
contains the lasts justification entered by the user.

When the user clicks Search, the system initiates the search
operation. When the system displays the search results, the
user can enter search parameters in various fields and click
Search to narrow the search results.

Enables the user to clear user-entered data from the fields

When using the Library Page be aware of the following:

The system places the total number of records displayed on the library page in the
Total Number of Row (x) read-only field in the Report header.

The user can select the number of cases to display from the Page Size drop-down

list.

The page size drop-down list contains the following values:

50
100 (default)
250
500

Reports: Periodic Reports 10-2



Periodic Report Types

- 1000
- 2000

s The system displays the number of reports currently in view and the system
automatically updates the range based on the selected page size. For example, if
the user selects a page size of 100, the system displays reports in groups of 100.

s The user can go directly to a range of cases from the Displaying Rows drop-down
option.

s The user can scroll through the reports page-by-page in increments as defined in
the Page Size drop-down list.

s The user can sort on all columns in the Reports view by clicking the column
header. The system displays an up arrow or a down arrow depending on whether
the column is sorted in ascending (A-Z, 1-10, etc.) or descending order (Z-A, 10-1,
etc.).

s Initially, the reports are sorted by Category.
s The default sort order is ascending.

= When you click the Filter icon, the system displays the filtering row to enable you
to filter on any element.

= The type ahead feature enables you to filter on any element except Draft/Final.
s Click the appropriate icon to minimize the filtering options.
s Click the X to close the filtering options.

s If filtering criteria is defined, the system displays the filtering elements icon to
indicate that filtering elements exist.

s If filtering criteria is not defined, the system displays the no filtering elements icon
to indicate that no filtering elements are defined.

= The system enables you to perform a like search. For example, if the user searches
for Cure, the system returns all elements that start with Cure.

»  The system enables you to perform wildcard searches. For example, if the user
searches for %Cure, the system returns all elements that contain Cure.

= When you click Clear, the system clears the filtering criteria from the fields.
s Clicking the filter icon enables you to filter for reports in the list of reports.

= The system saves all user preferences for future use. If the user has already entered
filter elements, the system displays the filter details for the last search when it
displays the dialog.

10.1.4 About CTPR: Clinical Trial Periodic Reports

The Clinical Trial Periodic Reports (CTPR) are created to report the IND Annual
reports and EU Clinical Trial Directive line listing reports to FDA.
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To create Clinical Trial Periodic Reports

1. Select Reports --> Periodic --> CTPR (Clinical Trial Periodic Reports) to open a list
of CTPR Reports.

2. To create a new report from an existing report in the list, click Copy or Modify.

3. Click New Report to create an entirely new report. The Clinical Trial Periodic
Reports dialog opens.

4. Enter an appropriate name for the report under Report Name.

5. Use the tabs in this dialog to configure the CTPR.

10.1.4.1 General Usage Information
When using the CTPR, be aware of the following;:

= The system enables you to group cases as per the options provided in the
drop-down list. Example: by Product Name or by Drug Regimen Frequency:

s Product Name

— This option enables you to group the Product Name - Formulation -
Concentration with Units when the elements are separate with a hyphen ( - ).

— If an element is missing, the system does not print the hyphen ( -).
— The system groups the cases based on the primary drug in the report.
= Dosage Regimen Frequency

—  This option enables you to group the frequency of the primary dosage
regimen for the primary drug in the report.

—  The system prints Frequency: followed by the frequency as defined above.

= You can select datasheets for specific report types similar to the CTPR Report for
the Inclusion criteria. If you select any rows in the inclusion criteria, the system
disables the Datasheet selection dialog.

= Report Type.This portion lists the report types (configured in Code List | Report
Type) the report will be run against (LM_REPORT_TYPE). The user must select a
report type so the system knows to save the criteria row.
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Serious Criteria.This enables you to specify the seriousness of the cases for the
selected report type as follows:

— Serious: Case Level or Primary Event is Serious.

— Non-Serious: Case Level or Primary Event is Non-Serious.

- If you select both Serious and Non-Serious, the system ignores the criteria.
— Fatal: At least one event has a Fatal event outcome.

- Non-Fatal: No events have a Fatal event outcome.

- If you select both Fatal and Non-Fatal, the system ignores the criteria.
Listedness.

— When using the case level assessment, the system does not consider the
datasheet. Cases appear in the CTPR if the case level assessment matches the
selected criteria.

- When using the primary event assessment in conjunction with a datasheet, the
system uses only the As Determined listedness for the primary event when
determining whether a case should be included in the CTPR report.

- If both Listed and Unlisted are selected, the system ignores the criteria and
includes all listedness values (including Unknown).

Datasheet.This enables you to specify which Datasheet to use when looking for
Listedness (LM_DATASHEET). The system uses the datasheet criterion only when
you select the primary event assessment as the CMN_PROFILE assessment.

When you select the <ALL> datasheet option, the listedness for the primary event
on at least one datasheet must match the selected criteria.

Related /Non-Related.

— When using case level assessment, cases appear in the CIPR when the case
level causality matches the selected criteria.

— When using the Primary Event assessment, cases appear only if the causality
for the primary event as reported or as determined matches the selected
criteria.

— When using the All Events assessment, cases appear if any case events with as
reported or as determined causality match the selected criteria.

- If you select both Related and Non-Related, the system ignores the
related /non-related criteria.

HCP/Non-HCP. To have a case included in the CTPR, you must identify at least
one case reporter as a HCP or Non-HCP. If this is being used in conjunction with
the Primary Reporter Only checkbox, the system evaluates only the primary
reporter for this criterion.

Primary Reporter Only. This enables the system to perform the HCP/Non-HCP
check against only the primary reporter. This updates the entire configuration
whether checked or unchecked.

You can copy an existing template by clicking the Create from Template button on
the CTPR reports list.

When you click Create from Template, the system displays the Create from
Template dialog.
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= You can choose the CTPR Group Name (as configured in the Product Name
configuration) from a type ahead field.

= When you enter the CTPR Group Name in the Select CTPR Group Name field
and the From and To dates in the Create from Template dialog and click OK the
system does the following:

Saves the CTPR Configuration with the new dates.

Replaces the products in the list of selected products with all products as
defined for the selected CTPR name.

Replaces the periodic report name in the newly configured periodic reports
with a new name in the following format:

XXXX: YYYY to 2277

where:

XXXX is the selected CTPR Name.

YYYY is the From Date entered by the user.
2777 is the To Date entered by the user.

Replaces the date ranges for the From and To date fields only for the Periodic
Report.

Bases the remaining configuration, including the security permissions, on the
selected CTPR template.

= When you enter the CTPR Group Name in the Select CTPR Group Name field
and the From and To dates in the Create from Template dialog and click Print and
Save, the system does the following:

Saves the CTPR Configuration with the new dates.

Replaces the products in the list of selected products with all products as
defined for the selected CTPR name.

Replaces the periodic report name in the newly configured periodic reports
with a new name in the following format:

XXXX: YYYY to 2277

where:

XXXX is the selected CTPR Name.

YYYY is the From Date entered by the user.
2777 is the To Date entered by the user.

Replaces the date ranges for the from and to date fields only for the Periodic
Report.

Calls the Report Batch Printing dialog.

Bases the remaining configuration, including the security permissions, on the
selected CTPR template.

10.1.4.2 Common Tab Fields

The Report Name, Report Category and Report Sub-Category fields are common to
all tabs of the Reports.

The following table below describes these fields:
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Field Description
Report Name Enter a name for the Report. The name entered here is displayed in the

Reports menu.

Report Category Select a category for the Report. This is displayed in the Reports menu.

Tip: Select New to define a subcategory within the report category.

The Periodic Report Category dialog is displayed.

Enter a category name in Category and click OK.

The category is entered in the Report Category drop-down list.

Report Sub Category  Select a subcategory for the report.

Tip: Select New to define a subcategory within the report sub-category.

The Periodic Report Category dialog is displayed.

Enter a category name in Category and click OK.

The category is entered in the Report Sub-Category drop-down list.
10.1.4.2.1 Subject of Report Tab The Subject of Report tab is used to configure the
report header and to specify the agency, products, etc. for which the CTPR is
applicable.
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The following table lists and describes the fields on this tab.
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Field

Description

Available Reporting
Destination

Primary Agency

Selected Reporting
Destination

Report #
Report Title

Ingredient

Trade Name

International Birth
Date

Report Footer

Print all
configuration criteria
on separate cover

page

Print page numbers
on reports

Displays the list of configured Regulatory Agencies. Select an agency
from the list displayed in Reporting Destination and click Add to add
the report to the Selected Destination list.

Select multiple agencies by holding the CTRL key when you click
them.

Likewise, select an agency from the Selected Destination list and click
Remove to remove it from the selected destination.

Select the primary agency for the report.
Note: When you submit a Periodic report, it goes to the selected
Primary Agency.

Displays the list of agencies where the report is being sent. Select an
agency from the list displayed in Reporting Destination and click Add
to add the report to the Selected Destination list.

Select multiple agencies by holding the CTRL key when you click
them.

Likewise, select an agency from the Selected Destination list and click
Remove to prevent it from being sent to the selected destination.

Enter a report number for this report
Enter a report title for this report

Automatically displays the "Ingredient” as provided in the Subject of
Report dialog.

Note: You can choose whether to view this field or not. Click the
checkbox displayed with this field to hide or view it.

Automatically displays the "Trade Name(s)". Multiple trade names are
also displayed together, separated by commas.

Note: You can choose whether to view this field or not. Click the
checkbox displayed with this field to hide or view it.

Automatically displays the earliest license awarded date, when a user
selects an Ingredient and a Product.

Note: You can choose whether to view this field or not. Click the
checkbox displayed with this field to hide or view it.

Enter the footer for the report

Mark this box to print out the configuration of this report when the
report is printed. This is only available when PDF option is selected
during printing.

When checked, this option enables the user to print page numbers on a
periodic report. This is the default for all report configurations.

If this checkbox is not checked, the following occur.

s The "Include Periodic Page Numbering" option in the CTPR
Summary Tabulations CIOMS Report section is inactive and
grayed out.

»  The "User Periodic Numbering on the report" option on CTPR
Summary Tabulations FDA CTPR support section is grayed out
and inactive.

= The "Additional Separate Page Numbering for UD Summaries"
option on the CTPR UD Summaries tab is grayed out and inactive.

»  The system removes all existing report page numbering and the
option to check page number check boxes on the report
configuration tabs are grayed out and inactive.
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Field

Description

Allow access to
report cases through
Hit List

When the report is run as final, it creates a Hit List, which can be
retrieved from other areas of the application where advanced
conditions can be selected. Click this checkbox to report cases through
the Hit List.

10.1.4.2.2 Product Selection Tab The Product Selection tab enables you to select the
products included in the CTPR report.
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The following table lists and describes the fields on the Product Selection tab.

Field

Description

Available Ingredients

Filter
Selected Ingredients

Available Countries

Selected Countries

Indication

Displays the list containing the Ingredients used for the product
configuration. Select an ingredient from the list displayed in Available
Ingredients and click Add/Remove to add/remove the ingredient.

You can select multiple ingredients at a time.

Enter an Ingredient name and click Filter to search for the entered
ingredient within the Available list of Ingredients.

Displays the list of ingredients selected from the Available Ingredients
list.

This list is auto-populated and displays only the countries with a
license containing the ingredient selected from the Available
Ingredients list.

Displays the countries selected from the Available Countries list.

This list contains the Indication configured for the product containing
the ingredients in the Available Ingredients section. The selections
made from this list get displayed in the Available Products section.

Note: You can select multiple Indications from the list at a time by
pressing the CTRL key and clicking the different Indication entities.
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Field

Description

Formulation

This list contains the Formulation configured for the product
containing the ingredients in the Available Ingredients section. The
selections made from this list get displayed in the Selected Products
section.

Note: You can select multiple Formulations from the list at a time by
pressing the CTRL key and clicking the different Indication entities.

10.1.4.2.3 License/Study Tab The License/Study tab is used to configure the report
header and to specify the agency, products, etc. for which the CTPR will be applicable.
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The following tables lists and describes the fields on the License/Study tab.

Field

Available Licenses

Selected Licenses

Available Studies

Selected Studies

Description

Contains licenses that use the ingredient selected in the Ingredient
field. This field is automatically populated when an ingredient has been
selected.

Displays the licenses selected from the Available Licenses list by
clicking Add/Add All. You can select Licenses that are related to
different ingredients for a report.

Contains studies that use the ingredient selected in the Ingredient field.
This field is automatically populated when an ingredient has been
selected.

Displays the studies selected in the Available Studies list by clicking
Add/Add All You can select studies that are related to different
ingredients for a report.

10.1.4.24 Inclusion Criteria Tab The Inclusion Criteria tab allows you to select search
parameters for inclusion of cases in a periodic report.
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The top section of the dialog allows you to specify the type of cases that will be
included in the periodic report.

The following table lists and describes the fields on the Inclusion Criteria tab.

Field

Description

Case Creation Date

Case Receipt Date

Case
Locked/Archived
Date

Use Current Version
Use DLP Version
Age Groups

Restrict Cases to
countries where
studies are active

Allows you to specify a range of cases by the date when the case was
created.

Allows you to specify a range of cases by the initial receipt date.

Note: The Date Range is only available when an unscheduled CTPR is
being created. You must specify only one date range out of Case
Creation Date and Case Receipt Date.

Allows you to specify the date when the case was locked /archived.

Allows you to use the latest revision to populate the data within the
selected reports.

Allows you to use the case data of the version as of the specified DLP
Version.

Allows you to include or exclude cases based on the patient's age
group. Select all the age group categories that apply.

References study configuration to determine if the case was submitted
during the dates the study was active.

Note: This option is available only if a study is selected from the
Available Studies section in the License/Study tab.

It should not be used for Centrally approved products (CAP), which
only have an EU license.
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Field Description

Advanced Condition Allows you to specify an advanced condition that must be satisfied by
each case that is included in the report. Ensure that the advanced
condition or the advanced condition query set that is specified here
does not contradict any other criteria specified in the dialog.

Datasheet for Select the Datasheet to look against for Listedness when running the

Listedness report.

Use Assessment in
Cases

Re-assess cases
against datasheet in
effect at the
beginning

Re-assess cases
against datasheet in
effect at end

Reference Type
(Clinical Reference
Data Element)

Expeditable Only

Exclude Follow-up
cases

Include Unlocked
Cases

Use Datasheet
Assessment for UDF
Tabulations

Add Cases not
included in previous
reporting period

Note: Select the ALL datasheet to use the most conservative listedness
for the primary event, or the Case Listedness for the tabulation.

When selected, the CTPR Report will use the Case Event Assessment
when performing datasheet listedness calculations.

When selected, the CTPR will re-assess the cases in the line listing
based on the Active Datasheet on or before the Start Date of the
Reporting period.

When selected, the CTPR will re-assess the case in the line listing based
on the Active Datasheets on or closest to the end date of the CTPR
Reporting end date range without exceeding that date.

Select the reference type to be displayed on the Main Listing if Clinical
Study Reference is selected as a Data Element in the Available Data
Elements section of the Line Listing tab.

This option is enabled only when an agency has been specified on the
Subject of Report tab. Check this option to include only those cases
that have submitted expedited reports to the specified Primary Agency.

Follow-up cases are cases with a significant follow-up in the Clinical
Trial reporting period where the initial receipt date is in a prior period.
Check this option to exclude follow-up cases from appearing on the
Clinical Trial report.

Check this option to allow cases that have not been locked for reporting
to appear on the report.

Allows you to select datasheet for a report to make UDF tabulations.If
no datasheet is selected, the most conservative listedness is chosen, i.e.
Unlisted followed by Listed.

Allows you to add cases which were not included in the previous
reporting period.

You can enter the start date of the period in the Start Date field.

10.1.4.2.5 Using the DLP Version DLP primarily uses two processes:

s Next Case Revision

s Last Case Revision

DLP Options

Be aware of the following DLP Options.

= Last Completed Version -- This option always uses the case version with the last
lock that existed prior to the DLP or "As of reporting” date. This option does not
enable data cleaning

Note: DLP saves only the last revision when multiple saves are performed in the
same job session.
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= Next Completed Version -- This option uses the current case lock or the next
following case lock if the case version was initiated prior to the DLP or the "As of
reporting” date with two exceptions:

If there is no case lock for the current version that was received prior to the
DLP, the last (current) case revision is used.

If there is a case version after the case lock that was created for the purpose of
data cleaning, it is to be used instead of the first locked case revision.

If there are multiple contiguous case versions following the first case lock for
the purpose of data cleaning, the last case data cleaning version is used.

Note: The Data Cleaning option is only available with the DLP
option Use Next Completed Version (Includes Data Cleaning).

10.1.4.2.6 Dates for Using DLP/"As of reporting" Function You can perform DLP queries for
the following:

= Receipt Date -- date entered by the user during case creation

= Initial / Follow up Receipt Date

= Safety / Safety Follow up Receipt Date

= System Date (Case Creation Date) - date the case was physically entered

10.1.4.2.7 As of Reporting Function The as of reporting function returns the same case
version results as the DLP Options, with the only difference that the date depends on
the "as of date" instead of a DLP date.

10.1.4.2.8 Availability of DLP/As of query functionality The DLP / as of query functionality
is available in the following application modules:

»  Periodic Reports

PSUR including all User defined Tabulations and expedited reports within the
Periodic Report

CTPR including all User defined Tabulations and expedited reports within the
Periodic Report

IND including all User defined Tabulations

NDA including all User defined Tabulations and expedited reports within the
Periodic Report

= System Reports

CIOMS II Line Listing
CDA Reports
Case Listing Reports

10.1.4.2.9 Line Listing Tab The Line Listing tab contains the following fields and
sections:
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Field

Description

Include Line Listing

Blind Line Listing
and Summary
Tabulations

Allows you to select whether you want the Line Listing Data Elements
printed with the CTPR Report.

Hides the selected listings from being displayed

10.1.4.2.10 Available Data Elements A number of optional fields are available in the
Available Data Elements frame. Select the check box associated with a data element to
add the data element to the report. Be aware of the following;:

= By default, the system print s unavailable fields on the report, and they cannot be

changed.

= Required data elements are printed as columns in the report. The optional data
elements are printed as separate rows below the column data for each case.

Refer to the following table for a list of data elements on this tab.

Data Element Notes

As Determined Causality Optional.
As Determined Listedness Optional.
As Reported Causality Optional.

Case Abbreviated Narrative

Case Classifications

Case Central Safety Date

Case Comment Text

Required and multi-language available.

Multiple classifications are displayed in separate
lines.

Optional.
Optional.
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Data Element Notes

Case Initial Receipt Date Optional.
Case Listedness Optional.
Case Narrative Optional.
Case Number Required.
Case Outcome Required.
Case Report Type Required.
Case Seriousness? Optional.
Clinical EUDRACT # Number Optional.
Clinical Study Reference Optional.

Company Agent Causality

Country of Incidence

Death Cause

Death cause as reported
Death Cause HLGT

Death Cause HLT

Death Cause LLT

Death Cause SOC

Dosage Regimen Batch/Lot #
Dosage Regimen Daily Dose
Dosage Regimen Duration
Dosage Regimen Frequency

Dosage Regimen Route of
Administration

Dosage Regimen Start Date/Time

Drug Dechallenge?

Product Indication
Product Indication HLGT
Product Indication HLT
Product Indication LLT
Product Indication SOC

Drug Rechallenge?
Event Description as Reported

Event Onset Date/Time

Optional. Displays event causality from product
name. Multiple causalities are displayed in separate
lines.

Required.
Optional. Multi-language available.
Optional
Optional.
Optional.
Optional.
Optional.
Optional.
Required.
Required.
Required.
Required.

Required. For the selected product the report is
based on. List for all dose regimens.

Required.

Optional. For the selected product the report is
based on.

Optional. For the selected product the report is
based on.

Optional. For the selected product the report is
based on.

Optional. For the selected product the report is
based on.

Optional. For the selected product the report is
based on.

Optional.
Required.
Required.
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Data Element Notes

Event Preferred Term Required.
Lab Data - Tabular Optional.
Literature Author Optional.
Literature Journal Optional.
Literature Pages Optional.
Literature Title Optional.
Literature Volume Optional.
Literature Year Optional.
Literature reference Optional.
Outcome of Event Optional.
Patient Age Required.
Patient Gender Required.
Patient Initials Optional.

Patient Relevant History
Patient Subject #

Product Name

Product Name Report Inclusion

Report Comment
Study ID

Study Other ID
Study ID Protocol #

Optional. Multi-language.
Optional.

Optional. Displays "product name (generic name)
product type, formulation, concentration unit" "daily
dose," "dose dose_freq, route"

Optional. Prints the Products that were part of the
CTPR Report for the case.

Displays "product name (generic name) product
type, formulation, concentration unit" "daily dose,"
"dose dose_freq, route"

Optional.
Optional.
Optional.
Optional.

10.1.4.2.11  Selected Data Elements This section lists the selected elements and enables
you to arrange the order in which these are to be printed. Click the Up or Down
buttons to arrange the listed elements above or below in order of priority.

Options

Field Description

MedDRA Hierarchy  Select Cases to populate the data from the case data. Select Dictionary
from to populate the data from the MedDRA dictionary.

Cases/Dictionary

Print Only the Term  Prints only the event Preferred Term (PT) or event Lower Level Term
(Preferred Term or (LLT) as per the selected radio button. Select the PT option to print only
Lower Level Term) the preferred term and not the verbatim description.

Print Dose Text in

Prints the dosage and frequency information from Dose Description

place of regimen dose field instead of Regimen Dose.
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Field

Description

Indicate if case was
expedited previously

English Language

Local Language

Print event info
(Serious, Un-listed,

Related) as Column

List cases only once,

under the primary
event

List cases under all

events, details under

the primary event

Print Product
Indication for the
product selected in
the report

This checkbox is selected if a primary agency has been selected in the
Subject of Report tab. Cases for which an expedited report was
previously submitted to the selected authority are marked with an
asterisk.

Provides the option to print the descriptions in English

Allows a user to specify which Local language for a multi-language
field is to be printed i.e. the Abbreviated Narrative field.

Select this check box to print the Seriousness, Listedness and Causality
under the Event Verbatim column.

Note: Events having listedness of "Unknown" are considered
"Unlisted." If only diagnoses are assessed for event assessment, the
events which are associated with a Diagnosis but have been marked
with Diagnosis as "Np" display " - " for both listedness and causality.

Select this option to view the details of cases in the Main Line Listing
only once under the Primary Event

Select this option to view the details of cases in the Main Line Listing
only once under the Primary Event, while non-primary events are listed
under their respective event hierarchy with a reference to the primary
event body system. Therefore, use this option when grouping on Main
Line Listing is by the Event Body System.

Select this option to print Product Indication for the product selected in
the report.

10.1.4.2.12 Grouping Tab Refer to the following table for a description of items in the

Grouping tab.
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Field Description

Available Groupings  Allows a user to group cases together from the given list. Select the
desired groupings from the list and click Add to move the grouping to
the Selected Groupings list. Up to 10 grouping options can be selected.

Selected Groupings  Lists the added groupings made available from the Available
Groupings list, and reports the groups in the order they were selected.

Ascending Select this check box to sort the selected entities in ascending order.

Page Break Select this check box to start the cases from a new page, while also
keeping the sorting together for every selected page break.

Available Sortings Allows a user to sort cases together from the given list. Select the
desired sortings from the list and click Add to move the sorting to the
Selected Sortings list.

Selected Sortings Allows a user to further sort cases without a total count for each sorted

item. Up to 3 levels of sorting can be selected from the Available
Sortings list.

10.1.4.2.13 Summary Tabulations Tab The Summary Tabulations tab enables you to
specify which summary tabulations/Listings will appear along with the line listing.
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The following table lists and describes the fields on the tab.

Field

Description

Include Index of
Cases in CTPR

Create an index page of case numbers, for all cases included in the
CTPR.
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Field

Description

Include Summary of
Cases Missing
Assessments

Count of Cases per
Report Type

Event Count per
Study Drug

All Study Drugs in
Single table

Grouped by Study
Drug

This option creates a sub-report of cases missing one of the following
items:

= Seriousness

= Case Causality

= Case Listedness

s Case Outcome

= Event Causality

= Event Listedness

Click this checkbox to create one or both of the following sub reports:

Cases Missing Assessments - This sub-report displays cases that have
been included in the CTPR line listing, but one or more of the following
have not been assessed:

n  Case Seriousness
»  Case Causality

»  Case Listedness
s Case Outcome

= Event Causality
= Event Listedness

Cases Not Included in Report - This sub-report displays cases that
have not been included in the CTPR line listing as a result of missing
one or more of the following items:

= Lock Status

= Safety Date

= Uncoded Event
= Causality

This option prints a Sub Report that counts the number of cases versus
the Report Type, based on the cases within the CTPR.

The Cases per Report Type can be either of the following:

Count Cases with Initial Expedited Reports: Counts cases with initial
Expedited report.

Count of cases with "Follow-up" Expedited report: Counts cases with
Follow-up Expedited report.

Total Count of "Initial" Cases in the Report: Counts any (serious -
non-serious) cases received during the reporting period.

Total Count of "Follow-up" Cases in the Report: Counts any (serious -
non-serious) follow-up cases entered during the reporting period.

Cumulative Count: Count of cases received from the start of the trial.

Creates a sub-report with Event count per Study Drug based on the
selected causality. 2 configurations are possible as to allow for a count
of related events vs. non-related events.

Suppresses '0' current columns (with their cumulative) and print
everything in a single cross tab.

Prints a cross tab report for every product. Prints the cumulative totals
even if the current period has no events.
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Field Description
Event Type to Prints SUSAR events on the CTPR Report based on the option selected
Include from the drop-down list:
= Separate counts of SUSAR and non-SUSAR events
Prints SUSAR and non-SUSAR events listed separately. SUSAR
events are marked with an asterisk
= Combined count of SUSAR and non-SUSAR event
Prints SUSARs. Normal events are grouped into one (current
functionality)
= Only count SUSAR events
Prints Only SUSARs i.e. non-SUSARs would not be printed
Title Enables you to select a title.
Include Line Listing  Select this checkbox to view a pre-defined summary tabulation of
Tabulation Report type, Seriousness and Listedness of all cases in the CTPR.
Include Initial Cases ~ Select this checkbox to include initial cases in the CTPR tabulation.

Include Follow-up
Cases

Include Summary of
Unlocked Cases

Additional Expedited
Report Forms
(CIOMS/MedWatch/
VAERS)

Select this checkbox to include follow-up cases in the CTPR tabulation.

Enables you to print the list of Case Numbers that are included in the
Periodic Reports but are not locked.

Allows you to print CIOMS/MedWatch/AERS forms (as per selection)
for its respective regulatory agency (as selection), for all cases in the
report. It also provides an option to have (or not have) a watermark in
the forms.

CIOMS Reports

™ prst G seports R mevipun b ted tates
I chusie Paricdc Fambering on CICMS reports

Field

Description

Print CIOMS reports
for serious/unlisted
cases

Include Periodic
Numbering on the
CIOMS reports

Allows a user to print CIOMS I forms for all Serious/Unlisted (Case
Level) cases appearing in the CTPR.

Note: CIOMS contain Internal or Other text printed on them when the
CTPR is printed using the Internal or Other option.

Numbers the requested CIOMS I with a periodic format. (i.e. A-1-1 of 2,
A-1-2 of 2, A-2-1 of 1, A-3-1 of 1 etc.). The index is modified to also
contain the Periodic paging of each CIOMS report.

Cumulative Summary
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Field

Description

Include Cumulative
Summary

Comparative Date
Range

Serious
Unlisted
Related

Diagnosis

Diagnosis &
Symptoms

Separate Diagnosis &
Symptoms

Select the checkbox to create a sub-report count of events, grouped by
Product and Body System (SOC) and sorted by Preferred Term. The
sub-report contains a previous date range count of events (comparative
date range), a current date range count (current CTPR date range) and a
cumulative count (all dates) of events assessed against the product(s) of
the CTPR and matching the inclusion criteria.

Allows a user to specify the previous date range as a comparison date
for the events counted, and therefore should not overlap with the
current date range specified on the CTPR inclusion criteria tab.

Select this check box to include only serious events.

Select this check box to include only unlisted events selected in the
Datasheet on the "Inclusion Criteria Tab." If no datasheet is selected,
then any Unlisted license is included.

Select this check box to include only those events that are assessed as
Related or Causal.

Select this radio button to include only those events that are marked as
diagnosis "Yes" and are without any symptoms associated with
diagnosis.

Select this option to include all events in the sub-report.

Select this option to include all SUSAR events in the CTR Report.

FDA CTPR Support
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Field

Description

FDA CTPR Support Section

Include Adverse Event

Summary

Select this option to generate a sub-report of events from the
line listing. This sub report is grouped by Body System and
Preferred Term.

Note: This section can be used if the company has obtained
an FDA waiver to submit a CTPR instead of an NDA report.
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Field

Description

Causality

Only Cases with HCP Reporter
Diagnosis

Diagnosis & Symptoms
Separate Diagnosis &
Symptoms

Domestic Consumer Report

Print Unsubmitted

Exclude Reports that are
Non-Serious and Listed

Use Periodic numbering on the
Reports

Select the desired causality from the list.
Ignore - Counts events regardless of causality assessment.

Causal - Counts events where the causality is considered
reportable in the Causality Category configuration in List
Maintenance.

Not Causal - Counts events where the causality is considered
non-reportable in the Causality Category configuration in
List Maintenance.

As Determined - Counts events where 'As Determined'
causality meets the above selected causality criteria.

As Reported - Counts events where 'As Reported' causality
meets the above selected causality criteria.

Both - Counts events where both 'As Reported' and 'As
Determined' causality meet the above causality criteria.

Either - Counts events where either the "As Reported" or "As
Determined" causality meets the causality criteria.

Select this check box to include events for only those cases
that feature an HCP reporter

Select this radio button to ensure that only events marked as
diagnosis are counted.

Select this option to ensure that all events are counted in the
sub-report.

Select this option to include all SUSAR events in the CTR
Report.

Enables you to select domestic consumer report.

This option allows a user to print MedWatch or VAERS forms
for U.S. cases. The following types of cases will be excluded:

= Foreign Cases (Country of Incidence not equal to U.S.)

s Clinical Trial Cases (Case Report type in list maintenance
has "this type includes cases from clinical trials"
checked.)

»  Literature Cases (Case Report type in list maintenance
has "this type include case from literature" checked.)

= Cases with submitted expedited reports to the Agency
selected in the CTPR.

Allows a user to suppress MedWatch or VAERS forms from
printing for Non-Serious listed cases where all events are
non-serious and listed for the datasheet specified.

Numbers the requested forms with a periodic format. (i.e.
Periodic Page 1 - 1, Periodic Page 1 - 2, Periodic Page 2 -1,
Periodic Page 2 - 2, etc.) An index with the Case Number is
also included.

10.1.4.2.14 Single Case Submission Support
| g Cas Sibmimiomtapoort ]

™ Cpmar i Pariodis 1058 sulsminions for canas Sl 82 nol huve o leant ane
B3R repost scheduled during the reporting periosd o sny of the Followsng

Wrposferg Des bradonlsk

Ganarns Penods 1058 subsmes s

Reports: Periodic Reports 10-22



Periodic Report Types

Field Description

Single Case Submission Support Section

Generate Periodic ICSR Select this check box to generate the E2B Reports only for
Submissions for any cases in this  the cases, where a Periodic E2B Report for the message
Periodic Report that does not have type chosen, does not exist.

at least one scheduled single-case

report during the reporting period Select one or more trading partners from the list box.

to the following Reporting Important: Any case that does not have an expedited or

Destination(s): Modify single case periodic submission to a trading partner, must
have an E2b report scheduled as a part of the Periodic
submission.

Click Modify to select a different Reporting Destination.

Schedule these single-case Select a single-destination trading partner for Periodic
Periodic Reports to the following  Reports from the drop-down list box.
Reporting Destination

Using the Message Type Select the required message type from the drop-down list
box

10.1.4.2.15 UD Summaries Tab The UD Summaries tab allows you to specify which
summary listings will appear along with the line listing.

&, Clinical Trial Periodic Report -- Webpage Dialog N |
I

[r——
Repart Category - Repont Sub Categary | |
Subject of Beport | Prodect Selection | L m AE | Lime Listing | Growping | Summary Tabulations | UD Summaries | Scheduling | Security | Temglates |‘
M inciude thess summary tabulations | Istings based on the set of cases A Duiste | B jeciude these summary Loulations based on all cases Add | Desste

presented in the line listing

|
Exciude Follow-ups I sdentify SUSAR and Special Interest Events ™ Aaditional Separste Page Numbering for UD Summarses [PDF oniy} | :
o Cancal 1
J)
Field Description
Include these summary Allows you to select from pre-configured summary
tabulations/listings based on the tabulations/listings based on Case Data Analysis, Case
set of cases presented in the line listing or CIOMS 11 line listing reports. These tabulations
listing are based only on the data included in the line listing.

Select the Exclude Follow-up Cases check box to filter
out follow-up cases from the attached report.

Note: If the Exclude Follow-up Cases option is selected
on the Inclusion criteria tab, this option is ignored and
follow-up cases are always filtered out.
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Field

Description

Include these summary tabulations
based on all cases

Include these summary
tabulations/listings based on the
Date Range

Identify SUSAR and Special Interest
Events

Additional Separate Page
Numbering for Summaries

Allows for additional sub-reports based on the 'Case
Data Analysis' template, to be included as an output for
the all cases in the database that meet the CTPR inclusion
criterion for all dates.

This option allows for additional sub-reports based on
Case Data Analysis, Case listing or CIOMS II line listing
reports to be included as an output for the cases meeting
the CTPR inclusion criterion for the Date Range specified
when adding the sub-report.

The dates are based on either the "Case Creation Date" or
the "Initial Receipt Date" as entered on the CTPR
Inclusion Criteria tab. Click the checkbox to the right of
the sub-report to ignore considering follow-up cases for
the sub-report.

Enables you to identify any SUSAR and special interest
events.

Enables you to include additional separate page
numbering for summaries.

10.1.4.2.16 Scheduling Tab The Scheduling tab allows you to specify details of how
often the periodic report will be scheduled.
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The following table lists and describes the fields on the Scheduling tab.

Field Description

Start Date This is the International Birth Date for the CTPR product. This date is
computed as the earliest Awarded date for any license of any type.

Recalculate Allows a user to recompute the International Birth Date of the CTPR

Product. This date can be overwritten/manually entered, if needed.
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Field Description

Report is due xx days Enter the number of days when the report will be due after the end date
after selected end specified for the scheduling period.

date (creation or

receipt date)

Automatically Allows a user to specify the timing of the automatic report generation,
generate report xx by specifying the number of days before/after the selected end date of
days before/after the report.

selected end date at

XX:XX

Group Allows the user to select the group to which the automatically

generated report is to be assigned

10.1.4.2.17 Scheduling Frequency

| Scheduling f're i [ aes Jimem ]|
¥ Py L L]

The following table lists and describes the fields in the Scheduling Frequency section.

Field Description

Frequency Allows a user to specify the interval required for this scheduling
period.

Start Allows the user to specify when the scheduling period starts.

End Allows the user to specify when the scheduling period starts.

Add Allows a user to add another scheduling interval.

Delete Allows a user to delete a scheduling interval.

10.1.4.2.18 Security Tab The Security tab is used to configure the security level for the
CTPR.
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The following table lists and describes the fields on the Security tab.

Field Description
Share this Report Click this check box to share this report with other users. Specify the
with Other Users privileges to be granted to groups by adding the group name from the

Users Groups list to either the "Execute” or "Modify and Execute" list. A
user group can exist in only one of these access lists.

User Groups The groups listed here have no access to the CTPR report template.
Click Add or Remove to move them to another access list.

Execute The groups listed here have read and execute access to the shared CTPR
report template.

Modify & Execute The groups listed here have read, execute and modify access to the
shared CTPR report template.

10.1.5 About ICH PSUR Reports

The Periodic Safety Update Reports (PSURs) are created on a periodic basis to enable
regulatory authorities to monitor the safety of a marketed product. This information is
used to view new data about the product acquired from appropriate sources. It helps
relate this data to the patient exposure and also indicates whether changes should be
made to the product information in order to optimize the use of the product.
Requirements on the due date of periodic reports may differ for different regulatory
authorities.
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To create Periodic Safety Update Reports (PSURs)

1. Select Reports --> Periodic --> ICH PSUR Reports. A list of PSUR Reports opens
in the right frame.

2. Click Copy or Modify to create a new reports from an existing report.
OR
Click New Report to create an entirely new report.

3. When the system opens the ICH PSUR Line Listing Reports dialog box, enter an
appropriate report name in the Report Name field.

4. Use the tabs to configure the PSUR.

10.1.5.1 General Usage Information

You can group cases for the PSUR Report by Product Name and Dosage Regimen
Frequency as follows:

s Product Name

= This option enables you to group the Product Name - Formulation - Concentration
concatenated with Units separated by a hyphen ( -).

» If any elements are missing, the system does not print the hyphen ( -).
»  The groups the cases based on the Primary Drug in the report.
= Dosage Regimen Frequency

—  This option enables you to group the frequency of the primary dosage
regimen for the primary drug in the report.

— The system prints Frequency: followed by the frequency as defined.
= You can copy an existing template by clicking the Create from Template button.

= When you click Create from Template, the system displays the Create from
Template dialog.

= You can choose the PSUR Group Name (as configured in the Product Name
configuration) from a type ahead field.
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When you enter the PSUR Group Name in the Select PSUR Group Name field
and the From and To dates in the Create from Template dialog, and click OK the
system does the following:

Saves the PSUR Configuration with the new dates.

Replaces the products in the list of selected products with all products as
defined for the selected PSUR name.

Replaces the periodic report name in the newly configured periodic reports
with a new name in the following format:

XXXX: YYYY to 2277

where:

XXXX is the selected PSUR Name.

YYYY is the From Date entered by the user.

2777 is the To Date entered by the user.

Replaces the From and To date ranges only for the periodic report.

Bases the remaining configuration, including the security permissions, on the
selected PSUR template.

When you enter the PSUR Group Name in the Select PSUR Group Name field
and the From and To dates in the Create from Template dialog and click Print and
Save, the system does the following:

Saves the PSUR Configuration with the new dates.

Replaces the products in the list of selected products with all products as
defined for the selected PSUR name.

Replaces the periodic report name in the newly configured periodic reports
with a new name in the following format:

XXXX:YYYY to 2277

where:

XXXX is the selected PSUR Name.

YYYY is the From Date entered by the user.

2777 is the To Date entered by the user.

Replaces the From and To date ranges only for the Periodic Report.
Calls the Report Batch Printing dialog.

Bases the remaining configuration, including the security permissions, on the
selected PSUR template.

10.1.5.2 Common Tab Fields

The Report Name, Report Category and Report Sub-Category fields are common to
all tabs of the Reports.

The following table below describes these fields:

Field

Description

Report Name Enter a name for the Report. The name entered here is displayed in the

Reports menu.
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Field Description

Report Category Select a category for the Report. This is displayed in the Reports menu.
Tip: Select New to define a subcategory within the report category.
The Periodic Report Category dialog is displayed.
Enter a category name in Category and click OK.
The category is entered in the Report Category drop-down list.

Report Sub Category Select a subcategory for the report.
Tip: Select New to define a subcategory within the report sub-category.
The Periodic Report Category dialog is displayed.
Enter a category name in Category and click OK.
The category is entered in the Report Sub-Category drop-down list.

10.1.5.2.1 Subject of Report Tab The Subject of Report tab is used to configure the
report header and to specify the agency, products, etc. for which the PSUR will be
applicable.
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Field Description
Primary Agency Select the Primary Agency.
Reporting Displays the list of agencies from where the report is being sent. Select
Destination an agency from the list displayed in Reporting Destination and click

Add to add the report to the Selected Destination list.

You can select multiple agencies from the list of agencies such that the
report can be submitted to multiple agencies at the same time.

Likewise, select a report from the Selected Destination list and click
Remove to prevent it from being sent to the selected destination.

Reports: Periodic Reports 10-29



Periodic Report Types

Field

Description

Selected Destination

Report #
Report Title

Ingredient

Trade Name

International Birth
Date

Report Footer

Print all
configuration criteria
on separate cover

page
Print page numbers
on reports

Allow access to
report cases through
Hit List

Displays the list of agencies where the report is being sent. Select an
agency from the list displayed in Reporting Destination and click Add
to add the report to the Selected Destination list.

You can select multiple agencies from the list of agencies such that the
report can be submitted to multiple agencies at the same time.

Likewise, select a report from the Selected Destination list and click
Remove to prevent it from being sent to the selected destination.

Enter a report number for this report.
Enter a report title for this report.

Automatically displays the "Ingredient” as provided in the Subject of
Report dialog.

Note: You can choose whether to view these field or not. Click the
checkbox displayed with this field to hide or view it.

Automatically displays the "Trade Name(s)" as provided in the Subject
of Report dialog. Multiple trade names are also displayed together,
separated by commas.

Note: You can choose whether to view this field or not. Click the
checkbox displayed with this field to hide or view it.

Automatically displays the earliest license awarded date, when a user
selects an Ingredient and a Product.

Note: You can choose whether to view this field or not. Click the
checkbox displayed with this field to hide or view it.

Enter the footer for the report.

Mark this box to print out the configuration of this report when the
report is printed. This is only available when PDF option is selected
during printing.

When checked, this option enables the user to print page numbers on a
periodic report. This is the default for all report configurations.

If this checkbox is not checked, the following occur.

»  The "Include Periodic Page Numbering on CIOMS reports" option
on the PSUR Summary Tabulations CIOMS Reports section is
grayed out and inactive.

s The "Use Periodic Numbering on the reports" option in PSUR
Summary Tabulations FDA PSUR section is grayed out and
inactive.

= The "Additional Separate Page Numbering for UD Summaries” in
the PSUR UD Summaries tab is grayed out and inactive.

»  The system removes all existing report page numbering and the
option to check page number check boxes on the report
configuration tabs are grayed out and inactive.

When the report is run as final, it creates a Hit List, which can be
retrieved from other areas of the application where advanced
conditions can be selected. Click this checkbox to report cases through
the Hit List.

10.1.5.2.2 Product Selection Tab Refer to the table below for a description of fields in the
Product Selection tab.

Reports: Periodic Reports 10-30



Periodic Report Types

Repori Reme
[N —— =l Feport Suab Categeey | =]
Tt ool Bt | Pridnat Beieotn | inonsen Cotens | e Listeg | S I L | | secienny
Slable e pdenty
Setected ngrecherrs
SECALT [FTRC ALY P | GEOLATE
rem
o rastation

Al P (ul 13

St L) P a1

Field

Description

Available Ingredients

Filter
Selected Ingredients

Indication

Formulation

Available Products

Selected Products

Displays the list containing the Ingredients used for the product
configuration. Select an ingredient from the list displayed in Available
Ingredients and click Add/Remove to add/remove the ingredient.

You can select multiple ingredients at a time.

Enter an Ingredient name and click Filter to search for the entered
ingredient within the Available list of Ingredients.

Displays the list of ingredients selected from the Available Ingredients
list.

This list contains the Indication configured for the product containing
the ingredients in the Available Ingredients section. The selections
made from this list get displayed in the Available Products section.

Note: You can select multiple Indications from the list at a time by
pressing the CTRL key and clicking the different Indication entities.

This list contains the Formulation configured for the product containing
the ingredients in the Available Ingredients section. The selections
made from this list get displayed in the Selected Products section.

Note: You can select multiple Indications from the list at a time by
pressing the CTRL key and clicking the different Indication entities.

This list is automatically populated with the selections made in the
Indication section.

This list contains products selected by the user from the Available
Products list. When a product is selected, the Trade Name field and
International Birth Date fields are auto-populated with the license trade

name ("formulation", "concentration") and earliest License Award Date
for the product.
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10.1.5.2.3 Inclusion Critetia Tab The Inclusion Criteria tab allows you to select search
parameters for inclusion of cases in a periodic report. The top section of the dialog
allows you to specify the type of cases that are to be included in the periodic report.
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Click Add to add a criterion. Select appropriate items from the list of items that

appear.

Field

Description

Case Creation Date

Case Receipt Date

Case
Locked/Archived
Date

Use Current Version
Use DLP Version

Age Groups

Use Assessments in
Cases

Re-assess cases
against datasheet in
effect at the
beginning

Re-assess cases
against datasheet in
effect at end

Allows you to specify a range of cases by the date when the case was
created.

Allows you to specify a range of cases by the initial receipt date.

Allows you to specify the date when the case was locked /archived.

Allows you to use the latest revision to populate the data within the
selected reports.

Allows you to use the case data of the version as of the specified DLP
Version.

Allows you to include or exclude cases based on the patient's age
group. Select Age Groups and then select all the age group categories
that apply.

When selected, the PSUR Report will use the Case Event Assessment
when performing datasheet listedness calculations.

When selected, the PSUR will re-assess the cases in the line listing
based on the Active Datasheet on or before the Start Date of the
Reporting period.

When selected, the PSUR will re-assess the case in the line listing based
on the Active Datasheets on or closest to the end date of the PSUR
Reporting end date range without exceeding that date.
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Field

Description

Expeditable Only

Exclude Follow-up
Cases

Include Unlocked
Cases

Advanced Condition

Use Datasheet

Assessment for UDF

Tabulations

Add Cases not

included in previous

reporting period

This checkbox is available only when an agency is selected in the
Subject of Report tab. If you select this check box, only the cases
classified as submitted expedited reports to the specified agency are
used.

Filters out follow-up Reports from the PSUR Line Listing Report.
Allows you to include unlocked cases in the periodic report.

Allows you to specify an advanced condition that must be satisfied by
each case that is included in the report. Ensure that the advanced
condition or the advanced condition query set that is specified here
does not contradict any other criteria specified in the dialog.

Allows you to select datasheet for a report to make UDF tabulations.

If no datasheet is selected, the most conservative listedness is chosen,
i.e. Unlisted followed by Listed.

Allows you to add cases which were not included in the previous
reporting period.

You can enter the start date of the period in the Start Date field.

10.1.5.2.4

Inclusion Criteria When using the Inclusion Criteria tab, the system enables

you to exclude blinded cases from the Inclusion criteria section of the report. It also
enables you to select All from the Inclusion criteria for the report type. This would
include all configure report types in the report.

Field Description

Dropdown list Select the appropriate report type from the drop-down list.

Datasheet This list allows you to specify which datasheet is to be checked to
determine the listedness (listed or unlisted) of the case.

Serious / If you select Serious and clear Non-serious, only cases having a

Non-Serious

Fatal / Non-Fatal

Listed / Unlisted

Related /
Non-Related

HCP / Non-HCP

Primary Reporter
Only

"

serious" event are included and vice-versa. If you select both Serious
and Non-Serious the seriousness criteria is ignored.

Select Fatal when at least one event has an event outcome of 'Fatal". If
not, select Non-Fatal. If you select both Fatal and Non-Fatal, both types
of cases are included.

Select Listed to view only Listedness values. If you select both Listed
and Unlisted, all Listedness values (including Unknown) are included.

Relatedness refers to the more conservative of reported or company
causality. Select Related for any reportable causality type, and
Non-Related for any non-reportable causality type.

HCP refers to cases that identify a Health Care Professional in the
Reporter section within the General tab of the Case Form.

This check box displays whether the Primary Reporter has been
selected to determine the HCP status.

10.1.5.2.5 Line Listing Tab The Line Listing tab contains the following fields and

sections:
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Field Description

Include Line Listing

Allows you to select whether you want the Line Listing Data Elements
printed with the PSUR Report.

10.1.5.2.6 Available Data Elements The following illustration shows the optional fields
under Available Data Elements.

= Select the check box displayed against each data element to add it to the report.
s The unavailable fields are printed on the report by default and cannot be changed.
= Refer to the table below for a list of the data elements that are included in this tab.

s The mandatory data elements are printed as columns in the report.

Data Element Notes

As Determined Causality Optional.
As Determined Listedness Optional.
As Reported Causality Optional.

Case Abbreviated Narrative Required and multi-language available.

Case Classifications Required. Multiple classifications are displayed in

separate lines.

Case Central Safety Date Optional.
Case Comment Text Optional.
Case Initial Receipt Date Optional.
Case Listedness Optional.
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Data Element Notes

Case Narrative Optional.
Case Number Required.
Case Outcome Required.
Case Report Type Required.
Case Seriousness? Optional.

Company Agent Causality

Country of Incidence

Death Cause

Death Cause HLGT

Death Cause HLT

Death Cause LLT

Death Cause SOC

Dosage Regimen Batch/Lot #
Dosage Regimen Daily Dose
Dosage Regimen Duration
Dosage Regimen Frequency

Dosage Regimen Route of
Administration

Dosage Regimen Start Date/Time

Drug Dechallenge?

Drug Primary Indication

Drug Primary Indication HLGT
Drug Primary Indication HLT
Drug Primary Indication LLT
Drug Primary Indication SOC

Drug Rechallenge?

Event Description as Reported
Event Lack of Efficacy

Event Onset Date/Time

Event Preferred Term

Lab Data - Tabular

Literature Author

Literature Journal

Literature Pages

Displays event causality from product name. Multiple
causalities are displayed in separate lines.

Required.
Multi-language available.
Optional.
Optional.
Optional.
Optional.
Optional.
Optional.
Optional.
Optional.
Optional.

Required. For the selected product the report is based
on. List for all dose regimens.

Optional.

Optional. For the selected product the report is based
on.

Optional. For the selected product the report is based
on.

Optional. For the selected product the report is based
on.

Optional. For the selected product the report is based
on.

Optional. For the selected product the report is based
on.

Optional.
Required.
Optional.
Required.
Required.
Optional.
Optional.
Optional.
Optional.
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Data Element Notes

Literature Title Optional.
Literature Volume Optional.
Literature Year Optional.

Indication

Listedness

Literature reference
Outcome of Event
Patient Age

Patient Gender

Patient Initials

Patient Relevant History
Patient Subject #

Product Name

Product Name Report Inclusion

Report Comment

Reporter Reference Number

Reporter Type
Study Blinded Status

Study Center ID
Study Drug

Study ID

Study ID Protocol #

Displays indication for product name.

Displays datasheet, product and listedness event
preferred term

Optional.
Optional.
Required.
Required.
Optional.
Multi-language.
Optional.

Displays "product name (generic name) product type,
formulation, concentration unit" "daily dose," "dose
dose_freq, route"

Prints the Products that were part of the CTPR Report
for the case.

Displays "product name (generic name) product type,
formulation, concentration unit" "daily dose,"” "dose
dose_freq, route"

Optional.

Optional. If you select this value the report includes
the reporter reference number as specified in the cases
included in the Periodic report of All reporters within
the case.

If the case does not have values, then label is not
printed in the Line Listing for the report.

Optional.

Optional. The system enables you to exclude blinded
cases from the inclusion criteria.

Optional.
Optional.
Optional.
Optional.

10.1.5.2.7 Selected Data Elements This section lists the selected elements and enables
you to arrange the order in which these are to be printed.
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Field

Description

MedDRA Hierarchy  Select Cases to populate the data from the case data. Select Dictionary

from
Cases/Dictionary

to populate the data from the MedDRA dictionary.
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Field

Description

Print Only the Term
(Preferred Term or
Lower Level Term)

Print Dose Text in
place of regimen dose

Indicate if case was
expedited previously

English Language

Local Language

Print event info
(Serious, Un-listed,
Related) as Column

List cases only once,
under the primary
event

List cases under all
events, details under
the primary event

Print Product
Indication for the
Product selected in
the Report

Prints only the event Preferred Term (PT) or event Lower Level Term
(LLT) as per the selected radio button. Select the PT option to print only
the preferred term and not the verbatim description.

Prints the dosage and frequency information from Dose Description
field instead of Regimen Dose.

This checkbox is selected if an agency has been selected in the Subject
of Report tab. Cases for which an expedited report was previously
submitted to the selected authority are marked with an asterisk and the
date of submission appears in the line listing.

Any case that has been previously expedited to a selected agency, is
listed in the list of Agencies in the Subject of Reports tab.

Provides the option to print the descriptions in English

Allows a user to specify which Local language for a multi-language
field is to be printed i.e. the Abbreviated Narrative field.

Select this checkbox to print the Seriousness, Listedness and Causality
under the Event Verbatim column.

Note: Events having listedness of 'Unknown' are considered 'Unlisted".
If only diagnoses are assessed for event assessment, the events which
are associated with a Diagnosis but have been marked with Diagnosis
as 'No' display '-' for both listedness and causality.

Select this option to view the details of cases in the Main Line Listing
only once under the Primary Event

Select this option to view the details of cases in the Main Line Listing
only once under the Primary Event, while non-primary events are listed
under their respective event hierarchy with a reference to the primary
event body system. Therefore, use this option when grouping on Main
Line Listing is by the Event Body System.

Enables you to print the product indication for the product selected in
the report.

10.1.5.2.8 Grouping Tab Refer to the following table for a description of items in the

Grouping tab.
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Field Description

Available Groupings Allows a user to group cases together from the given list. Select the
desired groupings from the list and click Add to move the grouping to
the Selected Groupings list.

Selected Groupings  Lists the added groupings, and reports the groups in the order they
were selected. Up to 5 grouping options can be selected from the
Available Groupings list.

Ascending Select this checkbox to sort the selected entities in ascending order

Page Break Select this checkbox to start the cases from a new page, while also
keeping the sorting together for every selected page break.

Available Sortings Allows a user to sort cases together from the given list. Select the
desired sortings from the list and click Add to move the sorting to the
Selected Sortings list.

Selected Sortings Allows a user to further sort cases without a total count for each sorted

item. Up to 3 sorting options can be selected from the Available
Sortings list. This list is populated with the Mandatory Line Listing
entities plus any optional data elements chosen for this configuration.

10.1.5.29 Summary Tabulations Tab The Summary Tabulations tab enables you to
specify which summary tabulations/listings will appear along with the line listing.The
system enables you to separate the cumulative summary by seriousness, relatedness,
and listedness. If you choose this option, the system separates the product event detail
into the following categories: Serious/Non-Serious, Related /Non-Related, and
Unlisted /Listed events.
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It contains the following fields and sections:

Field Description

Include Index of Create an index page of case numbers, for all cases included in the

Cases in PSUR PSUR.
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Field

Description

Include Summary of
Cases Missing
Assessments

Include Line Listing
Tabulation

Include Initial Cases

Include Follow-up
Cases

Include Summary of
Unlocked Cases

Additional Expedited
Report Forms
(CIOMS/MedWatch/
VAERS)

This option creates a sub-report of cases missing one of the following
items:

= Seriousness

= Case Causality

= Case Listedness

s Case Outcome

= Event Causality

= Event Listedness

Click this checkbox to create one or both of the following sub reports:

Cases Missing Assessments - This sub-report displays cases that have
been included in the PSUR line listing, but one or more of the following
have not been assessed:

n  Case Seriousness
»  Case Causality

»  Case Listedness
s Case Outcome

= Event Causality
= Event Listedness

Cases Not Included in Report - This sub-report displays cases that
have not been included in the PSUR line listing as a result of missing
one or more of the following items:

= Lock Status

= Safety Date

= Uncoded Event
= Causality

Select this check box to view a pre-defined summary tabulation of
Report type, Seriousness and Listedness of all cases in the PSUR.

Select this checkbox to include initial cases in the PSUR tabulation.

Select this checkbox to include follow-up cases in the PSUR tabulation.

Enables you to print the list of Case Numbers that are included in the
Periodic Reports but are not locked.

Allows you to print CIOMS/MedWatch/AERS forms (as per selection)
for its respective regulatory agency (as selection), for all cases in the
report. It also provides an option to have (or not have) a watermark in
the forms.

10.1.5.3 CIOMS Reports
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Field Description

Print CIOMS reports  Allows a user to print CIOMS I forms for all Serious/Unlisted (Case
for serious/unlisted  Level) cases appearing in the PSUR.

cases Note: CIOMS contain Internal or Other text printed on them when the
PSUR is printed using the Internal or Other option.

Include Periodic Numbers the requested CIOMS I with a periodic format. (i.e. A-1-1 of 2,

Numbering on the A-1-2 of 2, A-2-1 of 1, A-3-1 of 1 etc.). The index is modified to also

CIOMS reports contain the Periodic paging of each CIOMS report.

10.1.5.3.1 Cumulative Summary
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Field Description

Include Cumulative  Select the check box to create a sub-report count of events, grouped by

Summary Product and Body System (SOC) and sorted by Preferred Term. The
sub-report contains a previous date range count of events (comparative
date range), a current date range count (current PSUR date range) and a
cumulative count (all dates) of events assessed against the product(s) of
the PSUR and matching the inclusion criteria.

Comparative Date Allows a user to specify the previous date range as a comparison date

Range for the events counted, and therefore should not overlap with the
current date range specified on the PSUR inclusion criteria tab.

Serious Select this check box to include only serious events.

Unlisted Select this check box to include only unlisted events selected in the

Datasheet on the "Inclusion Criteria Tab." If no datasheet is selected,
then any Unlisted license is included.

Related Select this check box to include only those events that are assessed as
Related or Causal.

Diagnosis Select this radio button to include only those events that are marked as
diagnosis "Yes" and are without any symptoms associated with
diagnosis.

Diagnosis & Select this radio button to include diagnosis and symptoms together in

Symptoms the sub-report.

Separate Diagnosis & Select this radio button to include diagnosis and symptoms separately
Symptoms in the sub-report. Selecting this option means that the case numbers are
separated by Diagnosis and Symptoms respectively.

10.1.5.3.2 FDA PSUR Support
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Field

Description

FDA PSUR Support Section

Note: This section can be used if the company has obtained an FDA waiver to submit a PSUR

instead of an NDA report.

Include Adverse Event Summary Select this option to generate a sub-report of events from

Causality

Only Cases with HCP Reporter
Diagnosis
Diagnosis & Symptoms

Separate Diagnosis & Symptoms

Domestic Consumer Support
Print Unsubmitted

Exclude Reports that are
Non-Serious and Listed

Use Periodic numbering on the
Reports

the line listing. This sub report is grouped by Body System
and Preferred Term.

Select the desired causality from the list.
Ignore - Counts events regardless of causality assessment.

Causal - Counts events where the causality is considered
reportable in the Causality Category configuration in List
Maintenance.

Not Causal - Counts events where the causality is
considered non-reportable in the Causality Category
configuration in List Maintenance.

As Determined - Counts events where 'As Determined'
causality meets the above selected causality criteria.

As Reported - Counts events where 'As Reported' causality
meets the above selected causality criteria.

Both - Counts events where both 'As Reported' and 'As
Determined' causality meet the above causality criteria.

Either - Counts events where either the 'As Reported' or 'As
Determined' causality meets the causality criteria.

Select this checkbox to include events for only those cases
that feature an HCP reporter

Select this radio button to ensure that only events marked
as diagnosis are counted.

Select this radio button to ensure that all events are counted
in the sub-report.

Select this radio button to include diagnosis and symptoms
separately in the sub-report. Selecting this option means
that the case numbers are separated by Diagnosis and
Symptoms respectively.

Select this radio button to enable domestic consumer
support.

This option allows a user to print MedWatch or VAERS
forms for U.S. cases

Allows a user to suppress MedWatch or VAERS forms from
printing for Non-Serious listed cases where all events are
non-serious and listed for the datasheet specified.

Numbers the requested forms with a periodic format. (i.e.
Periodic Page 1 - 1, Periodic Page 1 - 2, Periodic Page 2 - 1,
Periodic Page 2 - 2, etc.) An index with the Case Number is
also included.

10.1.5.3.3 Single Case Submission Support
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Field Description

Single Case Submission Support Section

Generate Periodic ICSR Submissions for ~ Select this checkbox to generate the E2B Reports
any cases in this Periodic Report that does only for the cases, where a Periodic E2B Report for
not have at least one scheduled single-case the message type chosen, does not exist.

report during the reporting period to the

following Reporting Destination(s): Select one or more trading partners from the list

Modify box.
Important: Any case that does not have an
expedited or single case periodic submission to a
trading partner, must have an E2B report
scheduled as a part of the Periodic submission.
Click Modify to select a different Reporting
Destination.

Schedule these single-case Periodic Select a single-destination trading partner for

Reports to the following Reporting Periodic Reports from the drop-down list box.

Destination

Using the Message Type Select the required message type from the

drop-down list box

10.1.5.3.4 UD Summaries Tab The UD Summaries tab allows you to specify which
summary listings will appear along with the line listing.
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Exclude Follow-ups I menity SUSAR and Spocial Interest Events ™ Aaditional Separste Page Numbering for UD Summarses [PDF oniy}

The following lists and describes the fields on the UD Summaries tab.

Field Description

Include these Allows you to select from pre-configured summary

summary tabulations/listings. These tabulations are based only on the data
tabulations/listings  included in the line listing. Selecting the Exclude Follow-up Cases
based on the set of check box filters out follow-up cases from the attached report.
cases presented in the

Note: If the Exclude Follow-up Cases option is selected on the Inclusion
criteria tab, this option is ignored and follow-up cases are always
filtered out.

line listing
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Field

Description

Include these
summary tabulations
based on all cases

Include these
summary
tabulations/listings
based on the Date
Range

Identify SUSAR and
Special Interest
Events

Additional Separate
Page Numbering for
Summaries

Allows for additional sub-reports based on the 'Case Data Analysis'
template, to be included as an output for the all cases in the database
that meet the PSUR inclusion criterion for all dates.

This option allows for additional sub-reports based on Case Data
Analysis, Case listing or CIOMS 1I line listing reports to be included as
an output for the cases meeting the PSUR inclusion criterion for the
Date Range specified when adding the sub-report.

The dates are based on either the "Case Creation Date" or the "Initial
Receipt Date" as entered on the PSUR Inclusion Criteria tab. Click the
checkbox to the right of the sub-report to ignore considering follow-up
cases for the sub-report.

Enables you to identify any SUSAR and special interest events.

Enables you to include additional separate page numbering for
summaries.

10.1.5.3.5 Scheduling Tab The Scheduling tab enables you to specify details of how
often the periodic report will be scheduled.
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Field Description
Start Date This is the International Birth Date for the PSUR product. This date is
computed as the earliest Awarded date for any license of any type.
Recalculate Allows a user to recompute the International Birth Date of the PSUR

Product. This date can be overwritten/manually entered, if needed.
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Field Description

Report is due xx days Enter the number of days when the report will be due after the end date
after selected end specified for the scheduling period.

date (creation or

receipt date)

Automatically Allows a user to specify the timing of the automatic report generation,
generate report xx by specifying the number of days before/after the selected end date of
days before/after the report.

selected end date at

XX:XX

Group Allows the user to select the group to which the automatically

generated report is to be assigned

10.1.5.3.6  Scheduling Frequency

| Scheduling f're i [ aes Jimem ]|
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The following table lists and describes the fields in the Scheduling Frequency section.

Field Description

Frequency Allows a user to specify the interval required for this scheduling
period.

Start Allows the user to specify when the scheduling period starts.

End Allows the user to specify when the scheduling period starts.

Add Allows a user to add another scheduling interval.

Delete Allows a user to delete a scheduling interval.

10.1.5.3.7 Security Tab The Security tab is used to configure the security level for the
PSUR.
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Field Description
Share this Report Click this check box to share this report with other users. Specify the
with Other Users privileges to be granted to groups by adding the group name from the
Users Groups list to either the "Execute” or "Modify and Execute" list. A
user group can exist in only one of these access lists.
User Groups The groups listed here have no access to the PSUR report template.
Click Add or Remove to move them to another access list.
Execute The groups listed here have read and execute access to the shared PSUR
report template.
Modify & Execute The groups listed here have read, execute and modify access to the

shared PSUR report template.

10.1.5.3.8 Templates Tab Refer to the Argus Dossier User Guide for a description of
fields in the Templates tab.
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10.1.6 About US IND Periodic Reports

The system enables you to define an IND summary report. You can add a new report
as well as copy, modify and delete existing reports.
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Use the following procedure to create and IND Summary Report
1. Select Reports --> IND Reports to open IND Subject of Report view.

2. Click New Report.
OR
Select an existing report from the list and click Copy or Modify.
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o o k w

When you click New Report, the IND Line Listing Reports dialog opens.
Enter an appropriate name for the report under Report Name.
Use the tabs in this dialog to configure the IND Report.

From each tab in the IND Summary Report, you can choose to Print all

configuration criteria on separate cover pages (PDF Only).

10.1.6.1 Common Fields

The Report Name, Report Category and Report Sub-Category fields are common to
all tabs of the Reports. The following table describes these fields.

Field

Description

Report Name

Report Category

Report Sub Category

Enter a name for the Report. The name entered here is displayed in the
Reports menu.

Select a category for the Report. This is displayed in the Reports menu.
Tip: Select New to define a subcategory within the report category.
The Periodic Report Category dialog is displayed.

Enter a category name in Category and click OK.

The category is entered in the Report Category drop-down list.

Select a subcategory for the report.

Tip: Select New to define a subcategory within the report sub-category.
The Periodic Report Category dialog is displayed.

Enter a category name in Category and click OK.

The category is entered in the Report Sub-Category drop-down list.

10.1.6.1.1 Subject of Report Tab The Subject of Report tab is used to configure the
report header and to specify the agency, products, and other elements. Select multiple
ingredients for a configured IND Report to view the multiple licenses to be selected for

the report.
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Field

Description

Primary Agency

Reporting Destination

Selected Destination

Company Name

Product Name

Approval

Select the Primary Agency.

Displays the list of configured Regulatory Agencies. Select an
agency from the list displayed in Reporting Destination and
click Add to add the report to the Selected Destination list.

Select multiple agencies by holding the CTRL key when you
click them.

Displays the list of agencies where the report is being sent.
Select an agency from the list displayed in Reporting
Destination and click Add to add the report to the Selected
Destination list.

Select multiple agencies by holding the CTRL key when you
click them.

Likewise, select an agency from the Selected Destination list
and click Remove to prevent it from being sent to the selected
destination.

If a regulatory agency is selected in the Subject of Report tab,
then the company name associated with the regulatory agency
(this association is created by the Administrator) is
automatically entered in this field.

This field is automatically filled as per the Ingredient field.

Note: Click the checkbox corresponding to this field to choose
whether you want this field to appear on the report.

This field is automatically filled with License numbers,
separated by commas. This is an editable field.
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Field

Description

Award Date

Print all configuration criteria
on separate cover page

Print page numbers on
reports

Allow access to report cases
through Hit List

This field is populated with the earliest awarded
Investigational License for US amongst the licenses selected.
This field cannot be edited.

Note: Click the checkbox corresponding to this field to choose
whether you want this field to appear on the report.

Click this checkbox to print out the configuration of this report
when the report is printed. This is only available when the PDF
option is selected during printing.

When checked, this option enables the user to print page
numbers on a periodic report. This is the default for all report
configurations.

If this checkbox is not checked, the following occur.

= The "Additional Separate Page Numbering for UD
Summaries" option on the IND Summaries Tabulation tab
is grayed out and inactive.

»  The system removes all existing report page numbering

When the report is run as final, it creates a Hit List, which can
be retrieved from other areas of the application where
advanced conditions can be selected. Click this checkbox to
report cases through the Hit List.

10.1.6.1.2 Product Selection Tab Use the Product Selection tab to select product
information to include in the report.
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Field

Description

Available Ingredients

Filter
Selected Ingredients

Indication

Formulation

Available Licenses

Selected Licenses

Displays the list containing the Ingredients used for the product
configuration. Select an ingredient from the list displayed in Available
Ingredients and click Add/Remove to add/remove the ingredient.

You can select multiple ingredients at a time.

Enter an Ingredient name and click Filter to search for the entered
ingredient within the Available list of Ingredients.

Displays the list of ingredients selected from the Available Ingredients
list.

This list contains a list of all the indications for the products containing
the selected ingredient. The selections made from this list are displayed
in the Available Products section.

Note: You can select multiple Indications from the list at a time by
pressing the CTRL key and clicking the different Indication entities.

This list contains the Formulations configured for the product
containing the selected ingredient and indication. The selections made
from this list get displayed in the Selected Products section.

Note: You can select multiple Formulations from the list at a time by
pressing the CTRL key and clicking the different Indication entities.

This list is automatically populated with the licenses from the
Indication section.

This list contains licenses selected by the user from the Available
Licenses list. When a product is selected, the Trade Name and
International Birth Date fields are auto-populated with the license
trade name ("formulation", "concentration") and earliest License Award
Date for the product.

10.1.6.1.3 Inclusion Critetia Tab The Inclusion Criteria tab allows you to select search
parameters for inclusion of cases in a periodic report.
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Field

Description

Case Creation Date

Case Receipt Date

Use Current Version
Use DLP Version

Age Groups

Options -
Domestic/Foreign
Cases

Expeditable Only

Include Unlocked
Cases

Advanced Condition

Allows you to specify a range of cases by the date when the case was
created.

Allows you to specify a range of cases by the initial receipt date.

Allows you to use the latest revision to populate the data within the
selected reports.

Allows you to use the case data of the version as of the specified DLP
Version.

Allows you to include or exclude cases based on the patient's age
group. Select the Age Groups checkbox to activate the age groups and
select all the age group categories that apply.

This option allows the user to include domestic and foreign cases
within the periodic report. Select Domestic if Country of Incidence is
USA and Foreign if Country of Incidence is not USA.

This checkbox is available only when an agency is selected in the
Subject of Report tab. If you select this check box, only the cases
classified as submitted expedited reports to the primary agency are
used.

Allows you to include unlocked cases in the periodic report.

Allows you to specify an advanced condition that must be satisfied by
each case that is included in the report. Ensure that the advanced
condition or the advanced condition query set that is specified here
does not contradict any other criteria specified in the dialog.

10.1.6.1.4 Line Listing Tab The following table describes the fields in the Line Listing

tab.
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Field Description
Report All Events Select this option to report all events.
Report only Select this option to report only diagnosis events (only the diagnosis

Diagnosis Events

List cases only once,
under the primary
event

List cases under all
events, details under
the primary event

Create a Sub Report
for Death Cases

events that are either explicitly marked as diagnosis or are non-related
symptoms).

Select this option to view the details of cases in the Main Line Listing
only once under the Primary Event

Select this option to view the details of cases in the Main Line Listing
only once under the Primary Event, while non-primary events are listed
under their respective event hierarchy with a reference to the primary
event body system. Therefore, use this option when grouping on Main
Line Listing is by the Event Body System.

Select this check box to separate death cases from the main IND listing.
If the check box is checked, all death cases (Identified by any event
marked as death in Seriousness Criteria or any event having a Event
Outcome as Death) are filtered out from the IND Line Listing. All death
case show up in a sub report, called "IND Line Listing (Death Cases)."

10.1.6.1.5 Summary Tabulations Tab The Summary Tabulations tab enables you to
specify which summary tabulations will appear along with the line listing.
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Field

Description

Include these
summary
tabulations/listings
based on the set of
cases presented in the
line listing

Allows you to select from pre-configured summary
tabulations/listings. These tabulations are based only on the data
included in the line listing. Select the Exclude Follow-up Cases check
box to filter out follow-up cases from the attached report.

Note: If the Exclude Follow-up Cases option is selected on the Inclusion
criteria tab, this option is ignored and follow-up cases are always
filtered out.
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Field Description

Include these Allows for additional sub-reports based on the 'Case Data Analysis'

summary tabulations template, to be included as an output for the all cases in the database

based on all cases that meet the IND Report inclusion criterion for all dates.

Add Displays a list of memorized Case Data Analysis Reports that have
been marked for availability in a periodic report.

Remove Click this button to remove a selected report.

Additional Separate  Enables you to include additional separate page numbering for
Page Numbering for ~summaries.
Summaries

Include Summary of  Enables you to print the list of Case Numbers that are included in the
Unlocked Cases Periodic Reports but are not locked.

10.1.6.1.6  Scheduling Tab The Scheduling tab allows you to specify details of how
often the periodic report will be scheduled.
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The following table lists and describes the fields on the Scheduling tab.

Field Description

Start Date This is the International Birth Date for the IND Report product. This
date is computed as the earliest Awarded date for any license of any
type.

Recalculate Allows a user to recompute the International Birth Date of the IND

Report Product. This date can be overwritten/manually entered, if
needed.

Report is due xx days Enter the number of days when the report will be due after the end date
after selected end specified for the scheduling period.

date (creation or

receipt date)

Reports: Periodic Reports 10-55



Periodic Report Types

Field Description

Automatically Allows a user to specify the timing of the automatic report generation,
generate report xx by specifying the number of days before/after the selected end date of
days before/after the report.

selected end date at
XXIXX

Group

Allows the user to select the group to which the automatically
generated report is to be assigned.

10.1.6.1.7 Scheduling Frequency Description of fields in Scheduling Frequency:

T - |~ |
p— o = N
Field Description
Frequency Allows a user to specify the interval required for this scheduling
period.

Start Allows the user to specify when the scheduling period starts.
End Allows the user to specify when the scheduling period starts.
Add Allows a user to add another scheduling interval.
Delete Allows a user to delete a scheduling interval.

10.1.6.1.8 Security Tab The Security tab is used to configure the security level for the

IND Reports.
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The following table lists and describes the fields on the Security tab.

Field Description
Share this Report Click this check box to share this report with other users. Specify the
with Other Users privileges to be granted to groups by adding the group name from the

Users Groups list to either the "Execute” or "Modify and Execute" list. A
user group can exist in only one of these access lists.

User Groups The groups listed here have no access to the IND Report template. Click
Add or Remove to move them to another access list.

Execute The groups listed here have read and execute access to the shared IND
Report template.

Modify & Execute The groups listed here have read, execute and modify access to the

shared IND Report template.

10.1.7 About NDA Periodic Reports

The NDA Periodic Reports enable you to define an NDA Periodic report. You can add
a new report as well as copy, modify and delete existing reports.

Use the following procedure to create an NDA Periodic report

To create NDA Summary Reports:

1.

Select Reports --> Periodic Reports --> NDA Reports to open the NDA Subject of
Report view.

Click New Report to create an entirely new report,

OR

Select an existing report from the list and click Copy or Modify.

When you click New Report, the NDA Line Listing Reports dialog opens.
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4. Enter an appropriate report name in the Report Name field
5. Use the tabs in this dialog to configure the NDA Report.

6. From each tab in the NDA Report, you can choose to Print all configuration
criteria on separate cover pages (PDF Only).

10.1.7.1 General Usage Information
When using NDA Reports be aware of the following:

= You can print an Index of Cases included in the NDA report.

= If you select this option, the system lists the cases from the following sections once
at the end of the configuration pages:

- Sequential List of cases
— Serious Listed Initial /Follow up
— Non Serious Listed Initial /Follow up
— Non Serious Unlisted Initial/Follow up
- 15 Day Submission
s The page numbering for this sub-report continues from the configuration pages.

= You can separate initial case events from follow-up case events in the Summary
Tabulation tab of the NDA Report.

- If you select this option, the system counts events in the Initial section if the
case is in the Serious Listed, Non-Serious Listed, or Non-Serious
Listed/Unlisted sections.

- If you select this option, the system counts events in the Follow-up section if
the case is in the Serious Listed or Non-Serious Listed/Unlisted follow-up
sections of the NDA report.

— For the 15 Day events, if the case has not been previously reported in a NDA,
the system counts it in the Initial section then the Follow-up section.

- If you select List cases once under the Primary Event System Organ Class
(80OCQ), the system displays a footnote with an asterisk ( *) printed across all
the System Organ Classes on the report and the following statement: Primary
Event System Organ Class.

= If you select the Print FDA-3500A/VAERS form at the end option, the system
prints the report sections in the following order:

s Configuration (Including Case Indices (e.g. Sequential Case Listing, Listing by
Seriousness/Listedness, Listing of Cases Missing Analysis)

— Line Listing
— Summary Tabulations
- MedWatch/VAERS reports at the end of the report

= Page numbering for the MedWatches reports continue from the last page of the
NDA report.

s The configuration pages have been updated to reflect the updates made to the
NDA Reports

= The configuration pages are printed at the beginning of the NDA report.

= By default, these are unchecked on all the existing configured reports.
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10.1.7.2 Common Fields

The Report Name, Report Category and Report Sub-Category fields are common to
all tabs of the Reports. The following table describes these fields:

Field Description

Report Name Enter a name for the Report. The name entered here is displayed in the
Reports menu.

Report Category Select a category for the Report. This is displayed in the Reports menu.
Tip: Select New to define a subcategory within the report category.
The Periodic Report Category dialog is displayed.
Enter a category name in Category and click OK.
The category is entered in the Report Category drop-down list.

Report Sub Category Select a subcategory for the report.
Tip: Select New to define a subcategory within the report sub-category.
The Periodic Report Category dialog is displayed.
Enter a category name in Category and click OK.
The category is entered in the Report Sub-Category drop-down list.

10.1.7.3 Subject of Report Tab

On the Subject of Report tab you can select multiple Ingredients for a configured
NDA Report per allowable variations of product and license configuration and
periodic reporting requirements for the FDA. Select multiple ingredients to view the
multiple licenses to be selected for the report.
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The following table describes the items in the Subject of Report tab.
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Field Description

Primary Agency Select the Primary Agency.

Reporting Displays the list of configured Regulatory Agencies. Select an agency
Destination from the list displayed in Reporting Destination and click Add to add

Selected Destination

Company Name

Ingredient

Approval

Trade Name

Award Date

Print all
configuration criteria
on separate cover

page
Print page numbers
on reports

Allow access to
report cases through
Hit List

the report to the Selected Destination list.

Select multiple agencies by holding the CTRL key when you click
them.

Displays the list of agencies where the report is being sent. Select an
agency from the list displayed in Reporting Destination and click Add
to add the report to the Selected Destination list.

Select multiple agencies by holding the CTRL key when you click
them.

Likewise, select an agency from the Selected Destination list and click
Remove to prevent it from being sent to the selected destination.

If a regulatory agency is selected, the company name associated with
the regulatory agency (this association is created by the Administrator)
is automatically entered in this field.

This field is populated with ingredient selected in the Subject of
Report tab.

Note: Click the checkbox corresponding to this field to choose whether
you want this field to appear on the report.

This field is automatically filled with License numbers, separated by
commas. This is an editable field.

Automatically displays the Trade Name.

Multiple trade names are also populated from license trade name
(formulation, concentration) of selected licenses, separated by commas.

Note: Click the checkbox corresponding to this field to choose whether
you want this field to appear on the report.

Automatically displays the earliest license awarded date, when a user
selects an Ingredient and a Product.

Note: Click the checkbox corresponding to this field to choose whether
you want this field to appear on the report.

Click this checkbox to print out the configuration of this report when
the report is printed. This is only available when the PDF option is
selected during printing.

When checked, this option enables the user to print page numbers on a
periodic report. This is the default for all report configurations.

If this checkbox is not checked, the following occur.

»s  The "Use Periodic Numbering on the reports" option in the NDA
Line Listing tab is grayed out and inactive

= The "Additional Separate Page Numbering for UD Summaries" in
the NDA Summary Tabulations tab is grayed out and inactive.

»  The system removes all existing report page numbering and the
option to check page number check boxes on the report
configuration tabs are grayed out and inactive.

When the report is run as final, it creates a Hit List, which can be
retrieved from other areas of the application where advanced
conditions can be selected. Click this checkbox to report cases through
the Hit List.
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10.1.7.4 Product Selection Tab

The Product Selection tab enables you to select product information to include on the
report.
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The following table lists and describes the fields on the tab.

Field Description

Available Ingredients Displays the list containing the Ingredients used for the product
configuration. Select an ingredient from the list displayed in Available
Ingredients and click Add/Remove to add/remove the ingredient.

You can select multiple ingredients at a time.

Filter Enter an Ingredient name and click Filter to search for the entered
ingredient within the Available list of Ingredients.

Selected Ingredients ~ Displays the list of ingredients selected from the Available Ingredients
list.

Indication This list contains a list of all the indications for the products containing
the selected ingredient. The selections made from this list are displayed
in the Available Products section.

Note: You can select multiple Indications from the list at a time by
pressing the CTRL key and clicking the different Indication entities.

Formulation This list contains the Formulations configured for the product
containing the selected ingredient and indication. The selections made
from this list get displayed in the Selected Products section.

Note: You can select multiple Formulations from the list at a time by
pressing the CTRL key and clicking the different Indication entities.

Available Licenses This list is automatically populated with the licenses from the
Indication section.
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Field Description

Selected Licenses This list contains licenses selected by the user from the Available
Licenses list. When a product is selected, the Trade Name and Award
Date fields are auto-populated with the license trade name
("formulation”, "concentration") and earliest License Award Date for the

product.

10.1.7.5 Inclusion Criteria Tab
The following table describes the items in the Inclusion Criteria tab.
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Field

Description

Case Creation Date

Case Receipt Date

Use Current Version
Use DLP Version

Age Groups

Option (Applicable to
Non-15-Day Selection
Only)-
Domestic/Foreign
Cases

Allows you to specify a range of cases by the date when the case was
created.

Allows you to specify a range of cases by the initial receipt date.

Allows you to use the latest revision to populate the data within the
selected reports.

Allows you to use the case data of the version as of the specified DLP
Version.

Allows you to include or exclude cases based on the patient's age
group. Select the Age Groups checkbox to activate the age groups and
select all the age group categories that apply.

This option allows the user to include domestic and foreign cases
within the periodic report. Select Domestic if Country of Incidence is
USA and Foreign if Country of Incidence is not USA.
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Field Description

Option (Applicable to This option allows the user to exclude Literature and Study Cases from
Non-15-Day Selection being considered for the NDA Report. Select Exclude Literature Cases
Only)- to exclude literature cases and select Exclude Study Cases to exclude

Exclude Literature study cases.

Cases/Study Cases

Advanced Condition Allows you to specify an advanced condition that must be satisfied by
each case that is included in the report. Ensure that the advanced
condition or the advanced condition query set that is specified here
does not contradict any other criteria specified in the dialog.

Add Cases not Enter the start date. This adds cases not included in a previous
Included in a reporting period with the specified start date.

previous reporting

period Start Date

Include Unlocked Allows you to include unlocked cases in the periodic report.
Cases

Evaluate Primary Allows you to select only the Primary Suspect Drug.
Suspect Drug Only

10.1.7.6 Line Listing Tab

The NDA report comprises of three tabs. The options for these tabs can be configured
in the Line Listing tab.
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The following tables lists and describes the fields on the tab.

Field Description

Tab 1: FDA - Select this checkbox to generate the MedWatch 3500A (Drug) or VAERS
3500/ VAERS Forms  reports which are serious listed or non-serious
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Field Description

Suppress printing of ~ Select this checkbox to prevent printing the non-serious listed reports
non-serious listed but print their case numbers in the main NDA report indices

reports

Note: Tab 1 of the NDA Line Listing report cannot be generated
without Tab 2. However, Tab 2 can be generated without Tab 1

Tab 2: Index of Select this checkbox to generate an index of the forms from Tab 1 It
Submitted Formsin  prints all MedWatch/VAERS forms for the following cases:
Tab 1

s Serious Listed
s Non-Serious Unlisted
s Non-Serious Listed

Note: Previously expedited 15-day reports that are Serious and
Unlisted that have already been submitted to the FDA do not need to
be re-submitted with this periodic report

Tab 3 Part 1: NDA Select this checkbox to generate a list of all serious unlisted expedited

Line Listing of 15 reports within the specified time period.
Day Reports . . .
Submitted Note: The dates in these reports are in GMT.

TAB 3 Part 2: Select this checkbox to generate a tabulation by System Organ Class
Tabulation by System (SOC) of all events reported during the specified time period. This
Organ Class (SOC) of includes the cases for which expedited reports were previously

All Event Reports generated, as well as the cases that are submitted as part of the current
Submitted report

TAB 3 Part 3: Cases  Select this checkbox to print a list of all the serious unlisted events for
sent to FDA under which reports were submitted to the FDA previously

another NDA Note: If you select to print out the Tab 3 Part 3 section, the NDA report
looks for other submissions (E2B, MW, MW Drug, or VAERS) to the
same agency for the same case against other (not included in selection
criteria for this report) marketed licenses. Any submission matching
this criterion is listed on the Tab 3 Part 3 section of the NDA report. If
there are multiple submissions against different licenses, then each one
is listed. Each license is listed only once

Include Periodic Select this checkbox to include all cases that have been sent under
Submissions another NDA

Start Page Number Select the page number for the first page of the report

Listing Options These options for "List cases only once, under the primary event body
system" and "List cases under all events body systems" only apply to
the NDA Line Listing of Expedited Reports Submitted report

List cases only once,  Select this option to list cases only once
under the primary

event System Organ

Class

List cases under all ~ Select this option to list cases under each SOC for each event
events System Organ
Classes

Include Summary of  Select this checkbox to include a Summary of Cases missing
Cases Missing Assessments at the end of the report
Assessments

Include Summary of  Select this option to include a summary of unlocked cases
Unlocked Cases
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Field Description

Include Listing of Select this option to include cancelled 15-day alert cases during the
Nullified 15-day reporting period

Alert Cases : ;

Submitted During Note: The dates in these reports are in GMT.

the Reporting Period

Use Periodic Select this option to use periodic numbering on reports

numbering on the

Reports

Custom Case Enter the Summary Report Title

Summary Tabulation

Advanced Condition Select the Advanced Condition from the drop-down list

10.1.7.7 Summary Tabulations Tab

The Summary Tabulations tab allows you to specify which summary tabulations will
appear along with the line listing.
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The following table lists and describes the fields on the tab.

Field Description

Include these Allows you to select from pre-configured summary

summary tabulations/listings. These tabulations are based only on the data
tabulations/listings  included in the line listing. Select the Exclude Follow-up Cases check
based on the set of box to filter out follow-up cases from the attached report.

cases presented in the

line listing

Note: If the Exclude Follow-up Cases option is selected on the
Inclusion criteria tab, this option is ignored and follow-up cases are
always filtered out.

Include these Allows for additional sub-reports based on the 'Case Data Analysis'
summary tabulations template, to be included as an output for the all cases in the database
based on all cases that meet the NDA Report inclusion criterion for all dates.
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Field Description

Add Displays a list of memorized Case Data Analysis Reports that have
been marked for availability in a periodic report.

Remove Click this button to remove a selected report.

Additional Separate  Enables you to include additional separate page numbering for
Page Numbering for summaries.

Summaries
Case Count Enables you to print the list of Case Numbers that are included in the
Summary Report Periodic Reports but are not locked.

10.1.7.8 Scheduling Tab

The Scheduling tab allows you to specify details of how often the periodic report will
be scheduled.
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The following table lists and describes the fields on the tab.
Field Description
Start Date This is the International Birth Date for the NDA Report product. This
date is computed as the earliest Awarded date for any license of any
type.
Recalculate Allows a user to recompute the International Birth Date of the NDA

Report Product. This date can be overwritten/manually entered, if
needed.

Report is due xx days Enter the number of days when the report will be due after the end date
after selected end specified for the scheduling period.

date (creation or

receipt date)
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Field Description

Automatically Allows a user to specify the timing of the automatic report generation,
generate report xx by specifying the number of days before/after the selected end date of
days before/after the report.

selected end date at

XX:XX

Group Allows the user to select the group to which the automatically

generated report is to be assigned.

10.1.7.8.1 Scheduling Frequency The following is an illustration of the Scheduling
Frequency section.

The following table lists and describes the Scheduling Frequency fields.

Field Description

Frequency Allows a user to specify the interval required for this scheduling
period.

Start Allows the user to specify when the scheduling period starts.

End Allows the user to specify when the scheduling period starts.

Add Allows a user to add another scheduling interval.

Delete Allows a user to delete a scheduling interval.

10.1.7.9 Security Tab
The Security tab is used to configure the security level for the NDA Reports.
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Field

Description

Share this Report
with Other Users

User Groups
Execute

Modify & Execute

Click this checkbox to share this report with other users. Specify the
privileges to be granted to groups by adding the group name from the
Users Groups list to either the 'Execute’ or 'Modify and Execute' list. A
user group can exist in only one of these access lists.

The groups listed here have no access to the NDA Report template.
Click Add or Remove to move them to another access list.

The groups listed here have read and execute access to the shared NDA
Report template.

The groups listed here have read, execute and modify access to the
shared NDA Report template.

10.1.8 Bulk Reporting

Bulk Reporting enables you to print, transmit and/or submit reports in bulk.

1. Select Reports --> Bulk Reporting to view the Bulk Report screen.

2. The system displays the screen.

10.1.8.1 Bulk Reporting Filter Section
The Bulk Reporting Filter sections enables you to filter reports.

The following table lists and describes the fields in this section
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Field Description

Destination Select an Agency to filter reports by that particular agency. Only the
agencies that have reports in the Scheduled, Approved and Generated
states are displayed. Click Filter to select multiple agencies from the
Reporting Destinations dialog. The previous filtering criteria is saved
and retained when the user invokes this dialog. By default, all agencies
are assumed.

Report Form Select any of the listed report forms to view reports belonging to the
selected report form only.
Report Status Choose either Scheduled /Generated, Pending, Failed, or
Printed /Transmitted from the drop-down list.
Print Regulatory Prints the report as Draft or Final. The Draft option is disabled when
Report the printing option is set to Transmit. Select Medical Summary to view

the list of only medical summaries of distinct cases in a PDF.

Approved Reports Filters reports for only approved reports.

Only

View All Displays the bulk reports applicable to your filter selections.

Product Family Enter a Product family to view all cases where the scheduled reports
belong to the searched Product family.

Study ID Filters reports on the basis of the Study ID.

Product Group Filters reports on the basis of the Product Group. If a value is selected
in the Product Group filter, the Product Family dropdown values
automatically narrow down to the product families which belong to the
selected Product Group filter.

Specific Case # Searches a specific case. To do so, enter the Case Number of the case

you wish to search and click the Retrieve button. This stores the agency
selections last made.

10.1.8.2 Total Number of Rows Section
The system displays the search results in the Total Number of Rows section.
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The following table lists and describes the fields and columns in this section.

Field Description

Selected Allows the user to select the report.

Lock State Displays the Case status of the case to depict if the case is locked or
un-locked.

Status Displays the Report Status e.g. Scheduled or Generated etc.

Click the status to view the report details.
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Field

Description

Case Number

Country of Incidence

Report Type

Suspect Product

Diagnosis
(Event Verbatim)
S/U/R

ForLT

7/15

Report Form

Destination

Initial / Follow-up
)

Due Date
Days Past Due

Downgrade

View All

Displays the Case number.

Click the Case Number link to open the case.
Displays the view Country of Incidence.
Displays the Case Report Type

Displays the Trade Name for which the report has been scheduled. If
more than one Suspect Company Product exists for the case, an "(+)" is
placed at the end of the product name.

For Reports which were scheduled for the Device, the Device name is
displayed.

Displays the Primary Event Diagnoses PT
Displays the (Verbatim as reported) of the Primary Event.
= Displays the Case Level Assessments:

= Serious (Y/N)

= Unlisted (Y/N)

s Causality (Y/N)

s Unknown is treated asa "?"

= The SUR link displays the Case Summary associated with the
selected case.

Fatal / Life Threatening

= If any of the events in the case are Fatal or Life Threatening F or LT
is displayed.

= If the case is both F and LT, only F is displayed.
= If the case is neither F nor LT, only No is displayed.

Displays 7 if the report is due within 7 days
Displays 15 if the report is due in more than 7 days

1. Displays the Description of the report
2. Click the Report form link to view the DRAFT Report as a PDE.

Displays the report destination (agency) for which the report is
scheduled.

Initial or Follow-up

If Follow-up, the follow-up number is printed
Displays the due date.
Displays the number of days the report is past due date.

Allows the user to view if the report is downgrade.

Displays Yes if the report is a downgrade report else.

Allows administrator and workflow manager to see all items in the
system.

Tip: The icon (displayed in the lock state) in the Reports-> Bulk
Reporting screen denotes a SUSAR (Suspected Unexpected Serious
Adverse Reaction) case.
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10.1.8.3 Printing Options

Several printing options are available to you.

The following table lists and describes the available printing options

Field Description

Blind Study Product  Select this check box to print study cases with blinded information.

Mark as Submitted Select this check box to mark reports as Submitted when the
transmission/e-mail has been sent.

A dialog is displayed is this check box is not selected. This dialog
prompts you to confirm if the report is to marked as submitted or not.

Select Yes or No, as required. This selection is remembered for the next
time when you print a report.

Print Medical Allows the user to print the Medical Summaries.

Summary

Print Allows you to choose the printer for the selected report from the Select
Site Printer dialog.
Select the Site and Printer Name where you wish to print the report
and click OK.

Print List Allows the user to print the current view of the Bulk Reporting.

10.1.8.4 User Options

The following options are available to you.

s Lock State Header Options

= Lock State Icon Options

10.1.8.4.1 Lock State Header Options To sort the cases based on the following case status,

click the Lock State header row. A pop-up appears listing the following sorting
options:

= Lock State

= SUSAR

s Exp/Per

These options enable you to sort cases based on the case categorization.
Tip: The icon (displayed in the lock state) in the Reports-> Bulk

Reporting screen denotes a SUSAR (Suspected Unexpected Serious
Adverse Reaction) case.

10.1.8.4.2 Lock State Icon Options Click the Lock State icon to view the list of options.
The following table describes these options:

Field Description

View Report Displays the Draft report.

Report Details Displays specific information about the report as entered in the
Regulatory Reports section.

Case Summary Displays the Case Summary dialog

Remove Report Deletes the report from the case on being asked for a justification
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Field

Description

Mark for
Non-Submission

Remove Multiple
Reports

Mark Multiple for
Non-Submission

Displays the Submission tab in the Report Details dialog.

Select No for Mark for Non-Submission and enter the reason for the
non-submission.

Deletes multiple reports from the case on being asked a justification.

Deletes multiple reports from the case on being asked a justification.
The notes and date entered for the selected report are applicable for all
the reports selected for Non Submission.
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Reports: Bulk Reporting, E2B Pending, and
Processed E2B Reports

This chapter contains detailed information about the following reports:
Bulk Reporting

E2B Pending Reports

Processed E2B Reports

11.1 Bulk Reporting

Bulk Reporting enables you to print, transmit and/or submit reports in bulk.

Select Reports --> Bulk Reporting to view the Bulk Report screen shown in the
following illustration.

11.1.1 Bulk Reporting Filter Section

The Bulk Reporting Filter sections enables you to filter reports.

o Ittt ety
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|| ActiveCases | Worklist | Case Actions Reports Local Affiliate Utiities | Dashboards || Argus Console |

Reports > Bulk Reporting
BULK REPORTING

File__| Report Form

Report Status Print Regulatory Report
E e Transme

v

Specific Case? Study ID % Pre

The following table lists and describes the fields in this section

Field Description

Destination Select an Agency to filter reports by that particular agency. Only the
agencies that have reports in the Scheduled, Approved and Generated
states are displayed. Click Filter to select multiple agencies from the
Reporting Destinations dialog. The previous filtering criteria is saved
and retained when the user invokes this dialog. By default, all agencies
are assumed.

Report Form Select any of the listed report forms to view reports belonging to the
selected report form only.

Report Status Choose either Scheduled /Generated, Pending, Failed, or
Printed / Transmitted from the drop-down list.
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Field Description
Print Regulatory Prints the report as Draft or Final. The Draft option is disabled when
Report the printing option is set to Transmit. Select Medical Summary to view

the list of only medical summaries of distinct cases in a PDF.

Approved Reports Filters reports for only approved reports.

Only

View All Displays the bulk reports applicable to your filter selections.

Product Family Enter a Product family to view all cases where the scheduled reports
belong to the searched Product family.

Specific Case # Searches a specific case. To do so, enter the Case Number of the case

you wish to search and click the Retrieve button. This stores the agency
selections last made.

11.1.2 Total Number of Rows Section

The system displays the search results in the Total Number of Rows section.
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The following table lists and describes the fields and columns in this section.

Field Description

Selected Allows the user to select the report.

Lock State Displays the Case status of the case to depict if the case is locked or
un-locked.

Status Displays the Report Status e.g. Scheduled or Generated etc.

Click the status to view the report details.
Case Number Displays the Case number.

Click the Case Number link to open the case.
Country of Incidence Displays the view Country of Incidence.
Report Type Displays the Case Report Type

Suspect Product Displays the Trade Name for which the report has been scheduled. If
more than one Suspect Company Product exists for the case, an "(+)" is
placed at the end of the product name.

For Reports which were scheduled for the Device, the Device name is

displayed.
Diagnosis Displays the Primary Event Diagnoses PT
(Event Verbatim) Displays the (Verbatim as reported) of the Primary Event.

Reports: Bulk Reporting, E2B Pending, and Processed E2B Reports 11-2



Bulk Reporting

Field Description

S/U/R = Displays the Case Level Assessments:
= Serious (Y/N)
s Unlisted (Y/N)
s Causality (Y/N)

s Unknown is treated asa "?"

= The SUR link displays the Case Summary associated with the
selected case.

ForLT Fatal / Life Threatening

If any of the events in the case are Fatal or Life Threatening F or LT is
displayed.

If the case is both F and LT, only F is displayed.
If the case is neither F nor LT, only No is displayed.

7/15 Displays 7 if the report is due within 7 days
Displays 15 if the report is due in more than 7 days
Report Form Displays the Description of the report
Click the Report form link to view the DRAFT Report as a PDF.
Destination Displays the report destination (agency) for which the report is
scheduled.
Initial / Follow-up Initial or Follow-up
#) If Follow-up, the follow-up number is printed
Due Date Displays the due date.
Days Past Due Displays the number of days the report is past due date.
Downgrade Allows the user to view if the report is downgrade.

Displays Yes if the report is a downgrade report else.

View All Allows administrator and workflow manager to see all items in the
system.

Tip: Theicon (displayed in the lock state) in the Reports-> Bulk
Reporting screen denotes a SUSAR (Suspected Unexpected Serious
Adverse Reaction) case.

11.1.3 Printing Options

Several printing options are available to you.

The following table lists and describes the available printing options:

Field Description

Blind Study Product ~ Select this check box to print study cases with blinded information.

Mark as Submitted  Select this check box to mark reports as Submitted when the
transmission/e-mail has been sent.

A dialog is displayed is this check box is not selected. This dialog
prompts you to confirm if the report is to marked as submitted or not.

Select Yes or No, as required. This selection is remembered for the next
time when you print a report.
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Field Description

Print Medical Allows the user to print the Medical Summaries.

Summary

Print Allows you to choose the printer for the selected report from the Select

Site Printer dialog.

Select the Site and Printer Name where you wish to print the report
and click OK.

Print List Allows the user to print the current view of the Bulk Reporting.

11.1.4 User Options

The following options are available to you.
s Lock State Header Options
= Lock State Icon Options

11.1.4.1 Lock State Header Options

To sort the cases based on the following case status, click the Lock State header row. A
pop-up appears listing the following sorting options:

= Lock State

= SUSAR

s Exp/Per

These options enable you to sort cases based on the case categorization.
Tip: Theicon (displayed in the lock state) in the Reports-> Bulk

Reporting screen denotes a SUSAR (Suspected Unexpected Serious
Adverse Reaction) case.

11.1.4.2 Lock State Icon Options
Click the Lock State icon to view the list of options.

The following table describes these options:

Field Description

View Report Displays the Draft report.

Report Details Displays specific information about the report as entered in the
Regulatory Reports section.

Case Summary Displays the Case Summary dialog.

Case Details Displays the Case Details screen. The tree structure of the case displays
only the ‘Reports’ node, with its existing features.

Medical Review Displays the Medical Review screen.

Remove Report Deletes the report from the case on being asked for a justification

Local Labeling Allows Local Labeling for the selected case.

Mark for Displays the Submission tab in the Report Details dialog.

Non-Submission Select No for Mark for Non-Submission and enter the reason for the

non-submission.
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Field Description

Remove Multiple Deletes multiple reports from the case on being asked a justification.
Reports

View Multiple Allows you to view multiple reports.

Reports

11.2 E2B Pending Reports

The E2B Pending Reports page enables you to:

= View the E2B reports sent by the agency or the trading partner
m  Process an incoming E2B report.

You can do the following:

»  Check all the E2B values of the reports sent and determine whether to accept or
reject the reports

= Provide a user password and acceptance notes/rejection reason and accept or
reject an incoming E2B report

Select Reports --> E2B Pending Reports to view Incoming E2B Reports page show in
the following illustration.

11.2.1 Incoming E2B Reports Fields
The following table describes the fields on the IncomingE2B Reports page.

Field Description

Trading Partner Enter the trading partner. Click Filter to select an agency to filter by that
particular Trading Partner. This allows you to select multiple agencies
by clicking Add from the Select Reporting Destinations dialog.

Product Enter the product name or generic name, as required.
Name/Generic Name

Report Type Select the report type, as applicable.

Transmit Date Range Enter the range of the Transmit Date from the From and To fields. You
can also select the range from the Range drop-down list.

Trading Partner Displays the name of the Trading Partner of the case.

Initial / F/U / Null ~ The report version of the report
s Initial: If the case received is an Initial Case.
= Follow -up: If the case received is a Follow-up Case.

s Nullification: If the case received is a Nullification Case.

World Wide Unique # The worldwide unique number of the received case.

Sender Case # Displays the case number of the sender.
Transmission Sent Displays when the transmission was sent.

MDN Sent Date Displays the date the MDN was sent.
Interchange Displays the date the interchange was processed.

Processed Date
Case Receipt Date Displays the date the case was received.

Country of Incidence Displays the country where the incident occurred.
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Field Description
Report Type Displays the report type of the case.
Imported Case # Displays the number of the imported case.

Product Name
Generic Name
Event PT
Event LLT

Is/Will be assigned
to this site

Pat Initials
Study ID/Pat. ID
Reporter Type

Reporter

Displays the product name.

Displays the generic name of the product.

Displays the Primary Event and Verbatim as Reported.
Displays the Event LLT for the Event Information.

Displays the site membership of the case.

Displays the initials of the patient.
Displays the Study ID/ the ID of the patient in the case.
Displays the primary reporter's Reporter Type.

Displays the first and last name of the Primary Reporter.

11.2.1.1 Button and Right-click Options

The following table describes the different buttons and right-click options available on
Incoming E2B Reports page.

Button

Description

ICSR Viewer

View Error/Warning
Message
Duplicate Search

Accept ISCR

Reject ICSR

Select this right-click option to launch the E2B viewer. For details, refer
to the ESM User Help.

Note: At the time of generating an E2B report, some characters entered
by the user in the case form may not be displayed the same in the E2B
report. For example, the E2B report equivalent of the "&" character
entered in the case form is &. Similarly, there are other such characters
that are represented differently in the E2b report. The table below
contains the list of such characters and their equivalent representations
in the E2b report:

Select this right-click option to view all warning messages including
M2 validation errors and Multiple E2b Codes log.

Select this right-click option to perform Duplicate Search for the case
being imported with the case present in the system.

Selects the incoming E2B report
Execute these steps to accept an E2B Case:

1. Click the Accept E2B Case button. The Acceptance of Initial Report
Confirmation dialog opens.

2. Enter your user password, date, and select a justification from the
pre-defined list of justifications.

3. Click OK.

Rejects the incoming E2B report
Execute these steps to reject an E2B Case:

1. Click the Reject E2B Case button. The Rejection of Initial Report
Confirmation dialog opens.

2. Enter your user password, date, and select a justification from the
pre-defined list of justifications.

3. Click OK.
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Button Description

Reject ICSRs Enables you to reject multiple ICSRs by selecting the checkbox against
each ICSR to that needs to be rejected. You can select the type of report
to be followed up from the Follow Up Report Form screen.

This screen allows you to select a Follow-up Report format for a Report
Form.

Select the desired option and click OK to print out the CIOMS or the
MedWatch Report Form as a PDF report whilst importing the cases.

Accept ICSRs Enables you to accept multiple ICSRs by selecting the checkbox against
each ICSR to that needs to be accepted.

You can select the type of report to be followed up from the Follow Up
Report Form screen.

This screen allows you to select a Follow-up Report format for a Report
Form.

Select the desired option and click OK to print out the CIOMS or the
MedWatch Report Form as a PDF report whilst importing the cases.

11.2.2 Pending Reports

When using E2B Pending reports, be aware of the following:

»  The system uses the Oracle Text profile settings for the duplicate search in E2B
Pending configured in the Argus Schema Creation Tool.

»  The user can right click on the row and select the following:
Case Summary. This displays the Case Summary (current functionality)

Medical Summary. This displays the Medical Summary report, if the user has
permission to access the Medical Review dialog.

Case Form Print. This launches the Case Form Print dialog to enable the user to print
the case form in a new IE window.

11.2.3 Bulk Incoming E2B Reports

The Bulk Incoming Reports dialog allows the user to import multiple E2B reports that
have been sent by the agency or trading partner.

Be aware of the following:

s The reports that are imported can be a combination of Initial, Follow-up and
Nullification reports.

= The only pre-requisite for this dialogue is that Case numbering should be set to
auto-numbering and not manually.

s Bulk Incoming Reports does not prevent the duplicate cases to be loaded into the
system.

To view Bulk Incoming Reports

1. Select multiple reports from the Incoming E2B Reports screen and click Accept
ICSRs.

2. The system opens the Bulk Incoming Reports screen.

The following table lists and describes the fields in the Bulk Incoming Reports dialog
box.
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Field
Agency Name

Product Name

Follow Up Output
Format

Source Count

Report Type

Selected Count

Import

Cancel

Description

This drop down list contains unique trading partner from the E2b
reports have been received. You can select a particular agency/trading
partner to filter the E2b reports.

This drop down list contains unique suspect Product Names extracted
from the received E2b reports. Select a particular suspect product to
filter the E2b reports. If an Agency Name is selected, the Product Name
list contains all suspect products belonging to that agency name.

This drop down list contains CIOMS-I, MedWatch and Case Form. You
can print all E2b reports in CIOMS-I, MedWatch or Case Form format
only if the Follow Up checkbox has been selected.

Displays the total number of E2b reports with breakdown in 'Initial’
'Follow Up' and 'Nullification' category.

Displays the report type.

Displays the number of E2b selected by the user to load the E2b reports
in Argus Safety. Selected count can be changed by checking the 'Initial’
or 'Follow Up' or Nullification' checkbox.

Imports all the reports.

Note: For the Import process, if the system receives an E2B report with
the Medically Confirm field set to 1, the Primary reporter is marked as
HCP.

Removes the Import E2B reports window.

11.2.4 Duplicate Search

The Duplicate Search dialog for an E2B report enables you to search for possible
duplicate cases in the Argus Safety system. You can select different combinations of
search criteria. When more than one criterion is selected, only cases that satisfy all
criteria are listed. By default, only the fields that are present in the E2B Report are
checked for the Duplicate Search.
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11.2.4.1 Duplicate Search Dialog Box Fields and Field Descriptions
The following table describes the fields present in the Duplicate Search dialog.

Field Description

Agency The name of the primary agency.
Original Case The original case number.
Number

Message Number
Product Name
Generic Name
Report Type
Study ID
Receipt Date
Center ID

Sal.

Suffix

First Name
Last Name
Country of Incidence
State

Postal Code
Patient Name
Event Desc.
Initials

Onset Date
Pat. ID
Age/Units
Pat. DOB
Gender

Reference #

Journal
Nullification Reason

Select All / Deselect
All

Accept Initial E2B as
Follow-Up

Search

View E2B
Accept E2B Case
Reject E2B Case

The message number of the case.

The product name that caused the adverse event.

The generally known, popular name of the product.
The type of report.

The Study ID.

The date the report was received by Argus and saved in the system.
The ID of the center.

The salutation such as Mr. or Mrs.

The sulffix, if applicable, that follows the name.

The first name of the patient.

The last name of the patient.

The country where the incident occurred.

The state where the incident occurred.

The postal code of the area where the incident occurred.
The name of the patient.

A description of the adverse event.

The initials of the patient.

The date from when the first reaction or adverse event occurred.
The ID of the patient.

The age of the patient.

The date of birth of the patient.

The gender of the patient.

National Regulatory Authority's Report Number, used as a Reference
Number.

The journal name related to the adverse event.
The reason why the case was nullified.

Allows you to select (check) / deselect (uncheck) [respectively] all the
checkboxes associated with the searched fields.

Enables you to accept initial E2B as a follow-up

Finds results matching the specified search criteria.
Enables you to view the E2B report.
Enables you to accept an E2B case.

Enables you to reject an E2B case.
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Field

Description

View Warning

View Differences

Case Number

Pat. Initials

Action
Project ID
Study ID
Date
Country

Product

Event
Report Type
Reporter

Enables you to view warnings associated with the case.

Allows viewing differences between the current XML to be imported (a
message that is not yet imported into the database), the current case
data in the database, and if a case has been imported before, the last
imported case.

Note: This button is available only for follow-up and nullification
reports.

Displays the case number of the case matching the search criteria.

Displays the initials of the patient in the case matching the search
criteria.

Enables you to view the Case Summary dialog.

Displays the Project ID of the case matching the search criteria.
Displays the Study ID of the case matching the search criteria.
Displays the date of the case matching the search criteria.

Displays the country name of the case matching the search criteria.

Displays the product name involved with the case matching the search
criteria.

Displays the event involved with the case matching the search criteria.
Displays the report type of the case matching the search criteria.

Displays the reporter involved with the case matching the search
criteria.

11.2.4.2 Duplicate Search for Incoming Review

The Duplicate Search in Argus Central Incoming review enables you to search on
Reference ID and Keyword field in Argus cases.

You can right-click against the Case Number for a listed case and use the following

options:

Right-click Option

Description

Case Form Print

Case Summary

Medical Summary

Unlock/UnArchive
Case

This option is displayed for only those users who belong to the group
with access to Argus Console > Access Management > Groups > Menu
> File > Print. This option allows you to print the case form report.

This option is displayed for only those users who belong to the group
with access to Argus Console > Access Management > Groups > Menu
> File > Open Case Summary. This option allows you to open the
summary report of the case.

This option is displayed for only those users who belong to the group
with access to Argus Console > Access Management > Groups > Menu
> File > Print. It displays the medical summary of the case.

This option is displayed to allow users to re-open the archived and
locked cases. On clicking this option, a Locked Case/Archived Case
screen (as applicable) is displayed. You need to enter your password
along with any remarks/notes and select a reason for your action to
complete the unlocking /unarchiving of the case.

Note: This option is available only when the case is in locked /archived
status, and if the user has privileges to lock/close the case, as per
Console User Configuration > Case Form settings.
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Be aware of the following;:

s The Reference ID field searches on the following fields in the Argus case:

— Additional Info | Case Reference ID

— Reporters | Reporter's Reference #

- Argus Case Number

= By default, the system populates the Keyword field with the first value from the
incoming affiliate event.

11.2.5 View Differences Report

The View Differences Report enables you to view differences between the current
XML to be imported (a message that is not yet imported into the database), the current
case data in the database, and if a case has been imported before, the last imported

case.

Note: View Differences is available for follow-up reports only. This option is enabled
only when an initial case or case number is selected in the duplicate search output

section.

Click View Differences from the Duplicate Search screen to view the View Difference
report. This displays the E2B Difference Report.

The following table describes the fields in the report.

Field Description

Trading Partner Allows you to view the Trading Partner name from whom the E2B
report is received.
Note: The Lock/Archive icon displayed with this field denotes the
status of the case.

DTD Version Allows you to view the DTD version of the follow-up E2B report.

Case Number
Follow Up #

Total Number of
Rows

Import
E2B Element
Current E2B

Current Case in
Database

Last Imported E2B

Accept Follow-up
Reject Follow-up

Print List

Displays the original case number of the E2B report.
Displays the sequence number of the follow-up for the E2B report.

Allows you to select the type of E2B Difference to view from: Current
E2B vs. Current Case in Database

»  Current E2B vs. Last Imported E2B
= Current Case in Database vs. Last Imported E2B

Select this check box to highlight import differences.
Select this check box to highlight E2B differences.
Select this check box to highlight differences in the current E2B.

Select this check box to highlight differences in the current case in the
database.

Select this check box to highlight differences in the last imported E2B.

Allows you to update the corresponding fields for the selected E2B
elements in the Argus case.

Does not update the corresponding fields for the selected E2B elements
in the Argus case.

Provides the difference report in a PDF format.
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11.2.5.1 Displaying Differences
The system displays the differences in the E2B reports as follows:

= Addition -- New elements are highlighted in grey.

= Deletion -- Deleted elements are highlighted in red.

= Modification -- Modified elements are highlighted in yellow.

11.25.1.1  Accept Initial E2B Cases As Follow-Up This option is enabled only when an
initial case or case number is selected in the duplicate search output section.

1. Click this button to add an ICSR as a follow up to the Case Number, which you
have highlighted in the duplicate search output section.

2. A pop-up dialog appears: "Do you want to add this ICSR as a Follow-up to the
Case Number<Num>?"

3. Click OK to proceed.

4. The Argus application attaches the incoming ICSR as a follow-up, to the selected
case number highlighted in the duplicate search screen.

11.3 Processed E2B Reports

The Processed E2B Reports page contains a list of all the processed E2B Reports.

11.3.1 Search Criteria Section

The system enables you to enter search parameters in the Search Criteria section.
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The following table lists and describes the fields in the Search Criteria section.

Field Description

Trading Partner Enter the trading partner. Click Filter to select an agency to filter by that
particular Trading Partner. This allows you to select multiple agencies
by clicking Add from the Select Reporting Destinations dialog.

Product Name Enables the user to select a Product Name as a search criterion.

Import Status Enables the user to select Import Status as a search criterion.

Report Type Select the report type, as applicable.

Date Range Enables the user to select and specify the Date Range as the search
criteria.

Start Date Enables the user to enter the start date for the search.

End Date Enables the user to enter the end date for the search.

Range Enables the user to select a Range as a search criteria.

Retrieve Enables the user to retrieve any stored search criteria.
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11.3.2 Total Number of Rows Section

The system places the search results in the Total Number of Rows section.
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The following table describes the columns in the Total Number of Rows section.

Field Description

Originated Case# Displays the Originated Case Number of the case.

Initial /F-U/Nullification Displays the Initial /F-U/Nullification status.

Trading Partner Displays the name of the trading partner.

World Wide Unique# Displays the World Wide Unique # of the case.

Import Status Displays the import status of the case.

Warnings / Errors Displays warnings/errors associated, if any.

Accepted / Rejected By Displays who accepted or rejected the case.

Notes Displays the notes for the case, if any.

Interchange Date Displays the Case Number with which the case has been
imported on the specified interchange date.

Date Imported /Rejected Displays the date the case was imported/rejected.

ICK/ACK Sent Displays the status of the ICK/ACK.

= Yellow is displayed if it is still pending.

= Orange is displayed if it is accepted by warnings /
errors.

= Red is displayed if Rejected by user or system.

= Green denotes successful import in the system.

EDI Out Displays the EDI Out status.

= Yellow is displayed if it is still pending to send the
report out of the EDI / XML or PHY out folders.

= Green is displayed if it is already sent out of the EDI /
XML or PHY out folders.

= Red denotes that the EDI gateway failed to send the
report out of the EDI / XML or PHY out folders.
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Dashboards

This chapter describes the dashboards in the Argus Safety application.

12.1 Dashboards Options

Dashboards option is available on the menu bar. Place the cursor over Dashboards in
the menu bar to view the options available in it.

The following is list of available dashboard options.
s Open Case Summary Reports

= Open Action Items Reports

s  Quick Signal Reports

s Increased Frequency Reports

s Expedited Report Status

= Workflow Status

s Reports Due Soon

s Personal Argus Status

s Case Workload

12.1.1 Open Case Summary Reports

The Open Case Summary Report displays a summary of all open cases sorted in
ascending order according to the number of days the case has been open.
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To view the Open Case Summary Report
1. Select Dashboards --> Open Case Summary.

2. The system displays the Open Case Summary Report in PDF format.
When using the Open Case Summary Report, be aware of the following:

s The Date Received column prints the initial receipt date or the latest follow-up
date for the case.

»  If there are no follow-ups for a case, the system calculates open cases based on the
initial receipt date.

»  If there are follow-ups for a case, the system calculates the days open based on the
most recent follow-up in the case. If the latest follow-up date is older than the
previous follow-up, it considers only the last follow-up.

s The system also calculates days open based on the latest follow-up date for the
case.

The following table lists and describes each field in the Open Case Summary Report

Field Description

As of (date) Displays the report as per the current date (in dd-mmm-yyyy format).
Case ID Displays the Case ID of each listed case.

Date Received Displays the date when the case was received.

Product Displays the Product Name.

Event Displays the Event Info/Preferred Term.

Assigned To Displays the Workflow /Case Owner.

Days Open Displays the number of days since the initial receipt date.

Status Displays the Case Status.

Total Cases Displayed at the end of the report, it shows the total number of cases

listed in this Open Case Summary Report.
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12.1.2 Open Action ltems Reports

The Open Action Items Report displays all outstanding action items. This report is
sorted as per the Case ID of the listed cases.
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To view the Open Action Items Report
1. Select Dashboards --> Open Action Items.

2. The system displays the Open Action Items Report in PDF format as shown in the
following illustration.

The following tables lists and describes the fields in the Open Action Items Report.

Field Description

As of (date) Displays the report as per the current date (in dd-mmm-yyyy format)
Case ID Displays the Case ID of each listed case.

Action Item Lists the status of the case and the action that needs to be taken.

Date Assigned Displays the date when the case was opened/assigned.

Assigned To Displays the Workflow /Case Owner.

Date Due Displays the date when the action item was due.

Days Open Displays the number of days that have lapsed since the date when the

case was opened.

12.1.3 Quick Signal Report

The Quick Signal Report displays the changes in numbers of events over the past
year. This report is a summary listing of events, which have triggered signals.
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Click the following link for information about the information in the fields on the
report.

12.1.3.1 Quick Signal Report Fields
The following table lists and describes the fields in the Quick Signal Report.

Field Description

Product Displays the Product Name.

As of Displays the report as per the current date (in dd-mmm-yyyy format).

Term Displays the Event Information in alphabetical order Body system and
sort them within the body system in descending order.

Last 6 Months Displays the number of cases received in the past 6 months for the

(Selected Drug) selected drug.

All Cases (Selected Displays the total number of cases recorded for the selected drug.

Drug)

Last 6 Months (All Displays the number of cases received in the past 6 months for all the

Products) drugs.

All Cases (All Displays the total number of cases for all the drugs.

Products)

To enter information in the Product Browser
1. Select Quick Signal Report from Dashboards.

2. This displays the Product Browser dialog.

To search through the Product Browser dialog

1.

2.

Click the entities being displayed in the dialog.

The hierarchy above and below the entity being searched is also displayed. For
example, if Product Name is searched, it displays the Product Name as well as the
Family Name and Trade Name.

Search for Products based on the following criteria:
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s Ingredient - Displays the ingredients of the product
= Family - Displays the family of the product

s Product Name - Displays the Formulation (Dosage Form), Concentration
(Strength) and Indication to aid in the selection of the correct product.

s Trade Name - Searches the License Trade Name, Country fields.
3. When the system displays the results, select the appropriate Product.
4. Click Select to view the Quick Signal Report that matches the entered criteria.

12.1.4 Memorized Reports

The system enables you to recall a previously memorized case listing or case data
analysis report for printing. In addition to the reports for a specific user, the system
displays a list of reports whare are shared by all users.

You can select a memorized report from the dialog box. When you select the report,
the system enables the Open button to permit you to open the selected memorized
report. Click Cancel to close the dialog box. Click Delete to delte the selected
ememorized report.

To memorize a configured report, click the Memorize button on the configuration
dialog box for the Case Listing or Case Data Analysis report.The system opens the
Memorized Report .

The system enables you to save the memorized report, make it available for , and
Share the report with other users.

12.1.5 Increased Frequency Reports

The Increased Frequency Report displays events that have occurred at increased
frequency for a given product and indication, based on a FDA formula (modified
t-test).

To generate an Increased Frequency Report
1. Select Dashboards --> Increased Frequency.

2. When the system opens the Increased Frequency Wizard, enter the appropriate
information in the fields and click Generate.

Increased Frequency Criteria Fields and Field Descriptions
The following table lists and describes the fields in the Increased Frequency Criteria

section.

Field Description

Product Allows the user to select the product on which this report is to be based.
Indication Allows the user to select an indication for this product.

Reporting Date Defines the starting date.

Range From Date

Reporting Date Defines the ending date.

Range To Date

Comparison Date Defines the starting date for the comparison period.

Range From Date
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Field

Description

Comparison Date
Range To Date

Units Distributed in
Reporting Interval

Units Distributed in
Comparison Interval

Units

Generate button

Defines the ending date for the comparison period.

Allows the user to adjust the number of units distributed in the
reporting interval.

Allows the user to adjust the number of units distributed in the
comparison interval.

Allows the user to adjust the unit term as appropriate.

Generates the Increase Frequency Report.

The following table lists and describes the information that appears in the Increased

Frequency Report.

Field

Description

Adverse Event

Number of Adverse Events

Displays the name of the adverse event.

Displays the number of adverse events.

12.1.5.1 Increased Frequency Wizard

The Increased Frequency Wizard enables you to determine which events have
occurred at increased frequency for a given product and indication based on an FDA
formula (modified t-test).Select Utilities --> Increased Frequency Wizard to open the
Increased Frequency Wizard dialog box shown in the following illustration.

The following table lists and describes the fields on the Increased Frequency Wizard

dialog box.

Field/IControl Name

Description

Product
Indication

Reporting Date
Range From

Reporting Date
Range To

Comparison Date
Range From Date

Comparison Date
Range To DAte

Units Distributed in
Reporting Interval

Units Distributied in
Comparison Interval

Units

Generate

Enables you to select the product on which this report is to be based.
Enables you to select an indication for the product

Enables you to define the starting date.
Enables you to define the ending date.
Enables you to define the starting date for the comparison period.
Enables you to define the ending date for the comparison period.

Enables you to adjust the number of units distributed during the
reporting interval.

Enables you to adjust the number of units distributed during the
comparison interval.

Enables you to adjust the unit term as appropriate.

Click Generate to generated the Increase Frequency Report.

12.1.6 Expedited Report Status

The Expedited Reporting Status page enables you to search for and field information
about the status of expedited reports. Expedited Reporting Status also appears on the
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Worklist Group menu. Additionally, if you have access to Expedited Report Status,
you wil also have access to the Report Due Soon dashboard.

1. Select Dashboards --> Expedited Report Status to open the Expedited Reporting

Status screen.

2. When the system opens the Expedited Report Status screen, enter the appropriate
information in the fields in the Search Case section and click Retrieve.

3. he system creates the report based on the search criteria you entered.

12.1.6.1 Expedited Report Status Fields and Field Descriptions

The Expedited Report Status screen contains the sections mentioned below:

s Search Case

s Grouped Expedited Reporting Status

= Expedited Reporting Status

12.1.6.1.1 Search Case Status This section enables you to enter the search parameters

for the report
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The following table lists and describes the fields

Field Description

Product Family Allows the user to select which Product Family to be included in the
dashboard.

Site Allows the user to filter the workflow statuses to the selected site.

Serious Case

Related Case
Death/LT Only

All Other Serious

Cases
Reports
View All

Retrieve

Displays if the case is serious or not.
If Yes is selected, the seriousness criteria are enabled.

Note: A case that does not have a seriousness specified (i.e. blank) is
treated as serious.

Filters on the relatedness of the case. A case is only included if it meets
the relatedness criterion.

Select this option to include any case that has any of the Fatal or
Life-Threatening seriousness criteria.

If this seriousness criterion is checked, the case only gets included if
any of the following seriousness criteria of any event are checked:
Hospitalized, Disability, Congenital Anomaly, Medically Significant,
Intervention Required or Other.

Enables you to search for cases.
Enables you to search for reports.
Enables you to view all.

Prints the currently selected dashboard, including filter criteria.

12.1.6.1.2 Grouped Expedited Reporting Status (Pie chart) Click on the Color Coded Areas
of the pie to open all the Reports or Cases within that section instead of just the bar.

Dashboards 12-7



Dashboards Options

12.1.6.1.3 Expedited Reporting Status (Bars) Click on a bar to open the Worklist
displaying the cases that belong to the reports or the actual reports. These reports
belong to the specified timeframe.

12.1.7 Workflow Status

You can view the Workflow Status based on case owner, site, case seriousness, and
other criteria.

To view the Workflow Status

1.
2.

Select Dashboards --> Workflow Status to open the Workflow Status Screen.

When the system opens the Workflow Status screen, enter the appropriate data in
the Search Case fields and click Search.

The system displays the Workflow Status information.

12.1.7.1 General Usage Information
When using the Workflow Status screen, be aware of the following:

Workflow Status appears on the Worklist Group menu.
You can:

Click on a bar graph and select from a dashboard menu to open the list of cases in
the Workflow Status Dashboards.

Click on the graphical bars to drill down on the specific workflow state details.

If no updates are made to cases during case processing, the cases the system
displays the number of cases you clicked during the drill down.

If one or more cases change workflow state between loading the dashboard screen
and loading the worklist-specific screen, a discrepancy in case numbers may occur.

The system maintains user preferences once you return to the Workflow Status
Dashboard.

By default, the system displays only the first filtering results and makes other
filters available when you click More Filtering.

Worklist Status. This screen provides filtering capabilities by site, workflow state,
product family, date range, advanced condition, serious or non-serious, study or
non-study by clicking the More Filtering option. The More Filtering options also
hide additional filtering elements.

Site Filter. The Site Filter is a multiple selection screen that enables you to use the
CTRL and Shift keys to select multiple sites. The default value is All Product
Family. When you use the site filter, the system displays all active (undeleted)
sites in the Argus Code List. However, the system does not display LAM sites.

Workflow State Filter. The Workflow State filter is a multiple selection screen. You
can select use the CRTL and Shift keys to select multiple groups.

- The system displays all active (undeleted) workflow states, except
archived/closed, in the Argus Utilities - Configuration.

— The default selected value is <All>Product Family.
—  The Product Family filter is a type ahead field.

—  The default selection on the type ahead is blank (no filtering on Product
Family). By default, the system displays a maximum of 25 rows.
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— The system displays all active (undeleted) product families configured in the
Argus Code List Product & Family in the Product Family Filter results.

Date Range Filter. In this module, the Date Range function works in the same
manner as it does in other parts of the application.

— The default value for range is last month.

— The system automatically populates the values in the From and To fields with
the dates based on the This Month option.

— The date fields functions as they do in other parts of the application.

— The system evaluates Aware Date to fall in between the date range specified in
the Date Range filter.

Advanced Condition Filter.The Advanced Condition functions as it does in other
part of the application.

Serious or Non-Serious Filter. Five (5) sub-filtering options are available.
- Al

This is the default option. When you select this option, the report returns all
cases whether serious or non-serious.

— Serious

When you select this option, the system returns only those cases that are
serious. The system evaluates seriousness at the event level. If any event is
serious, the system considers the case serious and returns it in the results.

— Non-Serious

When you select this option, the report returns only non-serious cases. All the
events must be non-serious before the system returns the case in the search
results.

— Death/LT Only

When you select this option, the report returns cases that have an event where
Death or Life Threatening is checked. The system disables this check box when
you select the non-serious option.

— Serious other than death or life-threateningFilter.

When you select this option, the report returns only those cases that have an
event with a seriousness criteria other than Death or Life Threatening.The
system disables this check box when you select the Non-Serious option.

Report Type Filter. The Report Type filter is a multi-selection screen that enables
you use the CTRL and Shift keys to select multiple items. The default value is AlL

Project ID Filter. The Project ID filter is a multi-selection screen that enables you
to use the CTRL and Shift keys to select multiple items. The default value is All.
All active Project ID values are configured in the Argus Utilities Protocol ID Code
List.

Default Report Configuration Filter. When no other filters are used, the default
report configuration returns all cases for the current month. The system uses the
case Aware Date for evaluation purposes.

Search Filter. When you click Search, the system displays the Workflow Status
screen.
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= When you click the Bar Graph, the system displays a menu. You can select Late,
Over Normal, Normal or All to go to the worklist-specific screen. When you
double-clicks the bar, the system displays the worklist-specific screen.

s Print. When you click Print, the system uses the standard Argus Print function to
print the search results. This is the same as CDA print functionality.

12.1.7.2 Workflow Status Fields and Field Descriptions

The Workflow Status screen includes the following sections:
s Search Case
= Workflow Status

12.1.7.2.1 Search Case The Search Case section enables you to enter appropriate search
criteria to search for workflow information.
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The following table lists and describes the fields in the Search Case section.

Field Description

Site Allows the user to filter the workflow statuses to the selected site.

Date Range From/To Enables you to filter workflow status based on a specific date range

Range Enables you to filter workflow status based on a pre-define date range
(e.g., last 30 days, etc.)

Case Owner Enables you to filter the workflow status based on the case owner.

Related Case Filters on the relatedness of the case. A case is only included if it meets
the relatedness criterion.

Search Click Search to search for the workflow status.

More Filtering Click More Filter to display more filtering options on the More

Filtering section

Print Prints the currently selected dashboard, including filter criteria.

12.1.7.2.2 More Filtering Section The More Filtering section provides additional criteria
for filtering cases. The following is an illustration of the More Filtering section.
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The following table lists and describes the fields in the More Filtering section.

Field Description

Workflow State Enables you to filter the workflow status based on workflow state (e.g.,
data entry, medical review, etc.)

Report Type Enables you to filter the workflow status based on the report type.
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Field Description

Project ID Enables you to filter the workflow status based on the Project ID.
Serious or Enables you to filter workflow status based on the Serious/Non-serious
Non-Serious criteria as follows:

s All -- Search for all workflow statuses
s Serious -- Search for workflow status for serious cases
s Non-Serious -- Search for workflow status for non-serious cases

= Death/LT Only -- Search for workflow status for Death or
life-threatening cases

s All Other Serious -- Search for the workflow status for all serious
cases other than death or life-threatening.

Product Family Search for workflow status based on product family.
Advanced Condition Search for workflow status based on a selected advanced condition
AC Enables you to create an Advanced Condition.

Print Prints the currently selected dashboard, including filter criteria.

12.1.7.2.3 Workflow Status (Bars) Bar graph colors indicate the following statuses:
= Red -- Late Cases

= Yellow -- Outside of Normal Cases

= Green -- Normal Cases.

Click on the bar to view a Worklist with cases of the selected state (red, green or
yellow).

12.1.8 Reports Due Soon

As report scheduling is commonly configured to be executed when significant changes
are made to a case, it is possible that expedited reports may be delayed if a case never
gets locked. You cannot know that a report is late if it has never been scheduled. In
order to address this potential compliance issue Argus Safety assesses case
reportability prior to formal report scheduling. Workflow and Expedited Status
monitoring screens identify unlocked cases due soon.

To view a list of unlocked cases with reports due
1. Select Dashboards --> Reports Due Soon from Dashboards.

2. The system opens the Unlocked Cases with Possible Reports Due Soon screen is
displayed.

The Workflow and Expedited status include another report with cases that have not
had reports scheduled but that may generate a report with a due date in the near
future. This graph is displayed below the graph detailing the actual case status.The
reports included in this sub-dashboard are limited to the filter criteria specified for the
main dashboard

The following table lists and describes the fields on the Reports Due Soon screen.

Field Description

State Name Displays the workflow state of each listed case is.
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Field Description

Graph Red bars indicate that the report is likely to be due within the next 5
days.
Yellow bars indicate that the report is likely to be due in the next 10
days.

Total Displays the number of cases within the displayed workflow state.

R/Y Number of cases in Red /Yellow

Click the graphical bar to view a Worklist with cases of the selected state (red or
yellow).

12.1.9 Personal Argus Status

The Personal Argus Status screen of the Argus Safety application displays a list of
Cases Assigned, Contact Log Entries and Action Item Entries sections that are specific
to the logged-in user.

To view the Personal Argus Status screen
1. Select Dashboards --> Personal Argus Status.

2. The system opens the Personal Argus Status screen

To search for a case
Use the following procedure to search for a specific case.

1. Type the case number in the Case Quick Launch field of the Home page and click
Open.

2. Click the link displaying a case number to view the case details.

By default, each section and header column is sorted by Case Number in
ascending order.

3. Select the check box for any of the headers to enable that section.

The sections in which the check box is not selected are displayed at the bottom of
the screen.

12.1.9.1 Cases Assigned Section

The system displays the Workflow status for displayed cases in the Cases Assigned
section. You can right-click on the case row and select the Accept option. This moves
the cases to their Worklist Open list.

The following table describes the fields in the Cases Assigned section:

Field Description

Country (Case Displays the name of the country to which the case belongs, with the
Number) Case Number listed in brackets.

Report Type Displays the report type of the case.

Product Displays the product name.

Event Displays the event name
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12.1.9.2 Contact Log Entries Section
The following table describes the fields in the Contact Log Entries section:

Field Description

Country (Case Displays the name of the country to which the case belongs, with the
Number) Case Number listed in brackets.

Contact Date Displays the contact date

Description Displays the description of the case

12.1.9.3 Action Items Entries
The following table below describes the fields in the section:

Field Description

Country (Case Displays the name of the country to which the case belongs, with the
Number) Case Number listed in brackets.

Due On Displays the date when the case is due.

Description Displays a description of the case.

Overdue Action Displays the Action items where the action item due date is before
Items today's date (system date)

12.1.10 Case Workload

The Case Workload feature enables an administrator to view the case workload for
individuals and one or more sites. The Case Workload feature is available for only
Workflow Managers. For example, if a user belongs to a group which has access to this
menu option but is not a Workflow Manager, this option will not be displayed.

To view case workload information
1. Select Dashboards --> Case Workload.

2. The system opens the Case Workload screen.

The following table lists and describes the fields in th Case Workload screen.

Field Description

Site Enables you to view the Cases part of the site.

Displays the specific Worklist where the user can view the case
numbers.

Click + to view the next level and expand either the Workflow State or
Workflow Group.

Workflow State Enables you to view the Workflow State of the Cases part of the site.

Displays the specific Worklist where the user can view the case
numbers.

Click + to view the next level and expand to User Name.

Click the Header to toggle between Workflow Group or Workflow
States.
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Field

Description

Workflow Group

Week Forecast

User Name

Priority

Due In

# of Cases

Refresh

Expand All (+)
Collapse All (1)

Print

Export to XLS

Displays the Workflow Group of the Cases part of the site.

Displays the specific Worklist where the user can view the case
numbers.

Click the Header to toggle between Workflow Group or Workflow
States.

Click + to view the next level and expand to User Name.

Enables the user to view the number of cases projected in the next 5
days for the current workflow state or group.

If a case is routed to multiple workflow states/groups, it is counted
multiple times within the Week Forecast.

The Projected Week Forecast is based on the Dynamic Workflow
calculation for the entire case, as per the configuration settings.

Enables you to view the User Name to whom the cases are assigned.

Displays the specific Worklist where the user can view the case
numbers.

Click + to view the next level and expand to Priority.

Online Users can view the Online icon and their User Names appear in
bold.

Enables you to view the Priority of the Cases part of the User.

Click the link to view the specific Worklist where the user can view the
case numbers.

Enables you to view the Due In of the Cases part of the User.

Displays the specific Worklist where the user can view the case
numbers.

Due In is based on the Days remaining field, similar to the Worklist |
New dialog.

Enables you to view the Total number of the Cases for the row entity.

Click the link to view the specific Worklist where the user can view the
case numbers.

Enables you to only refresh the number and the entities but not the
entire page.

Enter a value in the text field for Auto-Refresh automatically refresh the
dialog every N minutes up to a maximum of 99 minutes.

Enables you to expand all entities across the Summary Tabulation.

Enables you to collapse all entities across the Summary Tabulation,
leaving only the Sites Total.

Enables you to print the Load Balancing Dashboard in PDF format.

Enables you to export the Load Balancing Dashboard in Excel format.
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Utilities

This chapter discusses the different utility functions to help you view, change, or
retrieve case-related information.

13.1 Utilities

To access the Utilities menu, place the cursor over the Utilities menu bar to view the
available options.The following utilities are available to you.

Change Password

MedDRA Browser

User Login List

Logs

E2B

Case Undelete

Batch Reports

End of Study

Clear Cache

Advanced Condition Library

13.1.1 Change Password

The Change Password functionality allows users to change the password that they use
to login to Argus. When you log on to the system for the first time, change the
password that has been assigned to you.
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Password Information for margarete
Old Password || |

Date Time 123-MAR-2010 20:03 |

Hew Password | |

Confirm Password | |

| ok || cancel |

Note: LDAP users cannot change their passwords.

To change your password
1. Select Change Password from the Utilities menu.

2. When the system opens the Change Password dialog box:
= Enter your current password in the Old Password field.
»  Enter your new password in the New Password field.
= Re-enter your new password in the Confirm Password field to verify it.
s Click OK to change your password,
3. Your password has been changed.
Be aware of the following;:

»  If the system has difficulty confirming the password, it presents the Password
Confirmation Failure dialog box.

= You cannot re-enter the password you are currently using when the system
prompts you to change your password.

= When you update your password, the system displays the system date and time.

13.1.2 MedDRA Browser

Use the Medical Dictionary for Regulatory Activities (MedDRA) to encode diseases,
symptoms, signs, and so forth. In Argus Safety, the usage of such a dictionary provides
consistency to the assignment of terms for adverse events.
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1. Select Utilities --> MedDRA Browser.
2. The system opens the MedDRA Browser screen.

13.1.3 User Login List

The User Login List displays a list of all the current users and their security levels. It
also displays a list of all the currently logged in users. The following is an illustration
of the User Login List.

To view the User Login List
1. Select Utilities --> User Login List.

2. The system opens the User Login List screen.

13.1.3.1 General Usage Information
When using the User Log List, be aware of the following:

= You can click a column heading to sort the displayed records.

= By default, the system displays the User Login List in ascending order based on
Login Time.

The following table lists and describes the fields on the User Login List.

Field Description

Full Name Displays the full name of the user.

Login Time Displays the login time.

Workflow Manager Displays whether the user is a workflow manager or not.
OS User Name Displays the Operating System user name.

Terminal Displays the name of the terminal.

Print List Allows you to print the user login list.
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13.1.4 Logs

= You can configure the number of cases to display from the Page Size drop-down
list in the User Login List dialog box. The Page Size drop-down list contains the
following values:

= 50

s 100 (default)
= 250

= 500

= 1000

= 2000

s The system displays the number of cases currently in view and automatically
updates the range as defined by the Page Size drop-down list. For example, if the
user selects 100, the system separates the rows to display into groups of 100 cases.

= You can go directly to a range of cases by selecting a range from the Displaying
Rows drop-down list.

= You can scroll through the User Login List search results in page-by-page
increments.

= You can select multiple users or click the All users check box in the header.

= When you select a user and click Reset User, the system resets all selected users in
the list.

s The system does not permit you to reset your login.

Logs are a repository of all the cases in the database, displaying the Activity, Audit
Data, User ID, and Date/Time entries. Three (3) types of logs are available in Argus:

s View Audit Log
= LAM Audit Log

s View Error Log

To view a log
1. Select Utilities --> Logs --> <Log Type> to view a log.

2. The system open the selected log type.

13.1.5 View Audit Log

The audit log is a chart that show modifications that have been made to a particular
case since the case's inception.

It also shows which user made the changes, the date and time the changes were made,
and the old and new field values. Run the AG Service Audit Log update to audit log
all the cases.

To view an Audit Log
1. Select Utilities --> Logs --> View Audit Log.

2. The system opens the Audit Log screen.
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13.1.5.1 Search Conditions Section

The Search Conditions section enables you to enter information about the logs you
want to view.

The following table lists and describes the fields in the Search Conditions section.

Field Description

Category Select the category for the search criterion.

Tip: You can also search for Advanced Conditions in this Application
release.

The system enables you to Select All to view all updates performed by a
user. You can select a category and filter on a specific field elements, and
you can view all revisions at the same time by clicking the checkbox near
the Revisions column.

Case Number Enables you to search for logs for a specific case number

Date Range Select the date range from the given drop-down list. This selection
automatically populates the From and To fields.

From Enter the initial date of the time period to be searched.

To Enter the end date of the time period to be searched.

User Name Select the User Name for the search.

Search button Displays the results of the specified search criteria.

13.1.5.2 Total Number of Rows Section
The system displays the search results in the Total Number of Rows section.

The following table lists and describes the fields in the Total Number of Rows section.

Field Description

Action Displays the Audit Log Details screen

Activity Displays the status of the activity. Displays whether it has changed or
not.

Audit Data Displays the audit data in the following format:

Name of the entity (such as Advanced Condition): deleted or changed
(as applicable) in entity (such as Advanced Condition)

User Displays the last user who made changes to the case.

Date/Time Displays the last time the case was changed.

Note: The time displayed is as per GMT.
Print List button Prints the list of all the logs.

13.1.5.3 Audit Log Details Screen

The Audit Log functionality tracks all central coding activities for the code-able event
and products.

Audit log for the case has the record of the central coding related changes. These
changes display the Username as the associated Central Coding Username
concatenated with Central Coding.

Multiple selections can be made to view the details of revisions.
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To view the Audit Log Details screen
1. Click the Action icon to view the Audit Log Details screen.

2. 2. Click a row displaying a revision to display the details in the upper portion of
the screen.

The following table describes the fields in the Audit Log Details screen.

Field Description

Total Number of Displays the total number of rows in the list.

Rows

Parent Displays the parent screen where the change has been made.

Field Displays the field where the change has been made.

Old Value Displays the previous value.

New Value Displays the new, changed value.

Rev Displays the revision number. The list is sorted in descending order of
the revisions that have been made so the latest revision is displayed at
the top.

User Name Displays the name of the last user who made a change.

Revisions Date Displays the last date when the change was made.

User Displays the name of the user who last made the revision.

13.1.6 LAM Audit Log
The LAM Audit Log enables you to track changes made while using the LAM module.

To view the LAM Audit Log
1. Select Utilities --> Logs --> LAM Audit Log.

2. The system opens the LAM Audit Log screen.

13.1.6.1 General Usage Information
= When using the Argus Safety Audit Log, be aware of the following:

s In the Argus Audit Log Options, Category has an <ALL> option that enables
viewing of all updates made by a user.

= If you select All, you must select the appropriate User Name from the drop-down
to enable the Search button. The system updates the default User Name to the
name of the user who is logged in.

s The system identifies the category on the Ul
s The print list displays the Category.

»  The system updates the element field label based on the category selected by the
user. If you do not enter an element value, the system returns the audit details as is
does in the current system.

= You can view All revisions at the same time by selecting the check box near the
revisions column. This system displays the entire audit trail for the elements.
13.1.6.1.1 Using the Argus Affiliate Audit Log When using the Argus Affiliate Audit Log

be aware of the following:

= You can filter for a specific Affiliate event in the audit log.
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= You can view all revisions at the same time by selecting the check box near the
revisions column. The system displays the entire Audit trail for the elements.

= You can view all LAM user updates made for Argus Safety cases under the LAM
Audit Trial. For example, the action Items which can be closed or local labeling
performed by a Affiliate user is visible under the LAM audit trail.

s Central User updates do not display under the LAM audit trail.

= Any user who has access to LAM Audit Log can view All cases associated with
that site.

s The audit trail detail print includes only the revisions the selected by the user.

13.1.6.1.2 Search Conditions The Search Conditions section enables you to enter
information for retrieving the audit logs you want to view.

The following table lists and describes the fields in the Search Conditions sections.

Field Description

Local Event Number Enter the appropriate local event number.

From Enter the initial date of the time period to be searched.
To Enter the end date of the time period to be searched.
Search button Displays the results of the specified search criteria.

13.1.6.1.3 Total Number of Rows The system puts the search results in the Total Number
of Rows section.

The following table lists and describes the fields in this section.

Field Description

Action Displays the Audit Log Details screen.

Activity Displays the status of the activity. Displays whether it has changed or
has been added.

Audit Data Displays the audit data.

Category Displays the category data.

User Displays the last user who made changes to the case.

Date/Time Displays the last time the case was changed.

Note: The time displayed is as per GMT.

Print List button Prints the list of all the logs.

13.1.6.1.4 Audit Log Details The Audit Log functionality tracks all central coding
activities for the code-able event and products.

Audit log for the case has the record of the central coding related changes. These
changes display the Username as the associated Central Coding Username
concatenated with Central Coding.

Multiple selections can be made to view the details of revisions.

To view the Audit Log Details screen
1. Click the Action icon to view the Audit Log Details screen.
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2.

Click a row displaying a revision to display the details in the upper portion of the
screen.

The following table describes the fields in the Audit Log Details screen.

Field Description

Total Number of Displays the total number of rows in the list.

Rows

Parent Displays the parent screen where the change has been made.

Field Displays the field where the change has been made.

Old Value Displays the previous value.

New Value Displays the new, changed value.

Rev Displays the revision number. The list is sorted in descending order of

the revisions that have been made so the latest revision is displayed at

the top.
User Name Displays the name of the last user who made a change.
Revisions Date Displays the last date when the change was made.
User Displays the name of the user who last made the revision.

13.1.7 Error Log

The Error Log screen provides information about errors that occurred during case
processing.

To view the error log

1.

2
3
4.
5

Select Utilities --> Logs --> View Error Log.

The system opens the Error Log screen.

In the Search Conditions section, enter or select a date range and click Search.
The system displays the search results in the Total Number of Rows section.

Locate the error log you want to view and click to view the error message text.

13.1.7.1 Search Conditions Section

The Search Conditions section enables you to search for error logs based on

pre-

defined or custom date ranges.

The following table lists and describes the fields in the Search Conditions section.

Field Description

Date Range Select the date range from the given drop-down list. This selection
automatically populates the From and To fields.

From Enter the initial date of the time period to be searched.

To Enter the end date of the time period to be searched.

Search button Displays the results of the specified search criteria.

13.1.7.2 Total Number of Rows Section

Total Number of Rows

Utilities 13-8



Utilities

The system retrieves the error logs for the specified date range and places the results in
the Total Number of Rows section.

The following table lists and describes the fields in the Total Number of Rows section.

Field Description
Total Number of Displays the total number of rows in the list.
Rows

Argus User Name Displays the Argus User Name of the user who got the error.

OS User Name Displays the OS User Name of the user who got the error.
Error Date Displays the date and time of the error.

Application Displays the name of the application where the error occurred.
Terminal Displays the name of the terminal where the error occurred.
Machine Displays the name of the machine where the error occurred.
Error Text Displays the text of the error.

Note: click the Zoom icon to view the complete text.

Print List button Prints the list of all the errors.

13.1.8 E2B Screens

The purpose of the E2B Transmit Status and E2B Receive Status screens is to monitor
the incoming and outgoing messages and acknowledgments. E2B screens are
categorized as:

s E2B Transmit
s E2B Receive Status

To view the E2B screens
1. Select Utilities --> E2B --> <E2B Category>.

2. The system opens the appropriate E2B screen.

13.1.8.1 E2B Transmit Status Screen

The E2B Transmit Status screen enables you to track outgoing messages. The
following is an illustration of the E2B Transmit Status screen:

To view E2B transmit status data
1. Select Utilities --> E2B --> E2B Transmit Status.

2. When the system opens the E2B Transmit Status screen:
= Enter the appropriate search criteria in the Search Reports section.
»  Click Search to display the search results in the Total Number of Rows
section.
13.1.8.1.1 Search Reports The Search Reports section enables you to enter information
for retrieving transmission information.

The following table lists and describes the fields in the Search Reports section.
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Field Description
Agency/Trading Select the agency/trading partner as the receiver from this list.
Partner

Search button

Transmit Date Range
From

To

Message # Range
From

To

Range

Type

Displays all the E2b messages and acknowledgments only for the
specified receiver.

Note: If 'Any' is selected as the Agency, the search results display all
messages and acknowledgements for all receivers.

Select this radio button to specify the date range for all transmissions.
Enter the initial date of the specified period

Enter the end date of the specified period.

Select this radio button to specify the date range for all messages.
Enter the initial date of the specified period.

Enter the end date of the specified period.

Select the desired range from the list.

Select the desired type from the list.

13.1.8.1.2 Total Number of Rows The system displays the search results in the Total
Number of Rows section as shown in the following illustration.

The following table lists and describes the fields in this section.

Field Description
Total Number of Displays the total number of rows that displayed in the list, as shown in
Rows the parenthesis.
Type Allows the user to view the type of entity transmitted.
Click the Details icon to view the attachment as a PDF.
Reports Allows the user to view the number of attachments transmitted.

Trading Partner

Control #
Local Msg#
Remote Msg#
File Name

Transmit to EDI

EDI Tracking ID
EDI Transmit Date

Transmission Status
EDI Receive Receipt

Print button

Allows the user to view the Reporting Destination to which the
attachment is transmitted.

This field is left blank for attachment transmission only.

Displays the local message number.

Displays the remote message number.

Allows the user to view the filename transmitted by EDI Gateway.

Allows the user to view the date and time when the attachment was
transmitted to the EDI Gateway.

Allows the user to view the EDI Tracking ID.

Allows the user to view the EDI Transmit Date and Time from the
gateway.

Allows the user to view the Transmission Status of the attachment file
transmitted from EDI Gateway such as Failure / Success / Pending.

Allows the user to view the date and time of the EDI MDN
Acknowledgement date.

Prints the list.

13.1.8.1.3 Type Icon Options Click the Type icon to view these options:
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= Any - Displays all the E2B messages and acknowledgments
= MSG - Double-click on MSG to view messages in the E2B Viewer.
s ACK- Double-click on ACK to view the acknowledgement.

When you click these options, the system opens the Message Acknowledgement
screen shown in the following illustration. This screen contains all the safety report
detail information such as, if the report is loaded or not loaded with error and enables
you to monitor message acknowledgements.

The following table lists and describes the fields in the Message Acknowledgement
Status dialog box.

Field Description

ICSR Message Number Displays the ICSR Message Number.

ICSR Message Receiver ID Displays the ICSR Message Receiver ID.

ICSR Message Sender ID Displays the ICSR Message Sender ID.

Sender Acknowledgement Displays the acknowledgement message number of the
Message # sender.

ICSR Message Date Displays the ICSR Message Date.

Acknowledgement Message Displays when the acknowledgement was initiated.
Initiated On

Transmission Acknowledgement Displays the Transmission Acknowledgement Code.
Code

Case # Displays the Case #.

Message Displays the message.

Authority # Displays the Authority #.

Local Case # Displays the Local Case #.

Other # Displays the Other #.

Report Status Displays the Report Status.

E2B Report Type Displays the type of the E2B Report.

13.1.8.2 E2B Receive Status

The E2B Receive Status screen enables you to monitor incoming E2B messages. The
following is an illustration of the E2B Receive Status screen:

13.1.8.2.1 Search Reports The Search Reports section enables you to search for
received messages.

The following table lists and describes the fields in the Search Reports section.

Field Description
Agency/Trading Select the agency/trading partner as the receiver from this list.
Partner

Receive Date Range  Select this radio button to specify the date range for all transmissions.

From Enter the initial date of the specified period.
To Enter the end date of the specified period.
Range Select a predefined date range from the drop-down list.
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Field Description

Message # Range Select this radio button to specify the date range for all messages.
From Enter the initial date of the specified period.

To Enter the end date of the specified period.

Type Select the desired message type from the list.

Search Initiates the search and displays all the E2b messages and

acknowledgments only for the specified receiver.

Note: If 'Any' is selected as the Agency, the search results display all
messages and acknowledgements for all receivers.

13.1.8.2.2 Total Number of Rows The Total Number of Rows section contains the search
results.

The following table lists and describes the columns:

Field Description

Total Number of Displays the total number of rows that displayed in the list, as shown in
Rows the parenthesis.

Type Displays the Type icon containing options.
Trading Partner Displays the name of the trading partner.
Control # Displays the control number.

Local Msg# Displays the local message number.
Remote Msg# Displays the remote message number.
Total Reports Displays the total number of reports.
Rejected Reports Displays the number of rejected reports.
File Name Displays the file name.

Receive from EDI Displays the messages received from EDIL

Transmission Status ~ Displays the Transmission Status.

Print Enables you to print the list.

13.1.8.23 Type Icon Options Click the Type icon to view these options:
= Any - Displays all the E2B messages and acknowledgments
= MSG - Double-click on MSG to view messages in the E2B Viewer.
s ACK- Double-click on ACK to view the acknowledgement.

When you click these options, the system opens the Message Acknowledgement
screen. This screen contains all the safety report detail information such as, if the
report is loaded or not loaded with error and enables you to monitor message
acknowledgements.

The following table lists and describes the fields in the Message Acknowledgement
Status dialog box.

Field Description

ICSR Message Number Displays the ICSR Message Number.
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Field

Description

ICSR Message Receiver ID
ICSR Message Sender ID

Sender Acknowledgement
Message #

ICSR Message Date

Acknowledgement Message
Initiated On

Transmission
Acknowledgement Code

Case #
Message
Authority #
Local Case #
Other #
Report Status

E2B Report Type

Displays the ICSR Message Receiver ID.
Displays the ICSR Message Sender ID.

Displays the acknowledgement message number of the sender.

Displays the ICSR Message Date.

Displays when the acknowledgement was initiated.
Displays the Transmission Acknowledgement Code.

Displays the Case #.

Displays the message.

Displays the Authority #.

Displays the Local Case #.

Displays the Other #.

Displays the Report Status.
Displays the type of the E2B Report.

13.1.9 Case Undelete

The Case Undelete option enables you to restore deleted cases.

To restore deleted cases

1. Select Utilities --> Case Undelete.

2. When the system opens the Undeleted Cases screen, enter the appropriate
information in the Case Search Criteria fields and click Search.

13.1.9.1 Case Search Criteria Fields and Field Descriptions
The Case Search Criteria enables you to enter information to help you retrieve deleted

cases.

The following table lists and describes the fields in this section.

Field

Description

Case Number

Enables you to enter the number for a specific case.

Date Range Enables you to select a date range from which cases may be selected.
The selection made from the Date Range drop-down list automatically
populates the From and To fields.

From Displays the initial date of the search period

To Displays the end date of the search period

Search Click to display the Search results that match the specified search

criteria

1.  When the system displays the search results in the Total Number of Rows section:

= Locate the case you want to restore and click the check box associated with its

case number.
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s Click Case Undelete.

13.1.9.2 Total Number of Rows Fields and Field Descriptions
The system displays the search results in the Total Number of Rows section on the

Case Undelete screen.

The following table lists and describes the columns in the Total Number of Rows

Section

Field Description

Total Number of Displays the total number of rows in the list
Rows

Check Box Enables you to select the case to restore.

Case Number

Displays the case number of each deleted case.

Initial Receipt Date ~ Displays the initial receipt date of the case.

Product Displays the product category that the belongs to.

Event Displays the event related to the deleted case.

Workflow State Displays the workflow state of the case.

Serious Displays if the deleted case was serious or not.

Deleted By Displays the name of the user who deleted the case.

Deleted Date Displays when the case was deleted.

Justification Displays the justification for deleting the case.
Note: Click the check box corresponding to the case to view the
justification for its deletion.

Case Undelete Displays the Justification dialog box.

Enables you to restore the selected case number.

Print List Prints the current worklist for reference.

1.  When the system opens the Action Justification dialog box:

= Enter the justification manually in the Please enter a justification for
performing this action field

OR

Select a preconfigured justification from the Select a standard justification for
this field drop-down list.

= Click OK.

13.1.9.3 General Usage Information
When using Case Undelete functions, be aware of the following;:

= You can search for a specific case from the Case Undelete dialog shown in the
following illustration.

= If you enter the Case Number to search for a specific case, the following apply:

The system disables the date range fields including From and To.

If you enter an invalid case number, the system displays the following message:
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The Case Number entered is not valid. Please enter a correct Case Number and search

again.

= You can configure the number of cases to display in the Case Undelete dialog box
from the Page Size drop-down list.

= The Page Size drop-down list contains the following values:

- 50
— 100 (default)
- 250

- 500

~ 1000

— 2000

s The system displays the number of cases currently in view and automatically
updates the range as defined by the Page Size drop-down list. For example, if you
select 100, the system separates the rows to display into groups of 100 cases.

= You can go directly to a range of cases by selecting a range from the Displaying

Rows drop-down list.

= You can scroll through the Case Undelete search results in page-by-page
increments as defined in the Page Size drop-down list.

13.1.9.4 Action Justification Dialog Box Fields and Field Descriptions
The following table lists and describes the fields in the Action Justification dialog box.

Field

Description

Please enter a justification for
performing this action

Select a standard justification for this
field

Spell Check

OK

Cancel

Enter the text that justifies the need to un-delete a
case.

Contains standard, pre-configured descriptions of
justifications for un-deletion.

Checks the entered/selected text for any
grammatical errors.

Saves the justification entered /selected for case
un-deletion.

Exits out of this dialog without saving any
justification.

13.1.10 Batch Reports

The Batch Reports dialog displays a list of those batch reports that have been

scheduled for generation.

To view a list of batch reports

1. Select Batch Reports from Utilities in the menu bar.

2. The system opens Batch Reports dialog box with a list of batch reports along with
their report titles and next run dates.
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To delete a batch report from the list
1. Select the check box corresponding to the batch report to delete.

2. Click Delete.

13.1.11 End of Study

When a study is complete, use the End of Study utility to unblind all the cases
associated with the study at the same time instead of unblinding them one by one.

To unblind a study
1. Select Utilities --> End of Study.

2. The system opens the End of Study Unblinding dialog box.
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13.1.11.1 End of Study Unblinding Dialog Box Fields and Field Descriptions
The following table lists and describes the fields in the End of Study Unblinding

dialog box.

Field Description

Display only Enables the user to view only unbroken cases

Unbroken cases

End of Study Only those studies that are "Eligible for unblinding" (as determined via

Unblinding List Maintenance) are displayed in this list. Select a study from this list.
This populates the list of cases based on the study chosen.

Case ID Displays the ID of each case.

AE Date Displays the Associated Event Date for the case.

Pat ID Displays the Patient ID.

Rand No Displays the Randomization Number of the case.

Drug Received Displays the name of the drug received.

Dosage Displays the Select button to view the Dosage Regimens screen.

1. Select the appropriate study from the End-of-Study Unblinding drop-down list.

2. When the system displays the selected information, locate the appropriate study
and click Select in the End of Study dialog.

3. When the system opens the Dosage Regimens dialog box, enter the drug dosage
information as required.

4. Click OK to save the changes, update the cases, and close this dialog.

Note: For each case that is unblinded by this method, the Blinding
Status is adjusted to "Broken After Study" if the study type is single or
double blinded and fills information about the Unblinding Date,
Study Drug, Follow-up Received Date, Mark case as Significant, and
Dosage Regimen.

13.1.12 Clear Cache

This section describes the steps required to clear cache. This action clears the
previously stored information in the system.

To clear your cache of previously stored information
1. Select Utilities --> Clear Cache.

2. The system clears the cache and displays the following message in the Clear
Cache dialog box.
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Clear Cache

' Cache iz cleared successfully.
f ! E

l§

13.1.13 Advanced Condition Library

The Advanced Condition Library option enables you to access the advanced
condition library and do the following:

»  Create a new advanced condition

= Reassign an advanced condition

= Set advanced condition permission levels
= Modify an existing advanced condition

= Delete an advanced condition

s Print a list of advanced conditions

To open the Advanced Condition Library
1. Select Utilities --> Advanced Condition Library.

2. The system opens the Advanced Condition Library screen.

For further information about Advanced Conditions, see Advanced Conditions.
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All the fields on this page are type-ahead fields.

To search for existing query sets or advanced conditions, enter the search criteria and

click Search.

The following table lists and describes the fields in the Advanced Condition Library.

Field

Description

Name

Description

Last Modified
Owner

Shared

Query Set
SQL

HitList

The name of the Query Set or Advanced Condition given by the user.

A description of the Query Set or Advanced Condition given by the
user.

The date the last modification was made.
The current owner of the Query Set or Advanced Condition.

Displays whether the Query Set or Advanced Condition has been
shared or not.

Displays whether the record in the row is a Query Set or not.

Displays a View link that redirects the user to a Qery Set or Advanced
Condition dialog for the selected record.

Appears only if the selected Query Set or Advanced Condition has a
HitList. It displays a link displaying the number of hits on the last
HitList update.
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Multi-Tenancy

This chapter describes Multi-tenancy and the Global Portlets in Argus Safety that are
used to manage work across multiple clients in a multi-tenant environment.

14.1 Introduction to Multi-tenancy

Multi-tenancy refers to a principle in software architecture where a single instance of
the software runs on a server, serving multiple client organizations (tenants).

With a multi-tenant architecture, the software application is designed to virtually
partition its data and configuration so that each client organization works with a
customized virtual application instance.

14.1.1 Multi-tenancy in Argus Safety

The Multi-tenancy feature in Argus Safety allows an organization to use a single
database for multiple clients. For example, Contract Research Organizations (CROs)
offer a range of global safety and pharmacovigilance services, which span from limited
case management activities to full clinical trial and post-marketing services.

The multi-tenancy feature allows multiple pharmaceutical clients of a CRO to reside as
separate and unique tenants in a single database with their data completely segregated
and restricted to authorized users. This enables the CRO to achieve standard
configuration across clients while at the same time provides the ability to a CRO to
have differentiation in configurations to specific clients as required. It provides the
ability to a CRO to quickly set up a new client based on existing configuration and
authorize users to the new client. It provides the ability to CRO users who have access
across multiple clients to view their work across clients, understand their sum of work
across clients and make decisions based on the priority.

Argus Safety assists manufacturers of pharmaceuticals and devices by providing a
simple and efficient way to comply with international and domestic regulatory safety
reporting requirements. It also facilitates internal company safety surveillance by
providing tools for signal detection and for analyzing the overall safety profile of both
investigational compounds and marketed products.

Contract Research Organizations (CROs) provide services to pharmaceutical and
device manufacturers, that range from case management activities to clinical trials. The
multi-tenancy feature allows an organization to provide services to many clients while
keeping client data isolated.

Multi-tenancy is enabled during the Argus Safety installation. Policies and rules are
centrally administrated and shared, with the option to personalize for each client.
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14.1.2 Data Segregation

Multi-tenancy allows an organization to use a single database for many clients, which
reduces the amount of hardware needed for an implementation. Fewer patches and
dictionary upgrades are required, which decreases the resources necessary to support
an implementation. This also allows administrators to use standard configurations,
such as code lists, workflow steps and user/new client setup.

The entire Argus Safety application and all of its components and data are partitioned
by Enterprise ID. The Enterprise ID is a unique identifier for a customer's client and
contract. The appropriate context of the Enterprise ID selected by the user that the user
has access to, is set by the system and operates within the partition of this context.

14.1.2.1 Data Segregation by Module

The following table describes how each module in the Argus Safety suite provides
data segregation in a multi-tenant environment.

Note: It is not recommended that you open the Argus Safety
application for multiple enterprises at the same time. Close the Argus
Safety application for the previous enterprise before opening it for the
next enterprise to avoid data issues.

It is recommended that you use the Application Access portlet to open
the Argus Safety application for different enterprises, as it takes care
of closing the previous enterprise before opening the new one.

Accessed Via

Module Cross Enterprise?  Portal? Notes

Global Worklists Yes Yes Displays data from
across multiple
enterprises

Global User Yes Yes Displays data from

Management across multiple
enterprises

Global Enterprise Yes Yes Displays data from

Management across multiple
enterprises.

Applications Access  Yes Yes Displays Application

Access options from
across multiple
enterprises

Argus Safety No No Displays data for one
enterprise at a time to
the logged-in user
based on the selected
enterprise.

Console No No Displays data only
for the enterprise for
which Argus Safety
was opened by the
user.
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Module

Cross Enterprise?

Accessed Via
Portal?

Notes

Affiliate

EOSU Tool

ESM Mapping Utility

ESM Service

ESM Service
Configuration

AG Service

AG Service
Configuration Tool

MedDRA Re-code
Tool

MedDRA Dictionary
Load

No

No

Yes

Yes

Yes

Yes

Yes

Yes

No

Displays data for one
enterprise at a time to
the logged-in user,
based on the selected
enterprise.

Displays data for one
enterprise at a time to
the logged-in user,
based on the selected
enterprise.

Displays data for one
enterprise at a time to
the logged-in user,
based on the selected
enterprise.

However, the screens
related to ESM
Service
Configuration
display data related
to all the active
enterprises,
irrespective of the
user access rights to
those enterprises.

ESM Service process
data from all the
enterprises, as itis a
background service.

As ESM Service is
common across all
the enterprises, hence
its configuration tool
is also common.

Argus Safety Service
processes data from
all the enterprises as
it is a background
service.

As AG Service is
common across all
the enterprises, hence
its configuration tool
is also common.

Allows the option to
perform recoding of
MedDRA terms
across the
enterprises.

Single
instance/version of
the loaded MedDRA
dictionary is
available for all the
enterprises.
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Module

Cross Enterprise?

Accessed Via
Portal?

Notes

Who Dictionary Load

MedDRA /WHO Web
Services

J Drug Dictionary

Case Intake

Literature Intake

New Case from
Image

PSL

DLP

TMS Integration

Yes

Yes

Yes

No

No

Single
instance/version of
the loaded WHO
Drug dictionaries (B2
as well as C formats)
is available for all the
enterprises.

These web services
remain common to be
used across all the
enterprises. Their
configuration is
maintained in a
common XML file on
the web server(s).

Single
instance/version of
the loaded ] Drug
dictionary are
available for all
enterprises.

Case Intake messages
for separate
enterprises are
segregated and
loaded into
appropriate
enterprise partitions.

Literature Case
Intake data for
separate enterprises
are segregated and
loaded into
appropriate
enterprise partitions.

Scanned Image folder
paths for separate
enterprises are
segregated and
loaded into correct
enterprise partitions.

The PSL interface
segregates the
incoming requests for
each enterprise
partition.

Partitions the case
revisions by
enterprises.

TMS integration for
single-pharma
installations only.
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Module

Accessed Via
Portal?

Cross Enterprise?

Notes

Dossier

No No

As this module is
linked to Periodic
Reports, hence it
partitions the
periodic reports data
by enterprise.

14.1.2.2 Data Segregation impact on system level configuration items

Following table specifies some specific system level configuration items which are
configured through Argus Console. It specifies the impact on these configuration items
due to data segregation design for multi-tenant installations and also specifies the
recommendations for customers on these items.

Recommendation for

Configuration ltem Application Design Customers
Enable/Disable System keeps it segregated for each None
MedDRA/WHOWeb enterprise.

Service Encoding

Lot Number Web
Service configuration

Documentum
Configuration

Enable/disable
LDAP

&

LDAP Server
configuration

Enabled Modules

Enable/disable SSO
&

SSO Header
Configuration

Argus Insight URL

Argus Safety Load
Balancer Server

However, the underlying web service
used for MedDRA /WHO is common for
all the enterprises as their configurations
are maintained in common XML file on

the web server(s).

System keeps it segregated for each

enterprise.

System keeps it segregated for each

enterprise.

This will be maintained by application

as common for all enterprises.

System shall keep it segregated for each

enterprise.

This will be maintained by application

as common for all enterprises.

System keeps it segregated for each

enterprise.

System keeps it segregated for each

enterprise.

As this is related to the
product, it is recommened
to keep specific for each
enterprise.

All parameters except for
Cabinet Name are expected
to be maintained as same
for different enterprises.

None

None

None

It is expected to be
maintained same for across
all enterprises by the
customer.

It is expected to be
maintained same for across
all enterprises by the
customer.
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Recommendation for

Configuration ltem  Application Design Customers
User Information System keeps it segregated for each For multi-tenant
enterprise. installations, user attributes

can be synchronized for all
the enterprises through
Global User Management.

However, user attributes
can also be updated for a
specific enterprise through
Console as well.

Default Enterprise System keeps it segregated for each This is a new internal
enterprise. common profile switch that

marks an enterprise as the
Default enterprise. This is
set during the time of
install. Default enterprise
once created during
database creation is fixed.
This is required to avoid the
data synchronization issues
that may occur for AG
Service users in different
enterprises.

SMTP Configuration System keeps it segregated for each None
enterprise.

14.1.2.3 Dictionaries

All dictionaries are stored in database schema separately outside Argus Safety and
Interchange schema. The Argus-supported dictionaries are:

=  MedDRA

=  MedDRA]
= WHO Drug
= JDrug

Only one copy of each dictionary version is maintained in the database and is not
segregated by enterprise. The dictionary version that is applicable for a particular
enterprise/client is defined in the common profile switches: Case Form Configuration'
Auto Encoding, Dictionary & Central Encoding. Since these switches are segregated
for each Enterprise, these dictionaries can be different versions for different
enterprises, as required.

J Drug dictionary is not configured through Console common profile switches (Case
Form Configuration' Auto Encoding, Dictionary & Central Encoding), and is internally
maintained as single version, therefore, it remains a common ] Drug dictionary for all
enterprises.

14.1.2.3.1 Coding Web Service

The Case Processing Dictionary Browser common profile switches are segregated by
enterprises to allow different configurations for different enterprises.

However, the URL and other configuration for WHO Drug and MedDRA web services
remain in configuration XML on the Web Servers as per existing design and hence
remain common across all enterprises.
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In a multi-tenant installation, if the provider chooses to operate using Coding via web
service, they should use the same web service across all enterprises.

14.2 Global Worklists

Global Worklists lets you access work items across enterprises where you have access.
It also allows you to filter the worklist to a specific enterprise where you have access.
When filtered to a specific enterprise, any further operation on the retrieved worklist
items are restricted to that enterprise.

For unauthorized users, the Global Worklist is not visible and their access remains
restricted based on portal privileges. The context menu on the Global Worklist
displays menu items according to rights and permissions of a user in a particular
enterprise.

The user preferences of each Global Worklist are saved for the user each time the
Worklist is loaded.

14.2.1 Global Worklist Tabs

Worklist New: displays the list of new cases across all the enterprises or a specific
enterprise, that the user has access, as well as cases assigned to user/ group but
not yet accepted.

Global Worklests Global Lnterprse Management Global User Management Apphcabon Access

Worklist Bew Worklist Cpen Worklist Contacts Workdist Action Items

Worklist Open: displays the list of new cases across all the enterprises or a specific
enterprise, that the user has access, as well as cases assigned to user/ group but
not yet accepted.

Worklist Contacts: Display the list of pending letters and allows you to generate
the letters.

Worklist Action Items: Allows the owner of the action item and workflow
managers to view and/or close the selected action item.

14.2.1.1 Link to Argus Safety

Case number - hyperlink on the case number allows you to open the case in the
Argus Safety application, with context set to the enterprise that the case belongs
to.

Enterprise - hyperlink on the Enterprise Short Name allows you to open
Worklist-Open in the Argus Safety application, with context set to the enterprise
that the case belongs to. The Worklist opens with preferences configured for you
in that enterprise.

14.2.2 Case Actions

Open Read-only - opens the case in read-only mode in the Argus Safety
application, with context set to the enterprise that the case belongs to.

Accept Case - accepts the case and assigns your user name as responsible for that
case
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s Un-Accept Case - reverses Accept Case and resets the case assignment set to
<Unassigned>

= Adjust Priority - modifies the priority level of the case

= Adjust Assignment - modifies the user assigned to the case, limited by your access
to the enterprise and the case

= Adjust Case Owner - modifies the owner of the case, limited by the your access to
the enterprise and the case

s Close Case - closes the case after entering the Case Closure details

s Coding Review - opens the exiting Argus Safety Coding Review screen as a dialog
and supports all existing actions within this dialog

s Medical Review - opens the Argus Safety Medical Review screen as a dialog and
supports all the existing actions within this dialog

»  Print/Print List - prints the current Worklist

Note: Multiple case actions are not supported, such as: Close
Multiple Cases, Route Multiple Cases, Print Multiple Cases and
Assign Multiple Cases

14.2.3 Search Case

The list of cases displayed in the worklist include active enterprises where you have
access. Your view is restricted to the search criteria result set, entered into the Value
search field. You may filter the content of this worklist to a specific enterprise. When
there is no filtering applied, all cases across enterprises are displayed.

Filter
You can filter your search by the following;:

Filter

Product X v]

Case Mumber

Event Preferred Term
Event as reported
Case Report Type
Product Group

s Case Number

= Workflow State

s Product

= Event Preferred Term
= Event as reported

»s  Case Report Type

s Product Group
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Note: Items that are unavailable will not appear in the filter list.

Value

Once you have selected an item to filter by, the Value field loads the corresponding
choices. For example, select Product and the list of Products loads into the Value field.
You can also type into the field to search the list.

Only view locked Cases requiring Follow-up

Select the Only view locked Cases requiring Follow-up option to limit your search to
these types of cases.

Search Case

Filter
| Caze Mumber &I

Only view locked Cases requiring Follow-up

14.2.3.1 View Options

Your view options for Worklist New are Individual, Group or All. Individual is the
default selection.

= Select Group to list all cases across authorized enterprises, which are assigned to
any other member of groups that you are a member of and that have not yet been
accepted by the assigned user.

Group Membership
Al E

View @ Individual O Group OAIl

= Select All to view every open case across all user groups and enterprises (or
specific enterprises) where you have access.

14.2.3.1.1 List Actions
= Sorting - sort by any list header

= Pagination - select page size and number of displaying rows.

14.2.4 Global Enterprise Management

From the Global Enterprise Management tab, you can:
= Add anew enterprise
= Define new enterprise attributes

= Copy configuration from an existing enterprise
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= Associate users to the new enterprise

14.2.5 Add New Enterprise

1. Click Add New Enterprise.

2. Enter information about your Enterprise. Enterprise Name and Enterprise Short
Name are required fields.

3. Click Next.

4. Select an Enterprise to use as a template for your new Enterprise from Copy
Configuration Data Source. You can makes changes to the configuration once the
enterprise has been set up.

5. Click Setup.
6. Click Finish.

14.2.6 Global User Management

Global User Management is intended to configure users across multiple enterprises.
When user configuration changes need to affect only a specific enterprise, it needs to
be done from the Argus Safety Console: User Management screen for that enterprise.
Your access is restricted depending on your access to this Portlet at the Portal server
level.

See the Oracle Argus Safety Administrator Guide for more information.

Browser

The browser displays a left hand pane that lists the existing users (distinct users based
on Login User ID) in the system, in a tree view. The tree displays users from the
enterprise partitions for which the user has access.
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Displaying Rows 251.269
O

B Users
{ | userPNS
{ |userls
[ JuseR_RG
{_JUSER_US
{_|usmedicaireview
{_Jusnonexpfuldata
| |usqcassessment
| usqcassessmentunbin
|| vanegsa
{ | vikasa
{ |vikasa_esm
L] vipin
{_| vipinbhar
{_] wighinj
{_] vipiniam
{ | vishal
|| vishaim
{ ] yuvikam
[jueAAtAtAtAr A

[ Euter ]
[cclc[]>2]

14.2.6.1 Associate Enterprise

Associates existing users in one enterprise to other enterprises.

1.

Select an enterprise from Copy User Attributes From. The enterprise selected is

used to set the attribute values for the user in the new enterprise to which the user
is being associated. The attribute values for the already associated enterprises

remain the same.

Select Save.

Add an Available Enterprise or Add All available enterprises.
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¥ UserlD
vanessa
Synchronize User Attributes I Associate Enterprises
Associate Enterprises
Copy User ]
Attributes From DFLT v
Available Selected
Enterprises Add > |¥ Enterprises
< Bamos| [OFLT
DOCA

Add All == | ENT1
<< Remove £ | ENTZ

Save Print

During Save, all the user attributes are copied from the Enterprise selected in the Copy
User Attributes From to all the newly associated Enterprises.

14.2.6.1.1 Print

Click Print and select Current User or All Users. Based on the selection, you can print
the User details of the current User or all Users.

14.2.6.2 Synchronizable User Attributes

The purpose of the Synchronizable User Attibutes section is to allow you to apply
updates to user attributes displayed in this section, and keep them in sync across all
enterprises.

The users that are listed to be administered in this screen are restricted by the
following rules:

1. Admin, System users and the users for which the Service User is checked in
Console are not listed.

2. Only the users from the enterprises for which you have access to the Console User
management screen, i.e. you should have access to all of the following in those
enterprises:

= Console User Management screen ' Application Access field ' Console checkbox is
checked.
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= Console Group Management screen ' Menus section ' Console, Access
Management and User radio options are set to enabled at least for one user group
in the respective enterprise partition.

s Is not marked as "Account Disabled"

vanessa

_ Synchronize User Atributes | Associate Enterprises |

Enterprises

OFLT n

poci
ENT1
CENT2 o

Use the following section to synchronize the selected user attributes for all above
enterprises.

" [] | Synchronizable Atribute | Synchronized Value | Current

[  User Mame hanessa |

[0 Email Address

[0 Enable LDAP Login

[0 LDAP Server Alias

[ | Application Access Argus " Disolav |
Insight _
Console |

[ Default Application

[0  Account Disabled

O | Worklist to display at Login

[]  UserRoles [ AC Library Admin
Copy Configuration |
Emterprise User
ESM Admin

[0  Allow unblinding of cases

| !:'mlect from unblinded [ [ [ﬂ

| r— | -

O

When you select the Synchronize User Attributes tab, the right hand pane displays a
list of enterprises to which the user being administered belongs to. The right hand
pane displays a list of Synchronizable user attributes in a grid.
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Note: If you make changes to the data on one of these tabs and
attempts to move away from this current tab without saving the
changes, then the warning message "You have made changes to the
existing item, if you press OK, changes will be lost." dispalys. Click
OK to ignore changes. Click Cancel to stay on the current tab.

14.2.6.3 Configure Synchronizable Attributes

Configure Synchronizable Attributes appears in the bottom of the left hand pane of
the Global User Management Portlet. Configure Synchronizable Attributes allows the
Portlet user to configure a list of user attributes as synchronizable fields. When
configured, these user attributes appear in the "Synchronize User Attributes" section.

When selected, the user attribute value specified in the Synchronized Value column is
applied across enterprises. If unselected, the user attribute is not saved. Selecting the
header of this column selects all the attributes listed.

The following user attributes are available for the Portlet user to add or remove from
the Synchronizable Attributes list in the following order which is in sync with the
ordering of these fields on Console ' User Management screen.

These user attributes are available as out-of-the-box Synchronizable fields in the
following order:

s User Name

= Email Address

= Enable LDAP Login

s LDAP Server Alias

= Application Access

s Default Application

= Account disabled

= User Roles

= Allow unblinding of cases

= Protect from unblinded information
= Protect from printing unblinded information
= Allow locking of cases

= Allow closing of cases

= Route on close case

=  Enable Checklist on Route

Any changes to these fields are applied across all the enterprises for which you are
restricted to based on the above points.

Tip: Maintain administrative users with these privileges for all
enterprises in the system, in-order to apply the updates to these fields
across all the enterprises. This prevents some enterprises from
becoming out-of-sync for some users for these attributes.
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14.2.6.4 Modifying User Attributes

The value of the Synchronizable fields can be modified for a specific enterprise using
Argus Console>User Management>Access Management so that these attributes can
be different for that enterprise as compared other enterprises.

If User Name and Email address fields are updated in Argus Safety Console for a user
which belongs to multiple enterprises, an error displays.

14.2.7 Application Access

Applications Access allows you to launch Argus Applications for any enterprise
where you have access.

Enterprise | DFLT v hpplication | [frpus Safetv | v | [__Cgen |

It is not recommended that you open the Argus Safety application for multiple
enterprises at the same time. Close the Argus Safety application for the previous
enterprise before opening it for the next enterprise to avoid data issues.

It is recommended that you use the Application Access portlet to open the Argus
Safety application for different enterprises, as it takes care of closing the previous
enterprise before opening the new one.

14.2.7.1 Enterprise

Select Enterprise to display a list of active Enterprises to which the you have access
and is not marked as Account Disabled. The list is alphabetically sorted by Enterprise
Short Names. This first Enterprise in your list is selected by default.

14.2.7.2 Application

Application lists the Argus appications that you can launch from the Application
Access tab. Application lists only those options, which are enabled in the selected
enterprise in Argus Safety Console>User Management>Application Access.

= Argus Safety - Opens the Argus Safety application homepage with the context set
to the selected Enterprise.

Tip: For an Affiliate user, this opens as Argus Affiliate application
for the selected enterprise. This action will not open the Insight
application, even if it is configured as the Default Application in
Argus Console.

= Argus Safety Case Book-In - Opens the Case Book-in screen within the Argus
Safety application, with the context set to the selected enterprise. This action
does not launch the Argus Insight application, even if your Default Application in
Argus Safety Console.
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Argus Safety allows new Case Book-In to be done aided by an image file where an
image file can be selected from a pre-defined folder and allows you to fill-in the
case book-in parameters manually using the details available on the image file.

In multi-tenant installations, the common profile switch defined as Case
Processing - Default Network directory for scanned images is partitioned by
enterprise/client, allowing you to define separate image folders to accept
company-specific image files for New Case from Image functionality.

Tip: For an Affiliate user, this opens the New LAM Event Entry
screen within Argus Affiliate application for the selected Enterprise.

Note: Argus Safety, Argus Affiliate, Argus Safety Case Book-in and
Argus Affiliate Event Entry options only display if the user has access
to these modules and have User Group menu level access to these
screens in the respective enterprises.

Open each of the applications - Argus Safety and Insight in separate
windows independent of each other. However, if you attempt to open
the same application again for same/different enterprise, then it opens
in the same window in which that application is already opened.
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